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Chapter 1: Introduction and Initial Setup 1

Chapter 1: Introduction and
Initial Setup

From front desk to operatory, Dentrix Enterprise provides profitable integration solutions for managing a
variety of information, including patient demographics, clinical details, and production analyses. Dentrix
Enterprise can boost staff productivity, enhance professionalism, increase collections, help keep your chairs
full, and improve your bottom line.

This chapter covers the following topics about the various Dentrix Enterprise modules and the basic steps to
set up and begin using the program in your office:

e Dentrix Enterprise Overview e Setting Up Multi-codes

*  Opening Dentrix Enterprise Modules *  Customizing Practice Definitions

* National Configuration Settings *  Setting Up Practice Defaults

e Setting Up Clinics *  Setting Up Auto Chart Numbering
e Setting Up Clinic Resources *  Setting Up Default Printers

e Setting Up the Appointment Book e Setting Up Passwords

*  Setting Up the Ledger *  Setting Up Program Preferences

*  Setting Up Continuing Care Types
* Editing Procedure Codes

Before setting up your Dentrix Electronic Dental Record (EDR), it is important to understand the
relationship between RPMS and Dentrix. An interface has been installed that allows information to flow or
be “pushed” from one program to the other. RPMS will push each patient’s demographics ONLY (name,
address, birth date, SS#, and so on) into Dentrix.

If dental staff enter a change of address into Dentrix it will not be saved because the demographic information
DOES NOT flow from Dentrix back into RPMS. Once that new information is entered into RPMS,
however, within seconds, the new information will be displayed in Dentrix because it will automatically flow
over to Dentrix from RPMS.

At this time, the only information that is pushed from Dentrix over to RPMS are the completed procedures
done in the Patient Chart—the “coding” is sent for billing purposes from the work done in the Patient Chart.

RPMS >  DPatient Information >  Dentrix
Dentrix > Completed ADA and IHS Procedures in Patient Chart > RPMS

Dentrix Enterprise 7.0 User's Guide



2 Chapter 1: Introduction and Initial Setup

Dentrix Enterprise Overview

The following five main modules of Dentrix Enterprise each manage specific types of information:

Family File — The Family File module can help you enter and manage patient information, such as a
patient’s name, address, employer, insurance information, notes, and continuing care (recall or recare).

Patient Chart — The Patient Chart module can help you enter and manage the clinical information for
your patients. In the Patient Chart, you can chart existing, completed, and recommended procedures.
Additionally, you can keep extensive and detailed notes regarding patient care.

Ledger — Dentrix Enterprise automatically posts procedures completed in the Patient Chart in the Ledger,
where patient accounts are managed. The Ledger contains a record of all financial transactions entered
into Dentrix Enterprise, including charges, payments, and adjustments. You can create claims and pre-
treatment estimates from the Ledger. The Ledger also provides you with information concerning patient
portions versus insurance portions, deductibles owed, and payment arrangements.

Office Manager — The Office Manager offers useful, customizable reports and lists (reports are also
available from the DXOne Reporting module). The Office Manager works with Microsoft Word to

help you create effective, professional-looking letters: welcome letters, congratulatory letters, thank-

you notes, a variety of appointment and continuing care reminders, progress reports, and collection
notices. Additionally, the Office Manager contains a set of utilities that you can use to customize Dentrix
Enterprise to fit your needs.

Appointment Book — The Appointment Book module can help you maximize production by using
visual, goal-oriented scheduling. In the Appointment Book, you can make changes to scheduled
appointments easily and reschedule appointments by clicking and dragging them. Convenient toolbars
and flip tabs help you navigate through the Appointment Book, search for open times, organize
appointments and notes, record broken appointments, and print route slips. Also, you can clearly see the
times when a clinic is closed and when a provider is unavailable.

In addition to the five main modules, Dentrix Enterprise also includes the following components and features:
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Treatment Planner — The Treatment Planner can help you provide patients with easy-to-understand
treatment options.

Perio Chart — With the Perio module, you can record periodontal measurements, such as plaque, pocket

depth, and bleeding.

Quick Letters — Dentrix Enterprise works with Microsoft Word to help you quickly create a letter for a
patient. You can choose from over forty pre-defined letter templates for your practice correspondence or
create your own.

Quick Labels — With Quick Labels, you can quickly print a variety of labels for a patient.
Continuing Care — Continuing Care can help you monitor your patients’ on-going dental care.

Send Message — With the Send Message feature, you can create and send email messages for patients
from within Dentrix Enterprise.

Patient Questionnaire — The Patient Questionnaire module can store information from new patient
forms, health history updates, and other forms used in your office to collect information from patients.

Prescriptions — The Prescriptions module can help you quickly create prescriptions and accurately track
medicines prescribed to your patients.

Office Journal — Like a journal of your daily activities, the Office Journal has two main functions: to keep
a record of past events and remind you of events in the future.
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*  Document Center — The Document Center can help you create a truly paperless office. You can scan,
capture, and import documents (such as patient medical and dental history, proof of income, insurance
cards, patient letters, EOBs, and referral letters) or images (such as patient pictures and X-rays). You can
then attach these documents to patients, providers, insurance carriers, and referral sources, or you can
print or email them.

*  Collections Manager — The Collections Manager can help you increase your practice’s revenue by
decreasing your accounts receivable. Based on criteria you select, the Collections Manager displays a list
of accounts that need to be contacted. From this list, you have access to all the necessary information
when contacting an account, including an aged balance, payment information, Office Journal entries, and
insurance estimates.

* Patient Alerts — Patient alerts are customizable alerts that you can attach to a patient or family when you
want a message to appear whenever you access information about that patient or family, according to
criteria you specify.

*  Medical Alerts — You can access medical alerts from the Family File, Patient Chart, and Treatment
Planner. When a patient has a health condition requiring attention, the medical alerts icon in those
modules and on the patient’s appointment (in the Appointment Book) is red. You can then click the icon
to view a list of the patient’s medical alerts.

The following products and packages are available as add-ons or integrated technologies for Dentrix
Enterprise:

e eClaims — With eClaims, you can send insurance claims electronically so that your office can receive
payment in a more timely manner. If your claim cannot be sent to the payor electronically, it will be
printed to paper and mailed within 24 hours.

*  QuickBill - With QuickBill, you can generate billing statements without having to print a page, stuff
an envelope, or lick a stamp. Instead, QuickBill sends statements to a clearinghouse where they are

professionally printed, folded, and mailed.

*  Guru — Guru is a patient education software program that integrates with Dentrix Enterprise through the
Patient Chart.

* Image — Image (developed by Dexis) integrates with Dentrix Enterprise, to capture digital, intraoral
images, and radiographs.

*  Voice — Voice allows you to enter data in both the Patient and Perio Charts using voice recognition
technology.

* DentriXlink — DentriXlink acts as a bridge between Dentrix Enterprise and other clinical technologies,
such as digital X-rays. With DentriXlink, you can open a supported third-party program and pass patient
information to that program.

Dentrix Enterprise 7.0 User's Guide



4 Chapter 1: Introduction and Initial Setup

Opening Dentrix Enterprise Modules

There are three ways to open a Dentrix Enterprise module:

e The Windows Start menu — After you install Dentrix Enterprise, a DXONE folder will appear in your
All Programs list on the Windows Start menu.

@ Microsoft Word 2010 4 I° Kppointment Book
(&] Microsoft Excel 2010 » SE Chart
A Adobe Acrobat 9 Pro » 2 Dentrix Enterprise 6.0 User's Guide
(5 SQL Server Management Studio v - Dentrix Enterprise 6.5 User's Guide

] || Dentrix Enterprise 7.0 User's Guide
B Remote Desktop Connection 4 s

,,-g DXOME Report Manager
D Calculator (% Family File
[ Snagit11 Editor » [ Ledger
lg] Microsoft Qutlook 2010 » Q Office Manager |3
l ¥ All Programs } 4 Back
0 | ||.'s: th programs and files 0 |

Click the name of the module you want to open.

Note: If you select a module other than the Office Manager, the Office Manager will open behind the
module you selected to open. The Office Manager must remain open if you want to have any other
module open.

*  Ashortcut icon on the Windows Desktop — You can create a shortcut on the Windows Desktop for the
Ofhice Manager.

kL

Office
Manager

Double-click it to open the Office Manager module (open another module from there, if needed).

*  Another Dentrix Enterprise module — Once you have opened the Office Manager, you can open other
modules from the File menu or the toolbar (for example, the Treatment Planner module includes a
Dentrix Enterprise Modules toolbar).

MBEYEC o seET 2 al

Clicking the first buttons on this toolbar will start the Chart, Family File, Ledger, Appointment Book,
and Office Manager, respectively.

Dentrix Enterprise will keep the current patient active when you open another module. For example, if
you are working in a patient’s Ledger and open the Family File from the Ledger, information for the same
patient appears in the Family File, and the patient name appears on the Family File window’s title bar.

Dentrix Enterprise 7.0 User's Guide
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National Configuration Settings

The Indian Health Service (IHS) National Configuration meeting was held September 15 — 17, 2009, at

the Henry Schein Practice Solutions (HSPS) building in American Fork, UT. Representatives from HSPS,
Science Applications International Corporation (SAIC), and IHS met to decide upon a national configuration
to be used for installation at future clinics as a part of the IHS EDR project. The national configuration
established a suggested pattern for installation, while also allowing for some decisions to be made by the

local clinic being installed. The purpose of this section is to list the standards established by the national
configuration, as well as to establish those settings that will be decided by the local clinic.

The standardized configurations listed in this document have been set up in the default database that is
installed at all installations of Indian Health Clinics that are participating in the IHS EDR Project. You will
refer back to these configuration settings as your site is set up with Dentrix.

Natlonal Settings

Within the clinical notes feature of the Dentrix chart there is an option to use an “approve” button to lock
a clinical note. This approval will lock the note so that the original note cannot be edited. It will allow
for appended notes, but not an edit of the actual note that existed when the “approve” button is utilized.

Those in attendance at the National Configuration meeting decided that this button needs to be enabled
through the global settings utility that is used when a clinic is installed with Dentrix Enterprise.

* In regards to password security settings, it was decided that the security rights settings that are used in
RPMS should be followed in the installation of Dentrix Enterprise:

* A new password must be established every 90 days.
* A user cannot use any password that has been used as one of the user’s previous 6 pass-words.

*  The password must be “strong”, meaning at least 8 characters in length, consisting of a combination
of upper case letters, lower case letters, numbers and special characters.

*  After three attempts, the user is to be locked out for an automatic stay of 1 hour. Another user with
appropriate permissions may unlock the user sooner than the one hour.

*  Another setting to be established in the Global Setting utility at the time of installation is the enabling of
the Medical History Review option. This option will enable a window that will pop up the first time each
day that a patient’s record is accessed through the Patient Chart.

e In the Appointment Book, it was decided to create a standard list of definitions to be used as
Appointment Statuses. This list is not comprehensive, allowing the local clinic to customize the list to
meet the needs of the clinic.

The appointment statuses that were added to the National Configuration are as follows, including the
colors to be assigned:

*  Confirmed *  Dark Blue
e Left Message * Light Blue
*  Unable to Contact *  Brown

e Patient Here *  Green

*  ER/Walk In * Red

*  Special Needs *  Orange

Dentrix Enterprise 7.0 User's Guide



6 Chapter 1: Introduction and Initial Setup

*  As Initial Reasons used for scheduling appointments, also found in the Definitions area of the Office
Manager, the following procedures were decided upon:

*  New Patient *  Oral Hygiene Instructions
*  Comprehensive Exam *  Deriodic Exam

* Pano *  Limited Exam

* 4 Bitewings *  Under 3 Exam

* 2 Bitewings e Consult

¢ TFMX *  Office Visit (Follow Up)

*  Prophy e Palliative Tx

e Child Prophy *  Perio Maintenance Therapy

¢ Fluoride

*  Also found in the Appointment Book is the Continuing Care List.

& Continuing Care EI@
File Edit Views 5tatus OfficeJournal Document Center
ALL -> ALL ALL

Dat

05/20/2011 ORTHO BM Bowen, John 46 | Provl |MESA IHC

05/20/2011 ORTHOD G “Bawen, Charlie 50 Provl | MESA IHC
05/24/2011 ORTHOD = Brown, Carlie a0 Provl | MESA IHC
05/24/2011 ORTHOD G *Brown, Carl 10 Provl [ MESA IHC
05/24/2011 ORTHOD = Brovar, Proni E Provl | MESA IHC
05/25/2011 ORTHOD EM *&hali, Broan 0 Prowl [ MESA IHC

It was decided to include the following standard lists as a part of the National Configuration:
* Last month of patients who were due for treatment but never seen.

*  Last 3 months of patients who were due for treatment but never seen.

e Last 6 months of patients who were due for treatment but never seen.

* Al patients that have been due for treatment but never seen.

*  'The list of available continuing care types that can be tracked automatically by Dentrix Enterprise is to
include the following:

*  Space Maintainer to be tracked at every 6 months and attached to ADA codes D1510 and D1515.

* High Risk Caries to be tracked at every 3 months. The attached code is to be determined.

*  Oral Path to be tracked at every 1 month. The attached code is to be determined.

*  Hygiene is to be tracked at every 6 months and attached to ADA codes D1110, D1120, and D4910.
*  Ortho is to be tracked at every 1 month and attached to ADA code D8670.

* In the Procedure Code Setup area of the Office Manager, the only change to be established on the
national level is the op site(treatment area) for ADA code D0220 and D0230 is to be set to tooth, thereby
requiring a tooth number.

Dentrix Enterprise 7.0 User's Guide



Chapter 1: Introduction and Initial Setup 7

* In the Letter Merge area of Dentrix Enterprise there will be templates included that will provide Post Op
instructions for the following codes and letter names:

« SSC sscpost.doc
*  Dental Surgery surgery.doc
e Simple Extraction simpext.doc

*  DPedodontic Extraction  pedoext.doc

e Trauma traumal.doc
*  Dentures denture.doc
e DPulpotomy pulppop.doc
*  Sinus Opening sinusop.doc
*  Excuse Letter excslip.doc

e It was decided that Prescriptions will continue to be entered as they currently are, meaning that they will
be entered through the EHR.

* It was decided to include the following as Allergies within the Definitions:

e Latex e Aspirin

*  Denicillin *  Codeine

*  Amoxicillin *  Hydrocodone
*  Clyndamycin e lodine

e Sulfa *  Erythromycin
* Ibuprofen e Tetracycline

e Local Anesthetic e See Notes

e Tylenol/Acetaminophen

* It was decided to include the following as Medical Alerts (in addition to those already included in the
installation):

*  Bisphosphonates
¢ Auto Immune Disorders
*  Hepatitis C

e In the Patient Chart, it was decided to use the following color scheme to represent the associated
treatment type:

e  Treatment Plan Red
e  Completed Blue
* Existing Blue
*  Existing Other Blue
*  Conditions Black

Dentrix Enterprise 7.0 User's Guide



8 Chapter 1: Introduction and Initial Setup

e Also in the Patient Chart, it was decided to establish 21 of the 24 Quick Procedure Buttons.

Setup Procedure Buttons @
Click a button to zet it up...
Azzsigned Codes
ADULT

0000 (ME0}—— 2] gooo @190 D110
CHILD || ey

= E 01120 DO274  DO272

ﬁ E 89900 pF140 DO330 9990

D1z06

&

01206 |D2140 D239

D2a40|D1320

i

O320

&

—-":
m
mm

DZ340 D1320  D9110

02330 02750 D3310

03220 |d1351  |d0220

EQ @8
g Ellj=o

15003 0000 ]

ﬂ

K. Cancel

The following codes and icons are used:

e 0000 1st Visit This Fiscal Year (10/1)

* 0190 All Subsequent Visits

« DI1110 Adult Prophy

e DI120 Child Prophy

e D0274 4 BWX

e DO0272 2 BWX

e D7140 Tooth Extraction, erupted/uncomplicated

e DO0330 Panorex

* 9990 Treatment Plan Completed

e DI1206 Fluoride Varnish

e D2140 Amalgam Restoration (use for anterior and posterior, any number of surfaces)
 D2391 Comp/Resin Restoration (use for anterior/posterior, any number of surfaces)
e D2940 Sedative Filling

e D1330 OHI

« DI110 Palliative Treatment

e D2930 Stainless Steel Crown

e D2750 Porcelain Fused to High Noble Crown
 D3310 RCT - any area of the mouth

 D3220 Pulpotomy

e DI1351 Sealant

* D0220 Periapical X-ray, first one

e Site Decision The clinic can decide which code and icon to use
e Site Decision The clinic can decide which code and icon to use
e Site Decision The clinic can decide which code and icon to use
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Chapter 1: Introduction and Initial Setup 9

Within the Password Setup, it was agreed to include five employee password templates that would be used
to base the assignment of password rights for all other employees. These five templates will be assigned to
“users” with the following names and roles:

e FD Template Front Desk

* DA Template Dental Assistant
e Prov Template Dentist

*  FATemplate Full Access

*  RDH Template Dental Hygienist

The rights assigned to each are as follows:

s
o

DA Prov

2

Security Option RDH

Appointment Day Notes, Modify

Appointment Lists

Appointment Views, Add New

Appointment Views, Delete

Appointment Views, Edit

Appointments, Break

Appointments, Delete

Appointments, Edit

Al el el el el el el ks
il ls
il s
R PR R R

Appointments, Open

Appointments, Purge

<
>
<

Appointments, Schedule New

Appointments, Set Complete

Appointments, Setup Clinic

Appointments, Setup Providers

Appointments, Setup Schedule

Approval Status
Appt Lists, View All Clinics
ApptBook, Change Prov Color

ApptBook, Copy View

sl sl el el el el ol ol el el el Bl Bl el el Kl Kl Kl e

ApptBook, Copy Views to Users

R R R KK O O
>
>

>~

ApptBook, Remove Prov

Auto Chart Number Setup Set up to not assign

<
~

Batch Processor, Delete Reports

>
o

Batch Processor, Print/Display Reports X
Billing/Payment Agreement, Modify X
Chart Setup
Chart, Open X X X
Clinic Admin

Clinic ID Change
Clinic Resource Setup @)
Clinical Notes, Append X

Clinical Notes, Approve X

PR R R R R R R <
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10 Chapter 1: Introduction and Initial Setup

Security Option

FD

DA

Prov

2

RDH

Clinical Notes, Delete

Clinical Notes, Modify

©)

Collections Manager, Open

Completed Procedures, Delete

Completed Procedures, Edit

Completed Procedures, Enter

Conditions / Diagnosis, Delete

Conditions / Diagnosis, Edit

Conditions / Diagnosis, Enter

Continuing Care, Clear Patients

Continuing Care, Edit Patients

S

Continuing Care, Open

Il kil bl B kel kel ks

Al sl sl el el el el ks

il sl il sl bl sl kel ks

Continuing Care, Setup

Credit Adjustment, Delete

Credit Adjustment, Edit

Credit Adjustment, Enter

Customize Toolbars

Database Mode Setup

Debit Adjustment, Delete

Debit Adjustment, Edit

Debit Adjustment, Enter

Dunning Messages, Modify

DXOne Report, Launch

>~

I il il sl bl bl Bl Ll el Bl el el el el el e el el el el el el e

Employers, Add New/Edit Info

Existing Procedures, Delete

Existing Procedures, Edit

Existing Procedures, Enter

Family File, Open

kel el kel

kel kel kel

el kil ks

Fast Checkout

Fee Schedule, Setup

Guarantor Notes, Modify

Guarantor Payment, Delete

Guarantor Payment, Edit

Guarantor Payment, Enter

Image, Open

Ins Payments, Delete

Ins Payments, Edit

Ins Payments, Enter

Insurance Claims, Create New

Insurance Claims, Delete

Insurance Claims, Edit

Al el il sl el el el bl el el el el el kel el ke
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Security Option

FD

DA

Prov

2

RDH

Insurance Claims, Open

Insurance Coverage, Modify

Insurance Payment Tables, Modify

Insurance Plans, Add New/Edit Info

LC/EC, Delete

LC/EC, Edit

LC/FC, Enter

Ledger + History

Ledger Setup

Ledger, Open

Ledger, Open Treatment Plan

Letters, Add New

Letters, Birthday

Letters, Collection

Letters, Continuing Care

Letters, Delete

Letters, Edit

>

>

>

o

Letters, Inactive Patient

Letters, Misc.

Letters, Referral

Letters, Welcome

Medical Alerts, Edit

Medical Alerts, View

I kol kel kol ko

Medical Consultation

Sl B i el ke

il i e kel ke

Sl el Kl el ke

Month End - Charges

Month End - Payment Plan

Month End - Update

More Info / Family Appointment List

>

>

>

Multi-Clinics, Purge Appt

Multi-Codes Setup

Office Journal, Add En-tries

Office Journal, Delete Entries

Office Journal, Edit Entries

Ofhice Journal, Open

Office Manager, Open

el Bl el e

el Bl kel ke

il il ksl ke

el Bl el e

Ofhice, Report Multiple Clinics

Password Administration

Password, Multi-Clinic

Patient Alerts, Modify

Patient Notes, Modify

=

S

S

Patient Notes, View

il sl il el ial sl bal Eal el ol el bal Lol kol Lol Kol Kol Kol Kol Kol Kol Kol Kol Kol ol ol ol Kol Kol Kol Kl K Kl B e Kl Bl Ks R Ks R ke
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Security Option FD |DA (Prov

2

Patient Prescriptions, Delete

Patient Prescriptions, New

Patient Prescriptions, Open

Patient Questionnaire Setup

Patient Questionnaire, Edit

Patient Questionnaire, New

Patient Questionnaire, Open

Patient Quick Letters X X X

S
<
S

Patient Referrals, Delete

Patient Referrals, Open X X X

Al el sl el el el el el ke

Patients, Add New

Patients, Archive

Patients, Delete

Patients, Edit Family Relations

Patients, Edit Information X X X

Payment Agreement Types, Setup

Payment Plans, Add New / Edit Info

Perio Chart, Open X X X

Practice Definitions Setup

Practice Preferences Setup

Prescriptions Setup

Prescriptions, View

Presenter, Open X X X
Print Appointment Book Views X X X
Print Billing Statements

Print Charts or Progress Notes X X
Print Continuing Care Lists X X X
Print Day Sheets

Print Day Sheets, MTD/YTD

Print Future Due Payment Plans

Print Insurance Aging Reports

Print Insurance Claims

Print Office Journal Reports X X X

Print Patient Notes X X X

Print Patient Prescriptions

Print Patient Questionnaire

Print Payment Agreements

A il sl il el ol el el bl el Bl el el el el el el Kel el Kl Kl el el Kl Kl Kl ks

Print Perio Chart Letters or Charts X X X

Print Route Slips X X X X
Print Treatment Plans X X X

Procedure Code Setup

Dentrix Enterprise 7.0 User's Guide
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Security Option

FD

DA

Prov

2

RDH

Procedure-Instructor, Enter / Edit

Providers, Inactivate

Purge Insurance / Employers

Referral Analysis, Open

Referrals, Add New/Edit Info

RVU, Auto Changes

Sched Reports, Delete Any

Sched Reports, Print/View Any

Send Electronic Billing

Send Electronic Claims

Suspended Credits, Apply

Treatment Plan, Delete

Treatment Plan, Edit

©)

=

el el el it el e el el el kel ke

©)

Treatment Plan, Enter

Trojan, Import

User Self Setup

View All Operatories

View All Patients

A kol kol

ol kel ks

A kel kel

il talls

View All Providers

X

X

X

>

el d ks

*Any option listed with an O in the box is to be left for the local clinic to decide.

Local Settings

As a part of the National Configuration Meeting, it was decided that there were aspects of the software setup
that should be left to the local clinic for decision making, including the following:

Production Types
Appointment Checklist

Appointment Book time increments

Multi-codes

Approval Status for Treatment Plans
Appointment Types

Billing Types

Medications

The local clinics are also to have the ability to add to any of the lists of standardized configurations to make
the software apply more effectively to the local clinic.
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Setting Up Clinics
You can add and edit clinic information for all clinics in Dentrix Enterprise. Set up clinics prior to setting up
providers. You must be in the Central clinic to set up a clinic. The Central clinic provides access to all setup

features. Configuring clinic information from one computer affects all computers running Dentrix Enterprise
on the network.

To add or edit a clinic

1. While logged on to the Central clinic, in the Office Manager,
from the Maintenance menu, point to Practice Setup, and
then click Enterprise Setup.

@ % Dentrix Office Manager - The Dentist Group <

The Enterprise Setup dialog RS

box appears.

2. Select your clinic (for example,
“MESA THC”), and then click
Edit.

The Clinic Information dialog
box appears.

3. Enter the following clinic
information:

General tab

Dentrix Enterprise 7.0 User's Guide

Clinic: Information

Clinics

The Dentist Group
1234 Dakdale Dr

American Fork, UT 84003
[801)555-9399
January

Clinic Resource Setup

AF Advanced women Health Care
The Dentist Group
The Dental Group

NO_CLINIC
FINEDALE The Dentist Group

oo N Tlom Pimsnbiok e

[ d

American Fark, UT & 1y - @

Descriptive ID — Type an ID that is four to 11 characters
in length (the maximum depends on a certain global
setting). Valid characters include A-Z, a-z, 0-9, and

a hyphen (-). This ID is used to reference the clinic
throughout Dentrix Enterprise and on reports.

Financial Number — Type the account number for the
clinic’s financial institution.

Merchant ID — Type the ID used by the clinic for
processing credit card payments.

Clinic TIN — Type the Tax Identification number of the
clinic.
Entity ID Code — Type the code used to identify the

entity for the clinic.

Title — Type the name of the clinic.

= Edi
£ OR
. | N
Clinic Information - MESA 3 3]
I General |Settings] Optional Settings riptions |
Descriptive [D: Internal 10:
[MESA |2
Financial Mumber: Merchant |D:
Clinic TIM Entity ID Code:
Clinic NP
Title:
|The Drentist Group
Address:
|1234 Dakdale Dr
City ST Zip
American Fork, ut 84003
Phone Ext. Fax
(801)555-9399 (801)555-9399
I

4 Cancel

Address — Type the clinic’s address, the phone number
and extension of the contact person in the clinic (if
applicable), and the clinic’s fax number.
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Settings tab Clinic Information - CENTRAL (=3
Administrative Contact — Click the search button **! to General Setiings | Optional Settings | Subscrptions |
select the business contact at the clinic. Only providers dniisive Contset [ ]
who have been entered into Dentrix Enterprise and who Bank Depasi Nurmber
have a 10-digit phone number are available for selection. !

. N Show/Hide/Mask SSN:

Bank Deposit Number — To have the clinic’s bank [Show Completely El
account number print on deposit slips, type the Fiscalyear's beginring marith (112 [T
appropriate number. Time Zane:

. . | (GMT-07:00) Maountain Time (US & Canada) =l
Show/Hide/Mask SSN — Select one of the following i

iling Statements

OpthHSZ ™ Use Central Office Info on Statements

(¢ se Clinic Info on Statements.

" Use Pravider Info an Statements.

e Use Central Clinic Option — The setting will be the
same as that for the Central clinic.

Change Provider Completion Options

. . , W Overtids Provider For il Transscti
*  Show Completely — Shows the entire Social Security sy e

number throughout Dentrix Enterprise. This option ¥ Fefesn
is selected by default for the Central clinic after the
update is installed.

* Hide Completely — Hides the Social Security x|

Cancel

number. All fields that display Social Security number
will be blank except in dialog boxes where the
number is entered or edited (for example, the Patient Information dialog box).

*  Mask Completely — Masks all digits of the Social Security number. Each digit will be replaced

with a lowercase x except in dialog boxes where the number is entered or edited.

*  Mask All But Last Four — Masks all but the last four digits of the Social Security number. Each
of the first five digits will be replaced with a lowercase x except in dialog boxes where the number
is entered or edited.

For a comprehensive explanation of where the Social Security numbers will be shown, hidden, or
masked throughout Dentrix Enterprise, see the “Enterprise Setup” topic in the Dentrix Enterprise Help.

Fiscal year’s beginning month (1-12) — Type the number of the month that your fiscal year begins.
The default value is 1 (January).

Billing Statements — Select the option that corresponds to the information you want to appear on
billing statements:

*  Use Central Office Info on Statements — To print the name and address of the Central clinic on
a statement sent to a patient of this clinic.

¢  Use Clinic Info on Statements — To print this clinic’s name and address on a statement sent to a
patient of this clinic.

e Use Provider Info on Statements — To print the name and address of the patient’s primary
provider on a statement sent to a patient of this clinic.

Change Provider Completion Options — If the completing provider for procedures is often not the
same as the treatment-planning provider, you can change the provider for those procedures and have
that provider be the default for any procedures completed for a selected patient or for all patients. To
enable the completing provider override feature, select Override Provider For All Transactions, and
then select one of the following options:

*  Per Patient — The specified provider will be used for completed procedures being posted for a
given patient until you select another provider or patient.

*  Per Session — The specified provider will be used for completed procedures being posted for all
patients until you select another provider or close all Dentrix Enterprise modules.
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Optional Settings tab (Central clinic only) Clinic Information - CENTRAL =
4 Automatic LOg Off " General | Settings  Optional Settings | Subscriptions |
. Automatic Log Off
*  Enable Automatic Log Off — To have users logged 5 Enable Automatictog OFF
off of Dentrix Enterprise after a specified length deTme: 15 Minutes
of idle time, select this check box. Type the length W' Enable Warning Messages
. . . . . - seconds before
of Idle Time, in minutes, that is allowed before a ooy [15 | e
user is logged off the program. Dentrix Enterprise Additional Settings
. . . . [¥ Enable Patient Access Logging
is considered to be idle while there are no mouse i
movements or keyboard strokes in any Dentrix Ll
Enterprise module on the computer to which a user S

is logged on except for the DXOne Report Manager, ¥ Patient Health Assessment
. . . v it
DXPrint, and DXOne Reporting processes, which i
. . . |v Medical Alerts
are used for reports. However, if a report is being

. . Appointment Book "Late Appt” Tracking
run, and the user is logged off automatically, the

[ Enable "Late Appt™ Tracking

generation of the report is canceled. APTSET =] ApptStatus to Watch for
Enable Warning Messages — To have a warning = NI beeE ptE aa et
message appear before users are logged off

. . . oK | Cancel
automatically, select this check box. In the Display red |

field, type the length of time, in seconds, that you

want the warning message to appear before a user is logged off automatically. The message will
present the options to the user to continue working in Dentrix Enterprise without being logged
off or to log off immediately. If the message is ignored, after the specified number of seconds, the
user is logged off automatically.

*  Copy to Clinical Notes

Patient Health Assessment — To have a clinical note created automatically each time a health
assessment for a patient is recorded, select this check box.

Prescriptions — To have a clinical note created automatically each time a prescription is entered
for a patient, select this check box. To add a note each time the status of a prescription changes,
select Prescription Status Changes.

Medical Alerts — To have a clinical note created automatically each time a medical alert is entered
for a patient, select this check box.

* Appointment Book “Late Appt” Tracking — To allow the time from the scheduled time of
appointments to the arrival time of the corresponding patients to be monitored by Dentrix Enterprise
(for the Appointment Statistics Report), select this check box. Then, set up the following options:

Dentrix Enterprise 7.0 User's Guide

Appt Status to Watch for — Select the status appointments will have before the corresponding
patient arrives. Dentrix Enterprise will begin monitoring a patient’s visit when the specified status
is selected for his or her appointment from the Appointment Information dialog box.

Minutes before patient is considered LATE — A patient will be considered late for his or her
appointment when the specified number of minutes has elapsed from the time of the scheduled
appointment until the status your office uses to indicate a patient has arrived is selected for that
appointment. If a patient is late for his or her appointment, the Late Appt check box is selected
in the Appointment Information dialog box, and a red dot appears in the upper-right corner of
the appointment on the schedule.
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Subscriptions tab Clinic Information - CENTRAL =

*  Outcome — If you have purchased a subscription for Genera| Setings | Dptional Setings - Subscrptions |
this feature (Quintiles is the third-party provider of the
Outcome service), click Setup Outcome to enable and set

up Outcome. -
Qutcome Expiration Date: | 01/31/2014

—Outcome

# Licenses: | 10

*  ePrescribe — If you have purchased a subscription for
this feature (AllScripts is the third-party provider of the
rePrescribe

ePrescribe service), click Setup ePrescribe to enable and .
HEHEhE # Licenses: | 10

set up ePrescribe. Setup
ePrescribe Expiration Date: | 01/31/2014

*  Patient Portal — If you have purchased a subscription
for this feature (UpDox is the third-party provider of

the Patient Portal service), click Setup Patient Portal to ‘Pa“:”tt::;‘ﬁ'
[v] Ve &1 .
enable and set up Patient Portal. setp 7 beenses:

Patient Portal |  Expiration Date:

IRRLERER

4. Click OK.

For comprehensive information about setting up Outcome,
ePrescribe, and Patient Portal, see the “Changing clinic
information” topic in the Dentrix Enterprise Help.

(] 8 Cancel

Setting Up Clinic
Resources

You can edit your clinic information, operatory IDs, provider information, and staff information.

To access the Clinic Resource Setup

* For any clinic
1. While logged on to the Central clinic, in the Office
Manager, from the Maintenance menu, point to Practice

Setup, and then click
Enterprise Setup.

2 Dentrix Office Manager - The Dentist Group <

Enterprise Setup

 Clinic: Infarmation

The Enterprise Setup dialog The Deniit Graup
box appears. American Fork, UT 84003

o [B01)555-3999 .
2. Select the clinic that you want January 3 ) cirie Resaurce et

to edit. ~ Clinic: —
. . . AF Advanced Women HeglllLare American Fork, UT  »
3. Under Clinic Information, DRAPER The Dentist Group ey
. .. The Dental Group esa, A2 K Edit
click Clinic Resource Setup. NO_CLINIC _ _ E
FIMEDALE The Dentist Group Pinedale, W Dielete
{=l=lniNin] Tl Dimmbink [rmnm Drmiam 1IT
The Clinic Resource Setup
dialog box appears.
*  For the clinic that you are logged on to =N
ﬁ Dentrix Office Mana Jhe Dentist Group -
In the Office Manager, from the Maintenance menu, point to File View Reports Lettefs JMaintenanc
Practice Setup, and then click Clinic Resource Setup. The Clinic F% zg@l\éléﬁl' ire| KA
Resource Setup dialog box appears. E
Des

Faniy ek ul Siaenect iebat.

The sections that follow explain about setting up clinic resources.
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Changing Clinic Information

You can edit a clinic’s information as needed.

To edit a clinic’s information

1. In thC CliniC RCSOl.ll'CC sctup dlalog bOX, Clinic Resource Setup - The Dentist Group < CENTRAL= @
Cl Cl. . I f . 1 k Ed, Clinic: Information Operatonies
under Clinic Information, clic it. The Dental Graup
.. . 1234 South Maple Drive MESAZ Mew
The Clinic Information (G inormation - MESA = e
dlalog bOX appears' I General |Settings] Optional Settings Tiptions |
2. Change the clinic Descriptive [D: Intemal ID: Edit
. . i
information as needed. MESA |2
FOI' information about Financial Murnber: Merchant ID:
the available options, see | | cboreh =
P 4 Cliric TIN Entity |0 Code: Bvid Edit
“Setting Up Clinics” in 2eeb Inactivate
this chapter. Clnic NP
3. Click OK. Tile:
|The Dentist Group
Address:
|1234 Dakdale Dr
| a%l Kaye Mew
racy
City ST Zip
American Fork ur 84003
Fhone Ext. Fax
(30115553333 [301)555-3333 Electronic Patient Portal
R Admin Setup Close
3 ] Cancel |
A
—

Setting Up Operatori

es

An operatory is a room, chair, or other location where treatment is performed in your office. Appointments

are scheduled by operatory on any given day.

To add or edit an operatory

1. In the Clinic Resource Setup dialog box,

under Operatories, do one of the following:

Click New to add an operatory.
*  Select an existing operatory, and then click

Edit to edit that operatory.
The Operatory Information dialog box

appears.
Type the following information:

ID — The unique ID for the operatory.

Operatory Title — The title to use for the
operatory instead of the ID when printing
the Operatory Appointment List.

Click OK.

Clinic: Information

The Dental Group
1234 South Maple Drive

Mesa, A7 85210

Clinic Resource Setup - The Dentist Group < CENTRAL=

(801)555-1111
January

Operatory Information
Administrative Contact:
Clinic ID: MES&

Provider(z]
AMCCLLURE

Caticel

P
Operatories 1
MESATo. [ p ]
MES&2
MESA3
MES&4
[ ew
Edit
Inactivate
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Setting Up Providers

Each individual that provides billable treatment to patients is considered a provider in Dentrix Enterprise.
During the initial push of information, all doctors (primary providers) will be moved into Dentrix from
RPMS. This initial information will need to be edited so that Dentrix contains appropriate User ID’s, logon
information, site address, NPI numbers, and so forth.

Hygienists do not get pushed over from RPMS. There will be one “place holder” hygienist in the Dentrix
Clinic Setup that can be tweaked to contain a dental hygienist’s information. Additional hygienists can be
added and mapped into Dentrix allowing that production to move back to RPMS under the Dental Chief’s
Dentrix 1D for billing purposes.

Important: To add a primary provider not listed in Dentrix Enterprrise, you MUST have that provider set up
in RPMS first, and then call Dentrix Technical Support to have a technician “map” the provider in RPMS to
Dentrix Enterprise. After that, the new doctor can be pushed to Dentrix Enterprise.

To edit a provider

1. In the Clinic Resource Setup dialog box, Clinic Resource Setup - The Dentist Group <CENTRAL> =
under Provider(s), select an existing provider, Cliic Infarmation Operatories
. . . . The Dental G
and then click Edit to edit that provider’s 1234 South Madls Drive MEGA? Mo
. . MESA3
information. Mesa, AZ 85210 MES &4
(501}655-1111 )
The Provider Information dialog box appears. St
Administrative Contact: .
. . . ii Ed
Tip: If you want to view providers that have Ciinc ID: MESA &
been inactivated in addition to the active P"'id S -
AMCCLLER - McLlure, Angela e
1 1 1 1 - Hayes, Debarah
providers listed, select List Inactive at tl‘le DavE o Dot "
bottom of the Clinic Resource Setup dialog - Kimball, Jacob A -
nactrvate
box.
2. Enter or change the following R [mSn)
. f . . Last First Ml Suffix Log On
Inrormation: Name: [Emith [Denris £ User ID: [DSMITH Edit
e Name — Type the provider’s ID: [DSMITH Tite:[0DS [ NonPersgn Hser Password: [
. Confirmn Pagsword: | ™
Last name, First name, and MI Specialy: [ Dentit =] .
. L o Electronic Fx ser
(mlddle 1n1tlal) . Address: |1234 Dk Street Fee Scheduls: W ﬂ
e ID - This ID is pre-populated |C_ — RVU Schedule: [1 >
. . ity tate Jip
with the provider’s NPI number [merican Fork 0T 54003 Clinic: [CENTRAL »]
Change the ID to something Phone: BT Ex[p TIN #: [<CLINIC B
more deSCflpthC (fOI' example, E-Mai |Desmithdds@henryschein.c:om
DRWROBERTS, for Dr. Wesley ss# [T
Roberts; and HYMJONES, State 1D #[122456 StatefUT
fOf Mary JOHCS, RDH) Type a J 2 Stah:e :CET;E:ZI;TDN 1111142020
edaical -
unique ID for the provider. The Dt o
1D must bC 4 to 10 characters Pravider ID Setup | DEA License E spiration: W
in length. You can use letters, Class DEA Schedule: W 1| W Il @ I @ v
P
numbers, and hyphens (-). Fly NPI: 1234567330

" Secondary J ¢ Blue Cross ID#: ’1117

. " Blue Shield ID#:
NOtCI PrOVIdCf IDS are USCd Insurance Claim Options Provider #: [222

tthllghOUt Dentrix Enterprise. ¥ Print Pravider's Signature Using: Oifice # [333
. . . ¢ Signature on File 7 Provider's Name .
Whenever a provider is displayed - Ditrer D
v Use Clinic TIN T s

or printed, it is usually only the —

provider ID that is seen. Cancel
&),
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e Title — Type the provider’ title, such as DDS, DMD, or RDH.
*  Non-Person — If this provider is an entity, such as a corporation or association, select this check box.
*  Specialty — Select the appropriate specialty for the provider.

*  Address — Type the business address of the provider. This address will be used on all correspondences
to patients, referrals, insurance carriers, and so forth. Also, type the provider’s E-Mail address.

*  Phone - Type the business phone number and extension (if applicable) of the provider.

* Class — Select the class for the provider: Primary, for primary care providers, such as dentists; or
Secondary, for secondary care providers, such as hygienists.

* Insurance Claim Options — To avoid having to sign each printed insurance claim, select Print
Provider’s Signature Using, and then select Signature on File or Provider’s Name. If you want to
use the clinic TIN on insurance claims, select Use Clinic TIN.

*  Log On User ID — If you are adding a new provider, type the ID that this provider will use to access
Dentrix Enterprise.

*  Password — In the User Password field, type the password that this provider will use to access
Dentrix Enterprise. Enter the same password in the Confirm Password field.

Important: The password must be at least 8 (for standard users) or 15 (for administrative users)
characters in length and meet the following requirements: have at least one uppercase letter, have
at least one lowercase letter, have at least one number, and have at least one special character (for
example, #, %, or &).

*  Fee Schedule — If this provider will use a different fee schedule from the default fee schedule, click
the search button **|, and then select the appropriate fee schedule.

*  RVU Schedule - To associate an RVU schedule with this provider, click the search button **/, and
then select the appropriate RVU schedule.

*  Clinic — Click the search button *?|, and then select the clinic where the provider works.

*  TIN - If the clinic Tax Identification number (TIN) will be used by the provider (Use Clinic Tin is
selected under Insurance Claim Options), the field displays “<CLINIC>.” Click the Tin # search
button **, and then add, edit, or remove the TIN of any clinics as needed. You must have at least
one TIN entered.

e 8S # —Type the provider’s Social Security number. This number will appear on insurance claims.

e State ID #, State, and State Expiration Date — Type the provider’s state license number, the state
where that license was issued, and the expiration date of that license. The state ID will appear on
insurance claims.

* DEFA #, License Expiration, and Schedule — Type the provider's DEA number and the date that
DEA license expires, and select the classes of medication that the provider can prescribe. The DEA
number can be used with specialized insurance claims.

* Additional IDs — Enter any of the following IDs, which can be used with specialized claims:
Medicaid #, NPI, Blue Cross/Blue Shield ID # (you must select one or the other), Provider #,
Office #, Other ID #, and UPIN#.

3. Click OK.

For information about adding other IDs through the Provider ID Setup, see the “Setting up provider IDs for
dental insurance” topic in the Dentrix Enterprise Help. For information about setting up the provider to use
ePrescribe, see “Editing and disabling/enabling ePrescribe user accounts” in the “Adding, editing, inactivating,
and reactivating providers” topic in the Dentrix Enterprise Help.
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Inactivating Providers

You cannot delete providers. When a provider no longer works at a clinic, you can inactivate that provider.
Inactivated providers are not available for selection throughout Dentrix Enterprise wherever providers can be
selected except when setting up options for reports. New procedures and treatment plans cannot be posted for
inactivated providers. New prescriptions and payment plans cannot be entered for an inactive provider. Also,
existing treatment-planned procedures associated with an inactivated provider cannot be set complete.

To inactivate a provider

In the Clinic Resource Setup dialog box, under Provider(s), select the provider who you want to inactivate,
and then click Inactivate.

Setting Up Staff

Staff members are employees who have not been entered as providers and who will use Dentrix Enterprise.

To add a staff member or edit a staff member’s information

1' IIl the Cllnlc Resource SetuP dlalog bOX’ Clinic Resource Setup - The Dentist Group <CENTRAL= @
under Staff, dO one Of the following: Clinic: Information Operatories
The Dental Group
¢ Click New to add a staff member. 1234 South Mapls Drive i New
o Mesa, &2 85210 MES44
e Select an existing staff member, and then fBUTES5TT1 ==
. ) 2. . . anuary
click Edit to edit his or her information.
Administrative Contact: .
The Staff Information dialog box appears. Ciinc ID: MESA [ &5 |
. . . Provider[z]
2. Enter or change the following information: AMCCLURE htcClue, dngela New
DHAYES -Hayes, Del_:orah =
e Log On User ID — Enter or edit the ID g D i | il
that this staff member will use to access nactivete
Dentrix Enterprise.
e Password — In the User Password field,
type the password that this staff member
will use to access Dentrix Enterprise. Staff o=
Enter the same password in the Confirm HERION e New
Password field. LB |
Important: The password must be at
least 8 (for standard users) or 15 (for ] U8lieste S i ==

administrative users) characters in length - LoaOnlser D: [TERICKSON  Eai
User Password; [

and meet the following requirements: have at least one

Confirm Pazsword: =

uppercase letter, have at least one lowercase letter, have at Ciric: [MESA »]
least one number, and have at least one special character Last Fist Ml Sulfs
(for example, #, %, or &). Nae; [Eickeon ] [

ID: [TERICKSON  Title: [Aesistant
e  (Clinic — Click the search button **|, and then select the @j el

ess: | 7856 South State
clinic where the staff member works. |
City 5T Zip

e  Name — Type the staff member’s full name. Mess iz [ee210

e ID —Type a unique ID for the staff member. The ID i [ = .

E-Mail |

554 Electronic Rx User
3 Cancel

must be 4 to 10 characters in length. You can use letters,
numbers, and hyphens (-).

e Tite — Type the staff member’s position (for example,
receptionist or office manager).

21
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*  Address — Type the staff member’s home address.
*  Phone - Type the staff member’s home phone number and extension (if applicable).
e E-Mail — Type the staff member’s email address.
e 8§ # —Type the staff member’s Social Security number.
3. Click OK.

Inactivating Staff
Staff cannot be deleted. When a staff member no longer works at a clinic, you can inactivate that staff member.

To inactivate a staff member

In the Clinic Resource Setup dialog box, under Staff, select the staff member who you want to inactivate,
and then click Inactivate.
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Setting Up the Appointment Book

You can customize several features of the Appointment Book to meet the needs of your practice. These options
can be set up and/or changed at any time without affecting data already entered. However, for consistency,
you should set them up before you begin using Dentrix Enterprise.

This section covers the following topics about setting up the Appointment Book:
*  Setting Up Views *  Setting Up an Operatory
*  Setting Up a Clinic *  Setting Up Flip Tabs
*  Setting Up a Provider

(] L]
Setting Up Views
Views allow you to see the Appointment Book in various ways; for example, you can have one view for when

you are in the operatory and a different one for when you are at the front desk. For each view, you specify
which providers, operatories, hours, and patient details are shown in the Appointment Book.

You can have up to 111 different views for the Appointment Book on any given computer in the office unless
a certain global setting is enabled; in which case, you can have an unlimited number of views.

To add or edit a view

1. In the Appointment Book, click View on the menu bar.

\) Appointment Book <The Dental Gro
Status Setup Appt Lis

The Select View dialog box appears. e
. Select View (23]
2. Do one of the following:
Short-cut: View Mame: Clinic:
¢ (Click New to add a new view. “Main
. . . . Select
*  Select an existing view, and then click Edit to 9 Seeat|
. . Ci i
edit that view. e
- Edit
The Edit View dialog box appears. e |
3. Set up the following options: @7 Delete
e Appt. View Name — Type a name for the view. =
*  Short-cut key to view — Select the shortcut key | e e e
tha[ you want to use to access the ViCW. Short-cut ke to the visw: v View alerts Iv “iew Provider Columins
. . .. . - Select Days Appointment Display Info
*  Clinic — Select the clinic that you want to view. A
Cinic: [WESs [~ Sunday Line 1: |Mame -
. . . . [[g]l= -
*  Selected Providers — Click Modify List to select = | & oy Line 2 [appt Fosson =]
. . Selected Providers W Tuesday
the providers for the view. Line 3 [Phone =
tadify List v wWednesday ) -
*  Selected Operatories — Click Modify List to AMCCLURE ¥ Thursday Lne . [Proider <]
. . DROBE . Ui -
select the operatories for the view. W Friday o B
. . . [~ Saturday Line B | Appt Type -
*  View Options — Select any of the following: . -
Selected Operatories Month Time Wiew & -
¢ View Amount — To have the scheduled Madiy List et BB Line 8: [w/ark Phone _~
production amount for the day, week, or T & am € pm| | % [Prel Name <]
MESA2 .
month r. EndHr [5
onth appea mggii ™ am & pm V' Default View
*  View Appt. Notes — To view a note symbol ( — —
aNCel
on any appointment with an appointment 4 )_I
note.

*  View Alerts — To view a red plus sign on any appointment for a patient with medical alerts.

*  View Provider Columns — To view the colored provider bar.
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*  Select Days — Select the days of the week that the office is normally open. The week and month views
will show only the selected days.

*  Month Time View — For the month view, Dentrix Enterprise requires that a start and end time be
entered. Type the earliest hour that you will see patients in the Start Hr field. Type the latest hour
that appointments will last in the End Hr field. Click am or pm for both fields.

* Appointment Display Info — Depending on the length of an appointment, up to nine lines of
information can be displayed on the face of an appointment. For each Line, select the information
you want to have displayed on that line, or select [None] to leave that line blank.

Tip: On average, appointments will probably display 2 — 4 lines, so assign the most important items

to the first lines. Also, make sure the appointment information to be displayed is HIPAA compliant.

*  Default View — Select this check box to have this view be your default for the current clinic.
4. Click OK.

(] (] o
Setting Up a Clinic
You can customize your practice hours, certain appointment defaults, and the time block size used throughout
the program. Any changes will affect all your computers that have Dentrix Enterprise installed.
To set up a clinic

1. In the Appointment Book, from the Setup menu, click Clinic Setup. @ \& Appointment Book <The Dental Gro
e vew == Appt Lis

The Clinic Appointment Book Setup dialog box appears. _
Select a Clinic. =

Set up the following options for the selected clinic: ik )

Clinic:

¢ Default Schedule — Select the check box next to

e Default Schedule *Default . Seftings Time Block Size

each day of the week the clinic is normally open. S _ 6 i

Also, you can break each day into three time ranges. ! o EEN | & 10 min

To set the working hours for any day, click the day’s 2 Hencey o} ?Che_dul—_lle:_HXED E @ Bth

search button **|, and then enter the start and end @ Tty | |7 PR

times of each range that you want for that day. W' Wednesday >3] ||~ *Sereen Colo £ 30 min

*  Time Block Size — You can schedule your At [ E::: ;zz:d L & Horizartal

appointments in 5-minute, 10-minute, @ Fidy ] € Yetical
15-minute, 20-minute, or 30-minute intervals. [ Satuday o ¥ iew Time at Fiight"

Select the time block size option that fits the
scheduling needs of your practice.

3 Cancel
Important: Time block size is used when setting

up procedure codes to indicate how long a procedure will take to complete. Dentrix Enterprise stores
this information in units, not actual time; as a result, changing the time block size can change your
procedure time settings for a procedure. For example, if your original procedure used 10-minute time
blocks, then a procedure that requires 60 minutes would be entered as six units. If you change the
time block size to 15 minutes, the procedure still has six units, but now, instead of being 60 minutes,
the procedure will default to 90 minutes.

* View Time at Right — To have the time column appear on the right side of the window in addition
to the left side, select this check box.

4. Click OK.

For a comprehensive explanation about all the available options for clinics, see the “Setting up a clinic” topic
in the Dentrix Enterprise Help.
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Setting Up a Provider

You can customize work hours, colors, and aliases for each provider in your office. Any changes will affect all
your computers that have Dentrix Enterprise installed.
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Note: You can set up providers in more than one clinic. When setting up the provider’s default schedule,
Dentrix Enterprise will warn you if the scheduled hours overlap in other clinics.

To set up a provider

1.

ARSI

6.

In the Appointment Book, from the Setup menu, click Provider

Setup.
The Provider Setup dialog box appears.
Select a Clinic.

Select a Provider.

Click Setup. The Provider Setup dialog box appears.

Set up the following options for the selected provider:

e Default Schedule — Select the check box next to
each day of the week that the provider normally
works. Also, you can break each day into three
time ranges. To set the working hours for any
day, click the day’s search button **/, and then
enter the start and end times of each range that
you want for that day.

*  Provider Color — All appointments scheduled
with that provider will use the designated
color as the background for the appointment
information. To assign the provider a unique
color, click the colored button, and then choose
the desired color.

@- \A Appointment Book <The Dental Gro

Cliriiz: |MESA

Provider Setup : @ _l

Provider:

™ Sunday J

¥ Monday ﬂ
V¥ Tuesday ﬂ
v Wednesda}lﬂ

=
CS) Thursday — »>
wpe? v Friday ﬂ

™ Saturday J

Provider Calor

—

Provider Setup [AMCCLURE, MESA] (=] J

Set Time Blocks

Staff kg Add |

6 ok Cancel

Tip: Appointment information text is displayed in black, so choose a light color for the provider’s color

that contrasts with the black text.

Click OK.

For information about setting up provider time blocks, see “Setting Up Perfect Day Scheduling Time Blocks”
in Chapter 3: Appointment Book.
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Setting Up an Operatory

You can customize available hours for each operatory in your office. Set up the operatories for each clinic
separately. Any changes will affect all your computers that have Dentrix Enterprise installed.

To set up an operato r
P P ry \A Appointment Book <The Dental Gro
1. While viewing the operatories for a clinic in the Appointment Appt Lis
Book (the view does not have to be displaying all operatories), from 5 t' C‘;‘;:"h Lal 2] ”“'”'@T [
. peratory Setup o
the Setup menu, click Operatory Setup.
. Setup
The Operatory Setup dialog box appears. 3)
Schedule
2. Select the operatory for which you want to set the available time
Operatory Setup [MESAL] @
and days.
Default Schedule
3. Click Setup. [~ Sunday i "
. ¥ tondap ¥
The Operatory Setup dialog box appears.
P ry P g 2% W Tuesday ﬂ
4. Select the check box next to each day of the week the operatory is v Wed ]
normally used. Also, you can break each day into three time ranges. W Thusd ]
To set the available hours for each selected day, click the day’s search bel iy 2
button **\. In the Set Time Limits dialog box, enter the start time Lissidy B
and end time of each range you want for that day, and then click OK. e —

5. Click OK

Setting Up Flip Tabs
Acting as a bookmark, a flip tab allows you to jump forward or backward several days, weeks, or months

in the Appointment Book, according to a user-defined length of time, such as seven days, two weeks, or six
months. No flip tabs are set up with the initial installation of Dentrix Enterprise.

Flip tabs are workstation-specific and must be set up on each workstation individually. You can have up to
four flip tabs per computer.

TO set llP a ﬂlp tab @. \A Appointment Book <The Dental Gro

1. In the Appointment Book, from the Setup menu, click Flip Tabs
Setup.

Flip Tabs Setup

The Flip Tabs Setup dialog box appears.

I Dap View Iﬂeek View] Month View

2' Cth the Day ViCW, Week ViCW, or [I)lejclription [I)lejc:ription g:'sjc?iption g:'sjc:iption
Month View tab to set up flip tabs for the [Tk o [B Mo Fud Wan 12014 |
corresponding Appointment Book view. Test Cotor  [HI] | TestColor [HD] | TewtColor (NN TextCoor [N

. Tupe Type Type Type

3' FOI' each Hlp tab you want to create, set U,p |F|e|ative j |F|e|ative ﬂ |Absolute j |[n0t used) ﬂ

the following options: B s Date

7 = B0 = 0/01 /2014

*  Description — Type a short description

. « 9 Direction Direction
for the flip tab (for example, “1 Week & Foruard & Farvend @
or “6 MOl'lthS”). " Backward " Backward
e Text Color — Click the colored button Relative to Relative to
" Today " Today

to assign a color to the text description

of the flip tab.

(* Displayed Date " Dizplayed Date

O
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e Type — Select the type of flip tab:
*  Absolute — Absolute requires that an actual calendar Date, such as 09/07/2012, be specified.

Note: An “Absolute” tab will always jump to the specified date in the Appointment Book.

*  Relative — Relative requires that a number of Days, Weeks, or Months (depends on the flip tab)
be specified.

Note: A “Relative” tab will jump to a date relative to the current system date or currently
displayed date. For example, if today’s date is January 1st, a relative tab set to move you seven
days forward relative to today will move you to January 8th, and then, if clicked again, the tab
leaves you on the 8th. However, a relative tab set to move you seven days forward relative to the
displayed date, will move you to the 8th, and then, if clicked again, the tab will move you to the
15th (another seven days ahead).

* Direction — For a relative flip tab, select a direction option: Forward, to go forward by the specified
number of days, weeks, or months in the Appointment Book; or Backward, to go backward by the
specified number of days, weeks, or months.

* Relative to — For a relative flip tab, select whether the book should move you relative to the current
date or relative to the date currently being displayed.

4. Click OK.
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Setting Up the Ledger

There are several features of the Ledger that you can customize to meet the needs of your practice. You can
set up or change these at any time without affecting data already entered. However, for consistency sake, it is
a good idea to set them up before you begin using the system. This section covers the following topics about
setting up the Ledger:

e Setting Up Checkout Options
e Setting Up Automatic Credit Allocation Options

e Setting Up Direct Print Options

Setting Up Checkout Options

In most offices, there are typically three tasks that are completed as a patient checks out after a visit. The
Fast Checkout button & combines these three tasks. With the click of a button you can collect a payment,
generate an insurance claim, and print a receipt.

To customize the Fast Checkout button

1. In the Ledger, from the File menu, click Set

Z Dentrix Ledger - (Abbott, James 5) [CENTRAL] [DROBE] [ABB101] [11/1
Checkout Optlons. Options  View Transaction Insurance Print  Month End  +
=[] [ [

The Checkout Options dialog box appears.

E
. “Retainer crr-po
2. Select the task options you want to cc?mplete T Checkout Options ol Check Pamer
when the Fast Checkout button is clicked: i Ponto parcelar
0 Pontic-parcelair
*  Enter Guarantor Payment — To post a B2 e v
payment to the Ledger. ¥ Create Inzurance Claim
. * Batch
*  Create Insurance Claim — To generate an insurance £ Print
claim. Also, select whether you want to send the claim % Walkou
to the batch processor in the Office Manager or print & Baich
the claim immediately. Pt
e Walkout — To print a receipt for the patient. Also, ™ Alwaps Show Checkout Options

processor in the Office Manager or print the report
immediately.

select whether you want to send the report to the batch Cancel

e  Always Show Checkout Options — If the tasks you perform as a patient leaves vary, you can select
this option so that the Checkout Options dialog box will appear each time the Fast Checkout
button is clicked, thus allowing you to select the options you need for each patient individually.

3. Click OK.
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Setting Up Automatic Credit Allocation
Options
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Dentrix Enterprise can automatically apply suspended credits and post automatic adjustments for re-allocating

credits according to selections you make.

To set up the options for automatic credit allocation

1. In the Ledger, from the File menu, click Set Auto

E Dentrix Ledger - (Abbott, James S) [CENTRAL] [DROBB] [ABB101] [11/1

Credit Allocation Options File | Options View Transaction Insurance Print MonthEnd F

IEMAMVEES
Set Automatic Credit Allocation Options

The Set Automatic Credit Allocation Options
dialog box appears.

Automatic Suspended Credit Allocation O ptions
* Automatically Alocate Suspended Credits when Applicable

2. Set up the following options:
" Do Mot Automatically Allocate Suzpended Credits

*  Automatic Suspended Credit Allocation Options

Automatic Insurance Payment Adjustment Options

Credit Adjustment Options

*  Automatically Allocate Suspended Credits oo A .
justment Tppe:
when Applicable — To have Dentrix Enterprise Professional Discourt »|

automatically allocate any suspended credits to Automatically Allocale:

.. . f* Usge A icS ded Credit All ion O
all charges that have a remaining balance. This S A A

will apply all applicable suspended credits to all

" Flag Adjustment "Do not automatically allocate'

l. bl h . h 1 d +Charge &djustment Type
app 1capble C arges, not ]ust the recent y pOStC |+DebitAdiustment ﬂ

charges.

[ Itemnize Automatic Adiustments for Biling Statements

* Do Not Automatically Allocate Suspended Acusiment Type for Negstive Payrmerts
Cl‘edits _ TO have Dentrix Enterprise not [v Enable Automatic Adjustments for Insurance Payments

automatically allocate any suspended credits.

[ Auto-post Refund adiustments to replace negative pagments
+Charge Adjustment Type
|+Drebit Adjustment ﬂ

*  Automatic Insurance Payment Adjustment Options
Electronic EOB Options

*  Credit Adjustment Type — Click the search Disfault Provider for Morvltemized sEOB Chargss:
button **| to select the adjustment type that you [Patients Pro =l
want Dentrix Enterprise to use for the credit [ Fory Electioric EDEs o Dostmert Cerler
adjustment to offset a charge adjustment when a 3 Cancel
leftover insurance payment amount needs to be Nt

allocated automatically.

*  Automatically Allocate — Select Use Automatic Suspended Credit Allocation Options to

default to the selection made for Automatic Suspended Credit Allocation Options when
entering insurance credit adjustments, or select Flag Adjustment “Do not automatically

allocate” to have Dentrix Enterprise not allocate the insurance credit adjustment automatically

regardless of selection for Automatic Suspended Credit Allocation Options.

* Charge Adjustment Type — Click the search button **/ to select the adjustment type that you
want to use for the charge adjustment when a leftover insurance payment amount needs to be

automatically allocated.

* Itemize Automatic Adjustments for Billing Statements — To have Dentrix Enterprise itemize

automatic adjustments on billing statements.

Note: It is recommended that you leave this check box clear because the automatic adjustments

will always be offsetting adjustments, so they will not affect an account balance and can be
confusing if included on billing statements.
* Adjustment Type for Negative Payments

*  Enable Automatic Adjustments for Insurance Payments — To allow negative insurance
payments to be posted for claims, select this option.
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*  Auto-post Refund adjustments to replace negative payments — To allow negative insurance
payments to be posted for claims, select this option. A negative payment will appear as a charge
adjustment on the Ledger. Next, select the Charge Adjustment Type you want to have used as the
charge adjustment that automatically replaces a negative insurance payment.

Tip: You may need to add a new adjustment type in Practice Definitions for this charge
adjustment.

*  Electronic EOB Options

*  Default Provider for Non-Itemized eEOB Charges — Select which provider will be attached
to a charge adjustment if an adjustment claim in an eEOB is not itemized. The provider can be
the patient’s primary provider (Provl from Family File), the pay-to provider on the claim, the
rendering provider on the claim, or the billing provider on the claim.

*  Copy Electronic EOBs to Document Center — If you want electronic EOBs imported into
Dentrix Enterprise to be copied to the Document Center, select this check box.

3. Click OK.

Setting Up Direct Print Options

You can print insurance claims and several reports from the Ledger: walkout statements, billing statements,
and a family ledger report. A button for each of these reports is located on the toolbar. With the direct print
options, you can indicate whether the report should be printed immediately or sent to the batch processor in
the Office Manager, where you can print it at a later time.

To set up direct print options

1. In the Ledger, from the File menu, click Direct A e e S T L
Print Options. @- Options  View Transaction Insurence Print MonthEnd -
PN EEECERNG- ] 6

Code De

Date Name Toaoth| Surf
A

The Direct Print Options dialog box appears.

2. For each report, select whether you want the “;’,?:éf?,“,,"n't Z;’;:j“‘“ : s I@%
report to go directly to your printer or to be sent Insurance Claits Family Ledgers rcsl
to the Batch Processor. L & 5 poeset

(* Print (* Print
Tip: If your office will be sending claims Biling Sttt ot
electronically, click Batch for insurance claims, so all  Batch  Batch
insurance claims generated during the day will be sent to & Pint @ Pint
the Batch Processor and can be transmitted simultaneously
at the end of the day. 3 ) ) oK Cancel |
3. Click OK.
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Setting Up Continuing Care Types

You can add or edit the default continuing care types that you assign to patients to help you track ongoing
patient care (recall or recare).

To add or edit a continuing care type

1.

In the Office Manager, from the Maintenance menu, point to
Practice Setup > Continuing Care, and then click Continuing

Care Setup.
The Continuing Care Setup dialog box
Continuing Care Setup
appears.
Type D escription Interval | Prov. |Time |  Status
1 . PROFPHY B +1 HY(G1
DO one Of the fOHOWIHg' “Lab- Azpen Azpen Dental Lab ] Frowl Etd
. . . “Lab-Alpine Alping Dental Specialists 5D Prave B
L4 Clle NCW to add a Contlnulng care type, “Lab-Heritag Heritage Dental Laboraton A0 Frowl Eibd
“Lab-HiTech i Tech Dental Technicians 50 Proel Bk
. . . . BITEWINGS 1 +1] Prowl
° Select an ex1st1ng contlnulng care type, CALL AMALG 1D Prawl
. . . CALL CROWN 20841 Provl
and then click Edit to edit that type. CALLRC 2t 41| Prov1
FHS 5 Proel
. . . ORTHO 1M +1 Provd
The New Continuing Care Type or Edit PANDREX 37 11| Provi
. . . FERIO 4 +1| Provl
Continuing Care Type dialog box appears. Prt Progp W | Provi
Set up the following options: -
e Type - Type an abbreviated name for New Delste Close

®

% Dentrix Office Manager - The Dentist Group <

this type of continuing care in all capital
letters.

Description — Type a more complete description of this continuing care type. This description will be

used on continuing care reminder cards, so pay
special attention to spelling, punctuation, and so

forth.

Interval — The interval indicates how often

the patient should be recalled for treatment or
follow-up. Specify the number of days, weeks,
months, or years for the interval. Select +1 Day
to prevent insurance billing problems if the
carrier has strict interval requirements.

Provider — If you want the provider of
continuing care appointments to be the
patient’s primary provider by default, click
Provl. If you want the provider of continuing
care appointments to be the patient’s assigned
secondary provider, click prov2.

Interval:

Provider:

{* Prowvl " Prov2

Drefault Appt. Time:
[~ Time?

Dizplay Colar:

MNew Continuing Care Type @
Type: Description:
| |
Initial 5 tatus:
| [Maone] ﬂ

lﬁ_il Morthe | B +1Day

[[oeiine.

Sample Text Color Set Colar...

®

4

Cancel

Default Appt. Time — To enter the amount of time this patient will need for appointments with this
continuing care type attached, select Time?. Drag the slider to set the number of units, and then set
up the time pattern for each unit (chair time [, assistant’s time I, or provider’s time M) to help you
make use of all operatories when scheduling appointments and maximize your productivity.

Click OK.
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Editing Procedure Codes

Many tasks and transactions in a dental office are linked to an ADA Procedure Code. Dentrix Enterprise
comes with all of the procedures listed in American Dental Association Code on Dental Procedures and

Nomenclature. Edit, or at least review, the following information for the procedure codes you use in your
office: fees, procedure time, and attached continuing care.

To edit a procedure code

1.

In the Office Manager, from the Maintenance menu, point
to Practice Setup, and then click Procedure Code Setup.

The Procedure Code Setup dialog box appears.

Select a Procedure Code Category. All procedure
codes associated with that category appear in the list
box to the right.

Select a procedure code, and then click Edit.

The Procedure Code Editor - Existing dialog box
appears.

@

Dentrix Office Manager - The Dentist Group -

Procedure Code Setup

Procedure Code

Category

Maxillo Prosth
Implant Serv
Prostho, fixed
Oral Surgery
Orthodontics

ADA

4. Set up the following options:

* Auto Continuing Care — When
a procedure with a continuing
care type attached to is completed,
Dentrix Enterprise automatically
adds the continuing care type to
the patient and/or updates that
patient’s continuing care due date.
Click the search button **/ to select
a continuing care type for this
procedure.

*  Procedure Time — To enter the
number of Appointment Book units
this procedure takes to perform,
click the search button **|. Drag
the slider to set the number of units,
and then set up the time pattern for
each unit (chair time |_, assistant’s
time I#, or provider’s time ) o

ADA-CDT Codes | Dental Diagnostic Codes | AMA-LPT Codes | ICD-9CM Diagnostic Code

Description

h oph
D1120 PiophywCh Prophylazis-child
01201 ProphFIC] Prophylaxis with flun
D1203 FluoridC] Fluoride w/o prophy
D1204 FlouridgA Fluoride wio prophy
01208 B | Prophylazis with fluo
01208 Topical fluoride varn
01310 Nutitional counselin
| 01320 g Tobacco counseling
D1330 OralRy}n Oral hygiene instruct
D1351 Sealant Sealant-per tooth
L. D138z PrevResl Preventive Restorat
New Edit

Procedure Code Editor - Existing

Description: |Prophylais-adult

Patient Friendly D escription

Cleaning of adult's teeth to help prevent disease

Cade Names Treatment Flags

PULLEM

FEE &

. DELTA
UPto3339

Fee Schedule | Rl Schedule |

[ EditFes

. DONTIST
D0

1
2.
3
1
5.
E. BSoffd
7.
8
9.
u
1

D0 AD Code 8| BifeY i
[~ Condition
Prophyéd Abbrev Desc ™ Remove Taoth
¥ Show in Chart
CPT
Luta Continuing Care
Medicaid FROPHY  »>4
Procedure Time
Ebe 5 Unifs) o
Procedure Category| Preventive =
Appaintment Type: ‘ Low Production j
Treatment Area: | Mouth -| Flags
Pairt Type: ‘ [Mane] j

Edit Mote New Code Mext Code

Expenses
Lab

Materials

™ Flag tor Medical Cross Coding
™ Do MotBill to Dental Insurance
I DoMatSend Over HL?

™ Require Start/Completion Dates

Save

Close

O

help you make use of all operatories when scheduling appointments and maximize your productivity.

*  Fee Schedule — No fees are pre-assigned with the initial install of Dentrix Enterprise. You can assign
up to 999 fees for each procedure. To add or change the fees for a procedure, select the fee schedule to
which you want to assign a fee, and then click Edit Fee. The fee in a field next to the name of the fee
schedule can now be edited. Next, type the dollar amount you want to charge, and then press Enter
to save the change or Tab to move down to the next fee schedule. Repeat this process for all fees that

you want to add or change.

Tip: The practice’s usual, customary, and reasonable (UCR) fees should be the first fee schedule.

5. Click Save.

For a comprehensive explanation of all the options available for procedure codes, see the “Adding and editing
ADA-CDT dental codes” topic in the Dentrix Enterprise Help.
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Setting Up Multi-codes

A multi-code allows you to post several procedures simultaneously. A multi-code is a group of procedure codes
that are typically recommended, scheduled, or completed at the same time.
To add or edit a multi-code

1. In the Office Manager, from the Maintenance menu, point to
Practice Setup, and then click Multi-Code Setup.

% Dentrix Office Manager - The Dentist Group <
File View Kepo

The Multi-Code List dialog box appears.

2. Do one of the following: ME—— Sl
. . Multi-Code  Abb. Desc. Description
° Cth NCW to add a multl-code. w111 CrrPClns Crn, Pst & Core, Insert
L. . . . widad, DO Amalg. [alu} Amalgam, permanent
*  Select an existing multi-code, and then click Edit to #2:C DO Comp. DO Composite. postpemanent
wadad, MOD Amalg  MOD Amalgam
edit that COdC w3zl MIOD Comp.  MOD Composite, post-permanent
: «<BRG Bridge Bridge
. . . wCCA  CCAdult Cont. Care - Prophy, Adult
The Multi-Code Editor dialog box appears. ®CCP  COCHId  Cont Cars - Prophy, Child
walClm Crrlmp Crowvendlmplant
. . bl P MNP Ex Mew Patient Exam
3. Set Up the followmg OptIOIlSI w0AM  Oamalg 0 Amalgam, permanent
#wORS Oreszin u} Figsin, post-permn
e Description — Type a description for the multi-code. oA L
wPhx Parthdax Partial Max
*  Multi-Code — Dentrix Enterprise automatically assigns i Hotmm - Hos Sengl and o
w5 LA Scale Sealing
“xx” as the first two characters of a multi-code. Type BTN 2TH 28it TiRaue Managemers
three additional alphanumeric characters to represent
the code that will be used to identify the multi-code
when posting.
. L. Mew Edi D elete Close |
*  Abbrev. Desc. — Type an abbreviated description of the | | |

multi-code.
e Type — If the multi-code will post a bridge, select Multi-Code Editor ( 3 \ =
. . . T Coae: \ I
Brldge’ OtthWlSC, SeleCt Standard Desciiption: [Crn, Pst & Core, Insert =
*  Procedure Codes — To add a procedure code to it Code: [ 11 Abtres. Dese: [CrPLins
the multi-code, click Add. In the Add Code dialog Aapciniment Type: [vigh Practon =l
H Type:
box, type an ADA procedure code, or click the erostae Tne[ 7] Uy | @ oomdnd £ 37
search button > to select a procedure code. If the
procedure code selected requires the entry of additional Fode Uiy
. . L. . . zD2752 Crown-pare fuzed noble metal aedd
information, additional options appear in the lower- e Prelab posticore n add o om
right corner of the Add Code dialog box so that you [
can pre-define a surface(s), a quadrant, or a sextant. Dot |
Then, click OK. . —
“Procedure requires treatment info; hen uzed
[ Disable This Multi-Cods Cancel
Important: A multi-code may consist of one or (4_* E=r

more procedures that require additional treatment

information to be entered, such as a tooth number.

Multi-codes that require additional information will be flagged with an asterisk (*) in the list box. The
additional information must be supplied when posting the multi-code.

4. Click OK.
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Customizing Practice Definitions

Dentrix Enterprise provides several “practice definitions” and allows user-definable entries for each. These
practice definitions, in addition to other features, can help you customize Dentrix Enterprise for your specific
needs.

You can add and edit practice definitions.

Important: Before you customize definitions, read the following recommendations carefully:
*  Customize definitions that have not yet been assigned to patients in order to avoid potential problems.

*  Dentrix Enterprise assigns the definition number to a patient, not the customizable description.
Modifying the text description of a definition will change that definition for all patients to whom the
definition has been assigned. For example, if patients are assigned medical alert 13 “hay fever,” and it is
changed to “pregnancy,” those patients will still have medical alert 13, but it will now show as “pregnancy”
in their file.

*  Before deleting a definition, try changing the existing description to a new, more useful description.
Deleting a definition can lead to data corruption. For example, if the appointment status 4 “Patient
has Arrived” will not be used in your office, you can change it to a more useful definition such as, “Left
Message.”

*  With the exception of medical alerts, definitions are listed in numerical order. As a result, the first
definition serves as a default selection for most definition types. Be sure to make the most commonly used
definition the first definition in the list.

To customize a practice definition

1. In the Office Manager, from the Maintenance menu, point to
Practice Setup, and then click Definitions.

The Practice Definitions dialog box appears.

2. Select a Definition

Practice Definitions

Type to add or edit D D T
deﬁnitions f()r that |— |Pr0fessi0naIDiscount
Allergies
fYPe- Allergy Reaction | — Add
Alternate Procedure Code Names 2 ' oo al [-":5“3':"-""'-
Appaintment Chack List : -Cash Dizcoun
3' DO one Of the AEEE::tm::t Hezgonsls 3 -Credit Adjustment Change
. . Anpointment Stak 4: +Debit Adjustment
fOHOWlng' AEE?olchgTatu: i 3 +Patient Refund
Appointment Types = B Awribe-0ff
° TO add a new Biling Types
. Blo_od Type
definition, select | |ElaimFamat
Continuing Care Status
Custom Maotes
and replace the Dental Diagnostic Code Categories
ot H Ethinicity
ex1st1ng ID (lf Fee Schedule Mames

Financial Clazs Types =

relevant) and Homeless Status
Definition Text | |jng.es oty

. Medical &lert or Allergen Severity
Wlth a new [D Medications
and description, | [pamerty
t
rion, | [pamn e . (4 )=
and then click
Add.
*  To edit a definition, select that definition, replace the existing Definition Text, and then click
Change.

4. Click Close.

For comprehensive details about customizing each definition type, see the “Practice Definitions” topic and its
subtopics in the Dentrix Enterprise Help.
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Setting Up Practice Defaults

When entering patient information or performing certain tasks, the process of having to choose a provider
or operatory can be redundant. Dentrix Enterprise allows you to set a default provider, billing type, chart
provider, insurance claim providers, and billing statement. Changing the practice defaults affects only the
computer from which you are changing the defaults. You can change the practice defaults at any time.

To set up the practice defaults

1. In the Office Manager, from the Maintenance menu, point to

& Dentrix Office Manager - The Dentist Group <
Practice Setup, and then click Practice Defaults. ;

The Practice Defaults dialog box appears.

2. Set up the following defaults:

General tab Practice Defaults @1
e Default Provider — The provider selected Gieneral | Clim Provider

will be the primary provider assigned to each ! 21

Default Provider: |DESMITH ﬂ |Smith, Dennis E
new head-of-house. If you want to remove a | Bl
selection, delete the text.

Default Capy Patient Infarmation

e  Default Chart Provider — The provider Copy Patient Clnic: | 4F 55| [Advanced Wamen Healt C:
selected will be the default provider when Lol 05 HITH Smith, Dennis E

. . . Character to be Appended Tao Chartd: ’_
charting procedures for the patient. Click
Drefault Chart Provider

.5 s
Patlents PIOVI to haVC the patlents prlmary * Palient's Provl I¥ Provider from Selected Appointment
provider act as this default, or click the Specific Clspearn et Bl

Provider search button **! to select a provider.

Default Billing Type Default Biling Statement
. - Standard Billing - finance charges ~
By default, thC Pl'OVldeI' from Selected 02 - Standard Billing - no finance charges a m
. . . 03 - Insurance Family - delay finance charges | 1146 Mailer- 8096 e
APpolntment Check bOX 1S Cleal‘. Select thls 04 - Insurance Family - finance charges 9546 Mailer-8035
05 - Pavment Plan - finance charoes T |Short Form - 9164 i

check box if you want to keep the provider for
a selected appointment in the Appointment
Book as the provider for charting when you
open the Patient Chart from the Appointment
Book (by clicking the Patient Chart module
button or by clicking Chart from the File ~~

menu) with an appogintment selected. EE==N (S)Ll =
If an appointment is not selected in the el

Appointment Book when the Patient Chart is

opened, the default Patient Chart provider will be the selected patient’s Provider 1 or the provider you
specify, regardless of whether or not the Provider from Selected Appointment check box is selected.

*  Default Billing Type — The billing type selected will be the billing type given to each new head-of-

house.

*  Default Billing Statement — The billing statement selected will be the form used when printing
billing statements.
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Claim Providers tab

Default Insurance Claim Providers

Billing Provider — Specify the provider that
will be the provider printed on claims.

Rendering Provider — Specify the provider
that will be the provider of services being
billed on claims submitted electronically.

Pay-To Provider — Specify the provider
that will be the provider whose name
appears in the pay to provider section of
claims.

Override Billing Provider Info for eClaims

Name and IDs — Specify the provider
whose name and provider IDs you want to
use for the billing provider’s name and IDs
on claims submitted electronically.

Address and Phone — Specify the provider
whose address and phone number you
want to use for the billing provider’s

Practice Defaults
"General  Claim Providers

Default Insurance Claim Providers
Billing Pravider
(¢ Provider of Procedures  © Patient’s Provl

€ Speciic Provider [00203 2]

I MName to use for Provider J |

Rendering Provider
{* Provider of Procedures © Patient’s Provl

" Specific Provider J |
Pay-Tao Provider

" Provider of Procedures ™ Patient's Provl

" Specific Provider | J |

I~ Name to use for Provider |

Override Billing Provider Infa for eClaims

Name and [Ds
& Claim Billing Prov " Claim Render Prov

" Clairn Pay-To-Prov

" Speciic Pravider | J |

I™ Mame to use for Provider |

Address and Phone

% Claim Biling Prov " Claim Render Prov

" Rendefing Clinic

" Claim Pap-To-Proy

" Specific Praovider J |

Freferences..

Cancel

address and phone number on claims submitted electronically:

3. Click OK to save the changes.

For comprehensive information about all the practice defaults, see the “Practice Defaults” topic in the Dentrix

Enterprise Help.

Setting Up Auto Chart Numbering

You can set up Dentrix Enterprise to generate chart numbers for your patients automatically (MSSQL databases
only). By using this feature, you can eliminate duplicate chart numbers and speed data entry for new patients.

Note: If your office uses the HL7 interface to connect Dentrix Enterprise with a medical practice management
system (PMS), chart numbers will likely be generated in the medical PMS and transferred to Dentrix Enterprise.

To set up auto chart numbering

1.

Dentrix Enterprise 7.0 User's Guide

In the Office Manager, from the Maintenance menu, point to
Practice Setup, and then click Auto Chart Number Setup.

The Automatic Chart Numbering Setup dialog box appears.

Select an automatic chart numbering option:

Numeric — To assign numeric chart numbers to all new patients.

Alpha/Numeric — To assign an alphanumeric chart number to all new
p g p

patients. The chart number will be the initial two characters of the
patient’s last name and then a unique numeric ID (for example John

Smith might be assigned SM0001).

%2 Dentrix Office Manager - The Dentist Group <

Maintenance

Automatic Chart Mumbering 5... @

Select Auto Chart Mumbering
" Numeric
* Alpha / Mumeric
™ Maone

Select Minimurm Length

B Characters hd

®

Cancel

None — Not to use chart numbers in your office or to assign chart

numbers manually.

4DK

From the Select Minimum Length list, select the minimum length for automatically-generated chart numbers.
Click OK.
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Setting Up Default Printers

You can set up a default printer for printing from the Ofhce Manager and other areas throughout Dentrix
Enterprise. However, before printing from the Office Manager or other modules, the printer to which you
want to print must first be selected.

To select a default printer

1. In the Office Manager, from the File menu, click Setup & Dentrix Office Manager - The Dentist Group -
Printer. View Reports Letters Maintenance
The DXONE Printer Selection dialog box appears.

2. Under Select Printer Area, select the area of Dentrix — 5

-

] . . . &5 DXONE Printer Selection (23]

Enterprise to which you want to assign a default printer: _ _
Select Office Manager Printer:

<Default Printer:

Microzoft ¥PS Document Wwriter

*  Office Manager Printer — To print reports from the

| »

Fax
Office Manager module. 3nd Floor Copier =
Send To OneMote 2010
*  Chart Printer — To print from the Patient Chart module. | |rovsf0r

e Label Printer — To print labels. Snagit 11 -

Select Printer &rea:

4 Document Center Printer — TO print documents fl'OlTl {+ Office Manager Printer ¢ Prescriptions Printer
the Document Center module‘ (" Chart Printer " Perio Printer
.. . L. " Label Printer " Presenter Printer 2
° PI‘CSCl‘lPtIOIlS — TO prmt PrCSCflpthﬂS from the  Dacument Center Printer

Prescriptions module.

Cancel | |

*  Perio Printer — To print periodontal examinations from
the Perio module.

*  Presenter Printer — To print treatment plan presentations from the Treatment Planer module.

3. In the list box of printers, select the printer that will be used to print from the selected area.

4. Click OK.

Setting Up Passwords

Passwords in Dentrix Enterprise serve many different functions. First, you can use passwords to prevent an
unauthorized person from performing certain sensitive tasks, such as changing information, deleting transactions,
and accessing financial information. Second, you can have the extra security of flagging certain operations to
require additional user verification—the password must be re-entered—to perform those operations.

In Dentrix Enterprise, each user is assigned “rights” to the tasks they need to complete. Dentrix Enterprise
then allows access to each password-protected operation, according to the security rights assigned to the
logged-on user. If a user does not have rights to perform a certain function, they cannot access that particular
area of the program or perform that particular task.

Assigned rights are clinic-specific. Each user will need to be given rights for each clinic to which they have access.

Note: It is reccommended that the doctor read this section carefully and be aware of who is given “Password
Administration” rights in the office.

This section covers the following topics on setting up passwords:
e Password Requirements

*  Assigning Security Rights

*  Setting Up Secure Passwords

*  Assigning User Verification to Tasks
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Password Requirements

The passwords for user accounts must adhere to the following criteria:

Dentrix Enterprise 7.0 User's Guide

Complexity — The password must be at least 8 (for standard users) or 15 (for administrative users)
characters in length and meet the following requirements: have at least one uppercase letter, have at least
one lowercase letter, have at least one number, and have at least one special character (for example, #, %,
or &).

Changes — When the password is changed, at least 75% of the characters must be different in the new
password than in the old password.

Storage and transmittal — Passwords must encrypted when being stored or transmitted.
Expiration — A password can be valid for one to up to 60 days. Then, it expires and must be changed.
Reuse — When changing a password, any of a given user’s previous six passwords cannot be reused.

Temporary passwords — A temporary password can be provided for a given user to log on to a system,
but a permanent password must be created by the user immediately upon logging on.




° L] (] L]
Assigning Security Rights
When assigning user rights, keep in mind which tasks each individual performs. Some rights are directly
related to others. Assign rights to only those individuals who will have a need to perform that operation.

To assign security rights to users

1. In the Office Manager, do one of the following:

*  From the Maintenance menu, point to Practice Setup >
Passwords, and then click Setup Users for Passwords.

*  From the Clinic Resource Setup dialog box, click

Password Setup.

The Password Administration - Setup
Users dialog box appears.

2. If necessary, select the clinic for which you
want to set up user rights. All users for
that clinic appear in the list box.

3. Select a User ID from the list of available
provider(s) and staff. The User Name and
User ID appear in the upper-right corner
of the dialog box.

4. To change or create a password, click
Change Password. In the Change
Password dialog box, type a password in
the New Password field, re-type the same
password in the Confirm Password field,

and then click OK.

These password fields cannot be left
blank. The password must be 7 to 11
characters in length and meet three of

the following four requirements: have at
least one uppercase letter, have at least one
lowercase letter, have at least one number,
and have at least one special character (for
example, #, %, or &).

39
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Password Administration - Setup Users

User [D: Clinic:
AMCCLURE  ME
DESMITH PROVO
DHAYES MESA

DROBR MESA
DEMITH CEMTRAL
ENTERPRISE CENTRAL
JED MESA
MCCLURE  AF
MSMITH MESA

Clinic selected:

P/S: User Mame: |McClure, Angela
3
P UsgrlD: |AMCCLURE

= Change Password

Copy Rights From Other User |

Copy Rights To Other Clinics |

|CENTRAL
Select Security Option Rights

Copy Rights To Other Uszers |

»

- ] Administration

- [ Appointments

- [#] Central Clinic Orly
- [ Appt Lists, View &l Clirics
- [] Database Mode Setup

- [] Morth End - Charges

- [] Maorth End - Payment Plan
- [] Month End - Update

- [] Multi-Clinics. Purge Appt

- [[] Pasaword, Multi-Clinics

m

- [] Wiew All Operatories
- [ Wiew All Patients

- [] Wiew All Providers
- [] Continuing Care

- [] Family File

- [] Chart

- [] Treatment Plans

- [] Completed Procedures
- [] Insurance

- [ Ledger 1

[ O e O O O e O e O

Important: Assign the user a password that will not be forgotten. It is recommended that the password
for the password administrator(s) (the person(s) with “Password Administration” rights) be written down

and placed in a secure location.

5. When first opened, the security options list is “collapsed,” thus hiding the detailed security options for
each category. To expand the list and view all security options, click Expand List. You can also click the
plus (+) sign next to any category to see the rights for that category.

6. Select the security options to which you want the selected user to have rights. Or, you can copy rights

from another user to this user; see step 7.

Important: Dentrix Enterprise requires you to set up at least one user with “Password Administration”
rights (by selecting the Password Administration check box in the Administration category).
Dentrix Enterprise will not allow you to exit this dialog box until at least one user is given Password

Administration rights.
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7. If different users will have the same security rights selected, or if a user works at more than one clinic, you
can save time by copying the rights to different users and clinics:

° COPy Rights From Other User — Click Password Administration - Copy Rights From Other Users [~ 7| [zl

this button to Copy rights ﬁ‘om a SpeCiﬁC Rights will be copied from the user selected in the list below ta the user curently
zelected in Password Adminiztration Setup for CURRENT clinic or for ALL selected

user to the Selected user. In the Password clinics in which the selected user has rights to

Administration - Copy Rights From User Lis

Other Users dialog box, select the user
from whom you want to copy rights.

[ Copy hom Ciinie: CENTRAL |

ah

Sith,
-Hayes, Debo
DROBE - Robb, David

DSMITH - Smith, Dennis E Copy From ALL zelected Clinics |

If the user has rights at more than the ENTERPRISE
.. . JKDT - Kimbal, Jacob & Close |
current clinic, you can select the desired MCCLURE - McClure, Jeffrey -

clinic(s) and then click the right arrow
button to move them to the right liSt bOX. Clinics available for selection: Clinics selected to copy rights fram:
Next, click Copy from Clinic: (Current)
or Copy from ALL selected clinics.

AEIE

*  Copy Rights To Other Clinics — Click Password Administration - Copy rights from current clinic to... [ 2 |[m2)
this button to copy the selected user’s
rights to other clinics. In the Password
Administration - Copy rights from

Uszer Mame: [McClure, Angela

User ID: |AMCCLURE

current clinic dialog box, select the Cunent Clinic: [CENTRAL

CliniC(S) to Wthh you want to copy rights) Clinics &vailable for selection: Clinics selected to copy rights to:
and then click the right arrow button to FyEs = .

move the clinic(s) to the right list box. No Dirie N

Next, click OK. PROVD

=

<<

* Copy Rights To Other Users — Click Password Adrministration - Copy rights t|o other users )
this button to copy the selected user’s
rights to other users. In the Password
Administration - Copy rights to other

Uszer Mame: |McClure, Angela

User ID: |AMCCLURE

. Cunert Clric: [CENTRAL
users dialog box, select the user(s) to rent e JCENTRAL
WhOIIl you want to copy I'ightS, and tl’lCIl lsers Available for selection: Users selected to copy rights to:
. : BMCCLURE - McCluas, Angel
click the right arrow button to move the i e
user(s) to the right list box. Next, click e .
DSMITH - Smith, Denniz i
OK. ENTERPRISE -, 3

JKD1 - Kimball, Jacob
MCCLURE - McClure, Jeffrey
MSMITH - Smith, Mary Kaye|

SHAYES - Hapes. Sally
SLAUGH - Slaugh, Mike 2

o[ cwed |

8. After the rights have been set up for the selected user, click Save, or select the next user. On the message
that appears and prompts you to save the changes, click Yes.

9. Repeat steps 3 — 8 for the other users that need passwords and/or rights assigned, and then click Close.

If you haven't saved the changes for the currently selected user, on the message that appears and prompts
you to save the changes, click Yes.

For a comprehensive list of all security options and their corresponding descriptions, see the “Security rights
list” topic in the Dentrix Enterprise Help.
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Setting Up Secure Passwords

A clinic can set up a time interval that forces users to change their passwords regularly. For instance, an office
may want to enforce a change of password every three months. In conjunction with this, your office can set a

requirement that users cannot reuse any of their previous passwords.

To set up secure user passwords

1. While logged on to the Central clinic, in the Office Manager,
from the Maintenance menu, point to Practice Setup >
Passwords, and then click Secure User Password Setup.

The Secure User Password Setup dialog box appears.
2. Set up the following options:

e  Password Expiration — If you want passwords to expire
so that users have to change their passwords after a
certain length of time, click Expiration, and then select
a password expiration date in days. If you want users
to be forewarned of a pending password change, check
Warn, and then select the days before the expiration date
that you want the notification to appear. If you do not
want passwords to expire (users will never have to change
passwords), click No Expiration.

*  Set Security Defaults

*  Lock user out for — To select how many logon
attempts a user has before that user is locked out of
the system for a specific period of time, check this
option, select the time interval for which a user will be
locked out in minutes, and select the number of logon
attempts users have.

Note: When a user is locked out, an administrator can reset any and all locked out users.
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& Dentrix Office Manager - The Dentist Group -
File View Reporis tE

Maintenance

I Date |

Secure User Password Setup

v

Password Expiration

{+ Expiration

expires every (90 - days

IV Warn |7 =| days before expiration

" Mo Expiration

Set Security Defaults

W Lock user out for

15 hd

E—

minutes after

failed logon attempts

I¥ Do not allow use of the past

5 hd previous passwords

3

e’

* Do not allow use of the past — If you want to prevent users from reusing a specific number of

old passwords, check this option, and then select how many previous passwords you want to

block.
3. Click Save.

41
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Assigning User Verification to Tasks

Once a user has logged on to Dentrix Enterprise, the user may perform all tasks to which they have rights.
There can be certain situations for which additional protection is desired. In these cases, the security options
can be flagged to “Verify User Before Access.” With this security flag enabled for a task, users will be prompted

to re-enter a user name and password when attempting to perform that task.

Tip: Consider how frequently the security task is performed before assigning the “Verify Users Before Access”
flag. This flag will always prompt users to enter their passwords before they can continue working; a lot of

interruptions might not be worth the added security.

To assign user verification

1. In the Office Manager, from the Maintenance menu, point to
Practice Setup > Passwords, and then click Setup Practice for
Passwords.

The Password - Setup Practice dialog box appears.
Select one or more tasks.

Click Verify User Before Access.

The selected tasks are flagged and moved to the bottom of the list.
An asterisk (*) appears before a security option that is flagged to
require re-entry of a password every time users attempt to perform
that task.

4. Click OK.

2 Dentrix Office Manager - The Dentist Group =

Security Options

Patient Questionnaire Open -
Patient Questionnairs S etup

Patient Quick Letters

Patient Referral, &dd/E dit

Patient Referral, Delete

Patient Referral, Dpen

Patient Reminder List, Open
Patignts, Add Mew

Patignts, Archive

Patients, Delete

Patients, Edit Family Relations

Patients, Edit Insurance Information [
Patients, Edit Patient Informatian W
Patients, Merge Patients

Payment Agreement Types, Setup

Payment Plans, Add New/Edit Info

Peria Chart. Open S

Werify User Before Access

Cancel
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Setting Up Program Preferences

You can customize Dentrix Enterprise to the way your practice works. Each computer can have different

preference settings.

To set up preferences

1. In the Office Manager, from the Maintenance menu, point to

Practice Setup, and then click Preferences.

The Preferences dialog box appears.

2. On the General Options tab, set up the following preferences:

* Find Appointment Time Defaults — Set
the defaults for the Find Appointment
Time button in the Appointment Book.
Select the Block size in minutes and an
Appt Length. Select All Operatories
Selected to search all operatories and/or
Sort by Operatory ID to sort the results
by operatory ID. Select whether to search
by the current Appointment Book view or
by the current clinic.

*  Apply to Charges for’ Default — To have
charges default to the family of the selected
patient when making a payment or credit
adjustment, click Family. Or, to have

% Dentrix Office Manager - The Dentist Group ~
File View Repo

Preferences

General Options | Print Options | Statemert Fomns | Paths |

Appt  [15

Length: 24
* By View
" By Clinic

Block | Min

size;

[# Al Operatories Selected
[™ Sort Results By Operatory 1D

TIicK Letters
" Include Today's Date
" Ewclude Today's Date

Additional Dptiohs:

™ Perio Beep an Ertry

7 Suspend Patiert Alerts

[ Suspend Treatment Area Flags

7 Autodnsert Name/Date [Clinical Note]

™ Use Classic Clinical Notes Dialog

[ Use Classic Treatment Plan Presenter
P

[™ Show Close Message for Tw Planner

V¥ Show Close Message for Doc Center

Spell Check.

¥ Enable Spell Check TETTG Carges Tor Dera

[~ Mark Al Misspelled Text . .
[¥ Mark Mizspelled Mew Text & Famiy ™ Ledger View

charges default to whomever’s account is being viewed in the Ledger, click Ledger View.

3. On the Print Options tab, set up the following preferences:

e Use ADA Codes in Descriptions — Preferences B8
To have ADA codes print with their GenerlOptons it Optrs | Sitemerd Foms | Pat |
. . . Print Formatting
descriptions, select this check box. e e R
° I)rovider ID Column for Statements _ TO Statement Count: [25 Patient Mate Repart Count: 250
. . | n
have the provider ID printed next to each PocectSea s [
transaction description on walkouts and PintDislay Options
bllhng statements, select this ChCCk bOX. Ir Use ADA Codes in Descriptions I™ Intemational Tooth Numbering
* No Insurance Flag(*) on Statements — To TR
wx . h ™ Provider ID Column for Statements Iv Sart Claim by 10
remove the text Indlcates tnis procedure [ Mo Insurance Flag [*] on Statements I Sant Pretreatment by 1D
has been bllled to Insurance” from bllhng I™ Werity Billing Statements to Send T ome LEBerE - STp petErts wha have
. pu— e —— requested no conespondence
statements, select this check box. UL E
N
*  Verify Billing Statements to Send — To ( 4 Cancel
preview billing statements before printing N
them or sending then electronically, select this check box.
e Sort Claim by ID — To print procedures on insurance claims in the order the procedures were posted
in the Patient Chart or Ledger, select this check box.
*  Sort Pretreatment by ID — To print procedures on pre-estimate claims in the order the procedures
were posted in Patient Chart or Ledger, select this check box.
4. Click OK.

Dentrix Enterprise 7.0 User's Guide



44 Chapter 1: Introduction and Initial Setup

Dentrix Enterprise 7.0 User's Guide




Chapter 2: Family File 45

Chapter 2: Family File

‘The Family File stores and displays important patient information, such as a patient’s name, address, phone
number, medical alerts, birth date, insurance coverage, employer, and referral information. Dentrix Enterprise
organizes patients by family in the Family File.

This chapter covers the following topics about using the Family File:
*  Using the Family File Window
e Selecting a Patient

*  Adding Families and Patients

*  Working with Employers

*  Working with Insurance

* Assigning Continuing Care

*  Working with Patient Notes

*  Working with Referrals

*  Assigning Medical Alerts

e Archiving Patients

* Editing Family Relations

*  Merging Patients
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[ J [ J (] [
Using the Family File Window
This section covers the following topics to help you understand how to use the Family File window:
e Using the Family File Blocks
*  Using the Family Member List
*  Using the Family File Toolbar

Using the Family File Blocks

The Family File window contains several boxes, called “blocks,” that display information. By double-clicking
any of these blocks, you can enter, edit, or delete corresponding patient information.

| & Dentrix Family File - (Abbott, Patricia) [MESA] [DDS1] [ABE102]
File

Edit Help

Mame: Abbott, James 5 [Jim] Chart #: ABE101

Patient Information

Address: 1234 0ak St
American Fork, UT 84003

Congent: 03/02/1993
First ¥isit: 03/02/1993
Last Visit: 01/09/2012

Clinic: MESA
SS# 111111
Birthday: 11/11/1962, 49
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Block

Phone: H 5851111 Mizzed Appt: Provider: AMCCLURE
Fee Sched: <Prov Default:
Status: Active, M, Married, Ins E-Mail:
. Medical Employer Cont. Continuin
Medical Alerts Block = el Pl Care 04/09/12 PROPHY Continuing
Employer Block neurance: | Dental Primary | Patient Notes
Company: fetna Dental Patient Notes
Group Plan: HSPS detna Block
Insurance EmuE #: 123456 [Na Mate]
Information Block Fee Sched:
Coverage: 1500.00 Used: 0.00
Ded. 5/P/0: 25/0/0 Met: 0/0/0
[[0->30 [31-560 [61->90 | 91> [Suspended Balance | |Refered By 03/02/1333
[ 246500 [ 000 [ 000 [ 131.00 | 000 [ ZR3700 | Croshy, Brent L Referral Blocks
Billing and Payment Payment: 100.00  Amt Past Due: 110293 Referned To
Agreement Block Bill Type: 4 Last Payment: 50.00 02/28/2010
Status Hame Poszition | Gender | Patient | Birthday
HofH Guar Ine | Abbatt, Patricia Married Female ez 1111963 -~
Ihz Abbatt, James 5 M arried M ale Yes 11/1141962
Sraith, Timothy Child hale Inactive | 1141141984
-

Note: From the Billing and Payment Agreement block in the Family File, you can change a family’s billing
type, set up payment agreements, and manage guarantor notes. These functions are discussed in Chapter 7:
Ledger.

Using the Family Member List

The Family Member List displays all members of the family. Double-click a family member to quickly access
that family member’s information in the Family File.

Status Hame Position | Gender | Patient | Birthday
HofH Guar Inz | Crozby, Brent b arried bd ale es 05/17/1360 -
Crazhy, Shirley td arried Female Yes 101441965 | T
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Using the Family File Toolbar

The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

EENPIVEEEEEE N A

The function of the buttons specific to the Family File are explained in the following table.

Click the Select Patient button to select a patient whose record you want to view in the Family File.

Click the Add New Family Member button to create a patient record in the family currently being
viewed in the Family File.

If the patient currently being viewed in the Family File has referred any patients to your practice,
click the Referral Analysis button to monitor referrals or enter gratuities.

Click the Patient Notes Report button to print patient notes and other types of notes in Dentrix
Enterprise for the patient currently being viewed in the Family File.

Click the Patient Alerts button to enter or manage the alerts for the patient currently being viewed

47

in the Family File.

currently being viewed in the Family File.

Click the Clinical Notes button to manage clinical notes regarding the treatments for the patient

Oo | (L) | o | )| L2 | 651 | [

patient currently being viewed in the Family File.

Click the Patient Referrals button to enter or manage referrals to and from your practice for the

For a comprehensive explanation of all the buttons on the toolbar, see the “Using the Family File toolbar”

topic in the Dentrix Enterprise Help.

Selecting a Patient

To view or edit a patient’s information in the Family File (or any other patient-specific module), you must
select the patient. By default, you search for patients by name; however, you can search for patients using
other information, such as a home phone number, chart number, or Social Security number.

Note: When you first install Dentrix Enterprise, no patients are in the database. Patient information must be

entered manually or through an electronic data conversion.

To select a patient
1. From the File menu, click Patient.

The Select Patient dialog box appears.

| & Dentrix Family File - (Abbatt

Mame: Abbatt, James 5 .
Address: 1234 Oak 5t

American Fork, L

2. Type all or the first few letters of
the patient’s last name in the Enter

Select Patient

DE[FlaH|i|s]e|C|m (F.VN P
. Enter Name(Last, First 1) + MName er
Name field, and then click the search | 9 0 RISIT UIVIWEXIY]Z] |~ o HinPhore
. . . 4 B 7 ) Clear
button **! to view a list of patients T an Css# O Bty

that match the search criteria.

es 5

‘Abbott, Patricia *

Tip: If you open this dialog box
from the Family File, to include
archived patients in your search,
select Include Archived Patients.

Recent Patient 5 elections:

[Eirthday
11/11/1962

[Cliniic:
MESA
MESS

MCCL
1141193 D

[Status [Chart # lss#

ABB101 111111111
ABBT02 GEE-EE-6EEE

|Abbott, James 5
3. Select the name of the patient.

4. Click OK. o |

1141141962 AMCCLURE

MESA

Mare Patient Information

ABBTOT 1111111

@)L
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Adding Families and Patients

This section covers the following topics about how to add patient records into Dentrix Enterprise:
*  Viewing Patient Records

* Adding Family Members

* Adding a New Patient with an Appointment

Viewing Patient Records

The Family Files stores patient records by family. A family in Dentrix Enterprise must hve at least one person,
the head-of-house (guarantor), even if that person is not a patient. When you register a patient in RPMS, the
patient and corresponding demographics are pushed to Dentrix Enterprise. If you want to add a patient in
Dentrix Enterprise, contact Dentrix Technical Support.

Important: The current functionality of an HL7 interface is to transfer data from a “host” system (RPMYS)

to a “secondary” system (Dentrix Enterprise). This means that any changes to some patient demographic
fields you make in Dentrix Enterprise may be overridden the next time the HL7 interface is processed and an
update message comes across.
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Adding Family Members

Since all patients in Dentrix Enterprise come from RPMS, the only time you may need to add a family
member to a family is for insurance purposes. Dentrix Enterprise allows you to enter up to 18 family

members per family.

To add a family member

1. With the appropriate family account being viewed in the Family File, from
the File menu, click Add New Family Member.

The Patient Information dialog box appears.

The last name, primary
provider, home phone
number, address, and
email address of the
head-of-house are already
entered for this patient.
However, you can change
any of that information
as needed and enter

the rest of the patient’s
information.

Click OK.
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| & Dentrix Family File - (Abbott

ott, James S [
4 Oak St

ame:
Address: 123
& an Fork, 1l

Patient Information IEI
AME = = Fatient Aliaz
Last First Ml Suffix Freferred Last Mame
|Abbott tary |— | | ’—
Salutation Title ;
[ [ [ Print Title on Stmts o=
?tatus . "
Fatient Gender M arital Face Ethnicity Fieligion Middle  Suffix
|F'atient j |Male ﬂ |Single j Unspecifiedj |Unspecifiedﬂ |Unspecifiedj
Language Poverty LE\E ‘whorker Stam Homeless Status  eteran User Def. Cat. Mother's Maiden Mame

|Unspecifiedj |Unspecifiedj |Unspecifiedj |Unspecified j |Unspecifiedj |Unspecifiedj Last Wame
Perzonal [Office
Bithdats ~ Ag= 554 Other 1D Prav1 First Marne
[ | 2 [AMCCLURE |
Diiver's License # | Prov2 Middle  Suffix
o ! N AL |
es Street Initial Provider -
|1 234w Oak 5t ﬂ | ﬂ Privacy Requests
| Clinic ™ Mo phone calls
City ST Zip |MESA ﬂ ™ Ma corespondence
|smerican Fork. UT  |s4003 ﬂ Fee Schedule [ Disclasure restrictions
County/Parish Country |<Prov Defaults ﬂ —
Chart £: Communication Pref.
E-Mail [<&UTO> oy | nspesied &
—
Phane - Consent |03/27/2013
Horne: Wwiork Ext Time ToCall —
[GE6TT1 | | Wil
Féu Mobile Other First Wisit Last Visit Copy Patient Information
| | | [03s27/2m3 |
Last Mizsed #
Pat Ext 1D: Patient Class:  Death Date: Appt Mizzed
| | | | 0

@L‘ Cancel
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Adding a New Patient with an Appointment

You can create a Family File record for a new patient who has an appointment in the Appointment Book. This
functionality can help prevent the re-entry of a person’s name and address when creating a Family File record.

To add a new patient with an appointment

1. Once the patient
h b P . t d \-} Appointment Book <The Dental Group> <MESA> EI@
as been ngIS cre = File View Status Setup Apptlists Help
in RPMS and | =
R EEEERE
pushed across to Hoie | RVU Fee: 00 Wednesday - March 27,2013
Dentrix Enterprise, 0l MESAT | MESA2 | MESA3 | MESA4
double-click the new 10
ient’ i Bl

patl}fl:ntAs appointment A
1 1 .50
in the ppomtment 9:00am -| MP-Catrell, Jim
Book You can L
; ; 30 h
identify a new- 0
patient appointment e

A0
by the “NP” that o

230
appears before the a0

person’s name on the
appointment.

Important: All demographics for the patient come from RPMS. Do not add a patient or change patient
information in Dentrix Enterprise.

Click Change Pat, and then select the patient.
Click OK.

You can now post treatment for this patient.
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Working with Employers

This section covers the following topics about how to manage patients’ employers:
*  Assigning Employers
*  Changing an Employer

(] L]
Assigning Employers
From the Family File, you can assign an employer to a patient or add a new employer and assign it to a
patient.

Tip: Dentrix Enterprise stores all employers and their corresponding information entered from the Family
File or Office Manager. When you assign an employer that has never been entered into Dentrix Enterprise to
a patient, you must enter all the employer’s information; however, the next time you need to assign that same
employer to a patient, you can choose the employer from a list instead of having to re-enter all the employer’s
information again.

To assign an employer to a patient

| & Dentrix Family File - (Abbott, Patricia) [MESA] [DDS1] [ABBLC-
1. In the Family File, with a patient selected, double-click the File Edit Help
Employer block. ' '
Name: Abbatt, James S [Jim]
The Employer Information dialog box appears. Ao e Fa T 84003 o
2. Type the first few characters of the employer’s name in the Phone: H 5551111 s
Employer Name field, and then click the search button 2, Status: Aciive, M, Maried Jpsme
: : mes- 2 e (1) e
The Select Employer dialog box appears so that you can verify — e Pai
that the employer does not already exist in Dentrix _ Company: fetns Dental
Enterprise. Employer Information ==
3. Do one of the following: Eneley e'Name:LEt';et < : >ﬂ
e If the employer Addess]
already exists, L =
select it, and IEH";eF:SEmD'we'NamE
then click OK
to display that I podress @
employer’s -
information in R
the Employer
Information /
dialog box Ok Close /

appears.
* If the patient’s employer does not already T — B /

exist, click Cancel to return to the EmnloyerNameriEIectric »]

H H Shreet
Employer Informatlor} dialog box, and ot TS
then type the employer’s name, address, and 5
phone number. City ST Zp
) [sLe [uT [s4003
4. Click OK.

Employer Phone: I[am 555-6729

For information about adding an employer from Cen | K| Concel |
the Office Manager, see the “Adding and editing 4

employers” topic in the Dentrix Enterprise Help. O/

51
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Changing an Employer

When a patient changes employers, or a patient’s current employer changes its name, address, and/or phone
number, Dentrix Enterprise lets you change that information. Any changes you make to an employer’s
information affects other patients who have that same employer.

To change the employer assigned to a patient

1. In the Family File, with a patient selected, double- || pentrix Family File - (Abbott, Patricia) (MESA] (DDS1] [ABE102]
click the Employer block. File Edit Help
‘The Employer Information dialog box appears. —boat
Address: 1234 Oak St Consent: 03/02/1993
1 . Armerican Fork, UT 84003 First Visit: 03/02/1933
2' DO one Of the fOHOWlng' Last Visit: 01/09/2012
. . Phone: H 555-1111 Missed Appt:
e If the patient has a new employer, click Clear, )
. Status: Active, M. Maried, |y E-Mail:
and then select or enter a different employer R =) Ferlyer ( 1 ) ot S
. .« .. » . . Alerts HSPS are
as explained in “Assigning Employers” in this Insusanos: veree Py Pationt Notes
Chapter. i Dnmgén_v Aetna Dental
. Employer Information @
e If the patient’s current employer has changed
. Employsr Name:[Fieci
its name, address, or phone number, make any resEn EECTC Bl
Teel

necessary changes. @_ Acdress [SLE Office
3. Click OK. A E

iy 5T Zip
If you have changed the information in any field (not OR B Jur feeat3
just selected or entered a new employer), a message e e
appears and states that the changes to this employer T Gl \7£K\v| Cancel
will affect the employer information for all patients \?J

with this employer. To confirm you want to make the
change to all the relevant patients, click OK.

Working with Insurance

Whenever a new family member is entered, he or she is automatically given the same insurance coverage as the
head-of-house, but a different insurance plan can be attached to the patient or head-of-house at any time. This
section covers the following topics about how to add and remove dental insurance for a patient or head-of-
house:

*  Assigning Dental Insurance to a Subscriber

*  Assigning Dental Insurance to a Non-subscriber
*  Changing Dental Insurance Carrier Information
* Assigning Coverage Tables

*  Clearing Dental Insurance Coverage
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Assigning Dental Insurance to a Subscriber

Before you can assign dental insurance to a patient who is not the insurance

plan subscriber, you must assign

insurance to the subscriber in the family. If the subscriber is not a patient, add the subscriber to the family as a

non-patient.

To assign dental insurance to a subscriber

1. In the Family File, with a patient selected, double-click the Alets |10 |turgglsow ¢
Insurance Information block. Insurance: |DentalPinayy v g
Company: &etna Dg
The Insurance Information dialog box appears. igﬁﬁ{ﬁ 238
2. From the Coverage Order list, select the type of coverage you iy iy e
want to add to the subscriber: Primary, Secondary, Tertiary, or [ S (Siom (Bl | 91 pusbended B
Quaternary. e I T L
3. If the subscriber’s name is not in the SR —
Subscriber field, click the search button 22 R LA RN =
In the Select Primary Subscriber dialog box, | 2™ | Medealinarance|
click Current Patient to make the patient S i W
currently being viewed in the Family File
the subscriber and return to the Insurance Subscrber: Cater 7N\
Information dialog box. S 2 | 4 2
4. To find out if the carrier already  [Sclect Dental Insurance Pl |
exists in Dentrix Enterprise, Enter Carrier Name: .
click the Carrier search button | I et ; Carier Name ; Giroup Plan
>*| In the Select Primary e preve ke
Insurance Plan dlalog bOX, Carrier Name Group Plan Employer Name Group # :ocal# | PaporID | Address
HGPS Aetna 123456
type the first few characters of AetnaLife and Cas... Actna ™ 321863 IN, Forl
the carrier’s name (you can also e
search by employer, group plan, oR
or group number), and then
click the search button >/ to @
view a list of all the carriers thar | etnuence Plret= o
match your search criteria.
Important: Always search for an insurance plan before adding it as a new plan in Dentrix Enterprise to
avoid creating duplicates of an insurance plan.
5. Do one of the following:

* If the carrier already exists, select it, and then click OK to return to

dialog box.

the Insurance Information

If the carrier does not already exist, click New Insurance Plan to add the insurance plan and return

to the Insurance Information dialog box. For an explanation about setting up the options for a new

insurance plan, see “Changing Dental Insurance Carrier Informatio

n” in this chapter.
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Insurance Information - (Abbott, James 5) IEI

Dental Insurance | Medical Insurance |

Coverage Order: | Primary -

Subscriber: Carrier:

Abbatt, James 5 ﬂ |Aetna Dental ﬂ

Subscriber |d #: |596-31-5673 Insurance Data | Coverage Table |
Signature an File Payrnent Table | Ded/Benefits |

v Release of Infarmatia

v Aszignment of Benefits Last Eligibility Date:
Plan Effective Date:

Fielation ta Subscriber o '7
(& Sef € Spouse ( Chid © Other | TN Expiation Date:

Clear Coverage

7 Cancel

N’

6. Set up the following options:

Subscriber Id # — The subscriber’s Social Security number is automatically entered as the subscriber
ID number, but you can change it.

Important: If this field is left blank, any insurance information you enter will not be saved and
attached to the subscriber.

Signature on File — If you want the words “Signature on File” to print on insurance claims for the
subscriber to authorize the release of information, select Release of Information. If you want to
authorize payments directly to the provider instead of the subscriber, select Assignment of Benefits.

Important: If your office accepts assignment of benefits from insurance carriers, you must select the
Assignment of Benefits check box; if you do not, insurance checks will be mailed to the subscriber,
not the office.

Relation to Subscriber — Make sure Self is selected to indicate that the current patient is the
subscriber.

7. Click OK.
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Assigning Dental Insurance to a Non-

subscriber

Before assigning insurance to patients who are not insurance subscribers, make sure that the insurance plan
has been assigned to the subscriber, and the subscriber for the insurance plan is part of the same family as the

patient to whom you are assigning the insurance plan.

To assign dental insurance to a non-subscriber

1. In the Family File, with a patient selected, double-click the

Insurance Information block.

The Insurance Information dialog box appears.

2. From the Coverage Order list, select the type of coverage you
want to add to the patient: Primary, Secondary, Tertiary, or

Quaternary.

3. If the subscriber’s name is not in the
Subscriber field, click the search button
to select the appropriate subscriber.

2

Important: The insurance carrier for the
selected subscriber appears in the Carrier
field. If you change the carrier for the selected
subscriber, the change will affect all other
family members under this subscriber.

4. Set up the following options:

e Subscriber Id # — The subscriber’s Social
Security number is automatically entered
as the subscriber ID number, but you can
change it.

Important: If this field is left blank, any
insurance information you enter will not
be saved and attached to the subscriber.

Medical
Alerts

L |Employer

o | HsPs

Insurance: ‘ Dental Primary
Company: Aetna De
Group Plan: H5PS
Group #: 12345
Fee Sched:
Coverage: 1500.00 sed: 0.00
Ded. 5/P/0: 25/0/0 Met: 0/0/0
0-->30 [31-->60 [61-->90 [ 91> [uspended Ba
246600 [ 000 [ 000 | 73700 [ 000 [ 2%
Monthly Payment: 100.00 Amt Past Due: 110593
Bill Type: 4 Last Payment: 50.00 02/28/2010

[xln

LI P

Status | Hame
Insurance Information - (Abbott, James 5) @
Dental Insurance | Medical Insurance |

Coverage Order: | Primary i : : ’
Subscriber: Carrier:

Abbatt, James 5 124 |Aetna Dental ﬂ

Subseriber 1d #: |996-31-5679 Inzurance D ata | Caoverage Table |

Gignature an Fils Payrnent T able | Ded/Benefits |

¥ Releaze of Informatio

¥ Assignment of Benefits

Relation to Subscriber

¢ Self © Spouse © Child ¢ Other

Last Eligibility D ate:
Plan Effective Date:
Flan Expiration D ate:

Clear Coverage

5 Cancel

N

* Signature on File — If you want the words “Signature on File” to print on insurance claims for the
subscriber to authorize the release of information, select Release of Information. If you want to
authorize payments directly to the provider instead of the subscriber, select Assignment of Benefits.

Important: If your office accepts assignment of benefits from insurance carriers, you must select the
Assignment of Benefits check box; if you do not, insurance checks will be mailed to the subscriber,

not the office.

* Relation to Subscriber — Make sure the patient’s relation to the subscriber is correct: Spouse, Child,

or Other.
5. Click OK.
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Changing Dental Insurance Carrier
Information

You can change information for a dental insurance carrier at any time. You can edit this information from the
Family File or Office Manager.

To change insurance carrier information e =
T ployer C
Alerts 'H_.J | HsPs C
1. In the Family File, with a patient selected, double-click the Insurance: [Dea Fimay <] P
. Company: Aetna De
Insurance Information block. Groumany pane
The I Inf dialog b cSorei:
1 1 Fee Sched:
¢ Insurance Information dia 0g DOX appears. Coverage. 150000 <ed: 000
. Ded. 5/P/0: 25/0/0 Met: 0/0/0
2. From the Coverage Order list, select the type of coverage you 0530 [31560 [ 61590 51> Buspended Be
dit: Pri d Terti [_245500 [ 000 | 000 [ 13100 | 000 [ &
want to edit: Primary, Secondary, Tertiary, or Quaternary. Monthly Payment 10000 _Amt Past Due: 1105 53
Bill Type: 4 Last Payment: 50.00 02/28/2010
3- Cth Insurance Data. Insurance Information - (Abbott, James §) @ -
The Dental Insurance Plan Information Dental nsurance. | Medical Insurance |
dlalog bOX appears. Coverage Order; | Primary |
Dental Insurance Plan Information @ i
Beniter e |A s Dertal s Auto Adjustrment Carrier:
gcia i e~ } ﬂ |Aetna Dental ﬂ
Group P|an3|HSF'S s vy Mo Adjustment
O . . -
Employer: |HSF'S ﬂ puiitelfE sinaiadinsuancelhoion Insurance Data | Coverage Table |
5 PUT— | 1: -Professional Discount J J
trest Address:[1234 Maple Rid. = Payment Table | Ded/enefis |
| r
City, ST Zip:[american Fark UT [B4003 r LastElighiity Date: |
. . r
Phaone: |(301)555-1111 Ext: - Plan Effactive Date:
Eontact:|
Flan Expiration D ate:
Group #: |1 29456 Loc:al:| {+ &
Last Update:|01/11/2012  Benefit Renewal: [JaN " Use Insurance Fee Schedule to Caloulate:
. [adjustment amount = provider/patient fee
Claim Format:| D2007 ﬂ Other Code: schedule amount - insurance fee schedule amount) %
Alt Code;| ADA ﬂ | 1: -Professional Dizcount J J _—

Fee Schedule: |<NONE: ﬂ S 6 Cancel
RVU Scheduls: | <NONE> 2| Provider D Setup r
Payor 1D: > r
E— -
Plan External ID:
Mational Plan 1D: Rate Code Options:
Sermo e Repmet |[N0ne] j [™ Send Rate Cade with Claim: ’— J

Insurance Claim O ptions

™ Replace initial character of procedure code with: |— =
-

& 0.00
™ DaMat Include Graup Plan Mame o~

[™ DaMat Bill ta Dental Insurance

™ Do Mot Bill to Dental Insurance if 0% Coverage |W"thAZ [0.00] Dollr & : J
i ero [0, ollar Amoun

Advanced -

Financial Class Types
* Mo Financial Class Types

" Use Financial Class Types

J Clear Cancel

4. Change any of the following options as needed:

*  Carrier Name — Type the insurance carrier’s name.

*  Group Plan — Type the group plan name.

Tip: If you do not have a group plan name, type the employer name as the group plan name; this will
assist you later on when you are assigning previously entered insurances to patients.
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>3

Employer — Click the search button *”! to select the employer that administers the group plan.

Contact Information — Type the address where insurance claims are to be mailed for this carrier.
Also, type the contact phone number and extension (if applicable), and the contact person.

Group # — Type the group number for this plan.
Benefit Renewal — Type the month that the yearly insurance benefits renew for the insured patients.

Claim Format — The claim format defaults to the first claim format listed in Practice Definitions, but
you can select a different one if applicable.

Fee Schedule — Click the search button _**! to select a fee schedule to attach to this insurance carrier.

Note: If a fee schedule is attached to the insurance carrier, it will be used instead of the fee schedule
attached to the patient’s primary provider. However, if a fee schedule is selected for the patient, that
fee schedule will be used instead of the one attached to the insurance carrier.

RVU Schedule — Click the search button **| to select an RVU fee schedule to attach to this
insurance carrier.

Payor ID — Type the payor ID that is to be used with electronic claims, or click the search button **

to find and select a payor ID.
Auto Adjustment — Choose from the following automatic adjustment options:
* No Adjustment — If you do not want an automatic adjustment posted for this insurance carrier.

*  Write Off Estimated Insurance Portion — To automatically make an adjustment for the
estimated insurance portion in the Ledger.

Select the credit adjustment type you want to use for the adjustment.

* If you want to post an adjustment after a claim is created, click Post when Claim Created.
This option should be used if claims will always be created for the insurance. Select Receive
Claim to change the claim status to “Received” with a zero payment after the adjustment
is made. If Receive Claim is selected, you can set up further actions you want to occur
automatically after a claim is received — Send to Batch, Applying Ins. Portions to
Maximums, and Apply deductibles based on expected Patient Portion.

* If you want to post an adjustment when a procedure is completed, click Post when
Procedure Completed. This option should be used if no claims will be created for the
insurance. With this option selected, any changes made to the coverage table after the
procedure has been set complete will not be reflected in the adjustment.

*  Use Insurance Fee to Calculate — To have the adjustment calculated using the following
formula: Provider or patient fee schedule amount - Insurance fee schedule amount =
Adjustment amount.

The following will happen with this option selected:

e If the patient has been assigned a fee schedule in the Family File, an adjustment will be
posted that equals the difference between the patient fee schedule amount and the insurance
fee schedule amount.

* If the patient does not have a fee schedule assigned to him or her, the patient’s primary
provider’s assigned fee schedule will be used. An adjustment will be posted that equals the
difference between the provider’s fee schedule and the insurance fee schedule amount. To use
this option, a fee schedule must be selected for the insurance carrier.

Select the credit adjustment type that you want to use for the adjustment:

* Ifyou want to post the adjustment using this calculation when the claim has been received,
click Post when Claim is Paid.

57
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e Ifyou want to post the adjustment using the formula previously mentioned when a
procedure is set complete, Post when Procedure completed. Select Create/Receive Claim
to have the following occur automatically: create a claim, post the adjustment, and then
change the status of the claim to “Received” with a zero payment. If Create/Receive Claim
is selected, you can set up further actions you want to occur automatically after a claim is
received: Send to Batch and Apply deductibles based on expected Patient Portion.

* Rate Code Options — Some insurance companies (usually state Medicaid) pay a practice a set dollar
amount per visit no matter how many or how few procedures were performed on a patient during
that visit. The “rate code,” also known as an “encounter code” or “visit code,” is a procedure code that
tells the insurance company how much that amount is. You can choose to include and under what
conditions to include an encounter, rate, or visit code on a claim:

a. Select Send Rate Code with Claim, and then click the search button *?| to select the
appropriate code.

b. Under Send Rate Code With, select one of the following options:

*  The Total of All Procedures — The selected rate code will be used as the first procedure on
the claim (printed or electronic), and the amount of the rate code will be the sum of all the
procedures on the claim.

The fee used for this calculation will be the default fee schedule (with the ID number “1”) for the

billing provider for the claim. This is the same fee schedule that is used for an “F” claim format.

*  Practice’s Rate — The selected rate code will be used as the first procedure on the claim
(printed or electronic), and the amount of the rate code will be the rate entered in the field.
By default, the field has the insurance plan’s fee schedule, but you can change it to specify the
rate code that you want to be used on the claim.

*  No Amount — The selected rate code will be used as the first procedure on the claim (printed
or electronic), but the amount or charge on the claim for the rate code will be blank.

c. From the Send Procedure Codes list, select one of the following options:

*  With A Zero (0.00) Dollar Amount — The procedures will be listed after the rate code on
the insurance claim (printed or electronic) with a zero dollar amount (0.00).

*  With The Procedure’s Fee — The procedures will be listed after the rate code on the

insurance claim (printed or electronic) with each procedure’s fee as the amount charged.

*  No Amount — The procedures will be listed after the rate code on the insurance claim
(printed or electronic) with each procedure’s charged amount being blank.

* Do Not Send Procedures — Only the rate code will be listed on the insurance claim (printed
or electronic).

d. If you want the rate code to be posted in the Ledger, select Post Rate Code to Ledger. The rate
code will not appear in the Patient Chart. The fee shown in the Ledger will be the same fee that
appears on the claim.

Important: The fee schedules for the procedure code(s) and rate code on the claim must not
conflict or double the account balance in the Ledger.

Notes:

*  Since the rate code has to be medically crossed coded to be placed on a medical claim, Dentrix
Enterprise will post the rate code and automatically edit the rate code to select the appropriate
AMA CPT and ICD-9-CM diagnostic code (with the installation of Dentrix Enterprise, a
“Rate Code” has been added to the AMA CPT list and ICD-9-CM diagnostic code list) as long
as the rate procedure code is cross coded with the AMA CPT “Rate Code” and ICD-9-CM
“Rate Code”.
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The AMA CPT “Rate Code” and ICD-9-CM “Rate Code” tied to the procedure rate code

If the AMA CPT “Rate Code” and ICD-9-CM “Rate Code” tied to the procedure rate code

are deleted, the rate code option for the claim will not work properly, and you will have to

cross code the rate code again.

5. Click OK to save the insurance plan and return to the Insurance Information dialog box.

6. Click OK.

If the carrier information has been changed for an insurance plan that is attached to at least one other
family member (subscriber or non-subscriber), a dialog box appears so that you can choose whether to
apply the changes to all other subscribers who have the same insurance plan, which will in turn affect the
family members of the those subscribers, or to have the change affect only the current subscriber and add
the changed plan as new insurance plan without changing the original plan.

Assigning Coverage Tables

Most insurance companies provide the patient with a schedule of benefits, which declares the maximum
annual benefits for the individual and entire family. The schedule of benefits also states the deductible
amounts, plan maximums, and the percentage of the usual and customary fee that the insurance company will

pay.

You can add this information to an insurance plan as a coverage table. A coverage table helps you create
treatment plan estimates that accurately reflect the benefits paid by an insurance carrier.

To assign or edit an insurance plan’s coverage table

1. In the Family File, with a patient selected, double-click the
Insurance Information block.
The Insurance Information dialog box appears.

2. From the Coverage Order list, select the type of coverage you
want to edit: Primary, Secondary, Tertiary, or Quaternary.

3. Click Coverage Table.

The Insurance Coverage dialog box appears.

medaical
Alerts

~ |Employer

o | Hsps

[x]n

Insurance: [Dental Frimary LI
Company: etna De
Group Plan: H5PS
Group #: 12345
Fee Sched:
Coverage: 1500.00 sed: 0.00
Ded. 5/P/0: 25/0/0 Met: 0/0/0

o

030 [ 3160 | 61->90 | 91> Fuspended B

by

ZI6500 | 000 | 000 | 13100 | 000 | 2
Monthly Payment: 100.00 Amt Past Due: 110893
Bill Type: 4 Last Payment: 50.00 02/28/2010

Insurance Information - (Abbott, James )

Dental Insurance | Medical Insurance |

Coverage Order:

Primary v‘ : ’

Clear Coverage

' =

Carrier:

ﬂ |Aetna Dental

|

Insurance Data | Coverage Ta' 3 ’
Payment T able | Deda’Benefits\r/
Last Eligibility D ate:

Plan Effective Date:
Plar Expiration D ate:

6 Cancel

Insurance Coverage - (Metropolitan Life/Metropoelitan) IEI
DEEE Lifetime  Annual  Annual '\":a;i.m}ém l|3eneFfit .
Individual Individusl Family hadiidual: arnily: 3 5
Standard |0 25 75 2000 8000
Pravantive 'D— 'D— 'D— [ Ortho Plan - Use az Ortha Lifetime b ax H#: |596-31-5673
Other |0 il il ?’ Claim n File
= 4 eadine: |2M ﬂ Ik i
e of [nfarmation
Coverage Table \ /
Beg End Cow Pre ment of Benefits
Froc Froc Category % Ded CoPay Est?
'E ’E‘ noo I Subscriber
80 S 0.00 S Add Spouse ¢ Child ¢ Other
80 S . N —m
D2000 L2999 Restorative a0 s n.on N |= Change
03000 03939 E ndodontics 80 5 0.00 M —
D4000 [4939 Periodontics 80 5 0.00 N B Delete
05000 [5939 Prostho, remay. 80 5 0.00 M -
DE000 DE939 Prostho, fixed 80 § 0.00 N T
. Clear Table
g
[ Co-Payment Calculations for Ins Portion: Selact
; Table:
o »]
Mates 5 ] Cancel
A
N

N’
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4. Set up the following options:

Dentrix Enterprise 7.0 User’s Guide

Deductible — Each range of procedure codes in your coverage table can be assigned its own

deductible type. The following types of deductibles are available:
* Standard (S) — Used for most insurance coverage tables.

*  Preventive (P) — Used if an insurance carrier’s coverage has a separate deductible for preventive/
diagnostic procedures.

e Other (O) — Used if an insurance carrier’s coverage has a separate deductible for specific
procedures other than preventive/diagnostic.

For each type of deductible, you can type the following:

* Lifetime Individual — Used for insurance carriers that require subscribers to pay one deductible
for the life of the policy for the patient.

*  Annual Individual — Used for insurance carriers that require patients to pay a deductible amount
each benefit year.

* Annual Family — Used for insurance carriers that require a maximum deductible amount for the

entire family each benefit year.

Tip: When Dentrix Enterprise calculates the patient’s portion of charges, the appropriate deductible
amounts will be added to the patient’s payment due amount. This figure will be displayed in the
Ledger as the Est. Patient Portion.

Maximum Benefit — Type maximum amount of benefits that will be paid by the insurance carrier for
the Individual patient and Family annually.

Coverage Table — A coverage table allows you to group several procedures into ranges and assign
the percentage the insurance will pay. When a new insurance plan is created, Dentrix Enterprise
automatically assigns it the first standard coverage table.

Tip: If you do not have or know the insurance company’s schedule of benefits, as insurance payments
and estimates are made, you will be given the option in the Ledger to automatically update a payment
table for the insurance plan, storing what the insurance company actually paid for a procedure.
Insurance estimate calculations will reflect the payment table amounts whenever possible, making
your estimates very accurate.

There are two things to keep in mind when modifying a coverage table. First, you must use the ADA
procedure codes. Second, you may not overlap the beginning (or ending) procedure code of any given
range with the ending (or beginning) procedure code in another range.

Do the following to modify the coverage table:
a. Select a code range.
Change any of the following values:
*  Beg Proc — The beginning procedure code in the range.

*  End Proc — The ending procedure code in the range. If you are assigning only one procedure
to a range, type that procedure code as the Beg Proc and leave the End Proc field blank. The
field will automatically be filled in with the beginning procedure code.

*  Category — The name you assign to represent the range of procedure codes.
*  Cov % — The percentage the insurance plan will pay for all of the procedures in the range.

*  Ded - The deductible type for the range of procedure codes.
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e Co-Pay — If you are setting up a capitation plan, type the patient’s co-pay amount.

e Pre Est? — If the insurance company requires you to submit a pre-treatment estimate for a
procedure in the range, select this option.

c. Do one of the following:
e To add the modified range to the coverage table as a new range, click Add.
* To apply the changes to the selected range, click Change.

d. Repeat steps a — ¢ for any other ranges you want to add or modify.

*  Co-Payment Calculations for Ins Portion — If the plan requires that specific co-pay amounts be
paid by the patient for each procedure, select this check box, and then select the method that will be
used to calculate the amount the insurance company will pay:

* Total Fee x Coverage %

* (Total Fee - Co-Pay) x Cov %

* (Total Fee x Cov%) - Co-Pay

Important: If the plan you are setting up is not a capitation type plan with specific co-payment

amounts for each procedure, do not select the Co-Payment Calculation for Ins Portion box.
Click OK to save the coverage table and return to the Insurance Information dialog box.

When a message appears, click OK to confirm that you want to apply the changes you have made to all
patients who have this insurance carrier.

Click OK.
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Clearing Dental Insurance Coverage

To move a patient from one family to another, you must first clear that patient’s insurance information. Also,
to switch a patient’s primary and secondary coverage, you must first clear that patients primary and secondary

insurance.

To clear a patient’s insurance coverage

1.

In the Family File, with a patient selected, double-click the

Insurance Information block.

The Insurance Information dialog box appears.

From the Coverage Order list, select the type of coverage you

want to remove: Primary,
Secondary, Tertiary, or
Quaternary.

3. Click Clear Coverage.
4. Click OK.
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Medical
Alerts

Employer

s | HSPs

o

Insurance: [Dental Primary
Company: fetna Dey
Group Plan: H5PS
Group #: 12345
Fee Sched:
Coverage: 1500.00
Ded. 5/P/0: 25/0/0

=

sed: 0.00
Met: 0/0/0

=

0-->30 | 31->60 [61-->90 | 91>

uspende

Inzurance Information - (Abbott, James 5)

Dertal Insurance | Medical Insurance I

Coverage Order: IPrimar_l,l vl : ’

[#232] ht: 50.00

Amt Past Due: 1108.93
02/28/2010

Subscriber: Carrier:

Abbatt, James 5

Subscriber [d #: |598-31 5679

ﬂ |Aetna Dental

Insurance Data | Coverage Table |

|

— Signature on File

FPayment Table |

Ded/Beneits |

¥ Release of Information

v Azsignment of Benefits

— Relation to Subscriber

f+ Seff  Spouze ¢ Child ¢ Other

< 3 )EIearEoverage |

Last Eligibility D ate: I
Plan Effective Date: I
Flan Expiration D ate: I

N

—

4 Cancel |




Assigning Continuing Care
You can manage the continuing care (recall or recare) attached to each patient from the Family File. If a
patient has had a completed procedure posted in the Ledger or Patient Chart, and that procedure already
has a continuing care flag assigned to it (for example, prophy), the appropriate continuing care type will
automatically be assigned to that patient. However, you can assign a continuing care type to a patient
manually and even customize the settings to meet that patient’s needs.

Chapter 2: Family File

To assign a continuing care type to a patient {8 Dentrix Family File - (Abbott, Patricia) [MESA] [DDSL] [ABB102]
. . . . File Edit Help
1. In the Family File, with a patient selected, double-
click the Continuing Care block. T p——
Address: 1234 W Dak St Consent: 03/02/1933
1 1 1 1 American Fork, UT 84003 First Visit: 03/02/1333
The Patient Continuing Care dialog box appears. merican Fo First Visit. 0310271333
. . Phone: H 5551111 Missed Appt:
2. Select the continuing care type you want to set.
Status: Active, M, Married, Ins E-Mail:
. . . Medical [~ Employer Cont. )
Note: If the selected continuing care type is already Nents |- 7 |visps Care ( 1)
. - = Patient Notes
set for the patient, the Date column for the Insurance: [Derld Pinay 3]
continuing care type contains a date, and the | Petient Continuing Care - (Aobett, James 5) =3
Set button iS labeled “Edit.” Date Tupe Appt? Statuz Prior Treat. | Prow
07421722 | PROPHY 04,/22/207 3+ | B /2042002 | Prove | -
“Lab- Aspen
3. Click Set. ;

The Set Continuing Care dialog box appears.

CALL AMALG
CALL CROWM
CALL RC

4. Customize the following options as needed:

¢ Due Date — To set the interval for the
patient’s recall, click the search button PERID
**|. Change the Interval to reflect FROPHY
the amount of time that should elapse

Set... Cloze
between the patient’s recall visits, and 3
select +1 Day to prevent insurance
billing problems if the carrier has strict
. . Set Continuing Care - (Abbott, James 5) IEI
interval requirements.
Type: Description;
e Status — To assign a continuing care status BITEWINGS Annual Bitewings
to thC patient, SCICCI’. the appropriate status. Date Set: eduled Appt.: Motivational Note: v

Statuses are used primarily when generating | §
. . l Due Date: 1 Treatment:

continuing care lists. w3rzsiz0ts > | [orstianiz

*  Provider — To have the default provider of Status:

.. . . N =

continuing care appointments be the patient’s Noel -

rimary provider, select Provl; or, to have it be Frovees
P ry p N i . >m " Provl " Prov2
the patient’s secondary provider, select Prov2.
Default Appt. Time: -

*  Default Appt. Time — To enter the amount
of time this patient will need for appointments
with this continuing care type attached, select
Time?. Drag the slider to set the number of
units, and then set up the time pattern for each unit (chair time [, assistant’s time I, or provider’s time %)
to help you make use of all operatories when scheduling appointments and maximize your productivity.

5. Click OK.

For comprehensive details about all the options available when assigning continuing care types, see the
“Assigning continuing care” topic in the Dentrix Enterprise Help. Also, for more information about setting
up continuing care types and their default settings, see “Setting Up Continuing Care Types” in Chapter 1:
Introduction and Initial Setup.

[ Time?

s

6 Cancel
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Working with Patient Notes

Patient notes apply only to an individual patient, and you can view, add, and edit them from the Family File.
This section covers the following topics about how to use patient notes in the Family File:

*  Viewing and Hiding Patient Notes
e Adding and Editing Patient Notes

*  Generating the Patient Notes Report

Viewing and Hiding Patient Notes

When Dentrix Enterprise is initially started, notes are hidden by default. Thereafter, whenever a patient is
displayed in the Family File, the notes will be viewed or hidden, depending on the state of the previously
selected patient’s notes.

To view and hide patient notes

If the notes are being hidden, you can view the notes |2 Notes V=]
by clicking View. (When you click View, the button
label changes to “Hide.”)

If the notes contain confidential information, it is Patient Notes Hide
. o - Fii - Oct 12, 2007 -
I‘CCOI‘nandCd that you hlde the notes by Chcklng Karen is divorced from Harmon Davis who is listed in her file az
. . B a nqn-patient to p_rov!de insuranpe coverage for their children.
Hide after each time the notes are viewed. (When He s alsn st up i his own Farily Fls

you click Hide, the button label changes to “View.”)

Note: If no notes have been entered for the patient, the block displays “No Note,” and the View/Hide option
is not available.

Adding and Editing Patient Notes

You can add notes to an individual patient’s record. Also, you can edit those notes at any time.

To add or edit notes for a patient

1. In the Family File, with a patient selected, double-click the

. Patient Not
Patient Notes block. s
The Patient Note dialog box appears. {No Note) @
2. Type the patient’s hobbies, interests, financial arrangements, or
. . . r Ref: d B 034021993
any other notes useful to your practice. A patient note is © Crosby, Brent L
limited to 4,000 characters. ' Referred To
Tip: If you want to delete the patient notes for this Patient Note =
patient, click Clear. The notes will not be deleted until Insett Dateine | %
you click OK, so if you click Clear accidentally, you can Patient Notes Here] Mon - Dec 22,2008 - p

restore the notes to how they were before you opened the @
dialog box by clicking Cancel instead of OK.

3. Click OK. !
Clear | Cancel
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Generating the Patient Notes Report

You can generate a report of all notes entered for a patient from the Family File. You can also run this report

from the Office Manager.

To print the Patient Notes Report

1. In the Family File, with a patient selected, from the File menu, click
Print Patient Notes.

| & Dentrix Family File - (Abbott
g Edit Help

H H ame: ott, [.
The Patient Notes Report dialog box appears. Adyame: Abball Janes
American Fork, LT
Patient Motes Report IEI

Report Date:|03/27/2013

Select Patient; Mote Tpes: @
From: [sbbaott, James 5 ﬂ

[ Patient &lert Notes
To:[abbott, James & ﬂ |o3/27/2013 - [03/27/2003

Patient Mate
Medical Alerts

Continuing Care Mot
" Guarantors Only ontinuing Lare Notes

™ Perio Exam Notes
Eebalionider [z7zrr201a - [oa/zvizms

From[call> »| Tofall »|
[ Appointment Naotes

ill g G tor Stab t Mok
Select Biling Type: |D2f25£2013 .|03£2?£2013 uarantor Statement Mote

From:| <&LL»  >> Ta:| <ALL> 3> Sawe as Default

Send to batch Print Cancel
3 | |

Insurance Claim Notes

Payment Plan Motes

Guarantor Mate

o o

)

2. Set up the following options:

* Filters — You can include notes for the current patient or a range of patients and for only guarantors.

If you run the report for a range of patients, you can further filter the report by patients’ providers

and/or billing types.

*  Note Types — Select the types of notes you want to include on the report:

Tip: If you want the selected note types to be selected the next time you run the report, click Save As

Patient Alert Notes — Notes entered in the Patient Alert system. You can also specify a date range

to include notes that were entered within that time period.

Perio Exam Notes — Notes entered in the Perio Clinical Notes dialog box (which is accessed
from the Diagnostics menu in the Perio Chart). You can also specify a date range to include
notes that were entered within that time period.

Appointment Notes — Notes attached to appointments. You can also specify a date range to
include notes that were entered within that time period.

Patient Notes — Notes entered in the Patient Notes block of the Family File.
Medical Alerts — Medical alerts for patients.

Continuing Care Notes — Motivational notes added from the Set (or Edit) Continuing Care
dialog box.

Insurance Claim Notes — Notes entered for insurance claims.
Payment Plan Notes — Notes attached to a future due payment plan set up for the patient.
Guarantor Note — Guarantor note entered in the Ledger.

Guarantor Statement Note — Guarantor billing statement note entered in the Ledger.

Default.

3. Click Send to batch or Print.
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Working with Referrals

Dentrix Enterprise provides two types of referral sources (“Referred by” referral types) that you can attach to
patients who have been referred to your practice: Referred by Patient and Referred by Doctor/Other. Also,
Dentrix Enterprise provides a “Referred to” referral type that you can attach to patients to help you keep track
of those patients who have been referred out to another doctor or specialist.

This section covers the following topics about patient referrals and referrals out to specialists:

*  Entering Patient Referrals
*  Entering Doctor/Specialist Referrals

*  Sending Correspondence to Referrals

Entering Patient Referrals

In the Family File, you can enter information about the patient who referred another patient to your practice.

1 Referred By
To enter a patient referral co | [ReferredBy | ﬂ]\
R . . . Refoed T
1. In the Family File, with a patient selected, double-click the Referred ereted o U/
By blOCk Position | Gender | Patient | Birthda
. : ——
X Patient Referrals - Abbott, James S(lirn) [ABB101] ==l -
The Patient Referrals
dialog box appears. f eCT=EED .
Boon P ez Date _ 5
. Dr. Evang, Jeff 0 ] Analys
2 Ee);'t tobthe l}efi?:iﬁi Crosby, Brent [Fatient] 03/02/1993 _ dnasis_|
ist box, clic
yf a_l ’ Select Referral Type 2
Referral. EIearHefenaIl
The Select Referral
Type dialog box appears.
3. Select Patient, and
then click OK. P
Th | | alelc|p E|F|le H[1]|u|Kk|L|M (EN'N ey
1 1 Enter Namel[Last, First MI): * Mame r
e Select Patient dialog box i o[F[a Als[T s v[Wr["]Z| |o oo o 00
IS 0(1|(2|3 4/5|/6 7|8|9]| .| Clar 554  Bithd
ap p cars. [~ Include Archived Patients ithday
4. Select the person who referred Name Bithday  [Provider = St Chanht BSH i

1 Abbott, J 5
the patient. A bbol. Paticia

Tip: If you cannot find the
referring patient’s name, first
check the spelling; then, if you

11/11/1962 AMCCLURE

1141/1963 DDS1 MESA ABBTO2 BEE-6E-BEEE

still cannot locate the patient’s i:::ff:;bmmss — 11/11/1362 AMCCLURE  MEGA ABBIO TN

name, he or she has not been \

entered in the Family File yet, _NowFaniy | boxe Bsberiiiomsion ms

or the referring party is not Abbott, James Referred By ==

one of your patients and must be entered as a non-patient referral

(Referred by Doctor/Other).

5. To change the date the patient was referred to your practice, with
the referring patient selected in the Referred By list box, click Edit. Phone: 5555622
In the dialog box that appears, type the correct date in the Patient

Referred-By Date field, and then click OK.

For more information on referral sources, clearing referrals, and referral [ e | ok | concs
analysis, see the “Working with referrals” topic and its subtopics in the

Dentrix Enterprise Help.

Name: Dr. Evans, Jeff

Address: 1450 N 500w
Provo, UT 84601

Total Referrals: 9

Patient Referred-By Date: |U3-"’2?-"'2U1 3
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Entering Doctor/Specialist Referrals

In the Family File, you can enter the information about the specialist to whom you referred a patient.

To enter a referral to a doctor/specialist

1. In the Family File, with a patient selected, double-click the

Referred To block.

The Patient Referrals dialog box appears.

2. Next to the Referred To list
box, click Add Referral.

The Select Referred To
dialog box appears.

3. [Inidially, all doctors/
specialists are listed. To
narrow the search, type the
first few characters of the
doctor/specialist’s name in
the Enter Name field, and
then click the search button

**| to view the doctors/
specialists that begin with
those letters.

Tip: If the doctor/specialist is
not listed, click New to add
the doctor/specialist. In the

Referred To Information dialog box, type the
referral information, and then click OK.

4. Select the doctor/specialist, and then click

OK.

5. If necessary, in the Patient Referred-To Date

ce ||feferred By aalle /1993
] Croshy. Brent L

Relerred To 1
Position | Gender hda;

Maried | Female Yes 1111963 | A

Married tale Yes 1141141962 =

Child ale Inactive 1 11/11/1994

Patient Referrals - Abbott, James 5(Jim) [ABB101] 23]
Referred By
M ame Date
Add Referral
Referred To -
M ame Date e
Charles M. Clark, .01, Analysiz

Add Referal

Clear Referral

i

Select Referred To IEI
Enter Mame:
Send Email Print Laky Cloze

Mame Specialty

Charles M. Clark.

Mark Tyler, D.D.5

Mew | Edit | Cancel
Abbott, James Referred To @

field, edit the date the patient was referred.

6. To insert a line about this referral in the current patient’s clinical

notes, click Insert Referral.

7. Do one of the following:

*  Click OK to return to the Patient Referrals dialog box.

Ignore the steps that follow.

¢ (lick Edit to edit the referral information. Proceed to the

next step.

Name: Charles M. Clark, M.D.

Addrezs: 1750 N Medical Way
Mesa, & 85210

Phane: [212)374-5511
Total Referrals: 11

Patient Refered-To Date: 03-"'2?-"’2013‘ 5 ’

[pical Mote
6 Inzert Referal | Wigw/Edit |
Cancel
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8.

10.

In the Referral To Information dialog box, edit any of the following referral information as needed:

*  Name — The doctor/specialist’s name, title (if
applicable), specialty, and salutation (for letters you
send to the doctor/specialist).

¢ Address — The address, email address, and contact
numbers for the doctor/specialist.

* Notes — Any notes or useful information regarding
the doctor/specialist.

Click OK to save the changes and return to the Referred
To dialog box.

Click OK to return to the Patient Referrals dialog box.

Referred To Information
e (8)
Last / Referral Mame U First bl
[ M
Title Specialty
| I[None] j
S alutation
I [~ NorPerson
1D Nurnber Type 1D Murnber
I[None] - I
— Addre
Street Fhaone
| |
Ext
| |
City 5T Zip Fax
| [ |
E-rrail Other
|
Motes g

0 Cancel |

Sending Correspondence to Referrals

You can quickly send correspondence to a referral.

To send correspondence to a referral

1.

Dentrix Enterprise 7.0 User’s Guide

In the Family File, with a patient selected, double-click the
Referred By or Referred To block.

The Patient Referrals dialog box appears.

ce Referred By 993
il Crosby, Brent L 1

Referred To

1111963
1111962

|

Select the referral you want
to correspond with.

Patient Referrals - Abbott, James S(Jim) [ABB101]

— Referred By

Click any of the following
buttons: i

i
Croshy, Brent [Pl
¢ Send Email — To

compose and send an
email message to the

Marme

Edit

01

3 Analysis
0340241993

Add Referal

Clear Referral

referral.
—Refered To

Marme

*  Print Label — To print

Date E dit

. Charles . ClaréM 0.
a single address label for T

the referral.

*  Quick Letters — To
quickly print a letter for

03/27/2M3 Analysiz

Add Referral

Clear Referral

the referral. In the Quick

Letters dialog box, select

Send Email Print Label QuickLettersl ‘ 3 ’

fLREE R g

Cloze

the appropriate letter,

and then click Print.
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Assigning Medical Alerts

You can add alerts for medical conditions, medications, and allergies to a patient’s account. You can customize
the list of available medical conditions, medications, and allergies in Practice Definitions. For information
about setting up medical alerts, see the “Customizing Medical Alerts” topic in the Dentrix Enterprise Help.

To add a medical alert to a patient

1.
block, or click the button in that block.

The Medical Alerts dialog box appears. Any existing medical alerts,

medications, and/or allergies are listed.

Note: You can also view a patient’s medical alerts from the Patient Chart, the
Treatment Planner, and Appointment Book.

In the Family File, with a patient selected, double-click the Medical Alerts

File Edit Help

Name: Abbatt, James 5 [Jim] l
Address: 1234 Oak St
American Forlk, UT 8400

Phone: H 555-1111

Status: Achi aried, Ins
1 er
2. Click the New Medical Alert button %7, Nt
Insurance: |D fimary
The New Patient = ESA] (AMICCLURE] [ABSLO) =
Medical Alert didog (2 g i % 9 o' 00 60 %0
box appears. "~ Medical Alerts Additionsl Information: ——————————
[ wedical Aot Desorption | status | severty Discovered Date Changed Codes
3. Select whether you Active Unknown 05/01/2012 05/0172012 SNOMED:
ICD-3:
ICD-10:
Medispan:
dd a Medical Megictions / Prescrip] S E E
want to add a Medic Cap
Alert, Medication, or & Medical Alert " Medication © Allergy
Allergy to the patient, N
. Discovery Date: Im 3
and then click the
Select Alet:
Select Alert search [odeine Aleay —
33 .
button ! to select a P— sererty: N
medical alert, |
medication, or allergy.
4. Click OK. ==
SNOMED: I Medispan: I
ICD-3: | First Databank |
ICD-10: |
—Motes:
y
e oK Cancel

For comprehensive information about all the available options, see the “Assigning medical alerts” topic in the

Dentrix Enterprise Help.
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Archiving Patients

If an individual is deceased or there is no possibility that he or she will be seen in your office again, you can
archive that patient in Dentrix Enterprise. You cannot post new procedures or treatment plans, set treatment-
planned procedures complete, create new prescriptions, create a new payment plan, or schedule appointments
for archived patients.

Archiving patients simplifies your patient database and makes patient selection faster and easier. Before
archiving patients, keep in mind the following:

*  Patients with future due payment plans or outstanding insurance claims cannot be archived.
*  Guarantors cannot be archived until all other family members have been archived.

*  Guarantors cannot be archived if they have a payment agreement or a balance.

Important: Although you can reactivate an archived patient, archiving a patient should be considered a
permanent action, as this will significantly change that patient’s data in the database, and some data will not
be able to be easily restored later.

To archive a patient

You can archive a patient from the Family File by changing that patient’s status to “Archived.” For information
on changing a patient’s status, see “Viewing Patient Records” in this chapter.

Tip: An archived patient appears in the Family Member List of the Family File with an “<A>” preceding
the name, on the View menu of the Ledger with “(Archived)” proceeding the name, on the Appointment
Information dialog box title bar with an “<A>” preceding the name, and on the Ledger, Office Journal, and
Document Center title bars with an “<A>” preceding the name.

Editing Family Relations

In the Family File, you can change the head-of-house, delete a patient, delete a family, and combine or
separate families. For detailed information on completing these tasks, refer to the Dentrix Enterprise Help.

Merging Patients

You can merge two patient records (family members or not) into one patient record, using specified criteria,
such as last name, birth date, and gender. This functionality is helpful for removing duplicate patients in
Dentrix Enterprise as a result of a data conversion from another dental practice management software to
Dentrix Enterprise. Duplication of patients can also occur when a patient is entered manually without
verifying that the patient already exists in Dentrix Enterprise or if you have an HL7 interface (used for
communication between Dentrix Enterprise and your medical software) and a patient record is entered
manually into Dentrix Enterprise and your medical software.

Important:

* Do not have either of the patients you are going to merge selected in any Dentrix Enterprise module on
any computer on the network except in the Family File on the computer from which will perform the
merge.

*  Both patients you merge must have an active or non-patient status, or you can merge a patient with a
non-patient status into an active patient record; however, you cannot merge a patient with an active status
into a non-patient record.
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To merge patients

1. In the Family File, with a patient selected, from the Edit menu, click @_
Merge Patients. T

Name: abbott. James S [Jim]

The Merge Patients dialog box appears.

Merge Patients - (Abbott, Patricia) [CENTRAL] (=3
2. If necessary, click the Primary Patient Info search
b33

Merge Criteria:

to select the primary patient_ This is the If the patients have the same Last Name, First Name, Gender, Date of Birth,
and Zip code, they will be merged. If you would like to modify the merge

patient record you want to keep and into which eritria, cick the “Advanced” button.
you want the secondary patient’s information to be |  seictpatints to Merge: < : >_1’“d""'”°5d

button

transferred Primary Patient Info {to keep)
[ Abbott, Patricia 2 >
3. Click the Secondary Patient Info search button cender:  Femdle TP b
*| to select the secondary patient. This is the Chart:  ABB102 PatExtID: _
. City:  American Fork = uT Zip: 84003
patient record you do not want to keep. Homes: 5551111 Works:
E-Mail:

If the secondary patient is a guarantor, that

o o . Secondary Patient Info (to be celted
patient’s information will be merged into the Scondery Pasentinto (tobe deet=d)

. . . =
primary patient’s account, and all family members 3
. . . Gender: DOE: SSN:

of the secondary patient will be moved to family Chart; PatExtD:

. . . . City: 1= Zip:
of the primary patient. If the secondary patient is o ok
not a guarantor, that patient information will be E-Mail:
merged into thC primary patient’s account. WARNING: To see the items that will be merged from the Secondary Patient to

the Primary Patient, dick the "Merge Info” button. Otherwise Click the Merge”
button to merge patients.

4. To set up the merge criteria, click Advanced. In
the Advanced Merge Patients Criteria dialog box, et |
select the patient information that must match < 5 )Merge | oo |
for both the primary and secondary patient for
Dentrix Enterprise to perform the merge: Last

Name, First Name, Gender, Date of Birth, Zip, Social Security #, City, State, E-Mail, Home Phone
#, and/or Work Phone #. Then, click OK.

5. Click Merge. On the confirmation message that appears, click Yes.
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Chapter 3: Appointment Book

The Dentrix Enterprise Appointment Book was created to facilitate “productivity scheduling.” Convenient
toolbars and exclusive flip tabs help you navigate through the schedule, search for open times, organize
appointments and notes, and handle all the common tasks you need to perform throughout the day. You can

schedule appointments, record broken appointments, and print route slips.

This chapter covers the following topics:

Using the Appointment Book Window
Changing a Clinic’s Schedule

Changing a Provider’s Schedule
Changing an Operatory’s Schedule
Switching Between Views

Finding Open Appointment Times
Scheduling Appointments

Scheduling “New Patient” Appointments
Scheduling Events

Managing Appointment Book Lists
Managing Appointments

Managing Events

Generating Appointment Book Reports
Working with Notes in the Appointment Book
Using Perfect Day Scheduling
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Using the Appointment Book Window

The Appointment Book is divided into the menu bar, calendar, time bar, provider color bar, date bar,
operatory ID, toolbar, navigation buttons, pin board, day view, week view, month view, and flip tabs.

(}alendar

Time Bar

Provider/Cﬂor Bar

Date Bar

Qperatory ID

wAppUin ent Book e Dental Group> < >
File Vi Status/Setup  ApptLj Help
<l

e

4 8:00am .
: 0
: 20
30 30
40 :
:50 :
9:00am :
0 :
20 :
30 ;
40 :

:50 :
10:00am 10:00am
0 0
20 20
30 30
40 40
:50 :50
11:00am 11:00am
0 0
20 20
30 30

40 40 2

B
K

e =]=]

paid W & | PArd AN |

Navigation
Buttons
L

/Pin Board

rDay View
~Week View

—~Month View

ﬁip Tabs

This section covers the following topics to help you understand how to use the Family File window:

*  Using the Appointment Book Toolbar
e Using the Month Calendar

e Understanding the Time Bar

*  Understanding Provider Colors

*  Understanding Operatory IDs

e Understanding Appointments

*  Using the Navigation Buttons
e Using the Pin Board

*  Using the Day View

e Using the Week View

*  Using the Month View

*  Using the Flip
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Using the Appointment Book Toolbar

The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

HEE% 2

The function of the buttons specific to the Appointment Book are explained in the following table.

FaMX

Click the Schedule Appointment button to choose the patient for whom you want to schedule an
appointment, and then enter the appointment information.

Click the Find New Appointment Time button to find an available appointment time by entering
search criteria.

Click the Locate Appointment button to choose a patient so that you can locate any existing
appointments for that patient.

With an appointment selected, click the Break Appointment button to remove the appointment
from the schedule and place it on the Unscheduled List.

Click the Set Complete button to post the scheduled treatment for the selected appointment as
complete to the Ledger and Patient Chart.

Click the Print Route slip button to print a route slip for the selected appointment.

Click the Delete Appointment button to delete the selected appointment.

Click the Perfect Day Scheduling button to turn Perfect Day Scheduling on and off. If the button
has red and blue rectangles, this feature is turned on. If the button does not have red and blue
rectangles, this feature is turned off. Perfect Day Scheduling must be turned on to see the Perfect Day
Scheduling time blocks.

OE &2 K E 2 A Z

For a comprehensive explanation of all the buttons on the toolbar, see the “Using the Appointment Book
toolbar” topic in the Dentrix Enterprise Help.

Using the Month Calendar

Click the Calendar button to open a monthly calendar. From the calendar you can view
production goals, scheduled production, and actual production, making it easy to quickly evaluate
your progress in meeting production objectives.

The following options are available:

Calendar for
. . Scheduled Production
*  Click the double left and right arrow
b . he desired h << | March 2013 =X
uttons to naVIgate to the desired month. Sun | Mon | T | Wed | Thur | s | Sat
*  Click Scheduled Production on the menu il =
bar to view scheduled production for each S s s e 3 s
day.
Totals for Scheduled, Production, and New I
Patients are displayed at the bottom of the T T B T e e AT
calendar.
* Click a date square to go to that date in the o | NI =
Appointment Book. 5 —
Cancel
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Understanding the Time Bar

800 The time bar on the left and right sides of the Appointment Book splits up hour intervals into

2 your selected time block size. The red bar indicates the current time of day. For information about
= changing the time block size, see “Setting Up a Clinic” in Chapter 1: Introduction and Initial

10 Setup.

Understanding Provider Colors

|[|  You can assign a unique color to each treatment provider in your office. These colors will be used to
 flag each appointment so that you can tell which provider the patient is seeing by the color of the
appointment.

On the left side of the Appointment Book, Dentrix Enterprise displays a color column for each
selected provider. A colored block in that column indicates that the provider is scheduled to be
working on a patient during the blocked time.

For example, in the blue column you see a blue block from 9:00 a.m. to 9:50 a.m., indicating that the “blue”
provider will be involved with a patient during that time. If a provider has been double-booked, the color
block will display white with stripes in the color assigned to the provider. If the provider column is gray, this
indicates that the provider is not available at the selected time.

For information about changing provider colors, see “Setting Up a Provider” in Chapter 1: Introduction and
Initial Setup.

Understanding Operatory IDs

The Appointment Book displays a column for each operatory added to Dentrix Enterprise.
MESAZ

Operatories are displayed in alphabetical order using operatory IDs. There is a limit of 10 operatories per
Appointment Book view. For information about views, see “Setting Up Views” in Chapter 1: Introduction
and Initial Setup.

Understanding Appointments

Each time an appointment is scheduled, it appears in the appropriate operatory column, using the appropriate
color for the assigned provider, for the amount of time scheduled. Depending on the length of the
appointment, Dentrix Enterprise will display up to nine lines of S—
customizable information, including Name, Appointment Reason, Home Imﬁtg‘]?gsn?asm J
Phone, Work Phone, Provider, Production Amount, Appointment Type, MIEH

Staff, Chart Number, and Preferred Name.

In addition, a red cross on the appointment indicates that the patient has
a Medical Alert. Similarly, a blue musical note indicates that the patient
has a note attached to the appointment. And, a green “V” indicates that
the patient’s insurance eligibility date is within 30 days.
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Using the Navigation Buttons

. | a| N The navigation buttons are used to move from day to day in the Appointment Book. Click the
- left arrow button to move back one day. Click the right arrow to move forward one day. Click
the circle button to quickly return the current system date.

The navigation buttons function differently for views other than the day view: if you are displaying the week
view, the navigation buttons will move you forward or backward a week at a time; if you are displaying the
month view, the navigation buttons will move you forward or backward a month at a time.

Using the Pin Board

Similar to a real pin board, you can use the Appointment Book to temporarily store appointment or event
information until you can find a new appointment or event time.

HYGIEME_3 | ™71 HYGIEME_3 b o b

-| Abbatt, Patricia TABbot. P t. ;
AmalgiPertt] 3 A
-| H:555-1586 - H:555-
] it
Dragging an appointment to the pin board Dragging an event to the pin board

Using the Day View

iLd| Opening the Appointment Book in the day view allows you to see detailed information pertaining

- to an individual day and its scheduled appointments. You can schedule appointments by double-
clicking at an available time. If you are on the week or month view, click the Day View button to
switch to the day view.

Using the Week View

| A time-saver when looking for an available appointment time, the week view allows you to see a
week’s worth of appointments at one time. Click the Week View button to switch to the week view.
The week view displays large columns for each day of your work week. Each day column is further
divided into operatory columns that show provider color blocks, which indicate appointments that
have already been scheduled, making it easy to see free scheduling opportunities. To schedule an
appointment, double-click at an available time.

Tip: To see details about an appointment, while pressing the Shift key on your keyboard, right-click the
appointment. A pop-up box appears and displays the patient name, appointment reason, phone number,
provider, appointment date and time, and status.

Chapter 3: Appointment Book
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Using the Month View

If your schedule is packed weeks in advance, then the month view will make finding a free
appointment time much easier. Click the Month View button to display an entire month’s worth
of appointment times for each provider. On the left side of the Appointment Book, each provider
is listed by ID and in color for each work day in the month. On the top of the Appointment Book,

the time of day is shown. To view the appointments on a particular day, click in that date’s row to
move to that date in the day view.

Note: Only appointments that have been scheduled using provider time (“X”s will appear on the left side of
each appointment) appear in the month view. See “Scheduling Appointments” in this chapter.

Using the Flip Tabs

Acting as a bookmark, a flip tab allows you to jump forward (or backward) several days, weeks, or

months in the Appointment Book, according to a user-defined length of time, such as seven days,

two weeks, or six months. No flip tabs are set up with the initial installation of Dentrix Enterprise.
For information about defining flip tabs, see “Setting Up Flip Tabs” in this chapter.

P A, ]

Changing a Clinic’s Schedule

From time to time, you will need to change the hours your office is open for a particular date (for example,
for vacations and holidays). Dentrix Enterprise allows you to change your working hours for a single day or to
close the office completely on a single day. Changing the hours of operation for a day or closing the office on
a day does not make changes to any previously scheduled appointments. For example, if you have scheduled
patients for March 5th, and then you close March 5th, those patients remain scheduled on March 5th.

o o 9y i
TO Change a CllnlC S schedule @ &) Appointment Book <The Dental Gro

1. In the Appointment Book, from the Setup menu, click Clinic ———— Appt Lis
Schedule. Schedule Calend, linic <MESA>
Office Clos&m
The Schedule Calendar for Clinic dialog box appears. == N\ warch 2013 =
. . . Su Mo T Wed Th Fri Sat
2. Click the double left or right arrows to navigate to the correct e — "1 | >
month, and then select the day you want to close or open the office. A
: . . . 5 6 I 8 9
3. From the Office Closed menu, click one of the following options: @ e o’ e o
1-5 1-5 1-5 1-5
*  Close Office on selected date — Closes the office on the n| 12] 13| 14 15 16
. . 812 812 812 812 812
selected day. The cell for that day will become light-gray. 5 |15 |15 |15 |15
You can close the office for yearly holidays that do not occur CL P e | e
1-5 1-5 1-5 1-5 1-5
on the same day of the month every year (for example, T e
Thanksglvmg). 812 (812 (812 (812 812
1-5 1-5 1-5 1-5 1-5

previously closed.

*  Open Office — Opens the office on the selected day that was - Praciice Clocett Close
Z 4 ;_

* Set Yearly Holiday on selected day — Closes the office
on the selected day. The cell for that day will become a pink color. When closing the office for a
holiday, be sure to do so for holidays that fall on the same day of the month every year (for example,
Christmas is always on December 25).
* Delete Holiday — Open the office on the selected day that was previously closed for a yearly holiday.
4. Click Close.
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Changing a Provider’s Schedule

Occasionally, you may need to change the hours a particular provider is available. In Dentrix Enterprise,
you can change a single provider’s hours for one day or to schedule the provider out of the office for one day.
Changing a provider’s hours for a day or scheduling a provider out of the office on a certain day does not
make changes to any previously scheduled appointments. For example, if you have scheduled patients for
March 5th and then set a vacation day for a provider who has patients on March 5th, those patients remain

scheduled on March 5th.

To change a provider’s schedule

1. In the Appointment Book, from the Setup menu, click Provider
Setup.

u Appointment Book <The Dental Gro

The Provider Setup dialog box appears.

File ™ View m\:ww Appt Lis

o . Provider Set
Select a Clinic. e N
Clinic: | ME S v,
Select the provider for which you want to set a schedule. -
. Seb
4. Click Schedule.
Schedule
The Schedule Calendar for dialog box appears. @—1
Add Provider
5. Click the double left or right arrows to sma:ﬁ:ﬁm DSMITH at CENTRAL
navigate to the correct month, and then select | Oetiens{ 4
. \—/ ril 2013
the day you want to set as a vacation day. << | ap _> |
Sun | Mon | Tues | Wed | Thur | Fri | Sat
6. From the Option menu, click one of the 1t 2] 3[ 4l 5[ 6
. . 812 812 812 812 812
following options: 15 |15 |15 |15 |15
T 8 9 10 1" 12 13
e Set Vacation on selected date — Indicates e Bl e
that the provider will be out of the office 14 7 18 19 20
B 812 812 812
on vacation on the selected day. The cell s s s
. 21 23 24 25 26 27
for that day will become a purple color. ez ez B12 etz a2
1-5 1-5 1-5 1-5 1-5
* Delete Vacation day — Removes B (S
s . 812 812
the provider’s vacation day that was -5 |15
revi l ¢ Practice Closed: Close
previously sct. Practice Holidays:
Provider Vacation:
* Reset Hours to default on selected

date — Returns the selected day to the
provider’s default work day for that day of the week

Click Close to return to the Provider Setup dialog box.
8. Click Close.
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Changing an Operatory’s Schedule

Occasionally, you may need to change the hours a particular operatory is available. In Dentrix Enterprise, you
can change a single operatory’s hours for one day. This does not make changes to any previously scheduled
appointments or events. For example, if you have scheduled patients for March 5th and then change

an operatory’s hours, and that operatory has patients scheduled on March 5th outside of the operatory’s
availability, those patients remain scheduled on March 5th.

To change an operatory’s schedule

1. While viewing the operatories for a clinic in the Appointment
Book (the view does not have to include all operatories), from the
Setup menu, click Operatory Setup.

The Operatory Setup dialog box appears.

2. Select the operatory for which you want to set the available time
and days.

3. Click Schedule.
The Schedule Calendar for dialog box appears for the selected operatory.

Close

‘ : ’Schedule |

4. Click the double left or right arrows to

i Schedule Calendar for MESAL
navigate to the correct month, and then Reset Hours for Selected Date m
double-click the day to change the hours «< | March 20— = |
for the selected operatory on that date. Sun | Mon |Tues | Wed | Thur | Fri | Sat
1 B
5. If you want to return the selected day to the ge
operatory’s default availability, click Reset 35 4 5[ e[ 7 & (9
812 812 812 812 812
Hours for Selected Date on the menu bar. 15 |15 |15 |15 |15
W[ M| 12[ 13 14| 15| 16
H 812 &12 812 &12 812
6. Click Close to return to the Operatory 32| (RN e oA |28
Setup dialog box. w[ 18 1 20| x| 2| »n
812 &12 812 &12 812
7. Click Close.
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Switching Between Views

You can quickly switch between views by pressing the function keys on your keyboard (F1, F2, F3, and so
forth) that correspond to the shortcut keys assigned to the views that have been set up.

For information about adding and editing views, see “Setting Up Views” in Chapter 1: Introduction and
Initial Setup.

Alternately, to switch to another view .
w Appointment Book <The Dental Gro.

Status Setup Appt List

The Select View dialog box appears. e View ﬂrﬁ@nmﬂﬁ

e Clinic:

1. In the Appointment Book, click View on the menu bar.

Select the view you want to use. Shortcut:  View Name:

Click Select.

Copy view
tew |

Cancel |

Finding Open Appointment Times

Dentrix Enterprise provides you with multiple ways to search for an available appointment time as explained
in the following topics:

*  Manually Finding an Appointment Time

*  Using the Find Appointment Tool

Manually Finding an Appointment Time

Dentrix Enterprise provides the following features to help you search for an available appointment slot manually:
e Day view — For information about this feature, see “Using the Day View” in this chapter.

*  Week view — For information about this feature, see “Using the Week View” in this chapter.

*  Month view — For information about this feature, see “Using the Month View” in this chapter.

*  Month calendar — For information about this feature, see “Using the Month Calendar” in this chapter.

*  Flip tabs — For information about this feature, see “Using the Flip Tabs” in this chapter.
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Using the Find Appointment Tool

When patients with very specific scheduling requirements call to make an appointment, it can be a very
complicated process to find a free time that meets both the office’s and patient’s needs manually. By using the
find appointment tool, you can enter a number of criteria and then have Dentrix Enterprise find the first free

time that meets those requirements.

To search for an available appointment time

1. In the Appointment Book, from the File menu, click Find New

Appointment Time.

The Find New Appointment
Time dialog box appears.

2. You can search by over seven
different criteria but are only

required to specify the following:

e Select Provider(s) — Select
the provider(s) for whom
you want to search.

e Start Date — Type the date
from which you want to
start searching in the field,
or click the search button

** | to select the date.

\A Appointment Book <The Dental Gro

View Status Setup ApptLis

Find MNew Appeintment Time

S elect Providers) Select Days Start Date
FHCECURE I Sunday wWziama x|
v Monday @ Dayls)
1] 2| 3
T week(s) jii
o 4|1 5[ B
v Wednesday e
v Thursday Time Range
Select Op.[s] [ Saturday [ Time Pattern Search
Clear Al Start l:lﬂ
e [ 2]
Providers/operatonies in
& View [Man ¥

" Clinic [ME52

] (0= RV Fee: 00
=5

Select Time Block

[~ Search By Appt Type

Appt Type: |High Production

v Select &l Ops

™ Mo Duplicate Operatory Times 3 SearchMiew |

Search | Cancel

To advance the start date
by a certain time interval,
click a time option (Dayf(s),
Week(s), or Month(s)), and then click the number of that interval to advance. For example, if you
want to look for an appointment starting in six months, click Month(s) and then 6 to advance the
starting date forward six months.

Tip: As needed, you can further refine your search by operatory, days of the week, providers/operatories
in a specific view or for the current clinic, and a time range. Also, to have only the first available operatory
for the search times found be listed, select No Duplicate Operatory Times.

3. Click Search/View.
The Available Appointment Times dialog box appears and

lists the first 10 available times that match your search criteria.

Awvailable Appointment Times
4. Select the time you want to see, and then click View. The
) } i Thu 03/28/2013 100pm- 500pm  AMCCLURE - RRGAT
Appointment Book displays the selected date in the schedule Fii  03/29/2013 8:00am- 12:00pm AMCCLURE - M
Toutl he selected T L L | Fi  03/23/2013 1.00pm- 500pm  AMCCLURE - ME
; ; Man 04/01/2013 E:00am - 12:00pm  AMCCLURE - M
and outlines the selected time. To see the next search result on el e e T il
; ; ; ; . Tue D4/02/2013 E:00am - 12:00pm  AMCCLURE - M
the schedule with the selected time outlined, click View Next. vy L A S
Wed 04/03/2013 500am-12.00pm  AMECLU
Wed 04/03/2013 1-00pm - 5:00pm  AMCCL

- MESAT
E:MESAL

Tip: If none of the 10 displayed times will work, click More
to list the next 10 available times. Then, repeat step 4 to keep
looking for an open appointment time that will work.

I tare | igw | igw Mext |

)

For comprehensive details about all the search options available, see the “Using the Find Appointment Tool”
topic in the Dentrix Enterprise Help.

5. Ifyou find a time you want to use, click Select; otherwise,
click Cancel to change your search criteria.
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Scheduling Appointments

Dentrix Enterprise provides the flexibility to schedule appointments using a variety of methods. Scheduling an
appointment can be as simple or detailed as you want it to be, but do not confuse flexibility with complexity.

To schedule an appointment

Initial — If the patient is being
seen for work that would be
done on an initial visit, such
as an exam or cleaning, click
Initial. In the Select Initial
Reasons dialog box, select the
reasons for the appointment,
and then click OK.

Select Initial Reasons

dE . Pro
NP Exam
Comp. Eval
Ext. Eval
Periodic
PA 1st
2 Bwis
4 B

Emerg Ex
Consult

an
Prophy-&dult
Frophyp-Child
Frophy/FI-Ch

Cancel

Mate:

1. In the Appointment Book, locate an available time on the schedule as T
explained in “Finding Open Appointment Times” in this chapter, and then 2 @
. . . :30
double-click in the desired a0
operatory at the appropriate date | SeetPatient
and time. Enter NamelLast, Fist MIE Alec]ofe] Fle[H[T] s K] ] & Name € Other D
Id:'b NCIENQ RIS BT UVWXﬂE " Chat 8¢ Hm Phone #
1 1 o|1(2|3 4[5|6 7/8|9[.| Cle ’
The Select Patient dialog box b A e 2| e s5n © Bithdey
appears.
[Name Bithday  Provider Clinic: [Status [Chart # S5t
2. Search for and select a patient. Aobr, Parica L E— a88102
‘The New Appointment e
Information dialog box appears.
3. 'The Provider field defaults to o
Recent Patient Selections:
the patient’s primary prOVidCr. If Abbott, James S5 111141962 AMCCLURE MESA ABB101 M1
necessary, click the search button
ﬂ . New Pat More Patient |nformation. . oK
to select another provider for
the appointment.
4. If the patient is being seen for a b e L ) ==
. . Continuing —

Prov:  [BMCC >3| C >y Ch Pat
continuing care reason, to aFtach Coe B enge P |
Contlnulng care to the app()lntment, N ¥ Uze Fieason ToAuta Up Patuentlnfol |i

. . . Other Appt(s)
click the Continuing Care it | pelec| &l
Attached search button **|. In the ™ | SN [ bl |
Patient Pending Continuing Care vis | Schd N |
dialog box, select the appropriate { 6 \ wiaitwil Call |

. . . Desc:
continuing care types, and then click esci |
OK Length: [0 min >3] Staws:  [aPTSET <] fop[MESE2 ] Find |
) Amount Schedule: |FIXED =] Joate: 02272013 55 FinBoad |
5. Select a reason for the appointment, v Tope [High Productio v | fTime: [800am 5| History
using any of the following methods: stat. | »]
Qrig. Sched. Operator: IENTEHPHISE D ate Sched.: IDB.-"2?.-"2D‘I 3

Inzert Dateline |

®

-

[~ Chart Pulled

I Insurance Coverage

™ Appointment Yerified | Refered By
I Personal Information [~ Consent Form Signed [~ Other Family Appts

I~ Fallow Up?

[ Cort. Care Set

I Mest Appointment
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e Tx - If the patient is being seen for work that was previously treatment-planned, click Tx. In the
Treatment Plan dialog box, select the reasons for the appointment, and then click Close.

Treatment Plan ===
Odr Date Code Drescription Tooth  Surf

? 04/12/2002 D710 Extraction-single tooth Ell 30
? 01/15/2009 D5214 Mand partial-metal base w/sdls 259726

? 01/15/2009  DE970 Post/core + brdg retainer, fabr & 10
? 01/15/2009 D6S70 Post/core + brdg retainer, fabr 7 10
? 01/15/2009 D697 Cast post/part of brdg retainer 23 10
? 01/15/2009  DE971 Cast post/part of brdg retainer 24 10
? 01/15/2009  D6S71 Cast post/part of brdg retainer 25 10
1 01/09/2009 D5213 Maxil partial-metal Base W/sdls 12514

1 12/15/2008 D7140 Extract.erupted th/exposed rt 1 10
2 01/09/2009 D6210 Pontic-cast high noble metal 19 10
2 01/09/2009 D6210 Pontic-cast high noble metal 20 10
2 01/09/2009 DE210 Pontic-cast high noble metal 21 10

Tip: To add to the treatment plans listed in the Treatment Plan dialog box, click New TX.

*  Misc — If the patient is being seen for treatment that has not been treatment-planned, click Misc. In
the Procedure Codes dialog box, select a procedure code, and then click OK.

Procedure Codes @

Category Procedure Code List

03421 Apicosct/Perrad-bicus/1stroat &
03425  Apicoect/Perirad-malar/1st roat
D3426  Apicoect/Perirad (each + root]
03430 Retrogiade fling-per ract
03450  Root amputation-per root
D3460  Endodontic endosseous implant
D3470  Intentional replant, inc spint
03910 Swrg isolation of th w/ub dam
D3320  Hemisection, no root can ther
D3350 Canal prep/fit of dowel/post

[Mane] -
Diagnostic
Preventive
Restorative

Periodontics
Prasth, remov
Mailla Prosth
Implant Sery

D3960  Bleaching of discolored tooth —‘

Orthodontics = Unspecified endo procedure, B /Rl

Cancel

6. Set up the following options:

*  Desc — Dentrix Enterprise adds a description according to the selected appointment reasons, but you
can edit it.

* Length — Dentrix Enterprise assigns a length of time to the appointment according to the selected
appointment reasons. Verify that the appointment length is correct. To change the length of time
needed to complete the procedures, click the search button **/. In the Appointment Time Pattern
dialog box, drag the slider to set the number of units, and then set up the time pattern for each unit
(chair time |_, assistant’s time I, or provider’s time E)

*  Amount — Dentrix Enterprise calculates the amount based on what procedures will be performed
during the appointment, but you can change it.

e Status — To indicate what the last contact with the patient was, select a status. For information on
setting up statuses, see “Customizing Practice Definitions” in Chapter 1: Introduction and Initial

Setup.

*  Schedule — Select one of the following options to categorize the appointment:
e FIXED - The patient has an inflexible schedule and can only be seen at the scheduled time.
*  OPEN - The patient is willing to change the date and time of the appointment if necessary.
*  ASAP - The patient wants to be seen earlier if an appointment time becomes available.

* Type - If you are using Perfect Day Scheduling, select an appointment type. For an explanation of
Perfect Day Scheduling and appointment types, see “Using Perfect Day Scheduling” in this chapter.

7. If necessary, type a Note for clarification or to record other details about the appointment.
8. Click OK.

For a comprehensive description of all the options available for scheduling appointments, see the “Scheduling
- comprehensive” topic in the Dentrix Enterprise Help.
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Scheduling “New Patient”
Appointments

You can schedule an appointment for a patient who has not been previously seen at the office. A patient is
considered to be new if the person does not have a Family File record.

To schedule a new patient appointment

1. In the Appointment Book, locate an available time on the schedule as i
. . . . . . . . 1:00,
explained in “Finding Open Appointment Times” in this chapter, and then | g'
. . . 20
double-click in the desired operatory at the 30
. . 40
appropriate date and time. T =
1 1 A|lB|C|ID E|FIGH|I|[J|K|L|M
The Select Patient dialog box appears. e Nl P G |
NDPQHSTUVWXﬂZ
2. Click New Pat. I of1]2]3 4[s[s 7|e|s] .| ceal
[ Include Archived Patients
T}le Enter NCW Patient Information dlalog Mame Birthday Provider Clinic: Status Chart #
box appears.
3. Enter the following information:
* Name — Type the patient’s last name, first Enter New Patient Information =
name, al’ld mlddle initial. Fecent Patient Selections: Last First il
Abbott. James § Mame: || | |—
. 5 Edwards, Anna .
*  Phone - Type the patient’s home phone Dayis Hamon o I
number. New Pat Street
Address:l <3>

*  Address — If desired, type the patient’s |

address. City 5T Zip

| [
Refermed By: I— ﬂ
4 Cancel

e’

* Referred By — If the patient was referred to your office,
click the search button **|to select the referral source.

4. Click OK.

The New Appointment Information dialog box appears.

5- Set up the appointment Mew Appointment Information - (Abbott, James 5) @
. . . ——
SPUOHS as explamed n ., Frov: [BMCCLURE  »o|Core | »|
H H Attached:
Scheduhng Appomtments e v Use Reason ToAuko Update CC Fatiert Infa I

Reason

Iritial Delete

. Ing Claim Info
6. Click OK. = @ b

M Schd, Next

Desc: |
Length: [0 min > Stas:  [aPTSET | op[MESE2 2 Find
gmount: [ Sohedule: [FIXED | Date: [mr27201Z 0 s Fin Board

o[ Type:[High Productio | Time: [ &00am ) Histary

sar | >3

Orig. Sched. Operator.  |ENTERPRISE Date Sched.: 03/27/2013

in thiS chapter. Other Appt(s]

B i

it Al Call

Cancel

i

Motes
Inzert D ateline
[™ Chart Pulled
[ Appaintment Yerfied | Refered By [ Cont. Care Set
[ Personal Information | Conzent Form Signed [ Other Family Appts
™ Insurance Coverage | Follow Up? [ Mext Appointrment
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Scheduling Events

You can schedule an event (a non-patient “appointment”) to block out time or close an operatory in the
Appointment Book for a day or up to one year. Events can include such items as staff meetings, vacation
schedules, or holidays. You can set up an event to repeat at regular intervals (a series). Also, you can easily
move an event to the pin board to reschedule it.

To schedule an event or a series of events

k\ Appointment Book <The Dental Grou
llﬂﬂ View Status Setup Appt List

1. In Appointment Book, from the File menu, click Schedule Event.
The Schedule Event dialog box appears.

2. Set up the following options: Schedule Event
*  Event Time — Enter a Start and an End time if | [©*"[™ N/ [ Operaterie
the event will only last part of the day, or select o CETI | =TI |
Close Operatory (All Day Event) if the event L o dui o i
will last the entire day. [Eventa oFe
Start [14716/2M3 | End [laniE2013 »| | | |OP7
e  Event Days — Enter a Start and an End date AT rE—— )
(up to a year away) for the event. Then, under M s ¥ Mon ¥ Tuess W Wed
Select Days of the Week, select the day(s) that W Thes [ Fi [ Sa  Cladl |
the event will occur within the specified date Ll
range. DEesmiptiDn: —Ewent Colar
went
*  Operatories — Select the operatory or operatories :— Center Descrition on Schaduled Event 1

for which you want to schedule the event. Nate
You cannot schedule an event that overlaps a
scheduled appointment or another event.

Inzert Dateline |E

o

* Description — Type a description for the event
or series. To have the description centered
: MOTE: If multiple operatories and/or days are specified for the Event, separate Events
horlzontally at the tOp Of the event blOCk’ SCICCt [one per day per operatory] will be created/displayed in the Appointment Book. The

Center Description on Scheduled Event Ewent creation process may take several minutes depending on the criteria specified.
‘ 3 ' oK I Caticel

¢ FEvent Color — Click the button to choose a
color for the event.

Tip: Select a light color to contrast with the black text of the event description and note.
*  Notes — Type any notes that apply to the event.

Important: If you create a repeating event, be aware that if you want to delete the whole series, you must

delete each event in that series one at a time.

3. Click OK. “ Appointment Book <The Dental Group> <MESA>

File View Status Setup ApptLists Help

Tip: If Dentrix Enterprise could not
create events that are part of a series
because those events overlapped with
an existing appointment or event, a log
file appears for your reference. You can
correct the conflicts and then schedule
events to match those in the series you
created previously.

Dentrix Enterprise 7.0 User's Guide



Chapter 3: Appointment Book 87

Managing Appointment Book Lists

Failed or canceled appointments can cost a dental office thousands of dollars a year in lost production time.
Dentrix Enterprise helps you avoid that missed revenue by providing you with several types of appointment
lists that can be used to fill open blocks of time in your schedule. This section covers the following topics

about how to use these lists:

Using the Appointment List

Using the Appointment List
Using the ASAP List
Using the Open List
Using the Unscheduled List

‘The Appointment List displays all appointments scheduled in the Appointment Book for a selected date.
As a useful tool to confirm appointments, the Appointment List displays the time, status, name of patient,
provider, operatory, reason, length, and patient phone number for the appointment.

To use the Appointment List

1.

In the Appointment Book, from the Appt Lists menu, point to
Appt List, and then click Current Clinic to view appointments for

the clinic currently being viewed or All Clinics to view
appointments for all clinics.

‘The Appointment List View dialog box appears.

Make your provider and operatory selections to filter the
appointments in the list, and then click OK.

The Appointment List window appears.

Perform any of the following functions:

\-) Appointment Book <The Dental Gro

File  View

O

e  Double-click — To see more

information regarding an

appointment or to make changes
to an appointment, double-click —
the line of that appointment. The

Appointment Information dialog

Oansw| Crosby, Brent L

Appointrment List View @
By Provider: By Operatory:
AMCCLURE  McClure Angele - JEFF1 -
D051 Smith.Dennis D MESAT
DDS2  BrownMay D Y MESAZ i
[ View Al
2 Cancel |
T
) jct < Clini ES
ﬂ @ ll View Appt Status  Office Journal
72013
Time | Status To¥/0 Clinic Re:

DEF_PROYV/ DEF_OM1 CENTRAL | PrtcPrFH

box appears.

e Calendar — To change days being viewed for the Appointment List, on the menu bar, click Calendar.

*  View — To filter the appointments in the list by provider or operatory, on the menu bar, click View.

*  Appt —To break the selected appointment (move it to the Unscheduled List) or delete it, from the

Appt menu, click the appropriate option.

*  Status — When confirming a selected appointment, from the Status menu, click the appropriate
status type to indicate the last contact with the patient.

e Office Journal — With an appointment selected, on the menu bar, click Office Journal to open the

corresponding patient’s Office Journal.
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Using the ASAP List

Many times patients call wanting an appointment sooner than your next available time. In these situations, it
can be useful to offer to call the patient if an appointment time becomes available. With Dentrix Enterprise,
you can flag scheduled appointments as ASAP (As Soon As Possible).

Once an appointment has been flagged as ASAD, it appears on the ASAP List. This satisfies the patient’s
request for a sooner appointment, while benefiting the office at the same time, by providing a list of patients
who can fill holes in an otherwise full schedule.

In addition to providing you with names of patients who can fill open appointment times, the interactive
nature of the ASAP List makes it simple to contact a patient and then create or move an appointment as

needed.

TO use the ASAP LISt u Appointment Book <The Dental Gro
1. In the Appointment Book, from the Appt Lists menu, point to e TeTT—

ASAP List, and then click Current Clinic to view
appointments for the clinic currently being viewed or All ASAP List View
Clinics to view appointments for all clinics. e By Dperatoy:

AMCCLURE McCluredngela - JEFF1 -
The ASAP List View dialog box appears.

CD51  Smith.Denniz D MESAT
pDs2 Brown Mary D e MESAZ 7

2. Make your provider, operatory, and day span selections to W iew Al
filter the appointments in the list, and then click OK. Span of Search
Days '?_ Type of Search
The ASAP List window appears. : 9 (P ® Dpn
Save zefting
3. DPerform any of the following functions: 2 Cancel
N?

*  Double-click — To see more
information regarding an
appointment or to make changes
to an appointment, double-click
the line of that appointment. The
Appointment Information dialog
box appears.

ASAP List <Clinic: ALL>
EI View Appt Refresh Status Office Journal

Reason
CompE %

pDS1/  DEF OP2 CENTRAL

Abbatt, James 5

* Calendar — To change the start date
of the ASAP List view range, on the menu bar, click Calendar.

e View - To filter the appointments in the list by provider or operatory and/or specify how many days
worth of appointments into the future to display, on the menu bar, click View.

e  Appt —To delete the selected appointment, from the Appt menu, click the appropriate option.

e Status — When confirming a selected appointment, from the Status menu, click the appropriate
status type to indicate the last contact with the patient.

e Office Journal — With an appointment selected, on the menu bar, click Office Journal to open the
corresponding patient’s Office Journal.
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When a patient calls to cancel at the last minute, the office must either scramble to find a patient willing
to come in on short notice or else lose valuable production. The Open List can help you quickly fill those
available slots by providing you with a list of scheduled patients who have more flexible schedules and may be

willing to come in at the last minute.

In addition to providing you with names of patients who can fill open appointment times, the interactive
nature of the Open List makes it simple to contact a patient and then create or move an appointment as

needed.
To use the Open List

1. In the Appointment Book, from the Appt Lists menu, point to
ASAP List, and then click Current Clinic to view appointments for

the clinic currently being viewed or All Clinics to view
appointments for all clinics.

The ASAP List View dialog box appears.

2. Make your provider, operatory, and day span selections to
filter the appointments in the list; under Type of Search,
select Open; and then click OK.

The Open List window appears.

3. DPerform any of the following functions:

ASAP List View

-

1 uAppointment Book <The Dental Gro

File View Stotoe

By Provider By Operatory:
AMCCLURE McClurefngela .« JEFF1 -~
DODS1T  Smith.Dennis D MESAT

pDs2 Brown Mary D ki MESAZ 57

IV iew &l

Span of Search

Days '?_

Save zefting

Tupe of Search
" ASAP & Dpen

e  Double-click — To see more ASAP List <Clinic: ALL>

information regarding an

EI View Appt Refresh Status Office Journal

appointment or to make changes
to an appointment, double-click
the line of that appointment. The
Appointment Information dialog

Statt
(02/02/2009 Abbott, James 5

Prov/Up Reason
D051/  DEF OP2 CENTRAL CompE %

box appears.

* Calendar — To change the start date of the Open List view range, on the menu bar, click Calendar.

e View — To filter the appointments in the list by provider or operatory and/or specify how many days
worth of appointments into the future to display, on the menu bar, click View.

e Appt—To delete the selected appointment, from the Appt menu, click the appropriate option.

e Status — When confirming a selected appointment, from the Status menu, click the appropriate

status type to indicate the last contact with the patient.

*  Office Journal — With an appointment selected, on the menu bar, click Office Journal to open the

corresponding patient’s Office Journal.
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Using the Unscheduled List

The Unscheduled List provides you with an easy way to view broken or wait/will call appointments.

To use the Unscheduled List

1. In the Appointment Book, from the Appt Lists menu, point to
Unscheduled List, and then click Current Clinic to view

appointments for the clinic currently being viewed or All Clinics to

view appointments for all clinics.

The Unscheduled List View dialog box appears.

2. Make your provider selections to filter the appointments in the list,

and then click OK.
The Unscheduled List window appears.
3. DPerform any of the following

1 uAppointment Book <The Dental Gro
File View  Sreroe wall Appt Lis

Unscheduled List View (23]
= By Praovider:

AMCCLURE MeClurefingel »
DDS1  Smith.Dienniz D
DDS2  BrownMay D e

functions

e  Double-click — To see more

v e Al
2 Carcel
N
(=8 HoR (=)
View Appt Refresh Office Journal
ug - 2013

information regarding an
appointment or to make
changes to an appointment,
double-click the line of
that appointment. The
Appointment Information

zzabumata-Mg. Liz
22 abumoto-Mg, Liz
Abis, Albert T
Elpus, Herbert b
Drahl, b argaret
Baber, Kirk 0
Robinsan, Hary C
Yaden, Randall
Abbatt, Patricia,

Cox, &rthur

Reason

RtCrnPFHr#2, RECEOD
RtCmPFHR#2, RICEOD

[342)555-0847
[942)555-0847
[319)555-3754
[319)555-2928
[743)555-6513
[319)555-3664
[919)555-1923
[743)555-3332
555111 (7

PROVO
MESA
ME SA

dialog box appears.
*  View - To filter the

appointments in the list by provider, on the menu bar, click View.

e  Appt—To delete the selected appointment, from the Appt menu, click the appropriate option.

*  Status — When confirming a selected appointment, from the Status menu, click the appropriate

status type to indicate the last contact with the patient.

e Office Journal — With an appointment selected, on the menu bar, click Office Journal to open the

corresponding patient’s Office Journal.
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Managing Appointments

Scheduling an appointment is only the first step in using an integrated electronic scheduling system. Dentrix
Enterprise makes it easy to quickly manage scheduling tasks such as rescheduling, breaking appointments,
confirming appointments, and even posting scheduled work once it is completed. This section will guide you
through completing the following 10 appointment management tasks:

* Editing Appointments

*  Locating Existing Appointments

*  Moving Appointments

*  Breaking or Canceling Appointments

*  Rescheduling Broken or Canceled Appointments
*  DPosting Scheduled Work

*  Deleting Appointments

*  Working with “New Patient” Appointments

Editing Appointments

You change any information pertaining to an appointment (provider, reasons, time, notes, and so forth).

To quickly change an appointment length

Abbott, James S il
If you want to quickly change the length of an appointment, EEE%E iy :
click the lower-right corner of the appointment, and then drag AN
up or down until the desired length is reached. While you are TEEoT Jamess &
dragging, a small box is displayed that shows the length, in Wi
minutes, of the appointment. i

A

To edit an appointment

. . . Baber, T
1. In the Appointment Book, double-click an appointment. ot
H2[9191555-3664
The Appointment Information dialog box appears. o .
2' Make any nf.:cessary.changes. FOI' MNew Appointment Information - (Abbott, James 5) @
comprehensive details about all the Continving
. . . . Frov. [EMCCLURE  »»|Care | 53]
options in the Appointment Information Atached:
. « . ¥ Use Reason To Auto Update CC Fatiert Infa I
dialog box, see the “Scheduling - Flesen
. .. . Other Appt(z)
comprehensive” topic in the Dentrix Iniial | [Pe Comp oral evabnew/estab pa Delete
. Ing Claim Info
Enterprise Help. T @ Del Al
. - Schd, Nest
3. Click OK. i | =
Wait/will Cal
Desc: |E0mpEx
Length:| 10 min >>| Status:  [<nones | opoPz Find
Amount: [36.00 Schedule: [454P ~| Date [0471E72013 Pin Board
Rl |0.00 T_l,lpe:|High F'roduc:tioj Time: |9:DDam ﬂ History
Staff: ﬂ
Orig. Sched. Operator.  [ENTERPRISE Date Sched:  |04416/2013
Notes Cancel
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Locating Existing Appointments

You have several options for finding existing appointments:

*  From the Appointment Book
u Appointment Book <The Dental Grow

1. In the Appointment Book, from the File menu, click Locate

View Status Setup Appt List

Existing Appointment.
The Select Patient dialog box appears. et ptint
Enter NamefLast, First M) ABEDEFGHIJKLlM }EyN © Other D € Sul
. nter NamefLast, First MI]: + Name el il
Search for and select a patient. e e— nfoela RS[TUVRX[VIZ] |o curne inphenst
— of1]2] 2 4s|s 7[e]s| | clar] |~ oo o g
I Include Archived Patieg —
M H [Name day  [Provider [Clinie: [Status [Chart # 55 # [Other |1
Clle Vlew APPt‘ Abbott. James § 1362 AMCCLURE MESA, ABB101 11414111
Abbatt, Patiicia 1963 DDS1 MESA ABB102 E6E-BE-BEEE
The Appointments for dialog box appears.
4. Chck Current to Appointments for Abbott, James 5 =3
ViCW appointments Date Daim“mTlme ----- Sfaus F:‘rnv > EEITUI Cliric: D ate schedulad TSI E T
. i
only at the clinic w——
hich D1 o00s T % #ors EENTRAL 01 202005 —
D
to whic you are 01/13/2009 TEZ DEF_DF2 CEMTRAL 01/13/2009
12/18/2008  Thu DEF_OF1 CEMTRAL 12/18/2002

12/15/2008 Mo

n DEF_OF3 CENTRAL 1241772008
12/08/2008 Mon

DEF_OF1 CENTRAL 12/15/2008

currently logged
on or All to view
appointments for

o . Clinic.
all clinics. @_P m

5. Select the Localg appt | Edft appt | Cancel I
appointment that / 6 \
you want to view or edit. U

6. Click Locate appt to go to the selected
appointment in the Appointment Book, or
click Edit appt to open the Appointment Information dialog box for the selected appointment.

* By right-clicking an appointment o
. . . . ImébtFmCm
1. To find other appointments a patient has, with one of that patient’s  f{ris1ass3ses

appointments selected in the

Appointment Book, right- Family Appointment List EX=
click that appointment, and
. Al
then click Other 8 CC: PROPHY 05/08/2002
Appointments. The Family
APPOintment List dlalog Appointment Op Cliric Cortinuing Care
Mo Appainiment] TC. FROFHY 07/21/2012 %
box appears
"01/20/2072 Fi_ 1.00pm DROEE PRAT FROVO 4
. 01A3/2012 Fi  1:00pm DROEE PRA1 FROVO -
Tip: This dialog box also
displays appointments for Treatment Plan
other famlly members Of 70441242002 D710 Extraction-single toath il 30 min
the selected patient. You
can select a different family
member to view that patient’s )
. (3 ) Wiew &ppt. Create Mew Appt. | Cloze I
scheduled appointments. y.

Select the appointment you want to view.

Click View Appt to go to the selected appointment in the Appointment Book.
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° From any module @. &X Appointment Book <The Dental Gro
1. Inany module, except the Office Manager, from the File menu, i ——————
click Patient. The Select Patient dialog box

Select Patient

appears. alB

CIDE|F GH|I|JIKIL|IM By
Enter NamelLast, First M) AERE F\ls o ulv = xﬂlz :Name :Dthev\D € Sub
. . ) abb Jl Chait #¢ Hm Phone #
2. Search for a patient, and select that patient’s of 1[5 /5|6 7]o]s|.[Oen] |- ooy c gt
[ Include Archived Patients
Marne

gloy  [Provider Clinic: Status (Chart # S5 & Other |

name.

k] CCLUR 111111111
1563 DDS1 MESA ABB102 BB BE-EEEE

(Abbot, Palricia *

3. Click More Patient Information. The
More Information dialog box appears.

Recent Patient S elections:

Tl‘le list bOX at the bottom displays any Abbott, James 5 11/11/1962 AMCCLURE  MESA £BBT0 T

scheduled appointments for the patient. — < 3 )M B %
N’
==l

Tip: This dialog box also

displays appointments
Smith, Timathy 8 CC: PROPHY 05/08/2002

for other family Abbott, Pa 43 CL: PROPH'Y 05/22/2002
50 £ PROPY 2
members of the selected - S

More Information

atient. You can select a
h -
different family member
. . s SSH Ch Status
to view that patlents 111111111 ABE101T Patient
h d 1 d . Address work Phone
scneaule appomtments. 1234w Ok 5t
City ST Zip Code Home Phone
4‘ SCICCt the appointment Armerican Fork uT 54003 5551111
. Appointment Provider / Operatory / Clinic Continuing Care
you want to view. Mo appointments> PROPHY(07/21/2012)

Past appaintment

: 012002012 Fi 1.00p JPROVD
5. Click Select to go to the 0113/2012  Fi  1:00p JPROVO
selected appointment in 044152002 Mon B10a MESA

the Appointment Book.

Moving Appointments

Whether a patient needs to reschedule or the office needs to lighten the schedule, from time to time you will
need to move an already scheduled appointment to a new date or time:

*  On the same date — In the Appointment Book, click and drag the appointment to a new time and/or
operatory. On the confirmation message that appears, click OK.

Abbott, James S5
ApicPaosFl, Fyéd

H:5585-111
DRORR S

|

tt, James S
Apic bt d
H:555-111
DROBE

1. In the Appointment Book, click and drag the HYGIENE 3 | 17

intment to the pin board i @R IV
appointment to the pin board. d Preitai
-Ilmnca

Tip: To return an appointment on the pin
board to its original date and time, from the
File menu, click Refresh.

¢ To a different date

. PH-UZ PH-S Tt il
2. Once you find a new date and time for the BB James S

Abbatt, James 5
appointment, click and drag the appointment [ g @™ 4— Aol o
to the desired spot on the schedule. On the DR A
confirmation message that appears, click OK.
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* By double-clicking an appointment

1. If you know the exact date and time to which you want to move an

appointment, in the Appointment
Book, double-click the
appointment you want to move.
The Appointment Information
dialog box appears.

2. Type the new Date and Time, and
if necessary, select the desired Op.

3. Click OK.

H:[9191555-3664

Baber, Tam
Irn&sbtRmCrm
nnssy

New Appointment Information - (Abbott, James S)

Continuing
Prov:  |AMCCLURE »»| Care |
Abtached:

¥ Use Reason To Auto Update CC

H

2] Change Pat
Patient Info | i

Reason

Imitial ||Pe  Comp oral eval-new/estab pa
el

Misc.
Desc: ICompEx

Length: W min ﬁ] Status: | <none> v

Delete

Del. all

Other Appt(s]
Ing Claim Info

Schd. Nest
e ait Al Call

Find

:

Amount: [36.00 Schedule: [ASLP =] foate: [0arterzmz PinBoard |
vl IF T_upe:|High Productio v | | Time: | %00am 2] Histary
Staff ] ( ) o

Orig. Sched. Operator.  |ENTERPRISE Date Sched.:  |04416/2013
~Motes s l

Breaking or Canceling Appointments

When a patient calls and cancels an appointment, to prevent these broken appointments from being
forgotten, Dentrix Enterprise moves them to the Unscheduled List, where they can be reviewed on a regular
basis. Also, when you try to schedule an appointment for a patient with a broken appointment, Dentrix
Enterprise displays a message that states that the patient has a broken appointment and prompts you to

reschedule it.

To move an appointment to the Unscheduled List

1. Code/complete the canceled or broken appointment.

2. In the Appointment Book, select the appointment, and then click the Patient Chart button on the

toolbar to open the Patient Chart module.

rj' Appointment Book <The Dentist Group> <CENTRAL >

File ‘iew Status Setup ApptLists Help

File Options View

Prim/Perm Procedures Multi-Codes

L

AAAAARK]

!

o
-
L
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3. Verify that the provider with whom the patient was scheduled is displayed on the title bar of the Patient
Chart window. If the correct provider is shown, skip step 4.

4. Ifyou need to change the provider being displayed in the Patient Chart, from the File menu, click
Change Provider to open the Select Provider dialog box. Select the correct provider, and then click OK.

5. Click the IHS - Other procedure code category button to open the Select Procedure Code dialog box.

Select the broken or canceled appointment code, and then click OK.

Diagnostic

Restorative

Endodontics

Pesiodontics

Prasth, remow

Maudlla Prosth

Imnplant Serv

Prostho, fixed

Dral Surgery

Orthodontics

Adiug

Conditions (

IHS - Cther

6. Click Comp to complete the code. The code and description are displayed in the progress notes, and the
code will be sent to RPMS like any other completed code.

Prostho, fixed | Oral Surgery
Adjunct Sery

IHS - Other

Orthadorntics

Conditiors

Date  |Tooth| Suif | Proc | Prov Descripti Stat | AP |Amount| |

11/16/1935 D1110 {DDS1 | Prophylasis-adult C 48.00| A « r' Q
11/16/1935 D0274 |DDS1 | Bitewings-four films C 32.00 ™ Treat Plan
11/16/1935 DO150 |DDST1 | Comp oral eval-new/estab pat [ 36.00 ¥ Completed
05/14/20010 [ 16 |0 D2391 |DDS1 | Resin composite-13, postenor C 90.00 ¥ Existing
05/14/20 17 |0 D2331 |DDS Resin composite-13. posterior [ 30.00 W T
06/08/20 32 D2761 |DDS1 | Crown Insest C 110.00 Exams
07/13/20 D1110 |DDS1 | Prophylaxis-adult o C 80.00 [~ Proc. Notes
07/13/2010 D0274 [DDS1 | Bitewings-four filrms o C 97.00 [ Clinic Notes
08/10/2010 9340 JODSY JCancelled Appointment C 0.00

7. Update the appointment note:

8. Double-click a patient’s appointment to open the Appointment Information dialog box.
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@] Appointment Book <The Dentist Group> <CENTRAL >
File ‘iew Status Setup ApptLists Help

Continuing -
Piov. [DDS3 55| Care | »] ngeFat |
Attached:
E"::“ »| W Use Reason ToAuto Updale CC Palient Iio |
BASON
Dither Appi(s)
Iritial | |7 1 Amalgam-1 suf. primdperm #13 B Dml 4’
Ins Claim Info

Tx Del &l
Mise. Siehd. Mest I

Desc: |AmalglPertt13
Length: |40 min >>| Staws: [MoArsw | op[DEF_OP1 »] Fnd |
Amount: [55.00 Schedude: [FIXED =] Dae: [BA02010 > PinBoard |
RvL: [0.00 Type: [High Productio = | Time: | &:00am | Hitoy |
A |

0K
Orig. Sched. Opesator:  |ENTERPRISE Date Sched:  |08/10/2010
Cancel |
™ Chaet Pulled

ﬁdﬁ Insert Dateline |

-------------- Tue - g 10,2010 <ecvveeedeath in Family - out of town next week
- left meszage on recorder on Satuday - AK

A

[ Appointment Verfied | Referred By I~ Cont Care Set
[ Personal Information [~ Consent Form Signed | Other Family Appts
[ Inswance Coverage | Follow Up? I Mest Appointment

9. Under Notes, click Insert Dateline, and then type the reason for the broken or canceled appointment. Be
sure to add your initials at the end of the note.

10. Also, as part of the note, type the number of times this appointment has been missed and the next date
the patient is allowed to be seen.

11. Click OK to save the note. The information in the note will stay with this appointment, for your
reference, when you reschedule the patient.

12. Move the appointment to the Unscheduled List:

*  Using the Wait/Will Call Method — When a cancellation is made with advanced notice or you must
reschedule the appointment, use this method to move the appointment to the Unscheduled List:

a.  Double-click a patient’s appointment to open the Appointment Information dialog box.
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@] Appointment Book <The Dentist Group> <CENTRAL >
File Y¥iew Status Setup ApptLists Help

Tx Del. Al

Desc: IArnalglPsﬂt'IQ

Length: 40 mn >>| Status: [No#nsw  »| op/DEF_OPI »]

Amourt: [55.00 Schedule: |FIXED | Date [087102010 ﬂ
RvU: [0.00 Type: [High Productio = Time: [ &:00am »
- =i

Confirwing I
Frov: [DDS3 »>| Care I ﬁj
ENCH Attached:
»| ¥ Use Reason To Auto Update CC
Reason
Initial Tx 1 Amalgam susf, prim/peim s B Deletes |
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Patient Info |
Oiker Appt(s)
Ins Claim Info

Schd. Mext

_ fd |
Pin Board |
History I

b. Click Wait/Will Call to move the appointment to the Unscheduled List.

B Dentrix Family File - (Abbott, Patricia) [MESA] [DDS1] [ABB102]
Fle Edit Help

Mame: Abbott, Patricia
Address: 608 5 500w
Murap, UT 84123

Consent: 03/02/1933
First Visit: 03/02/1933
Last Visit: 08/10/2010
Phone: H 3751586 Missed Appt: 08/10/201

Status: Active, F, Mammed, Guar, Ins, H-of-H

CEX

Chart #: ABB102
Clinic: MESA
SS#: 778561123
Birthday: 03/30/1963, 46
Provider: DDS1
Fee Sched: <Frov Default>

E-Mail: pabbot@grmail com

The number of missed appointments for the patient is increased by one in the Family File.

Using the Break Appointment Method — For no shows, last-minute cancelations with short
notice, and patients arriving too late to be seen, use this method to move the appointment to the

Unscheduled List:

a. Select a patient’s appointment on the schedule, and then click the Break Appointment button
on the toolbar; or right-click the appointment, and then click Break Appointment.
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@] Appointment Book <The Dentist Group> <CENTRAL >
File Y¥iew Status Setup ApptLlists Help

Tuesdey -August 102010
DEF_OF2

Dentrix Dental Systems

!} The appointment: will no longer be displayed from the Appointment List.
1t will be moved to the Unscheduled List, BREAK appointmenit?

Yes | ] |

o
EEP ISR Y

b. On the confirmation message that appears, click Yes to move the appointment to the
Unscheduled List. This appointment will not be shown anywhere in the Appointment Book
except on the Unscheduled List.

B Dentrix Family File - (Abbott, Patricia) [MESA] [DDS1] [ABB102] 9=
File Edt Help

MName: Abbatt, Patricia Chart #: ABB102
Address: 608 S 500w Consent: 03/02/1993 Clinic: MESA
Murrayp, UT 84123 First Visit: 03/02/1993 SS#: 778-56-1123

Birthday: 03/30/1363, 46
rovider: DDS1

ee Sched: <Prov Default>
Status: Active, F, Mamied, Guar, Ins, H-of-H E-Mail: pabbot@Egmail com

Phone: H 3751586 Missed Appt: 08/10/2010, 2

The number of missed appointments for the patient is increased by one in the Family File, and
the date for the last missed appointment is updated to reflect the date this appointment was
broken.
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Rescheduling Broken or Canceled
Appointments

You can reschedule a broken or canceled appointment using the following two methods:
*  From the Unscheduled List

1. In the Appointment Book, from the Appt. Lists menu, point to Unscheduled List, and then click
Current Clinic or All Clinics to open the Unscheduled List window.

@ Appointment Book <The Dentist Group> <CENTRAL >
File Wiew Status Setup EaTdC@NEE

B(C
GUUNETN  Unscheduled List »

DEFOPT—""

S[=1e

View Appt Refresh Office Journal

Tue - Aug 10,2010
Date Name Prov I
05/25/20100w/Call [Baber, Tom | D053 | CENTRAL |a
08/10/2010 Broken Abbott. Paticia DDS9  CENTRAL

2. Double-click an unscheduled appointment you want to schedule to open the Appointment
Information dialog box. The information from the original appointment, including the notes, is

displayed.

Appointment Information - (Abbott, Patricia)

Continuing '
Prov. [DDS3 »|cae | »] |
Attached:
E’:::” » ¥ Use Reason To Auto Update CC Palient Iio |
S350
Qther Appt(s) I

Iritial |[{T= 1 Amalgam-1 susf. primdperm "3 B

j
)

g |8
A

Desc: |Amalg1Pertt19

Length: | 40 mnﬂ Status: |<nur|e> ﬂ DDC|
Amount: [55.00 Schedule: | FIXED | Date |
RvU: [0.00 Type: | High Productio_»| Time: |

P | ald

-

el ¥
%ﬂ.
o

Histoay

3. Click Pin Board to place the appointment on the pin board in the Appointment Book.

4. To schedule the appointment, navigate to a date in the Appointment Book, and then drag the
appointment from the pin board to the operatory and time slot where you want to schedule the
appointment.
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<CENTRAL =

AmalglPeri1g
H:375-1586

*  From the Family Appointment List

1. In the Appointment Book, navigate to a date, and then double-click in the operatory and time slot
where you want to schedule an appointment to open the Select Patient dialog box. Select a patient
with an unscheduled appointment.

2. On the message that appears and states that the patient has unscheduled or broken appointments,
click Yes (always click Yes when this message appears) to open the Family Appointment List dialog

box.
Family Appointment List [X|
Guar  Abbott, Paliicia 46 CC: PROPHY 01/14/2011
Spouse Abbott, James 5 48 CC: PROPHY 04/09/2002 +
Chid  Smith, Timothy 25 CC: PROPHY 05/08/2002

Op Clirac Continuing Care

C: PROPHY 01/14/2011

|*08/02/2010 Mon 330sm DDS3 DEF_DF CENTRAL M

Treatment Plan
| ? 05/13/2010 D1201 Frophylasis with fluoride-child

»

1 05/13/2010 D050 Comp oral evalnew/estab pat
1 05A13/2010 D201 Prophylasis with fluoride-child
1 0813/2010 D207 Prophylasis with fluoride-child

S el = gad
<

C yenson D) cioeewsont | [_Gon

3. For the selected patient, in the middle list box, select the “<Unscheduled Appt>” item, and then click
View Appt. to open the Appointment Information dialog box.

Appointment Information - (Abbott, Patricia)

Conlirning '
Prov: [DDS3 »>| Cave | »] 3
ENCH Attached: -
»| ¥ Uise Reason To Auto Update CC Palient Info
Reason Other Appte)
$|
Initial | |T% 1 Amalgam-1 susf, prim/permn #19 B Dml
I Clai Info

Desc: [AmalglPet9

Length: | 40 mnﬂ Status: I(nuﬂe) ﬂ I:Ipc|
Amount: 55,00 Schedule: |FIXED | Date: |
RVU: [0.00 Type: | High Productio = |  Time: |

P | wl

4. Click Pin Board to place the appointment on the pin board in the Appointment Book.
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To schedule the appointment, drag the appointment from the pin board to the operatory and time
slot where you want to schedule the appointment.

<CENTRAL = E”E”z|
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Deleting Appointments

You can permanently delete an appointment from the Appointment Book.

To delete an appointment
1. In the Appointment Book, select the appointment you want to delete.

2. From the File menu, click Delete Appointment. On the confirmation message that appears, click Yes.

Working with “New Patient” Appointments

An “NP” to the left of the patient’s name indicates that the appointment is a new patient appointment, and
the patient’s information has been temporarily added to Dentrix Enterprise.

To find a new patient appointment

Since the patient does not yet have a Family File record, to locate the new patient appointment, use the Locate
Existing Appointment feature of the Appointment Book as explained in “Locating Existing Appointments” in
this chapter.

To create a Family File record for a new patient

For information on how to create a Family File record for a new patient who has an appointment in the
Appointment Book, see “Adding a New Patient with an Appointment” in Chapter 2: Family File.

Managing Events

Scheduling an event is only part of using an integrated electronic scheduling system. Dentrix Enterprise makes
it easy to quickly manage event tasks such as rescheduling, editing, and deleting events. This section covers the
following topics about event management tasks:

*  Rescheduling Events Using the Pin Board
* Editing Events

e Deleting Events

Rescheduling Events Using the Pin Board

You can drag a partial-day or all-day event to the pin -
board as a means to reschedule the event. A copy of the ____ HYGIENES | _ e
event will appear as an event icon on the pin board. To
reschedule that pin board event, drag the icon to the
desired date, time, and operatory.
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Editing Events

You can edit an event’s details at any time. If the event is part of a series (an event that repeats at regular

intervals), only the occurrence you are editing is affected.

To edit an event

1. In the Appointment Book, double-click the event you want to edit, and then click Edit

Event.
The Edit Event dialog box appears.

2. Edit the various event options as needed. For
information on setting up event options, see
“Scheduling Events” in this chapter.

3. Click OK.

Chapter 3: Appointment Book

Ewent

[[u]
holi
empl
Edit Event (23]
Event Time Operatories
ﬂ End:[500pm ﬂ OF1
I” Close Operatory (4l Day Event)
Ewent Days
Stat [0471672013 >»| Ena:[0471672013 »» |
Select Days of the Week
7 Sun. [ Mon ¥ Tues [ ‘Wed.
[ Thws, [ Fi. I Sat Clear Al
a0
Ewent Color

[rescription:

e [—
I” Center Description on Scheduled Event
Irsert Dateline %

-

Motes

MOTE: If multiple operatories and/or days are specified for the Event, separate Events
[one per day per operatory] will be created/displayed in the Appointment Book. The
E vent creation process may take several minutes depending on the criteria specified.

Delete Cancel

103
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Deleting Events

You can delete a single event or an event that is part of a series. You cannot delete a whole series of events at

one time; you must delete each occurrence separately.

To delete an event
1. In the Appointment Book, double-click the event you want to delete.

The Edit Event dialog box appears. 0
2. Click Delete. On the confirmation message that appears, click Yes.

=

I Center Description on Scheduled Event

Mote
Insert D ateline |ﬂ

.

MNOTE: If multiple operatories and/or days are specified for the Event, separate Events
[one per day per operatory] will be created/displayed in the Appointment Book. The
Event creation process may take several minutes depending on the criteria specified.

Delete aK Cancel
‘ 2 ) I
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Generating Appointment Book
Reports

There are two reports that can be printed directly from the Appointment Book:
e Appointment Book View Report

* Routeslip

Appointment Book View Report

The Appointment Book View Report shows your daily schedule.

To print the Appointment Book View Report

U Appointment Book <The Dental Gro
View Status Setup Appt List

PREEEERE

1. In the Appointment Book, from the File menu, click Print
Appointment Book View.

The Select View dialog box appears. Select View 2 B
. . . Select = Print Wiew
2. 'The current view in the Appointment Book Provider(s] " Agpaiiment DaptayInfo——| [ pri Amaunt

determines the default settings for the report, but you Line 1: [Name 1| 1 Frint Appt Colors
can change any of the following options as needed: Line 2 [Appt Feason =] | | Pint Day Note

. . [~ Prirt Perfect Day
*  Select Provider(s) — Select up to 10 providers to Selkst Line [Phone -]

Op.(s) [ Print Time at Fight

include on the report. Line & [Frovider =] | [ 1meView
Stanrt Hr: IS_
e Select Op(s) — Select up to 10 operatories to lne5 [amout ] | ® am  pm

i EndHr [5
include on the report. et [omTeme ] | |E [
) Date  am & pm
*  Date — By default, the current date is used as the [arer2ns »s| || Lne?: [otan | — :;
date for which the schedule will be printed, but et | .
. > Load Print Yiew

you can type a new date in the Date field or click
the search button **! to select a date.

Line 3 Im
* Appointment Display Info — Depending on 4 Pint | [ Bach || cancel |

the length of an appointment, up to nine lines
of information can be displayed on the face of an appointment. For each Line, select the information
you want to have displayed on that line, or select [None] to leave that line blank.

*  View Options — Select any of the following:
*  Print Amount — To print the scheduled production amount for the day, week, or month.
e Print Appt Colors — To print in color if you are using a color printer instead of in grayscale.
e Print Day Note — To print the Appointment Book day note for the date being printed.
*  Print Perfect Day — To print the perfect Day Scheduling time blocks.

* Print Time at Right — To include the time bar on the right side of the appointments in addition
to the time bar along the left side.

e Time View — Type the earliest hour of appointments that you want to print in the Start Hr field.

Type the latest hour of appointments that you want to print in the End Hr field. Click am or pm
for both fields.

3. If you want to save the current settings for the next time you print the Appointment Book View, click
Save Print View. Only one Appointment Book View per computer can be saved.

4. Click Print to print the report to the default printer for the Office Manager, or click Batch to send the
report to the Batch Processor in the Office Manager.
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Route slip

The route slip provides up-to-date, comprehensive information for a patient. You can use the route slip as a
reminder of medical alerts, patient notes, collection information, and so forth for patients being seen that day.

i i i i Baber, T
To print a single route slip for a patient Iln'naAEt[F!mDEn;'u @ J

. . H:[9191555-3664
1. In the Appointment Book, select an appointment.

npss

w Appointment Book <The Dental Gro.
View Status Setup Appt List

= I [ =5 [ |

ote B e (00
Print Route Slip

2. From the File menu, click Print Route Slip.

The Print Route Slip dialog box appears.

3. Click Print to send the route slip to the default printer for the
Office Manager, or click Batch to send the route slip to the Batch 5 00am
Processor in the Office Manager.

Tip: To generate route slips for all scheduled patients, in the Office Manager, from
the Reports menu, point to Lists, and then click Daily Appointment List. Set
up the options, making sure the Patient Route Slips check box selected, and then
click OK. For more information, see the “Daily Appointment List” topic in the
Dentrix Enterprise Help.

Working with Notes in the
Appointment Book

You can attach important information directly to an appointment or date. This section covers the following
topics on Appointment Book notes:

* Adding Appointment Notes
e Adding Appointment Book Day Notes
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Adding Appointment Notes

Appointment notes are attached directly to an appointment and usually reference special situations the office

should be aware of before a patient is seen.

To add an appointment note

1. In the Appointment Book, double-click an appointment.
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H:[9191555-3664

Baber, Tom
ImésbtFmCrn
nnssy

©)

The Appointment Information dialog box appears.

2. Type a new note or change an existing
note in the Notes field. Click Insert
Dateline to date stamp the note.

Tip: To insert a blank line or start a new
line, while pressing the Ctrl key, press
the Enter key.

3. Click OK.

The appointment now as a blue
musical note in the upper-right corner,
indicating that the appointment has a

note.
wﬂj

Crosby, Brent L
Periodick, Amalg3Pri
H: 2255953

New Appeointment Information - (Abbott, Jarmes )

Continuing
Prov. [SMCCLORE  »»|Care | >
Attached:

¥ Uze Reason To Auta Update CC

Change Pat

Patient Info | Ii

Reazon

Initial | Pc  Comp oral eval-new/estab pa
el
Misc. |

Desc: ICDmpEx

Length: W min ﬂ Status: |<n0ne>

Amount: |36.00 Scheduls: [ASAP

Delete |

Del &l

| opor2
=] Dae 0162013 >

Other Appt(s] |
Ing Clairn |rfo |

Schd. Mext |
“wait Al Call |

Find |

Pin Board

Rll: IU-UU Type:lHigh ProductioLI Time: | 9:00am ﬂ
Staff: | »|

Orig. Sched. Operator.  |ENTERPRISE Date Sched.: |D4.-"1 £/2013 ‘
Mote:

- Inzert D ateline |
@)

Histaory

Cancel |
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Adding Appointment Book Day Notes

An Appointment Book day note can be created for each day of the year and is generally used as a reminder
for a specific date (for example, to order supplies, to call a school about a hygiene class, or to attend a dental
society meeting).

To add an Appointment Book day note

1. In the Appointment Book, click the Note icon located in the upper-left corner
of the schedule.

The Appointment Book Note dialog box appears.

Type a note or reminder for the day.
Clle OK Fieorder supplies

'The Note icon is now has a yellow background,

indicating that the day has a note. @
M ate

Clear | 3 ()8 Cancel
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Using Perfect Day Scheduling

Many practice management consultants advocate a strategy of scheduling a day that consists of just the right
balance of high production, medium production, and low production procedures. Dentrix Enterprise helps
you achieve that perfect balance by allowing you to reserve certain times during the day by blocking those
times for the scheduling of specific procedure types (for example, crowns or exams).

This section covers the following topics about setting up and using Perfect Day Scheduling:
*  Customizing Appointment Types

*  Customizing Procedure Codes

e Setting Up Perfect Day Scheduling Time Blocks

*  Activating Perfect Day Scheduling

*  Finding an Available Time Block

Customizing Appointment Types

The initial installation of Dentrix Enterprise includes four appointment types: General, High Production,
Medium Production, Low Production. If necessary, you can delete or change these type and add more (up to
a total of 10) in Practice Definitions. For information about setting up appointment types, see the “Practice
Definitions” and “Customizing Appointment Types” topics in the Dentrix Enterprise Help.
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Customizing Procedure Codes

Each procedure code in Dentrix Enterprise can be assigned a default appointment type. Once a type has been
properly designated for a procedure, Dentrix Enterprise automatically assigns the correct appointment type to
any appointments scheduled using that procedure code. When you schedule an appointment in a Perfect Day
Scheduling time block, Dentrix Enterprise verifies that the appointment’s type matches the type permitted for

that reserved time block.

To edit a procedure code

1. In the Office Manager, from the Maintenance menu, point
to Practice Setup, and then click Procedure Code Setup.

Maintenance

* Dentrix Office Manager - The Dentist Group -«
File View Reports rette

The Procedure Code Setup dialog box appears.

2. Select a Procedure Code Category. All procedure
codes associated with that category appear in the list
box to the right.

3. Select a procedure code, and then click Edit.

The Procedure Code Editor - Existing dialog box
appears.

4. Select an Appointment Type.
5. Click Save.

Procedure Code Setup

Procedurs Code

Category ADA

01120

1201

D1203

Endodontics' 01204
Perindontics 01205
Prosth, remoy 01206
Maxillo Prosth 01310
| 5 01320

D1330

D1351

Orthodontics S 01382

User Code

ADA-CDT Codes | Dental Diagnostic Codes | AMA-LPT Codes | ICD-3CM Diagnostic Code:

Description

h
Prophylaxis-child
Prophylaxis with fluo
Fluoride w/o prophy!
Fluoride w/a prophy
Prophylazis with fluo

Topical fluoride varr
Nutitional counselin
Tobacco counzeling
Oral hygiene instruct
Sealant-per tooth

Preventive Restorat

Procedure Code Editor - Existing @
Description: [Prophylasis-adult Fee Schedule l RvU Scheduls |
Patient Friendly Description ’_ Edit Fee
Cleaning of adult's teeth to help prevent dizease - 1. Dffice
h 2. PULLEM 4400
Code Mames Treatment Flags i BEEHST gggg =
D10 ADACode B i | i 5 FEE5 37.00
[ Condiion B BSoiPA 30,00
Frophyad Abbrev Desc ™ Remove Tooth 7. DELTA 000
W Show in Chart 8. UP933 0.00
CPT X 0.00
Auta Continuing Care 10. 0.00
Medicaid PROPHY  »» 1. 0.00
12 0.0
Procedure Time 13, 0.00
fode® 5 unis) 5> |14 000
15. 0.00
Pracedure Category: i - 18 "
rocedure Category: | Preventive J 17 0o
} ooo -
Appointment Type: | Laoww Praduction f
. Expenzes
Treatment Area: | Mouth v| Flags Lah Materials
Faint Type: | [Mane] j
I™ Flag for Medical Cross Coding
[™ Da Mot Billto Dental Insurance
™ Da Mot Send Over HL?
I” Require Start/Completion Dates
Edit Mate Mew Code Mext Code | Save

)
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Setting Up Perfect Day Scheduling Time

Blocks

You can set up Perfect Day Scheduling time blocks for each provider.

To set up a time block

1. In the Appointment Book, from the Setup menu, click Provider

Setup.
The Provider Setup dialog box appears.

Select a Clinic.

Select the provider for which you want to set a time block.

4. Click Setup.
The Provider Setup dialog box appears.
5. Under Set Time Blocks, click Add to add a

new time block.
The Block Settings dialog box appears.
6. Set up the following options:

* Time Block Name — Type a short
description of the block’s purpose (for
example, “Crowns” or “Exams”).

*  Color — Click the color button to the right
of the Time Block Name field to choose a

color to represent the time block.

*  Week Days — Select the days of the week
for which you want to set the time block.

O

\-) Appointment Book <The Dental Gro

File  View — Appt List

Provider Setup
Clinic: |MESA 1 : )
Provider:

(1)

Schedule

A Provider |

Provider Setup [AMCCLURE, MESA]

Default Schedule

™ Sunday J
v tonday ﬂ

v Tuesday ﬂ
v Wednesda}lﬂ
W Thursday — »»
v Friday ﬂ

™ Saturday J

Provider Color

—

Set Time Blocks

7\

@ Close

Staff btg 5

8 oK Cancel

Add
E dit

Delete

Then, for each selected day, click the Start and End search

¥

buttons to set the time range:

* Assigned Op — Select the operatory where the types of

procedures for this time block are performed.

*  Block Appt Type — Select the appointment type you want to

assign to this time block.

Click OK to return to the Provider Setup dialog box.

8. Click OK.

N

Block Settings

wieek Days
™ Sunday

™ Monday

V¥ Tuesday
I~ wWednesday
™ Thursday
™ Friday

™ Saturday

Aszszigned Op

Tirme Black Mame: |[Staff Mid (|

el

Start End

1:00pm 2:30pm

el el
M M M 2 2 R A

Block Appt Type

|oF3

7 ak

=

| <alls

— L

Cancel

y A
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Activating Perfect Day Scheduling

To display the Perfect Day Scheduling time blocks in the Appointment Book, you must activate Perfect Day
Scheduling. If Perfect Day has not been activated, the defined time blocks do not appear in the Appointment
Book, and no warning will appear if anyone tries to schedule appointments during reserved time blocks.

To activate Perfect Day Scheduling

From the File menu, click Perfect Day Scheduling. If the Perfect Day Scheduling menu option has a check
mark next to it, the feature is already activated.

Once Perfect Day Scheduling has been activated, Dentrix Enterprise will display the defined provider time
blocks in the Appointment Book. When you schedule an appointment in a defined time block, Dentrix
Enterprise will check both the provider and the appointment type to verify that the provider and appointment
type match what is allowed for that time block. If either the provider or the appointment type do not

match, a warning message appears and asks if you want to override the time block setting and schedule the
appointment.

To move a time block

Individual time blocks can be moved within their respective operatory by dragging the time block to the
desired time.

To resize a time block

You can increase or decrease the size of the time block by clicking the bottom border of the time block and
dragging up or down.

Finding an Available Time Block

You can locate the first available blocked time for the type of appointment you are scheduling.

To find the first available time block

1. In the Appointment Book, from the File menu, click Find New
Appointment Time.

\ Appointment Book <The Dental Gro

v Status Setup Appt Lis

The Find New Appointment Time dialog box appears. T ‘

““““ [ bACC A

2. Set up your search criteria as T ==

explained in “Using the Find Sokec Pl _ [ SolctDage— -5 D ToRS e B

Appointment Tool” in this DROEB B Sty CFEZTERNEN F

.. . v Monday &+ Dayls)
chapter. Additionally, if you w22 C
¥ Tuesday EEHE ﬂﬂﬂ

have Perfect Day Scheduling iy || @ M

time blocks set up, to set the ¥ Thusdey | - Tine Range

time block search options ity appt Lengthy [ T8 | 5|

under Select Time Block, Bl R ™ Time Pattem Search ( 2 \

select Search By Time Block, =TI ﬁﬁ \_/

End: £
select whether to search by the !
Pl‘ovider or Operatol’y blOCk Providers/operatonies in
. & Wiew  [Main -
type, and then select the desired -
/ Clinic ’h‘ [ Search By Appt Type

tume blocks. W SeiectAlOps Appt Type: |High Froduction

3. Chck Sea_rch/VieW to see the I” Mo Duplicate Operatory Times 3 SearchMiew | Search | Cancel

available times that match your
search criteria. For information

about previewing and selecting a time slot and scheduling the appointment, see “Using the Find
Appointment Tool” in this chapter.
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Chapter 4: Patient Chart

The Dentrix Enterprise Patient Chart can be used for entering and maintaining clinical records for your
patients. Its complete chair-side integration makes it the perfect tool to simplify record keeping while giving
you opportunity to take advantage of the newest technical innovations in dentistry. The Patient Chart module
consists of the following:

Patient Chart — The Patient Chart provides a quick and easy way to enter existing, recommended, and
completed treatment or conditions. Dentrix Enterprise uses standard, easy-to-recognize textbook charting
symbols. Treatment is color coded so that with a single glance at the patient’s graphic chart, you can tell
whether a procedure is a condition, existing, treatment-planned, or completed.

Clinical notes — You can use clinical notes to document and track patient care. These notes can be
attached to a patient as a clinical record. Dentrix Enterprise provides several template options (including
customizable templates) to help make entering notes a simple process.

Treatment Planner — You can use the Treatment Planner to help explain and demonstrate proposed
treatment to patients. The Treatment Planner can be opened from the Patient Chart and the Ledger. For
more information about the Treatment Planner, see Chapter 6: Treatment Planner.

Perio Chart — Using customizable script settings, you can enter periodontal treatment information
quickly and completely in the Perio Chart. Information can be displayed graphically in the Perio Chart,
making it possible for patients to visually understand perio data. The Perio Chart also provides a variety
of letters for you to generate correspondence quickly for patients, referring dentists, and insurance
consultants. For more information about the Perio Chart, see Chapter 5: Perio Chart.

This chapter covers the following topics:

Using the Patient Chart window * Invalidating Procedures in History
Clearing the Patient Chart *  Changing the Displayed Dentition
Changing the Provider for a Charting Session e Setting the Default Dentition
Entering Treatment *  Entering and Editing Procedure Notes
Editing Treatment *  Working with Clinical Notes

Deleting Treatment *  Printing from the Patient Chart

113
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Using the Patient Chart window

The Patient Chart window consists of the menu bar, toolbar, graphical chart, procedure buttons, procedure
code category buttons, status buttons, and progress notes.

Procedure Buttons Procedure Code 'Category Buttons

\
a.é Dentrix Chart - (Abbott, Patricia) [CENTRAL] [DD51] [ABB102] [11/11/1963]

File Options View Prim/Perm Procedures  Multi-Codes

9]
Dental Diaynostics  Help

/

B -~ Diagnostic Freventive
H ﬁnu ﬁuﬂ Restorative Endodontics
ﬁ ﬁ: f w0 | Periodontics | Prosth, remov
a— L y i" IE Mavillo Prosth | Implant Sery
! s ==y .
Graphical Chart=— é i Prostho, fised | Oral Surgery
. i ! A [ R ‘R ﬁﬂl Orthodontics Adjunct Serv
£ o /. A& fla V=
; ; s - & |FV|0S]  condiions Misc.
L A ) ) - =5
i Eégg EEEE E E_‘ @Im EO|Ex| Tx Comp |+
Clear
Date  |Tooth| Surf | Proc | Prov Description Stat | AP |Amount| |
114161955 01110 [DD5T | Prophylaxis-adult 5 48.00 » J f‘ @
114161995 00274 [DDS1 | Bitewings-four films 5 32,00 'at Plan
1141619595 D80 (D051 | Comp oral evaknew/estab pat = 36000 mpleted
02/28/2002 | 31 D710 D051 | Extraction-single toath [ 100.00 visting
02/27/2012 ) 20 DL D250 D051 JAmalgam-2 surf. prim/pem [5 75.00 el
[ [Exams
Proc. Mates
Clinic: Mates
|
Progress Notes Status Buttons

This section covers the following topics to help you understand how to use the Patient Chart window:
*  Using the Patient Chart Toolbar

*  Using the Graphical Chart

*  Using the Procedure Buttons

*  Using the Procedure Code Category Buttons

*  Using the Status Buttons

*  Using the Progress Notes Panel
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Using the Patient Chart Toolbar

The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of the buttons specific to the Patient Chart are explained in the following table.

Click the DentriXlink button to open third-party software, such as a digital X-ray or imaging
program, that has been installed and set up to work with Dentrix Enterprise.

Click the Select Patient button to select a patient whose record you want to view in the Patient

Chart.

Click the Print Dental Chart button to print the patient chart for the selected patient.

Click the Work Chart button to display the work chart view.

Click the Full Screen Chart button to display the full screen chart view.

Click the Progress Notes button to expand the Progress Notes panel to fill the Patient Chart
window.

Click the Treatment Planner button to open the Treatment Planner module.

Click the Perio Chart button to open the Perio Chart module.

Click the Clinical Notes button to display any clinical notes for the selected patient.

B T=EEEEN AN

For a comprehensive explanation of all the buttons on the toolbar, see the “Using the Patient Chart toolbar”
topic in the Dentrix Enterprise Help.
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Using the Graphical Chart

The graphical chart visually depicts the condition of the patient’s mouth. Treatment is shown on the chart
using textbook charting symbols. In addition, treatment is color-coded to indicate the status of the treatment.
For example, completed work can be displayed in blue while recommended treatment can be displayed in red.
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Permanent

In the graphical chart, you can select the teeth you want
to post treatment to by clicking the appropriate teeth.
Selected teeth have a dotted box around each one.

Tip: To deselect teeth, click each tooth you want to
deselect to remove the dotted box, or click Clear below
the procedure buttons.

Using the Procedure Buttons

p4] = [#2]  You can select the treatment to post with the procedure buttons. The 24 procedure buttons
|| [{j=](ge] collectively represent the most common procedures performed in an operatory. Each user-
% [[po|fp=| definable button can represent a single ADA Procedure Code, Dental Diagnostic Code,

W @ multi-code, or condition.

S E|E

£ 8=
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Using the Procedure Code Category Buttons

Diagnostic | Preventive |  YOU can select treatment to post from the procedure code category buttons.

Restorative Endodontics

Each of the procedure code category buttons opens a Select Procedure Code dialog

Periodontics | Prosth, remov

box that displays a list of specific procedure codes

Mazillo Prosth Implant Sery

Select Procedure Code :
for that category. For example, exam and X-ray

Prostho, fixed Oral Surgery

Code D' escription

codes are accessed from the Diagnostic category

Periodic oral evaluation

Oithedonties | dkret®=v | since those are diagnostic procedures. N
omp oral eval-new/estab pat

Conditions Misc. D160 Detail/estensive oral eval, B/R
pmyo Limited re-evaluation estab pat
Dmao Comprehensive perio evaluation
D210 Intracral-complete series [bw]
Dozzo Intraoral-periapical-1st film
Do230 Intracral-periapical-each add'l

Dozyz Bitewingz-two films

Doz74 Bitewingz-four films

D277 ‘Yertical bitewings-7 ta 8 films
D020 Skull &facial bone survey film
00330 Panorarnic: film

D350 Oral/Facial Photographic Images
D0460 Pulp witality tests

D470 [riagnostic casts

ak | Cancel

Using the Status Buttons

The status buttons and fields are used to specify the type of treatment being posted. Once posted, a treatment
appears in the Progress Notes panel and is painted on the graphical chart (if a charting symbol is used in
conjunction with the posted procedure) in the color assigned to that status.

Eo/Ex| Tx | Comp [+

The status buttons consist of the following options:

Existing Other — The EO button is used when entering existing work performed by a provider outside of
your practice. (Used almost exclusively when charting existing work for new patients).

Existing — The Ex button is used when entering existing work performed by a provider within your
practice. (Used almost exclusively when charting past work done by your office).

Treatment Plan — The Tx button is used to enter recommended treatment for a patient.
Completed — The Comp button is used when entering completed work and conditions for a patient.

Auto-State — This button is used to quickly assign several procedures the same status. After clicking the
Auto-State button, the next button selected will remain selected until another procedure status buttons is
selected. While the auto-state is turned off, the button has a plus sign (+). While the auto-state is turned
on, the button remains depressed and has a minus sign (-).

Important: If you do not turn off the auto-state when you finish charting for a patient, whatever status
was selected will remain selected for the next patient’s charting.

Surfaces — This field shows the surfaces, if applicable, for the procedure being posted. You can type a
surface(s) in the field (multiple surfaces must be separated by commas).

Procedure Code — This field shows the procedure code being posted. You can type a procedure code in
the field.

Tip: To clear the procedure code and treatment area(s) from the fields and deselect any tooth/teeth that are
selected on the graphical chart, click Clear below the procedure buttons.
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Using the Progress Notes Panel

Progress notes centralize documentation and exam information to help you quickly review a patient’s history.
If you are viewing the work chart view, the Progress Notes panel is located below the graphical chart. Progress
notes are displayed in chronological order.

Each time a procedure, exam, condition, treatment plan, referral, or clinical note is posted in the Patient
Chart, Dentrix Enterprise adds a line to the progress notes. For each item recorded in the progress notes, you
will see the date the treatment

. D ate Tooth| Surf | Proc | Prov Description Stat | AP | Amount
was entered, treatment arcas (lf 10/15/1936 [ 14 [MOD [ D2160 [DD52 | Amalgam-3 surf. prim/perm C 90.0 A J [‘ Q’
. 1041541996 | 16 D110 [DDS1 | Estraction-single toath C L= VT A
apphcable), the procedure code, 04/12/2002 | 31 D7110 [DROBE | E stractionsingle tooth TP 7| f Leatrn
id d .. 12/15/2008 D670 [DROBE | Periodic orth visit [contract C I E;‘;‘t'i’n”
proviaer, a description, tréatment [7z/15/2006 | 1 D7140 [DROBE | Extract erupted th/exposed it TP TR [
1 241542008 | 16 07140 | DDS2 | Exbract.erupted th/exposed rt [ 1350 |1 Exams
e e e e —fogipa a0 | 5
. Extract ted | b 3 i
and the dollar amount associated {ecelpied i 2uposecl | Eifiletes
w

with that procedure.

Notes:
* Ifa procedure has a note attached to it, a double arrow (>>) is visible to the right of the description.
* Ifaprocedures has a referral attached to it, an “R” is added to the beginning of the treatment status.

You can use the controls on the Progress Notes panel to work with the items in the progress notes. The
following table explains each control.

V Click the Set Complete button to mark the selected treatment-planned
procedures as completed.

[' Click the Delete button to remove the selected treatment-planned or existing

J [‘ Q procedures from the Patient Chart.

V¥ Treat Plan Q Click the Print Progress Notes with Chart button to print the progress notes
I Completed and graphical chart currently being viewed.

[ Existing

[ Conditions .

[ Exams Select the check boxes that correspond to what you want to have show in the progress
[ Proc. Motes | [ notes: treatment-planned procedures, completed procedures, existing and existing other
[ Blinic Notes | | work, conditions, perio exams, procedures notes, and/or clinical notes.

Note: The next time the Patient Chart is opened, those same options will be used as the
default view settings. Each computer on your office network can have different settings,
and each Dentrix Enterprise user can have different settings on any given computer.

Clearing the Patient Chart

To protect the privacy of an individual patient, it may be wise to display a blank chart in your operatories
while waiting for patients to arrive.

To display a blank chart

In the Patient Chart, from the File menu, click Clear Patient.

No patient information is displayed in the Patient Chart until another patient is selected.
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Changing the Provider for a Charting

Session

By default, Dentrix Enterprise assigns all treatment posted in the Patient Chart during a patient’s charting
session according to the default chart provider setting in the Practice Defaults dialog box. However, you can
select a different provider for the current charting session. All procedures posted during the current charting
session will be assigned to the selected provider. The next time a patient is selected, work will automatically

default back to the default chart provider.

To change the provider for a charting session

1. In the Patient Chart, with a patient selected, from the File menu, click

Change Provider. The Select Provider dialog box appears.

24 Dentrix Chart - (Abbott, Patr

2. Select the provider to whom all work posted

. . . . Select Provid
during this session should be assigned. NE—
Search By:
Tip: You can sort the provider list by clicking @ ThisCliric | AllProviders
D Last Mame:
on each header (ID, Name, or Status). | Ias St © AlCiics | InApptBook

3. Click OK. D
4 Dost e

Post treatment for the patient. DDS?
. . .. CROBE
You can change the provider for an individual JKD1
L . MCCLURE
procedure by editing it after it has been
posted.

Mame [ Clinic: 1D
Smith, Dennis D
Brawn, bary D C
Hewitt, Mark 0 C
Robb, David MESA
Kimball, Jacob & MESA
McClure, Jeffrey AF

‘ 3 ’DK | Cancel

Entering Treatment

This section covers the following topics on how to chart treatment in the Patient Chart:

*  Charting Treatment with Procedure Code Category Buttons
e Charting Treatment with the Auto-State Button

*  Charting Supernumerary Teeth
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Charting Treatment with Procedure Code

Category Buttons

You can chart treatment with procedure code category buttons if the procedure for the treatment you want
to enter is not assigned to a procedure button but is assigned to a procedure code category button. For

information about charting treatment with procedure buttons, see the “Charting treatment with procedure
buttons” topic in the Dentrix Enterprise Help.

To chart treatment with a procedure code category button

1. In the Patient Chart, with a patient selected, if the treatment you are entering requires a tooth number,

select the appropriate tooth/teeth in the graphical chart.

2. To select a procedure,
click a procedure
code category
button. In the Select
Procedure Code
dialog box, select the
appropriate procedure
code, and then click
OK.

Note: Procedures

are only available on
the Procedure Code
Categories panel if
those procedures have

been assigned to a procedure code category other than “None” and set
up to be shown in the Patient Chart from the Procedure Code Editor
dialog box. For details about setting up procedure codes, see “Editing

RAL] [DDS1] [ABB102] [11/11/1963] [49]

ocedures  Multi-Codes

Dental Di

nostics

Help

Diagnostic—

—Pravsrmve|

Restorative

Endodontics

Periodontics

Prosth, remov Code

Maxillo Prosth

D020
o140

Implant Sery

~

Prostho, fixed

00150

Oral Surger
s DO160

Orthodontics

Do170

Adjunct Serv DO

Conditions

Procedure Codes” in Chapter 1: Introduction and Initial Setup.

00210

Misc. D220

00230
D272
00274
00277
00230
00330
00350
DO4ED
00470

Select Procedure Code

Dezcription
Periodic orz evaluation
Lirvited oral evaluation,
Comp oral eval-new/gstab pat
D etail/exstensive oral@wval, B/R
Lirited re-evaluationl estab pat
Comprehengive pegio evaluation
Intracral-complete fenies [bw]
Intracral-periapicl-1 st film
Intracral-periapicfl-
Bitewings-two fifng
Bitewings-four ilms

Wertical bitewjhgs-7 to 8 films
Skull &facial pone survey film
Panoramic ffm
Oral/FacialPhotographic Images
Pulp vitalih tests

Diagnostif casts

Cancel |

3. Click the appropriate status button for the procedure being entered. For an explanation of each status, see
“Using the Status Buttons” in this chapter.

4. If the selected procedure requires additional treatment information (surfaces, quadrants, sextants, or
arches), the Surface Selection, Quadrant Selection, Sextant Selection, or Arch Selection dialog box
appears. To specify the appropriate treatment area(s), select all

surface, quadrant, sextant, or arch check boxes that apply; for
surfaces only, click Add; and then click OK.

Dentrix Enterprise posts the procedure to the selected teeth.
The procedure is added to the graphical chart (if a charting
symbol is used in conjunction with the posted procedure) and

the progress notes.

Note: All completed work posted in the Patient Chart is
automatically posted to the Ledger, and the appropriate charges
are listed on the patient’s account. Similarly, all treatment-planned
work is automatically posted to the Ledger-Treatment Plan.
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Charting Treatment with the Auto-State
Button

In most offices, charting is entered in order by treatment status. For example, during a new patient exam, the
treatment provider might first chart existing work and conditions. Once existing work has been charted, the
provider might then enter work that needs to be completed (treatment-planned). Finally, work completed that
day will be entered.

To make charting in this manner easier, Dentrix Enterprise provides the Auto-State button. To save you the
extra step of entering the status for each procedure individually, the Auto-State button keeps the status button
of the type of treatment you are charting selected and assigns that status to procedures entered.

To chart treatment with the Auto-State button

1.
2.

In the Patient Chart, with a patient selected, click the Auto-State button (+).

Leave the Tx button

is selected, or click
the status button
that corresponds to

the type of work you

want to chart.

Note: The selected

status button will

remain selected until

another procedure
status buttons is
selected.

If the treatment you

RAL] [DDS1] [ABB102] [11/11/1963] [49]

‘ocedures  Multi-Codes

Dental Diagnostics

Help

-
-

are entering requires a tooth number, select the

appropriate teeth in the graphical chart.

To select a procedure:, click a procedure code category button.
In the Select Procedure Code dialog box, select the appropriate
procedure code, and then click OK.

B Q@ Diagnostic Freventve ]
H ﬁ’lm ﬁ’lw Restorative Endodontics | geject Procedure Code
ﬁ ﬁ’:sn ﬁun Periodontics Prasth, remoy Code
2| Manilo Prasth | Implant S
!' ’g_‘ﬁ ’LT‘B arillo Prosf mplant Sery oot
,f§/': @ ’E;‘ Prostho, fixed Oral Surgery Bg:‘lgg
.E' ﬁ ﬁﬂl Orthodontics | Adjunct Ser D70
D180
it i D210
w m U Conditions Misc. DO220
[E % @E\D Fi“l Tx l[:omp |+ nggg
00274
Clear L D077
00230
2 1 00330
00350
D460
D0470
6 )or( 6

Description

Periodic orzi ev
Limited oral evaluation
Comp oral eval-new/gstab pat
Detail/entensive oralfeval, B/R
Limited re-evaluationl estab pat
Comprehensive peglo evaluation
Intracral-complete fenes [bw)
Intracral-periapicgl-1 st film
Intraor al-periapical-
Bitewings-two fjims
Bitewirgs-four films

‘Yertical bitevajhgs-7 ta 8 films
Skull &facial pone survey film
Panoramic ffm

Oral/F acialPhotographic Images
Pulp wvitalitp tests

Diagnaostf casts

Cancel

If the selected procedure requires additional treatment information (surfaces, quadrants, sextants, or
arches), the Surface Selection, Quadrant Selection, Sextant Selection, or Arch Selection dialog box

appears. To specify the appropriate treatment area(s), select all
surface, quadrant, sextant, or arch check boxes that apply; for

surfaces only, click Add; and then click OK.

Once you have posted all work for the selected status, click a
different status button to enter work for that status, or click
the Auto-State button (-) to turn off auto-state for the status

buttons.

Surface Select.., @
I~ Mesial
I Incisal/Dcclusal
[~ Distal
I Lingual S
™ Facial/Buccal Quadrant Selec.. @
[ Class Five - Rl oL
S Add
e C LR
Sextant Selection
@ Arch Selection @
I~ 51| s2(I” s3
™ s6| T ss| T s
oK | Cancel | oK | Cancel |
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Charting Supernumerary Teeth

Because it is not possible to select a supernumerary tooth in the graphical chart, it is necessary to post the
procedure to the nearest tooth and then edit the posted procedure with the appropriate supernumerary tooth
number, based on the following ADA recommendations:

Permanent Teeth — Add 50 to the tooth number nearest the supernumerary tooth (for example, 1 =51, 2

=52,3 =53, and 32 = 82).

Primary Teeth — Add an “S” to the tooth letter nearest the supernumerary tooth (for example, A = AS, B
=BS,C=CS,and T =TS).

Editing Treatment

After treatment has been entered into the Patient Chart, you can make changes to the procedure, as needed.
For an THS-completed procedure, do not edit the procedure; delete it, and then re-enter it.

Important:

To provide security and protect the integrity of your patient data, Dentrix Enterprise locks out changes to
procedures once they have been moved into history. (Procedures are moved into history when the Month
End Update utility is run.) Procedures in history cannot be edited or deleted. For information about how
to remove a procedure in history from the Patient Chart by invalidating that procedure, see “Invalidating
Procedures in History” in this chapter.

Procedures attached to an insurance claim cannot be edited until the claim has been deleted. For
information about deleting an insurance claim, see “Deleting Dental Insurance Claims” in Chapter 7:
Ledger. After the corresponding claim has been deleted, the procedure can be edited.

To edit treatment

1. In the Patient Chart, with a patient selected,
from the Progress Notes panel, double-click the
. D Tooth| Surf Description t
treatment item you want to Change. /16/1995 1 Yadult C
! 995 our films C
. . qorF I -1 r
The Edit or Delete Procedure dialog e 0150 [0S Comefal evalnen/estah pa .
bOX appears Edit or Delete Procedure @
k h Operator: | ENTERFPRISE Encounter #:
2' Ma < any necessary ¢ anges: Drate: |01/20/2012 Start [ ate: Completion Date:
° Date — To change the date Procedure: [D1110 ﬂ Prophylasis-adult Frocedure Status
o " Treatment Plan
assigned to a procedure, click in oinic:[PROVD Approval Status
h ﬁ ld d l h .. d Override Ins. estimate Mare
the field, delete the existing date, P s & Congloted
and thCIl fpr the correct date‘ AT ,w ™ Sec. Ins. ™ Existing-Current Prav
S .. . _ P
¢ Clinic — To change the clinic, click RVL; 000 = Do Not Bill Dental Insuance Evisting-Other Prov
the search button **! to select the 2 Provider: DR0BB >3] | I Renie Start/Completion Date.Modifer:
correct clinic.
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*  Procedure — To change the
procedure code, click in the field,

Hotes: |Geeral scaling with hand instruments. Ultrasonic scaler on lower anteriors-lingual. =

delete the eXiSting COdC, and then T Baking soda uzed on upper and lower arch. Flossed all contacts. Patient rinsed
. with a medicated ringe after Px.

type the correct code; or click the Croditeos

search button *”/ to select the Fotatod Feforl

correct COdC. Refered: 1D Nurnber Type 1D Nurnber

|BY: Dr. Evans, Jeff ﬂ Remave -
Delete e Cancel




e Treatment area — Change the treatment area (if applicable): for a tooth,
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edit the Tooth number; for

a surface, click the Surface search button *?. to select the correct surface; for a quadrant, click the

Quadrant search button **/ to select the correct quadrant; for a sextant,

> | to select the correct sextant; for an arch, click the Arch search button

click the Sextant search button
> | to select the correct arch.

*  Amount — To change the amount charged for the procedure, click in the field, delete the existing

amount, and then type the correct amount.

*  Provider — To change the provider attached to the procedure, click the
correct provider.

b

search button to select the

* Notes — If a default note has been associated with this procedure, the note text appears automatically.

Make any necessary changes to the note.

* Related Referral — To add a related referral to the procedure, click the

search button %/, select

Referred To Doctor or Referred By Doctor/Other, click OK, select the appropriate referral source,

and then click OK.
3. Click OK.

Deleting Treatment

You can delete completed, treatment-planned, or existing procedures that were
procedure is in history or attached to a claim. You can also delete conditions.

To delete a completed, treatment-planned, or existing procedure

1. In the Patient Chart, with a patient selected, on
the Progress Notes panel, double-click the
completed, treatment-planned, or existing

posted incorrectly unless the

procedure you want to delete. | Da o Description t
/16/1995 D1110 [DD 1 e C

. . /16/1995 D0274 [0D ou films C

The Edit or Delete Procedure dialog box AT DOTE0 [DDS ;Ww;estab ol c
02/28/2002 | 31 D7110 [DDS E xtraction-single tooth C

appears. 02/27/2012 | 20 _|DL_| DZ150 |DDST | Amalgam-2 sui_prim/perm C

2. Click Delete. On the confirmation message

that appears, click OK.

Edit or Delete Procedure

Procedure: 01110 »» | |Prophylasiz-adult

Cinic: PROVD ]
Override Ins. estimate

I~ Piim. Ins
Amount: 42.00 ™ Sec. Ins.

RVL: 0.0a ™ Do Mot Bill Dental Insurance

Diagnoses: »»

Operatar: | ENTERPRISE Encounter #:
Drate: |01/20/2012 Start D ate: Completion D ate:

Provider: | DROBE ﬂ I” Require Start/Completion Date  Modifier:

sl

Procedure Status

" Treatment Plan
Approval Status
Mone

+ Completed
" Ewisting-Current Prov

" Existing-Other Prov

with a medicated rinze after Px.

Credits >

Related Referal

Motes: |General scaling with hand instruments. Ulbasonic scaler on lower anteriors-ingual.—— »
% Baking zoda uzed on upper and lower arch. Flozsed all contacts. Patient ringed

Referred: 1D Mumber Tupe 1D Mumber
|BY' Dr. Evans, Jeff ﬂ Remove | |[[EEGE)] hd
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To delete treatment-planned or existing procedures

1. In the Patient Chart, with a patient selected, on the Progress Notes panel, click the treatment-planned or
existing procedure you want to delete.
Tip: To select
s A = S — e — =Aaram= m'%il—_u“—_xl Iz |L;omp|+
- iE= POy B '
multiple EEEEEE R o >
procedures, while
B Date Tooth| Surf | Proc | Pro Description Stat | AP | Amount
pressing the Crrl 11/16/1335 D1110|DDS !\ 1 )zt E oo - |V ||
T1/16/19% D274 |DDS o fims £ 32.00)
key on your 1171671335 DOT50 |DDST_| CoMPeral evanewdestab pat E 3600 E E:frgl‘jl':{aeg
; 272672002 | A1 D7110 | DDS1_| Evtraction-single toath £ 700,00 m
keyboard, click 0272772012 | 20 DL | 02150 [DD5T [Amelgam? surf prim/pem t i o
each procedure. " Exams
I Proc. Notes
I Clinic Notes
2. Click the Delete
button [ next to

the progress notes.

On the confirmation message that appears, click OK.

Invalidating Procedures in History

Dentrix Enterprise locks out changes to a transaction once the transaction has been moved to history (when
the month is closed). Posting errors in the Ledger should be corrected using an adjustment. However, the
Patient Chart serves as a clinical record of patient care and needs to be completely accurate. Errors in the
Patient Chart should be corrected to reflect the actual care given.

To address the differences in record keeping between these two modules, Dentrix Enterprise allows you to
invalidate a procedure in history if a posting error is discovered. Invalidating a procedure removes it from the

Patient Chart but leaves it in the Ledger.

To invalidate a procedure

1.
the Progress Notes panel, double-click the
history procedure you want to invalidate.

The Validate/Invalidate Procedure in
History dialog box appears.

Under Validate/Invalidate Procedure,
click Invalidate Procedure.

Click OK.

Dentrix Enterprise removes the procedure
from the Patient Chart. In the Ledger,

a plus sign (+) appears in front of that
procedure’s description to indicate that the
procedure has been invalidated.

Important: Post the procedure again,
using the correct information, except for
the charge amount; make that 0 because
the account has already been billed for

the procedure. Also, make sure the date of
the procedure is the same as the date the
procedure was originally posted.

In the Patient Chart, with a patient selected,

on

Tooth| Surf Description

D1110 Yradult

D0274

0|6 |5

| n|an

DO150

Validate / Invalidate Procedure in History

Walidate / Invalidate Procedure

1 our films
Co al eval-new/estab pat
Start Date:

E
@ Completion D ate:

Operator: ENTERPRISE Clinic; [CENTRAL
D ate: | 0140942000 Encounter #:
Procedure: |DE7H0 Retainer crn-porc fused-hi nob

Overide Ins. estimate
Tooth: ’5_

~ [
—

Modifier:

* ‘“alidate Procedure ¢ Inwalidate Procedure

Frocedure Status
~

MHone

=
e~
.

-

Amovit: 613.00

Rl 0.00

Provider: [DROEE

[ Dao Mat Bill Dental Insurance

Diagnoges: |

Motes:

Credits >

Related Referal

Fieferred: 1D Mumber Type 1D Mumber

2| Remoe] | =l
e Cancel
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Changing the Displayed Dentition

You can change the graphical chart to display primary, permanent, or mixed dentition on a patient-by-patient
basis.
To change the dentition being displayed in the graphical chart

1. In the Patient Chart, with a patient selected, if you are changing the dentition for certain teeth, select
those teeth. If you are changing the dentition for all teeth, you do not have to select any teeth.

2. From the Prim/Perm menu, click one of the following options:

e Change All — Reverses the primary/permanent state for all teeth. For example, if all teeth have been
changed to primary and the Change All option is clicked, all the teeth in the mouth will change to
permanent.

*  Change Selected — Reverses the primary/permanent state for the selected teeth in the graphical chart.

Setting the Default Dentition

You can indicate whether you want the Patient Chart to open with primary or permanent dentition that is
being displayed in the graphical chart for all patients by default.

To set the default dentition

In the Patient Chart, with a patient selected, from the Prim/Perm menu, click one of the following options
(the option with the check mark is the default dentition currently being used):

*  Default to Permanent — Changes all the teeth in the graphical chart to permanent dentition. Also, every
time you open the Patient Chart, the graphical chart will display all permanent teeth, even if you select a
patient that does not have any permanent teeth or that has mixed dentition.

*  Default to Primary — Changes all the teeth in the graphical chart to primary dentition. Also, every time
you open the Patient Chart, the graphical chart will display all primary teeth, even if you select a patient
that does not have any primary teeth or that has mixed dentition.

Then, on a patient-by-patient basis, you can change the dentition as explained in “Changing the Displayed
Dentition” on this page.
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Entering and Editing Procedure

Notes

You can attach default notes to a procedure for documentation and reference purposes so that each time a
procedure with a default note is posted, the note is attached automatically to that procedure. These notes can
also be added manually during posting or at a later time. Once the note has been added, the clinician reviews
the note and makes any small changes that pertain to the specific patient. You can edit procedure notes
attached to a posted procedure at any time if the procedure is not in history.

To enter or edit a procedure note

1. In the Patient Chart, with a patient selected, on

the Progress Notes panel, double-click the
procedure for which you want to add a note.

The Edit or Delete Procedure dialog box

appears.

2. In the Notes field, make any necessary
changes to the note, or type a new note.

3. Click OK.

A double right arrow appears next to the
procedure’s description on the Progress
Note panel to indicate that the procedure
has a note attached.

Tip: You can review procedure notes by
double-clicking a procedure; or, from the
View menu, point to Progress Notes, and

then click Expand Notes.

D Tooth| Surf Description t
/16/1995 01110 |DDS 1 Yadult C
A16/1395 D0274 | DD our films C
A16/1995 DO150 [DDS Col al eval-new/estab pat C
Edit or Delete Procedure @
Operatar:| ENTERPRISE Encounter #:

Drate: |01/20/20012 Start D ate: Completion D ate:
Procedure: (01110 »» | | Prophylasiz-adult Procedure Status
» " Treatment Plan
Clinic: | PROVD = Approval Stalus

Override Ins. estimate Naone
™ Prim. Ins % Completed
AR 3500 [ Sec.lns. " Ewisting-Current Prov

RVL: 0.0 " Existing-Other Proy

Provider:|DROBE ﬂ

I” Do Mot Bill Dental Insurance
™ Require Start/Completion Date  Modifier:

Diagnoses: »»

Motes: |General scaling with hand instr Ultrazonic scaler on lower anteriors-ingual. -
% Baking zoda uzed on upper ch. Flossed all contacts. Patient rinsed
with a medicated rinse after

Credits »» A

Related Referal
Referred:
|Br: Dr. Evans. Jeff

Delete

1D Mumber Type 1D Mumber

ﬂ Remove | |[[EEGE) %

e Cancel
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Working with Clinical Notes

Keeping accurate and thorough documentation of each procedure performed in the dental office is an essential
part of clinical dentistry. In Dentrix Enterprise, you can enter a clinical note to store information about a
patient’s exam and treatment that are not specific to a procedure.

Tip: You can access a patient’s clinical notes from not only the Patient Chart but the Ledger and Family File.

This section covers the following topics about clinical notes:
* Adding Clinical Notes

* Adding Clinical Notes Using Templates

* Editing Clinical Notes

* Adding an Addendum to a Clinical Note

*  Printing Clinical Notes

* Signing Clinical Notes

Adding Clinical Notes

The clinical notes are arranged by date, note number, and then page. You can have as many notes as you want,
with a maximum of 10 pages per note.

To add a clinical note

24& Dentrix Chart - (Abbott, Patri

1. In the Patient Chart, with a patient selected, from the File menu, click —
F1c] Options v

Clinical Notes.

The Clinical Notes window appears.

Click the New Clinical Note button "' @ @ @
Type a note you want to attach to this

patient regarding an exam or treatment @- Clinicl Notes - (AbbmesS} [CENTRAL] [AME.URE] [ABB101] [11/11/1962] [50]

given. HEIE e @0 ) e
4. To add a page to the clinical note, with Notes: (5] (5 SRy
this note still selected in the left pane, &-n1up0 B‘;“gﬂ;jr’fftr'iﬁfg;i'gg‘;:i
click the_New Clinical Note Page 8 ”°* tmoth 1,
button ", In the Change Date and a2 724552 PM DROBICENTRAL @

Time dialog box, leave the current
system time entered, or type a different
time; and then click OK.

&3]

112472011

5. To assign a different clinic than the
currently selected clinic for the clinical note, click the Change Clinic for Selected Note button ¢ 1o
open the Select Clinic dialog box and select the appropriate clinic.

6. Click the Save Clinical Note button €.

Tip: If you need to add additional information to the selected clinical note at a later date and time, click
the Insert Date/Time button ™, and then begin typing the note; although, if the note is locked, you
cannot change a clinical note, but you can add an addendum.
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Adding Clinical Notes Using Templates

Using clinical note templates as a guide when collecting patient information, you can enter clinical notes for a

patient in an orderly manner.

To add a clinical note using a template

1. In the Patient Chart, with a patient selected, from the File menu, click

Clinical Notes.
The Clinical Notes window appears.

24& Dentrix Chart - (Abbott, Patri

Notes: g

L

L,

- 04/16/2013
| B Note#f [11122333]
B8 Pg1 - 1:42:55 PM [AMCCLURE] [CENTR

03/25/2013
0172472012
- 11/2472011

4 I 2

Clinical Notes - {Ahhugmsﬂ [CENTRAL] [AMCCLURE] [ABB101] [11/11/1962] [50]
@-_T‘E‘ - @l r& @lﬁm & El|[QN('m:Templailt:

Lidocaine solution
Lidocaine ointment
Lidocaine spray

Oragix

Procaine

Topicaine anesthetic gel
Topex anesthetic gel
Topex anesthetic spray

ok | [ Caneal

E=3ECR ==
SHE
" Administrative -

3
Local Anesthetic, P
No Injection Given...

Clinical Exams

Endodontics

Fixed Prosthetics

Hygiene

Medical Alerts

Orthodontics

Patient Complaint

Pedodontics | 4

Periodontics

Prescriptions

Recommendations _

m

Click the New Clinical Note button M.

In the Template pane (on the right), expand a category to view the list of available templates for that
category by clicking the plus sign (+) next to the category name, and then double-click the template you

want to use.

Tip: If a clinical note page is not selected when you choose a template, a new clinical note will be added.
So, to add a template to an existing note, make sure the appropriate page of that clinical note is selected.

4. Respond to the prompts associated with the template, if applicable. The template text and any responses

you entered appear in the note field.
5. Click the Save Clinical Note button 4.

For more information about clinical note templates, see the “Creating clinical note templates,” “Creating
clinical note prompts,” and “Setting up clinical note template categories” topics in the Dentrix Enterprise

Help.
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Editing Clinical Notes

You can edit a clinical note that has not been moved into history after the month-end process, that has not
been signed, or that has not been locked.

To edit a clinical note

1.

In the Patient Chart, with a patient selected, from the File menu, click

Clinical Notes.

The Clinical Notes window appears.

Expand the
appropriate date
category in the left
pane, and then
select the page of
the clinical note you
want to edit.

If you are adding to
the note at a date
other than when
the clinical note was
originally entered,
click at the end of

©®» OO
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24E Dentrix Chart - (Abbott, Patri

Clinical Notes - (Abbot}, James S) [CENTRAL] [AME.URE] [ABB101] [11/11/1962] [50]

gl 5 <In N e o = fee
Notes: E R f ’
- 03/25/2013 Patient experiences pain but has no swelling in the
= 01/24/2012 UR guadrant. The pain seems to be associated with
=—htote1 [ ]

®

Pg1 - 12:41:37 PM [DROBE] [CENTRAL]
Pg2 - 12:43:32 PM [DROBE] [CENTRAL]
[ Note#2 []
B 11/24/2011

tnoth 1. @

the text, press Enter, and then click the Insert Date/Time button % (o insert a date and time stamp.

Add to, change, or remove a part of the clinical note as needed.

To assign a different clinic than the currently selected clinic for the clinical note, click the Change Clinic
for Selected Note button # to open the Select Clinic dialog box and select the appropriate clinic.

Click the Save Clinical Note button 2.
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Adding an Addendum to a Clinical Note

You cannot edit a locked clinical note (a note that has been moved into history after the month-end process,
has been signed or approved, or has been locked automatically). However, you can add an addendum to a
clinical note that has been locked.

To add an addendum to a clinical note

24E Dentrix Chart - (Abbott, Patri

Options  View Prim

1. In the Patient Chart, with a patient selected, from the File menu, click
Clinical Notes.

The Clinical Notes window appears.

2. Expand the appropriate
date category in the left
pane, and then select the

Clinical lef - (Abbott, James §) [CENTRAL] [AMCCLURE] [ABB101] [11/11/1962] [50]

.. iy 5 BF | % F Bl L] b =
page of the clinical note SHeRo T WS
. . =] LB
to which you want to Bl =0 R
=-5/13/2010 Performed general scaling with hand instruments. Flossed all contact:
add an addendum. = Hotet
2 Patient rinsed with Peridex after treatment.
. Pg2 - 11:05.28 4M [DDS1] [CENTRAL]
3. Click the New & Moot

Proper technique of brushing demonstrated. Flossing with fingers an:

Ad den dum butt on _‘; X #-1/12/2010 5 older demonstrated. Patient given a soft toothbrush and floss.
._Ih N Add d Mew Addendum - 01 - Note#1 - *Pgl - 12:41:37 PM [DROBEB] [CENTRAL]
¢ INew enaum
; R = |
dialog box appears. “ r Ve : _ =
Proper technigue of brushing demonstrated. Flossing Administrative
with fingers and a floss holder demonstrated, Patient Anesthetics
4' Type thC text Of thC given & soft toothbrush and floss, Clinical Exams
addendum. Endodontics
Fixed Prosthetics
5. If necessary, click the Select Provider @ Hygiene
L. Medical Alerts
button % and/or Select Clinic button —r—
#l 10 select the provider and/or clinic Batientimplafl;
you want to attach to the addendum. Periodontics
Prescriptions
6. Click OK. On the confirmation Recommendations
. Removable Prosthetics
message that appears, click Yes. Restorative
Treatment
X-rays
6 Corcs
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Printing Clinical Notes

From the Clinical Notes window, you can print all clinical notes within a certain date range for the current
patient and/or all members of that patient’s family. For instructions on how to print the Clinical Notes Report
from the DXOne Reporting module, see “List Reports” in Chapter 9: DXOne Reporting.

To print clinical notes

1. In the Patient Chart, with a patient selected, from the File menu, click

Clinical Notes.

The Clinical Notes window appears.

2. Click the Print button 4.

The Print Clinical Notes dialog
box appears.

3. Set up the following options:

*  Select Date Range — Click
Date Range, and then type
a range in the From and
To fields; or, click Relative
Date Range, and then select
a range. The clinical notes
within that date range will
appear on the report.

Tip: Using a relative date
range is recommended if
you are saving your report
settings as the default so that
you do not have to manually
type a date range each time
you run the report.
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24E Dentrix Chart - (Abbott, Patri

Options  View Prim

Clinical Notes - (Abbott, James 5) [CENTRAL] [AMCCLUR

> (Y @ §

|5 o7
Notes:g

[ABB101] [11/11/1962] [50]

;A)F,

- 03/25/2013
E1- 01/24/2012
B Note#1 []

Pg1 - 12:41:37 PM [DROBE] [CENTRAL]

Pg2 - 12:43:32 PM [DROBE] [CENTRAL]

[+ Note#2 []
- 1172472011

tooth 1.

Patient experiences pain but has
UR gquadrant, The pain seems to |

2.2 Print Clinical Notes - (Abbott, James 5) [CENTRAL] [AMCCLURE] [ABB101] [11/11/1962] [50]

Select Date Range
f* Date Range

From: [0a/16/2013
To |p4Ac/2013

" Relative Date Range

| Current Day

-

Patient Selection
&+ Current Patient

All Member's of Current Patient's

Family

G

Feport Type Selection
+ AllMotes
™ Motes Already Approved
" Motes Needing Appraval

‘ 4 ’ Save az Default | Clear Defaults |

Cliriz: S election @
ﬂ v Al

Prowvider /Staff S election
ﬂ v Al

Encounter # 5 election

ﬂWAII

Cancel

*  DPatient Selection — Select whether you want to include clinical notes for the patient currently
selected or for the current patient and anyone else in that person’s family.

*  Report Type Selection — Select whether you want to include all clinical notes, clinical notes that have
already been approved or signed, or clinical notes that have not been approved or signed.

*  Clinic Selection — Click the search button *>! to select the clinic(s) you want to include on the

report, or leave All selected to include all clinics.

*  Provider/Staff Selection — Click the search button > to select the provider(s) you want to include

on the report, or leave All selected to include all providers.

4. To save the current settings for the next time you run the report, click Save as Default.

5. Click OK to preview the report.
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(] ° ° L]
Signing Clinical Notes
A provider can digitally sign a clinical note to indicate his or her approval of the note. Signing a clinical locks

it to prevent changes from being made to the text and to prevent the note from being deleted; however, a
signed or locked note can be appended to.

To sign a clinical note
24E Dentrix Chart - (Abbott, Patri

1. In the Patient Chart, with a patient selected, from the File menu, click

Clinical Notes.
The Clinical Notes window appears. m
2. Expand the appropriate date \ 3 /
category in the left pane and Clinical Motes - (Abbott, James 5) [CENTRAL] [AMCCLURE] [ABEB101] [11/11/1962] [50]
T = ol -
then select the page of clinical uy 5 — [ |‘E i Al ; ol 5
note to want to sign. Notes: = SR -
3. Click the Sign Clinical =1/24/202 Patient experiences pain but has no swelling in
= Note# LR quadrant. The pain seems to be associated
Note button .. 2 Pal - 12.41:37 PM [DFIOBB] [CENTRAL] || ey
Pg2 - 124332 PM [DROBB] [CENTRAL)
‘The Approval Verification i et
dialog bOX appears 1+ | Clinical Notes, Approve @
User Mame: ICardon, Thomaz

4. Type your User ID and
Password, and then click OK. T o a— @

Password:||—
The Sign Clinical Note dialog
bOX appears_ k. I Cancel |

5. In the signature box, sign your
name using a mouse, light pen, finger on a touch

screen, or stylus on a writing tablet.
g

Tip: If you need to clear the signature to re-sign,

Sign Clinical Note

click Clear, and then re-sign. Name: | Denris Srmith (0.0.5.) Date: [04/16/2013
. WARNING: Adding a signature to Clinical N
6- Cth OK will prohibit any editing of the Clinical Note. D( ) OK ] [ Cancel ]
V4

N

When a signature has been added to the clinical
note, a “Signed on [date]” stamp is added to the end of the clinical note.

Note: If you select a clinical note that has been signed, the Sign Clinical Note button ‘£ changes to the
Signature button ‘4. To view a signature for the selected clinical note, click the Signature button.

Printing from the Patient Chart

You can print the following from the Patient Chart:
e Patient’s Chart

*  Datient’s Progress Notes and Chart

*  Referral Recap Report

e Referral Slip
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Patient’s Chart

You can print a patient’s dental chart.

To print a patient’s chart

1. In the Patient Chart, with a patient selected, from £, Dentrix Chart - (Abbott, Patri
the File menu, click Print Dental Chart. The Print Options View _ Prim
Options dialog box appears. ’

2. Select the desired print option(s):

U
*  Print Todays Work — To print completed work - Print Options (]
posted on the current system date. Top Margin in Inchest [ 0.
] . ¥ Print Todays Work
*  Print Treatment Plan — To print treatment-planned work s e
. IV Print Treatment Plan
that was posted on the current system date. Then, to include W Pint TP Estimate Deta (2 ’
a list of treatment-planned work and the billed amount, W' Pint Cht s Displayed

¥ Frint Selected Images

R ; W Include Mates
Estimate Detall- V¥ Include Annotation

patient portion, and insurance portion of each, select Print TP

¥ Include Prev. [1.%] Annotation

e Print Chart as Displayed — To include the graphical chart.

*  Print Selected Images — To include patient images if you are < _ Cancel_|

using Image. You can also include notes and/or annotations.

3. Click OK.

Patient’s Progress Notes and Chart

You can print the progress notes and graphical chart as they are currently being viewed in the Patient Chart.

Tip : If you want to print the progress notes without the graphical chart, switch to the progress notes view in
the Patient Chart, and then complete the steps that follow. For instruction on how to switch the Patient Chart
view, see the “Working with views” topic in the Dentrix Enterprise Help.

To print the progress notes with the chart

the File menu, click Print Progress Notes With
Chart. The Print Progress Notes with Chart dialog
box appears.

Options  View Prim

1. In the Patient Chart, with a patient selected, from : 2 Dentrn Chart - (Abbott, Patr

2. Set up the following options:

Print Progress Motes with Chart @

* Note Range — To print all displayed progress Note Fange:

notes, select All Progress Notes; or, to print notes specific to & 4l Progress Notes

a certain date range, select Date Range, and then type a date " Date Range

range- 041642002 044642013

r Show Encounter Mumbers
¢ Print Procedure Amounts — To include amounts for
rocedures that appear on the report.
p pp p [ Print Procedure &maunts

3. Clle OK ‘ 3 ; oK | Cancel |
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Referral Recap Report

The Referral Recap Report shows any completed work within a specified date range that has been flagged as
“Referred By Doctor.” Treatment-planned work that has been referred to the practice by the same provider is
also included. For information about attaching a referral to a procedure, see the “Editing treatment” topic in
the Dentrix Enterprise Help.

To print a referral recap

1. In the Patient Chart, with a patient selected, from
the File menu, point to Print Referral, and then
click Referral Recap. The Print Referral Recap

24 Dentrix Chart - (Abbott, Patri
| Fild Options  View

Prim

dialog bOX appears. | Print Referral Recap @

2. Under Completed Work Date Range, type the date SLRERLEER
range for the completed referred procedures you C CEEEE  EEER <2>
want to print. Only procedures that were completed aceiton Notes .
within the specified date range and are flagged as “RC” (Referred &

-

Completed) will be included on the report.

3. Type any necessary Additional Notes that you want to have print
on the report.

4. Click Print to send the report to the Patient Chart printer or
Print 4 Batch Cancel

Batch to send the report to the Batch Processor.

N V4
N

Referral Slip

You can print a referral slip for patients to give to the doctor they are being referred to. All procedures that
have been flagged as “RTP” (Referred Treatment Planned procedure) and are within the specified date range
will be included on the slip. The referral slip will also include the patient, provider, and referral’s information,
as well as any notes you have entered. For information about attaching a referral to a procedure, see the
“Editing treatment” topic in the Dentrix Enterprise Help.

To print a referral slip

1. In the Patient Chart, with a patient selected, from
the File menu, point to Print Referral, and then
click Referral Slip. The Print Referral Slip dialog

box appears.

24 Dentrix Chart - (Abbott, Patri

Print Referral Slip

2. Under Date Range, type the date range for the

referred procedures you want to print. Only Date Range
procedures that fall within the specified date From: [04/16/2013  To: [04/16/2013 @)
range and are flagged as “RTP” (Referred Treatment Planned

procedure) will be included on the referral slip. Additiona Notes

3. Type any necessary Additional Notes that you want to have
printed on the slip. @

4. Click Print to send the slip to the Patient Chart printer or Batch

to send the slip to the Batch Processor. /\
Print Batch Cancel

v
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Chapter 5: Perio Chart

The Dentrix Enterprise Perio Chart is a clinical tool that allows you to record mobility, furcation grades,
plaque, calculus, bone loss, pocket depths, bleeding and suppuration points, gingival margins, CAL levels, and
MG] measurements. Automatic calculation formulas allow you to expedite the charting process by eliminating
the need to measure multiple indicators.

Once entered, you can view data numerically or graphically. Also, you can print custom reports, charts, and
letters for an insurance consultant or the referring dental professional.

This chapter covers the following topics:
*  Opening the Perio Chart Window
*  Using the Perio Chart Window

*  Entering New Perio Exams

*  Viewing Perio Exams

*  Changing the Perio Exam View

*  Comparing Perio Exams

*  Printing Perio Chart Reports

Opening the Perio Chart Window

You can open the Perio Chart from the Patient Chart.

To open the Perio Chart

In the Patient Chart, with a patient selected, from the Options menu, click Perio.

Tip: If the selected patient does not have an exam, the Perio icon on the Patient Chart toolbar is gray [ 1
the selected patient has an existing exam, the icon is blue [,

The Perio Chart opens and displays the data for the last exam performed (if one exists) or displays a blank data
chart for you to start a new exam.
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Using the Perio Chart Window

The Perio Chart window is divided into the following areas: the data chart, tooth indicator controls,
navigation controls, and data entry controls.

Data chart Tooth indicator controls

R Dentrix Perio Chart - Abbott, Jaries S(im) - DDSL [04/16/2013]CENTRAL(NEVY) [11/11/1962] [50] [ = | & |34
File Options PerioScore Setp Date Provider Diagnostics Summafy Help
TH| 1| 2| 3[4 |56 F| 8| 9|10 11 [12]13[14[15]|16 Tooth # I ability
PO [1] [Focicacsc {
Bid Tooth Code Furcation Grade(z)
Sup
GM | [nane) | |
%1%'_ Flague Bone Lozs
Fa[ | 0-N ~||o-N -
A cle|e|c |10 Nere =llo-Nore ]

[ Seript <- Arch -
PD ICl >
SBld Prev | Hfme | Mext
L 7/
Gl _
E.“%L *Facial/Lingual

Probing Depth

MG l:l l:l l:l th: PESLPE

T#|32 |31 30(29]es |27 |26 |2a]24(23]22 |21 (201918 |A7

Navigation controls Data ent?y controls
This section covers the following topics about how to use the Perio Chart window:
e Using the Data Chart
*  Using the Tooth Indicator Controls
e Using the Navigation Controls

*  Using the Data Entry Controls

Usmg the Data Chart

TH[TT 2 5[6[718|  You can use the data chart to input and display all

Bl periodontal data relevant to the current perio exam in a
g numerical format. The column that extends down the left
Fa side of the data chart indicates each measurement type.

The following list provides an explanation of the abbreviations used in the left column:

e T# (Tooth Number) — Indicates the tooth number to which the displayed information belongs.
*  PD (Pocket Depth) — Indicates the depth of the periodontal pocket in millimeters.

* Bld (Bleeding) — A red oval in this row indicates a bleeding point.

*  Sup (Suppuration) — A yellow oval indicates suppuration (infection) at that site.

* GM (Gingival Margin) — Indicates the gingival margin (recession) measurement in millimeters.
¢ CAL (Clinical Attachment Level) — Indicates the CAL measurement in millimeters.

*  MG]J (Mucogingival Junction) — Indicates the MG] measurement in millimeters.
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¢ FG (Furcation Grade) — Indicates the furcation involvement for the tooth.

* TC (Tooth Code) — Indicates special conditions relevant to the tooth. Conditions can include the
following: C for crown, P for pontic, I for implant, U for unerupted, M for missing, ID for impacted
distal, and IM for impacted mesial.

e  PMB (Plaque, Mobility, and Bone Loss) — Indicates plaque, mobility, and bone loss measurements
specific to the tooth.

The shading within the data chart has special significance:

*  Yellow areas — Represent measurements taken from the facial (buccal) side of the tooth.
*  Blue areas — Represent measurements taken from the lingual side of the tooth.

*  White areas — Represent measurements that correspond to the tooth in general.

Within the yellow and blue areas, you can input six measurements (three on the facial side and three on the
lingual side) for each tooth.

Using the Tooth Indicator Controls

Tooth Mokilly The tooth indicator controls provide options for inputting data specific to a
[1] [focica2csc 4 . Lo ST
TosthCode  Fuoation Bradeld selected tooth. The information input through the tooth indicator controls
[ fonel ] ||| is displayed in the white areas of the data chart. From the tooth indicator
Plague Bone Loss . . .
l = <]| controls, you can input mobility, furcation grade, plaque, and bone loss. In
Soit < | Awh | - addition, you can reference the tooth number currently selected and a text
Prev | Home | Neut description of any codes associated with that tooth (for example, a crown,

pontic, or implant).
The following list explains the function of each control:
*  Tooth # — This field references the current tooth being charted.

*  Mobility — Click the desired mobility classification. The number appears in the center placement of the
PMB line on the data chart.

*  Tooth Code — This field displays applicable condition information about the tooth.

*  Furcation Grade — Click the search button **| to open the Furcation Grade dialog box, which displays
the furcation grades relevant to the selected tooth. Select the appropriate furcation, and then click OK.

* Plaque — From the list, select the appropriate plaque classification. A corresponding number appears in
the left placement of the PMB line on the data chart.

* Bone Loss — From the list, select the appropriate bone loss classification. A corresponding number
appears in the right placement of the PMB line on the data chart.

137
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Using the Navigation Controls

For quick entry of perio exam data and to facilitate different charting styles, the Perio Chart allows you

to set up a “paths” and “scripts” to indicate the tooth order, site to site movement on each tooth, and the
measurement to be taken (for example, PD, GM, or CAL) at each site. For information about setting up
charting paths and scripts, see the “Customizing perio entry settings” topic in the Dentrix Enterprise Help.

Script <- Arch -»
Prev Home Mext

The navigation controls work in conjunction with the script settings. The following list outlines the function
of each control:

Script — This box displays the tooth number of the current position of the active script. It is a reference
point in case the script is overridden by a different selection, so you know where the script stopped and
where to recommence.

Left Arrow (<-) — Click this button to move from the current tooth to the previous tooth.

Right Arrow (->) — Click this button to move from the current tooth to the next tooth.

Arch — Click this button to switch between the upper and lower arch (or vice versa).

Prev — Click this button to rewind the script from the current tooth to the previous tooth.

Next — Click this button to advance the script from the current tooth to the next tooth in the script.

Home — Click this button to return to the first tooth in the script.

Using the Data Entry Controls

DD T, ees gival margins.

G G G * clinical attachment levels, and mucogingival junction
gingival j

Gingival Margin 1121 3

Clinical &tt, Level 0 | Clear

I:I I:I I:I Path: PESLPE |

“Facial/Lingual The data entry controls allow you to input data specific

Probing Depth to different sites on the selected tooth: pocket depths,
S bleeding and suppuration points, gingival margins,

measurements.

| ow | >
MG

The following list outlines the function of each control:
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Facial/Lingual — Click this button to switch from the facial side to the lingual side of a tooth (or vice
versa).

Probing Depth — Enter the pocket depth measurements.

B (Bleeding) — Click the “B” oval, or press “B” on your keyboard, to indicate a bleeding point on the
tooth. A red oval that corresponds to the selected tooth and site appears on the data chart.

S (Suppuration) — Click the “S” oval, or press “S” on your keyboard, to indicate an infection point on
the tooth. A yellow oval that corresponds to the selected tooth and site appears on the data chart.

Tip: To add both suppuration and bleeding to the same tooth, while hold down the Ctrl key, press “B”.

Gingival Margin — Enter the gingival margin measurements.
Clinical Att. Level — Enter the clinical attachment level.
MG] - Enter the mucogingival junction measurements.

0 — 9 — Click these buttons to enter charting measurements.
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e 1-—To enter a measurement that is greater than nine millimeters, click 1- button followed by the
appropriate number (for example, to enter a pocket depth of 12 millimeters, click the 1- button followed
by the 2 button). Measurements greater than nine millimeters appear as a greater than sign (>) on the
data chart.

* +—To record a gingival margin that is above the CEJ, click the + button followed by the appropriate
number. To indicate that the GM is a positive number, the number appears on the data chart as a white
number in a black square.

e Nxt — Click this button to move from the current site to the next site of the script.
e Clear — Click this button to clear all entries on the current tooth.

* Left, Down, and Right Arrows (<-, v, ->) — Click these buttons to move around the data entry area
(Probing Depth, B, S, Gingival Margin, Clinical Att. Level, and MG]J) without advancing to another
tooth.

e Path — This button always displays the current path being used (for example, PBSL, PBSR, or none).
To manually switch between paths while charting, click the button until the desired path appears on the
button.

Entering New Perio Exams

Dentrix Enterprise offers a great deal of flexibility for entering data into a perio exam. You can enter only the
most basic information, such as pocket depths. Or, if you want to do a more comprehensive exam, almost
every perio classification and measurement is available to be charted and noted.

To enter perio measurements

24& Dentrix Chart - (Abbott, Patri

1. In the Patient Chart, with a patient selected, from the Options menu, click
Perio.

The Perio Chart opens.

Tip: If a patient has an 2

existing perio exam, Dentrix Dentrix Perio Chart - Abbott, J msw DDS1 [04/16/2013]CENTRAL(NEW) [11/11/1962] [50] | = | & [[wZa]
m Dat

Enterprise automatically File | Options Perio Score m Provider Diagnostics Summary Help
h THI1 | 2| 34|56 7|[8]83 \R 1213|1415 |16 Tooth # b obility
opens the most recent exam || [1] Foriczcary
as a reference. You can save  ||£8 \ ToothCode _Furcation Gradels]
. b . l h Gk \ | [none] | >>|
time by entering only the | Plaque Bon Loss
measurements that have EK 3) clelele \ w [1ONere  xflo-None -]
H P Script
changed since the last exam. [P0 \ B < | Awh | >
g SBld \ Prewv | Home Mext
up
. G .
2. To choose the script that CaL N *Facial/Lingual
matches your charting style o Picting Depth
) y g ty b4 Eld
click Setup on the menu i
. CAL +
bar. To select the desired M
path, click the Path button |} L] Mt
. 5 FD
until that path’s name i
up >
appears on the button. e MG !
. M l:l l:l l:l Path: FESLFE
3. Enter perio measurements, T# |32 |31 (30|29 28|27 |25 | 25 [ 24| 23] 22 | 21 |20 [ 19| 18] 17 4

following the selected path
and script. To enter information not included in the script, use the controls located on the right side of
the Perio Chart.
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The following list contains the keyboard commands that can be used if you prefer using the keyboard for
data entry:

*  Numeric key pad — Works the same as the number buttons on the data entry controls.
*  Number keys — Work the same as the number buttons on the data entry controls.

*  PAGE UP — Works the same as the Prev button on the data entry controls.

*  PAGE DOWN - Works the same as the Next button on the data entry controls.

*  HOME - Works the same as the Home button on the data entry controls.

¢  DELETE — Clears all entries in the current selection. Works the same as the Clear button on the data
entry controls.

*  Arrow keys — Works the same as the arrow buttons in the data entry controls.

*  Asterisk (¥) — Works the same as the Facial/Lingual button on the data entry controls. It toggles
between the two surfaces of the selected tooth.

* ENTER - Advances the selection through the current script settings.

4. From the File menu, click Save Exam.

Viewing Perio Exams

Once an exam has been saved, it can be viewed at any time.

To view an existing exam

[M Dentrix Perio Chart - Abbo

Options  Perio Score

1. In the Perio Chart, from the File menu, click Open Existing
Exam.

Perio Chart Open

The Perio Chart Open dialog box appears.
) 01/25/2012
Select the exam that you want to view.

Clle OK Delete
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Changing the Perio Exam View

From the Perio Chart, you can view perio data in several different formats. This section covers the following
view options:

*  Viewing the Graphic Chart
*  Viewing the Combined Graphic and Data Chart

*  Viewing Quadrants

Viewing the Graphic Chart

Unlike the data chart, which displays perio data numerically, the Perio Chart’s graphic chart view displays
numeric perio data in a graphical representation. You cannot add or change data while in the graphic chart

view.

To view the graphic chart
In the Perio Chart, from the Options menu, click Graphic Chart.

—— e N

o

— Gingival Margm —— Clmical Attachment Level —— Mucogmgival Junction
¢ EBleedimg © Suppuration ¢ Bleedmg and Suppuration
Furcation: F1 +» F2 < F3 w F4 w Mobility: 1 2 2 4 [ Prb Depth

141
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Viewing the Combined Graphic and Data
Chart

In the Perio Chart, you can view a combination of the data chart and graphic chart. Numerical data appears
above the graphic portion of the chart. You cannot add or change data while in the data and graphic chart view.

To view the combined graphic and date chart

In the Perio Chart, from the Options menu, click Combined Graphic & Data Chart.

—— [CAL = Climcal Attachment Level
[ = Central @ Bleeding 2 Suppuration = Bleedmg and Suppuration
M = Mesial Furcation: F1 - F2 =~ F3 w F4 ~w Mobility: 1 2 3 4 B PD="PrbDepth

© Dentrix 1990 - 2008

Viewing Quadrants

You can enlarge a quadrant to view that area close up.

To zoom in on a quadrant
1. While viewing the data chart or graphic chart, click in the quadrant you want to view.
2. From the Options menu, click Quadrant Zoom.

3. If you want to zoom back out to see all quadrants or to select a different quadrant to zoom in on, while
in the quadrant zoom mode, right-click anywhere in the window to zoom out so that all quadrants are
being viewed in the graphic chart (the pointer changes to a magnifying glass), and then click the desired
quadrant.

4. When you are finished using the quadrant zoom feature, from the Options menu, click Quadrant Zoom
again to get out of the quadrant zoom mode.
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Comparing Perio Exams

To help you educate your patients regarding periodontal disease progression, you can compare up to four
saved perio exams with the current exam.

To compare exams

1. In the Perio Chart, from the Options menu, click Exam Comparison. ¥ Dentrix Perio Chart - Abbe
—Fi-h-lml Perio Score
The Perio Comparative Selections dialog box appears. ’Tn 1[2]3 ’ a[5]¢
FD
2. Under Compare, SClCCt the type Of Comparison Peric Comparative Selections - @
that YOU want ViCW: Comnpare Select Comparizon Exam
. . * Probing Depths (Data) 10/16/1995
* Probing Depths (Data) — To review B 01/25/2012
a data comparison of probing depth 2 g c @
—
measurements. E_I]nlcal Attachmlint Lewvel
*  Gingival Margin — To review a comparison ® iy (et

" Furcation Involvement [Data)

of gingival margin measurements. Select
whether to view a Graphic or Data

- -
representatlon.

Dizplay

= Cancel
* Clinical Attachment Level — To review a 3)'— o
. . |— =0
comparison of CALs. Select whether to view -

a Graphic or Data representation.

*  Mobility — To review a data comparison of
mobility measurements.

*  Furcation Involvement — To review a data comparison of furcation grades.

3. Under Display, select what you want to display: MGJ Line, Bleeding, Suppuration, Mobility, or
Furcation Involvement. These options are not available if Probing Depths (Data) is selected under
Compare.

4. Under Select Comparison Exam, select the exams you want to compare to the current exam.

Click OK.

[B Dentrix Perio Chart - Abbott, James S(lim) - DDS1 [04/16/2013]CENTRAL(NEW) [11/11/1962] [50] o] @ (=
File Options Perio Score Setup Date Provider Diagnostics Summary Help
Probing Depth Comparison

MAXILLARY TOOTH # 1 2 3 4 5 b 7 ] 9 [10 [11 (12 |13 |14 |15 |16
| DCM DCM DCM DCM DCM DCM DCM DCM MCD MCD MCD MCD MCD MCD MCD MCD
_ Facial _05£12f2010 123123412364612354675123746712354761235465125536
Change T X TR + + T
| 05{13f2010 234671234871263647(612374273614551511231231234676
_ Lingual 05£12f2010 145362155453214321(323213213255155325614563216/554
Change TR IEED A T T I IR
05{13f2010 764372[167632614321(876[413872643[261/864362[176/231[321

MANDIBULAR TOOTH # 32 |31 |30 |29 (28 |2
DCM DCM DCM DCM DCM DC

~

26 (25 |24 (23 (22 |21 |20 [19 [18 |17
DCM DCM MCD MCD MCD MCD MCD MCD MCD MCD

=

_ Facial 05/12f2010 235455465231 654712(354651235465123566125364255(345
Change L Mokt bkt H L otk ot
| 05/13/2010 128364123417 236617236(471234[123451236412534523[155
_ Lingual 05/12f2010 212435P264532157432156/432564/321432154631527453]215
Change T IEY YT t b
05/13/2010 212[154553(251/455/321(453[216/456(321[545/135[245532[145321
LEGEND
[_TOOTH CODES
M Missing 0to 9 mm below the CE.J )+ >1mm and 2mm worse
U Unerupted > >»9 mm below the CEJ - >2mm worse
P Pontic A 1 mm above the CEJ 4~ >1mm and 2mm better
I Implant B 2 mm above the CEJ >2mm better
C Crown C 3 mm above the CEJ
IC Implant+Crown D 4 mm above the CEJ
ID Impacted Distal E >4 mm above the CEJ

IM Impacted Mesial
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Printing Perio Chart Reports

From the Perio Chart, you can print a variety of different charts and letters with periodontal exam
information.

To print the Perio Chart reports

1. In the Perio Chart, while viewing the exam you want to

].I Dentrix Perio Chart - Abbott, James S(Jim) - DDS1 [01/
print, from the File menu, CliCk Print. @- File | Options Perio Score Setup Date Provider
TR 1| 2| 3[4[5[6 78 3[M0][T[
The Perio Print Selections dialog box appears. po, 12 111 221 22{ 12 BN O e
2. Specify the letters and information you want to print: & ¢
CAL|NR| 111|221 |222] 212 211|z1z|1z1 [ |2
*  Letters — Select any of the following letters P ==
that you want to print (Microsoft Word Lstters Charts R e
. I Insurance Consultant ™ Data Chart
must be installed): B Eere
™ Pocket Depths Only il
. [ Patient Initia - Z
* Insurance Consultant Letter — Printsa | - 22000 @l— Graphic Chart 1
letter that can be sent as documentation | | Patient Completion I Combined GraphicDataChat | - (IS
{,‘P : d d B [ Refering Dentist |nitial ™" Exam Comparison S BT
of Perio disease diagnosis to an e 221(212|2
Refering Dentist Progress
insurance carrier. I™ Refering Dentist Completion Print Cancel
e Patient File — Prints a document that ekl QST b Bl e Gl
. . ) Sup 0
B
can be placed in the patient’s chart that gaL| 111|121 [212{111 | 112|121 |211 212 ] 221 |2n2 121 |
documents the perio diagnosis for the -
lected exam |32 (31|30 20| 28|27 |28 | o5 | 2a | 23] 22| 2
selected exam.

*  DPatient Initial — Prints a letter that can be sent
to the patient to remind him or her of perio diagnosis and to suggest home care aids.

*  Patient Progress — Prints a follow-up letter that can be sent to provide an update for the patient
on his or her perio status.

*  Patient Completion — Prints a congratulatory letter that can be sent to a patient on the
completion of his or her perio treatment. The letter contains several helpful reminders to aid the
patient in maintaining perio health.

*  Referring Dentist Initial — Prints a letter that can be sent as documentation of Perio disease
diagnosis to the referring dentist.

*  Referring Dentist Progress — Prints a letter that contains updated diagnostic information for the
referring dentist.

*  Referring Dentist Completion — Prints a letter that contains final diagnostic information and
explains that the patient should be returning to the referring dentist for general dental care.

e Charts — Select any of the following perio chart information that you want to print:
* Data Chart — Prints the data chart.
*  Pocket Depths Only — Prints the data chart but only includes pocket depths.
*  Graphic Chart — Prints the graphic chart (will print in color if sent to a color printer).

* Combined Graphic & Data Chart — Prints the graphic and data chart (will print in color if sent
to a color printer).

*  Exam Comparison — Prints the exam comparison chart. This option is available only if you are
viewing an exam comparison.

3. Click Print.
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Chapter 6: Treatment Planner

The Treatment Planner can help you provide your patients with easy-to-understand treatment options. When
the Treatment Planner is opened for a selected patient, his or her entire treatment plan is used to create a
default treatment plan case. You can set up additional cases and visits, and you can view detailed treatment
and insurance information. Also, you can group procedures in a treatment plan case by visit or by case to
provide patients with different treatment options.

This chapter covers the following topics:
*  Opening the Treatment Planner

*  Using the Treatment Planner Window
*  Customizing Case Settings

*  Selecting the Case Details to Display
*  Working with Treatment Plan Cases
*  Viewing Case Status History

* Adding Consent Forms to Cases

*  Signing Consent Forms

* Editing and Deleting Procedures

*  DPosting Completed Procedures

*  Updating Treatment Plan Fees

*  Generating Treatment Planner Reports

Opening the Treatment Planner

You can open the Treatment Planner from the Patient Chart and Ledger.

To open the Treatment Planner

In the Patient Chart or Ledger, with a patient selected who has treatment-planned procedures, from the
Options menu, click Treatment Planner.
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Using the Treatment Planner Window

The Treatment Planner window consists of a menu bar, toolbars, the Treatment Plan panel, the case details,
and the graphical chart or progress notes.

Treatment Plan Panel Case Details Graphilca\ Chart

= Dentrix Enterprise [Treatment Planner - Baber, Kirk O [BA0O001] [06/23/1964] [48]

i File Edit Optiony Wiew Insurance Help
W EYEC BT 2 AR D E S @ e wino
s m0ols 8 53Ol

Case Status: Created: 5/1 Case Severity: Mone
(¥ VisitNot Se
Code Th | Surf Description Fee Pat. Portion
: 5 1] D2110 4 O, Arnalgarn-1 surface, primary 123.10 123.10
& Case 123,10 $0.00
Created: 5/17/2010 |8
Treatment Plan
Created: 51772010 Treatment Plan Case Total $123.10
Estimated Deductible Applied $0.00
Estimated Insurance Payment $0.00
Estimated Guarantor Portion $123.10

[ Include Rejected Cases

(. Treatment Plan Case Setup

a Insurance/Case Amounts

This section covers the following topics on how to use the Treatment Planner window:

e Using the Treatment Planner Toolbar

*  Using the Treatment Plan Panel
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Using the Treatment Planner Toolbar

The Treatment Planner includes toolbars with buttons you can click to access certain areas or features of
Dentrix Enterprise.

D $ 0052830

The function of the buttons specific to the Treatment Planner are explained in the following table.

@

Click the Refresh button to update the data from other modules, such as the Ledger or Patient
Chart.

£

Click the Update Treatment Plan Fees button to update the treatment plan fees manually to
reflect any fee schedule changes.

Click the Primary Dental Insurance Notes button to view the primary dental insurance plan
note for the primary dental insurance plan of the patient currently being viewed in the Treatment
Planner. You also have buttons for secondary, tertiary, and quaternary dental insurance if the
current patient has those particular types of insurance coverage.

Click the Insurance Benefits button to view a summary of the current patient’s insurance benefits.
You also have the option to include all family members.

Click the Print button to print one of the Treatment Planner reports.

Click the Treatment Planner View button to select a Treatment Planner view.

Click the Copy Case Detail to Clipboard button to copy the case detail currently being displayed
to the Windows Clipboard so that you can paste the information into a word processing program.

g &L L&

Click the Other Appointments button to view appointments that have been scheduled for the
patient selected in the Treatment Planner and that patient’s family members.

For a comprehensive explanation of all the Treatment Planner toolbars, see the “Using the Treatment Planner

toolbars” topic in the Dentrix Enterprise Help.
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Using the Treatment Plan Panel

From the Treatment Plan panel, you can assign treatment to cases, set the order of the visits, create alternate
cases, view insurance estimates, add supporting information, view case history statuses, and set up the default
settings and required consent forms for new cases.

The Treatment Plan panel consists of several sections that you can open by clicking the corresponding section
button.

w2 ORItV IEE

Coostad: 5772010
Cooeiad: 51772010
o
et Al L
—‘_-'/f El

Treatment Plan
B 1PN p(orosed: 05713/2008

Include Completed Cases
[ Include Rejected Cases [ Include Completed Cases
[ Include Rejected Cases

|z Treatment Plan Case Setup

£l Insurance/Case Amounts |ix Treatment Plan Case Setup

- Supporting Information Section ﬂ Insurance/Case Amounts Section
Buttons - N . Buttons

(&) Case Status History - Supporting Information

@ Settings @ @ ]

Note: If you resize the button area so that not all the buttons fit on the panel, a smaller version of any section
button that does not fit on the panel in its full size appears at the bottom of the panel.

The following is a brief explanation of each section;

*  Treatment Plan Case Setup — Open this section to assign treatment to cases, create and link alternate
cases, set a recommended case, change the status of a case, set the severity level for a case, set the order of
visits for a case, add and sign consent forms, complete procedures, and print Treatment Planner reports.

* Insurance/Case Amounts — Open this section to view insurance estimates, treatment plan case totals,
insurance plan notes, and patient and family benefit details.

*  Supporting Information — Open this section to add notes and consent forms to a case.

*  Case Status History — Open this section to assign and view status changes for a case. You can also create a

referral.

*  Settings — Open this section to set the defaults for all new cases that are created and to manage consent
forms.
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Customizing Case Settings

Before treatment planning a case, set up the case defaults. Changes made to the default case settings affect all
other computers on your practice’s network, and the selected settings will be used for every new case that is

created.

To customize case settings

In the Treatment Planner, on the Treatment Plan panel, from the Settings section, set up the following
options:

*  Default Settings for New Cases

Estimate Expires — Select the default expiration date for all cases: Default Settings for New Cases

“1 year from current date,” “3 months from current date,” “1 Estimate Expires:

» « . . » |
month from current date,” “Beginning of next calendar year, Dl Case Nete Templste
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“Beginning of next fiscal year,” “Beginning of next month,” or [INDNE] =] [[Template Setup

“Prim. Ins. Benefit renewal month.”

Default Case Note Template — Select the default that will be

used to create case notes from a template. “[NONE]” is the only option that is available until another

template has been set up. To add, modify, or delete a template, click Template Setup.

*  Automatic Case Status Updates — Select the case statuses that you want to be added automatically to the
case status history:

Automatic Caze Status Updates

Select which Case statuses should be

Printed — A case will be updated with the “printed” status when the  Ziamaticaiy appied

case is printed.

Frinted

Proposed — A case will be updated with the “proposed” status to

present or propose the case to the patient.

Note: If you select a status, the status is automatically applied to the current case.

*  Setup Consent Forms — Any existing consent forms that will be used for new cases appear in the list box.
Do any of the following:

Setup Conzent Forms

New — To add a consent form, click New. Cansent Forms:

Edit — To edit an existing consent form, select that consent form,

and then click Edit.

Delete — To delete a consent form, select that form, click Delete,
and then click Yes to confirm the deletion.

Mew...

[ Select Procedure Information

Select Procedure Information — To select what procedure

Select Electronic Signature Device:

information is allowed on consent forms by defaul, click Select [Pointing Device
Procedure Information.

Select Electronic Signature Device — Select the device that will be used to sign cases at this
computer.

Important: If you are using Terminal Services or Citrix on this computer to connect remotely to a
computer with Dentrix Enterprise installed, an ePad will not work for signing consent forms from

this computer.

For a comprehensive explanation of all the available case settings, see the “Customizing case settings” topic in
the Dentrix Enterprise Help.
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Selecting the Case Details to Display

You can specify what, if any, procedure information you want to be displayed in the case details area.

To select the procedure information to display

1.

In the Treatment Planner, from the View menu, click Procedure Information.

The Procedure Information dialog box appears.

Insurance Help

@_ .

<# Dentrix Enterprise Treatment Planner - Baber, Kirk O [BA0001] [06/23/1964] [48]

[ iEnitry Date |

[F] Procedure Date
Procedure Code

Toath

Surface

Provider

Description

[ Procedure Progress Notes

Select the columns you want to display for each Case.
Fee
[ Other Fee )

Select All
Patient Portion
[ Primary Dental Insurance Estimate

B fary Dental | Exct

[ Pre-Est
e —

W EVLY RO O seBH & I!Ei& Ta'g 8 @ saber, kirko
i & 555, 2.l
Procedure Information

le Status: Created: 5/13/2010

b

Case Severity: Mone

(® Visit Not Set

Code Th
Dzii0 4

Surf
D,

Description
Amalgam-1 surface, primary

Fee Pat. Portion
123.10 123.10
$123.10 $0.00

Treatment Plan Case Total $123.10
Estimated Deductible Applied $0.00
Estimated Insurance Payment $0.00
Estimated Guarantor Portion $123.10

2. Select the information you want to display in the case details. The case details will have a column for each

information item that is selected.

3. Click OK.

Working with Treatment Plan Cases

Treatment-planned procedures can be grouped into a case. This section covers the following topics about

treatment plan cases:
.
Creating New Cases

Creating Alternate Cases
Linking Alternate Cases

Setting the Recommended Case

Ordering Procedures by Visit
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Using the Treatment Plan Case Setup Section
The Treatment Plan Case Setup section

g Il td aEE on the Treatment Plan panel displays the

o Treatment Plan 1 treatment plan cases that have been created
N Created: 01252012 )
D050 Comp oral evalnew/estab pat fOI‘ a patlent.
[D1207: Prophylasis with fluoride-child
Bl D2160: Amalgom3 su. prin/perm [#13 MOD] As you select a case in the list, the other
3 D220 Amalgam-2 suface, primary (R>] [#14 D, L] . .
py Case2 sections (except for Settings) on the panel
.
Created: 5/17/2010 .
o and the case details are updated to reflect
aze ) . .
'S Created: 51772010 the information for the selected case.
Treatment Plan

/ Created: 5142010

Include Completed Cases
[ Include Rejected Cases

The function of each button on the section’s toolbar is explained in the following table.

Click the New Case button to create a new treatment plan case you can use to group treatment-
Y g
planned procedures.

n Click the Delete Case button to delete the selected treatment plan case.

Click the Link Alternate Cases button to link alternate treatment plan cases together so that,
e when one of the cases is accepted, the others are automatically rejected. You can also set the
recommended case.

L Click the Update Case Status button to change the status of the selected treatment plan case.

@ Click the Set Case Severity button to specify a severity for the selected treatment plan case.

Click the consent forms button to add, sign, or view consent forms for the selected case. The
appearance and functionality of the button varies depending on the status of the consent forms
for the case:

?‘ There are no consent forms attached to the case. Click the No Consent Forms button to
' add consent forma to the selected case.

The case has at least one unsigned consent form. Click the Case Has Unsigned Consent

Forms button to sign the consent forms.

The case has at least one consent form that is missing one of the two required signatures.
Click the Consent Forms Missing Signature button to sign the consent forms.

All the consent forms for the case have been signed. Click the All Consent Forms Have

Been Signed button to review the consent forms.

t ‘ Click the Move Case Up button to move the selected case up one place in the list. Click the
Move Case Down button to move the selected case down one place in the list.
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i Click the Print button to select a Treatment Planner report you want to print.

Click the Expand All button to view all the treatment-planned procedures for every case listed.

= Click the Collapse All button to show only the name and date of every case listed.

You also have the following options at the bottom of the Treatment Plan Case Setup section:

Include Completed Cases — Selecting this option includes completed treatment plan cases in the case list.
Include Rejected Cases — Selecting this option includes rejected treatment plan cases in the case list.

Create Visit — When procedures that have not been assigned a visit number are selected, clicking this
button [Z] creates a new visit that is given the next available number for the corresponding case.

Delete Visit — When procedures that have been assigned a visit number are selected, clicking this button
(2] deletes the visit from the corresponding case.

Creating New Cases

The Treatment Planner groups treatment-planned procedures by case. There is always a default treatment plan
case, but you can create additional cases as needed.

To create a new case Treatment Plan Case Setup

1.
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In the Treatment Planner, on the Treatment Plan panel,

. . Treatment Plan 1
from the Treatment Plan Case Setup section, click the fa) Created: 0172572012
New Case button * . The new case appears in the case list. g

Type a name for the case, and then press Enter to apply the
name.

Select the procedures in the Treatment Plan [1]
default case that need to be ls
put in the new case (to select

multiple procedures, while

pressing the Curl key, click the procedures), and then click again and drag the selected procedures to the

new case.

'ﬁﬁ‘ Created: 5A18/2010

Tip: All treatment-planned procedures are automatically added to the default case (“Treatment Plan” is
the name if it has not been renamed). If all the procedures in the default treatment plan case are part of
the same case, you can rename the default case instead of creating a new case and moving the procedures.
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Creating Alternate Cases

Alternate cases can be created for the same set of treatment-planned procedures. Creating alternate cases
provides patients with several treatment plan options. An alternate case is linked to the original case.

For example, a patient may need a tooth extraction and an implant or bridge. One treatment plan case can
include the root canal and an implant. An alternate case can include a root canal and a bridge.

To create an alternate case

Treatment Plan Case Setup

w2 ORItV HEE

Renarme Case

1. In the Treatment Planner, on the Treatment Plan panel, from
the Treatment Plan Case Setup section, select the case for
which you want to create an alternate case. Right-click that
case, and then click Create Alternate Case.

B ooen:
1 IDIENE

E D216 Set Case as Patient's Default Treatment Plan
The Create Alternate Case dialog box appears. 3 D21z

Consent Forms...
2. Verify that the case being displayed in the Create Alternate
INk. AICErNale ases

Case For list is the case for which an alternate case is Set & ecommended Case
Create Alternate Case @

Delete Case

being created.
Create Alternate Case for: N

Tip: The selected case is the case that will be flagged as the EIEEETI =
. I of Al Case:
recommended case. If you do not want this case to be the C )am permate Case

K K K Treatment Plan 1 Alternate
recommended one, you can select a different case while in Joct procedurcs 1o copy into alterate Cose:

this dialog box, or you can change the recommended case I DBOA0: Comprehensive ortho, adul dert
w| D2730: Crown-full cast high noble mtl [#19 ]
later. v 03330 Root canal therapy - molar [#15 ]

™| 01110: Propl dult

3. In the Name of Alternate Case text field, type a name for @

the alternate case.

4. Select the procedures you want to copy to the alternate

case. 5 Yok ] [ cons

Tip: The procedures common to the alternate cases are
procedures that must be treated regardless of which
treatment plan is selected. For example, since a root canal therapy must be completed regardless of the
type of restoration placed on the tooth, root canal therapy must be included in both cases.

5. Click OK.
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Linking Alternate Cases

When you create an alternate case, the alternate case is automatically linked to the original case. Also, if you
have created cases that are all alternate cases for each other but are not linked, you can link them manually.
You can link several treatment plan cases together if necessary; however, make sure each case is functioning as
an alternate treatment plan being offered to a patient.

Additionally, linking cases can be beneficial for updating statuses. For example, if you apply an Accepted
status to a case, the other linked cases are automatically given a Rejected status.

To link alternate cases

Treatment Plan Case Setup

w2 ORItV IEE

Renarme Case

1. In the Treatment Planner, on the Treatment Plan panel, from
the Treatment Plan Case Setup section, select a case that is
already linked to another case, or select a case that you want to
be the recommended case and link to another case. Right-click
that case, and then click Link Alternate Cases.

The Linked Cases dialog box appears.

D 50:
D1201:

E D2160: Set Case as Patient's Defaulk Treatment Plan

Delete Case

3 D20 Consent Forms...

2. Ifyou right-clicked a case that is not already linked, from oE 5 PETIEIeT S
the Recommended Case list, select the recommended Linked Cases ==
case; otherwise, this list is unavailable and displays the Recommended Case: g
recommended case you right-clicked or the recommended case for Letmen Pon Q) -
the case you right-clicked. Linked Cases:

3. Select the cases you want to link. At least two cases must be &4 TisementEiEn

v Treatment Planl

SCICCth. v Treatment Plan2 @
4. Click OK.

Tip: Linked cases have link icons (B or B after them. The
background color of the icon varies, depending on how many sets
of linked cases exist for the patient; for example, you could have
two cases linked together and two other cases linked together, and
the background color of the link icon for both of those sets will be different.

Setting the Recommended Case

The recommended case is the case that contains the recommended treatment plan. The recommended case
can be changed after alternate cases have been created.

To set the recommended case

Treatment Plan Case Setup

v QR 1tV SEE

Renarme Case

In the Treatment Planner, on the Treatment Plan panel, from the
Treatment Plan Case Setup section, select the case you want to set
as the recommended case. Right-click that case, and then click Set

; L. . . . 1 e
as Recommended Case. This option is unavailable if the case is Diony|  Deete Cese
. D21 BU: Set Case as Patient's Defaulk Treatment Plan
not linked to an alternate case. 2
3 D&z Consent Forms...

Tip: The link icon Bl after the case will become starred El. The

starred link icon after the prior recommended case becomes a

normal link icon.
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Ordering Procedures by Visit

You can organize treatment-planned procedures within a case into visits when more than one visit will be
required to complete the treatment plan. For example, a patient could have a root canal performed and a
temporary crown placed on the first visit and then the final crown seated on another visit.

To order procedures by visit

155

1. In the Treatment Planner, on the Treatment Plan Treatment Plan
panel, from the Treatment Plan Case Setup section, |zt el U AT

expand the appropriate case by clicking the plus sign D2750: Crevrvporc fuse high noble mi (83 ]
(+). 02150 Ams

Delete Procedurels)
Set Complete

Create Yisit

2. Select the procedures that will be completed in one
visit (to select multiple, while pressing the Ctrl key,
click each procedure). Next, right-click one of the selected Move to Visit 1 (HEW)
procedures, and then click Create Visit. The visit number appears next
to the procedures.

Repeat this step for all subsequent visits of the treatment plan. As visits are created, the number of the

visit increases (1, 2, 3, and so forth).

Treatment Plan
EREE-Y Croated. 5H19/2010]

D01 50; Comp oral eval-newdestab pat
02140; Amalgam-1 swif, primdperm 19 B.]
E D2 60; Amalgam-3 swif, primdperm [H13 MOD]

Viewing Case Status History

As a case is created and modified, the Treatment Planner tracks the changes in status and provides a way for
you to view those changes. After reviewing the status history of a case, you can update the case status.

To view and update the status history of a case

Treatment Plan Case Setup

1. In the Treatment Planner, on the Treatment Plan panel, from
the Treatment Plan Case Setup section, select a case.

2. Open the Case Status History section for the selected case,

which is shown at the top of the section. —
ase

Case: Created: BA7/2010

The Case Status History table displays the status history for

Caze Status History:

the selected case, which includes the date of the change, the Date Status o
08A7/2010 Created Case was set
current status of the case, and any comments made at the A cieated e

time of that particular change.

3. If necessary, to update the status of the case, under Update @
Current Case Status, from the New Case Status list, select
the appropriate status, and then click Update.

Tip: You can also update the status for a selected case by
clicking the Update Case Status button * on the Treatment
Plan Case Setup section’s toolbar. < i |

Update Current Case Status

Mew Caze Status:  |Propozed 3
Caomment:

| /

I
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Adding Consent Forms to Cases

You can add consent forms to cases for a patient and provider to sign. You can set up consent forms from the
Settings sections of the Treatment Plan panel.

To add a consent form to a case

1. In the Treatment Planner, on the Treatment Plan panel, from
the Treatment Plan Case Setup section, select a case. Next,
right-click the case, and then click Consent Forms. The
Dentrix Consent Forms dialog box appears.

2. From the Select Consent Form list, select the form you want

to add to the selected case.

3. Click Add.

The Consent Form dialog box appears.

Dentrix Consent Forms
4. Under Patient/Representative signature, the patient selected in
the Treatment Planner is entered in the Name field but can be Foms for sejeced Cese
changed. Also, the Relationship to patient has “Self” entered by B
default but can be changed (for example, you can type “Spouse” Date | Consent Fom | Signatures
or “Parent” if the person signing the form is the patient’s spouse
or parent). The name and relationship can be edited at a later
time (for instance, when the consent form is going to be signed).
5. Under Practice signature, click the Name search button |z to mnfapens et
select the provider (primary or secondary) who will sign the form,

or you can type the provider’s name in the field. The name can
be entered at a later time (for instance, when the consent form is

going to be signed).

Tip: The consent form can

be signed by the patient and
provider at a later time. Also,
both signatures do not need to
be acquired at the same time.
For information about signing
consent forms, see “Signing
Consent Forms” in this chapter.

Click Save.

To print the consent form, click
Print. You can print any consent
form, signed or not.
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Treatment Plan Case Setup

2 ORItV HEE

Rename Case
Delete Case
Set Case as Patient's J3

B ooven:
1 IDIENE
ER D2160:

3 D21am

b Treatment Plan

Consent Forms... a

Create Alternate Case

Link Alternate Cases
Set as Recommended Case
Unlink Selected Case

Select Consent Form:
Consent for Anesthesia ‘ :: ’ m 3

Consent Form = @
Consent for Treatment ﬁ -
|, the undersigned patient, hereby authorize the undersigned provider to perform the procedure(s) or course(s) of -

treatment listed below. | understand my dental condition and have discussed several treatment options with the i
undersigned provider. | have been given a printed copy of the procedure or treatment details and any post-op =
instructions.

| understand the risks inherent in the treatment{s). | have discussed these risks with the dentist. The dentist has
Addressad all nnestions and concems | have nreserted | nnderstand the exnected results of the nocedured=) or

Patient/Fepresentative signature

Practice signature

Clear Clear

MName: | Kirk O. Baber MName:

Date: 041672013 @ Date: 041672013

Relationship to patient Self
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Signing Consent Forms

The patient and provider can electronically sign consent forms attached to a treatment plan case. Once a
signature is added to a consent form and the form is saved, the signature cannot be removed. The consent
form is considered locked once both parties have signed it (both parties do not have to sign on the same date).

To sign a consent form

1.

Treatment Plan Case Setup

w2 ORItV HIEE

Renarme Case

In the Treatment Planner, from the Treatment Plan Case
Setup section of the Treatment Plan panel, select a case that
needs to be signed. Next, right-click the case, and then click
Consent Forms.

B ootsn:

Delete Case
[1 0EE

et D
E DZ1E0: Set Case as Patient's b Treatment Plan

The Dentrix Consent Forms dialog box appears.
Create Alternate Case

Double-click the consent form you want to sign. The Dentrix Consent Forms
Consent Form dialog box appears. Forms for selected Case:
Informed Consent

Under Patient/Representative signature, if the Form

correct patient is not already entered in the Name Date | Consert Fom s
field, type the name of the person who will sign the AL e

form. Also, if the correct Relationship to patient is
not already entered, type a relationship (for example,
“Self,” “Spouse,” or “Parent”). Then, have the patient or [ Remove Seecied Form |
patient’s representative sign in the box using an input

Select Consent Form:

device. Consert for Anesthesia LI
Note: You can click Clear if the patient needs to re-sign.

‘This button is unavailable if the consent form has been
saved with a signature (even
the slightest mark registers as a
signature) or no signature has

been added yet. Once the form is @ @
. Clea Clea
saved, the signature, name, and ' '

Patient/Representative signature Practice signature

relationship cannot be changed. o et Name:
Date: | 047162013 Date: | 041162013
Under Practice signature, if the Relationship to patient Self

correct provider is not already
entered in the Name field, click
the search button 2] to select
the provider (primary or secondary) who will sign the form, or you can type the provider’s name in the
field. Then, sign in the box using an input device.

Note: You can click Clear if you need to re-sign. This button is unavailable if the consent form has been
saved with a signature (even the slightest mark registers as a signature) or no signature has been added yet.
Once the form is saved the signature and name cannot be changed.

Click Save.

To print the consent form, click Print.
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Editing and Deleting Procedures

You can edit or delete existing treatment-planned procedures that are not in history.

To edit or delete a treatment-planned procedure

Treatment Plan
1. In the Treatment Planner, on the Treatment Plan = Created: 5772010
panel, from the Treatment Plan Case Setup section, 2750 Crown-porc fuse high noble mi [#3 ]
expand the appropriate case by clicking the plus sign D2150: Amalgam-2 surf. primperm [#14 MO ]
(+), and then double-click a procedure. 05120 Complete denture - mandibular [#18-31
P
The Edit or Delete Procedure dialog Edlit or Delete Procedure =
b()X appears‘ Operatar:| ENTERPRISE ncounter #: ||
f h {: ll . Date: |0416/2013 Start D ate: Completion Date:
2' DO one of the 1o OWIHg' rocedure: |D2391 »» | | Rakin composite-1=, posterior Procedure Status
" % Treatment Plan
*  Make any necessary changes, and Cinc: CENTRAL Approval Status
. . . Toaoth: {14 Overide |ns. estimate N -
then click OK. For information ootief 14 _— —
Surfaces:’l\u‘l,i . tim. s " Completed

about the options that are wmon[—0% || T — £ Ersting Current Prov

available for editing, see “Entering - £ Evisting Dthe Prow

T » . h 4 P . 0.00 ™ Do Mat Bill Dental Insurance

reatment  1n C apter : Fatient ‘ 2 Provider. |DDS1 ﬂ ™ Require Start/Completion Date  Modifier:
Chart' [™ Owvenide Proc Flags

¢ Click Delete and then OK to delete
Di. g
the procedure. The treatment- g Bl
l . f Motes: Bsg:ral scaling with hand instruments. Ulrasonic scaler on lower anteriors-ingual. — »
P anned procedure 1S removed rom | OR % BakMng soda used on upper and lower arch, Flossed all contacts. Patient rinsed
. with a medicated rinse after Px.
the Treatment Planner, Patient Crodters
Chart, and Ledger-Treatment Plan. T
Referred: |0 Mumber Tupe 1D Mumber

Tip: To delete multiple procedures at the [ B B de 2| Remove| z
same time, in the Treatment Plan Case 2 oeke -

Setup section, while pressing the Cerl
key, click the procedures you want to
delete. Next, right-click one of the selected procedures, and then click Delete Procedure(s). Then, on the
confirmation message that appears, click Yes.

Posting Completed Procedures

After you complete procedures, you can post those procedures from the Treatment Planner.

To post a completed procedure

In the Treatment Planner, on the Treatment Plan panel,
from the Treatment Plan Case Setup section, expand
the appropriate case by clicking the plus sign (+), right-

& Treatment Plan
Created: 5A7/2000

D27a0: Crown-porc fuse high noble mtl [#3 ]

click the procedure you want to complete, and then D21l ame

click Set Complete. In the case details, a blue check 05120 Cor ]
mark appears next to any completed procedures. Create Visit

Tips: Mave to Visit 1 (NEW)

* To complete multiple procedures at the same time, in the Treatment Plan Case Setup section, while
pressing the Ctrl key, click the procedures that you want to complete. Next, right-click one of the selected
procedures, and then click Set Complete.

*  To set all the procedures in a selected case complete at the same time, click the Update Case Status
button * on the Treatment Plan Case Setup section’s toolbar, and then click Completed.
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Updating Treatment Plan Fees

To maintain the integrity of treatment plan estimates, Dentrix Enterprise does not automatically update the
fees for procedures assigned to a treatment plan. If your fees have changed since the time a treatment plan
was given to a patient, that treatment plan can be manually updated for that patient from the Treatment
Planner to reflect any fee schedule changes if certain criteria you specify for the procedures are met. You can
also update treatment plan fees for all patients with treatment-planned procedures matching the criteria you

specify.

To update treatment plan fees

1.

In the Treatment Planner, from the Edit menu, click Update
Treatment Plan Fees.

The Update Treatment Plan Fees dialog box appears.

Set up the following options:

Update Treatment Plan Fees For — To update the fees for
the currently selected patient only, select “Current Patient.”

To update the fees for all patients with treatment plans,
select “All Patients.”

Procedure Information — This tab
provides the following options for
updating treatment plan fees:

Procedure Code(s) — Select
the procedure or range of the
procedures to update for From and

To. To update all procedures, leave
From “<All>” To “<All>"selected.

Procedure Date Before — Select the
cut-off date to use for updating fees
for treatment-planned procedures.
Only treatment-planned procedures
dated on or before the selected date
will be updated with the new fees.

Tx Clinics — To update treatment-
planned procedures performed in
specific clinics, select the desired

€

O

4f Dentrix Enterprise Treatment Planner - Baber,
—F m Options View Insurance Help

N EBHEY 2O R
< B -l

Treatment Plan Case Setup

x_é‘ '@‘f 13

1

Update Treatment Plan Fees
| Ipdate Treatment Plan Fees FBr:ICL"TE'-It Patient LI I
{Procedure Information | Case Information |
L 42 G LA e i e g e
Procedure Code(s) From: | <plls lz‘ To: | <Al |Z|
Procedure Date Before: 04/16/2013 E
Tx Clinics: Tx Providers: Eilling Type for Patient's Guarantor:
AF AMCCLURE  » 1: Standard Biling -finance charges
CENTRAL DDs1 T : Standard Billing - no finance charge
DRAFPER DDs2 : Insurance Family - delay finance che
MESA DEF_PROW : Insurance Family - finance charges
Mo_Clinic DESMITH £ : Payment Flan -finance charges
PINEDALE DHAYES : Payment Plan - no finance charges
PROVO DRO1 o Statement and Mo Finance Char
SPRING DROBB —  |8: Bad Debt - at risk
DSMITH 5: Bad Debt - to collections
ENTERPRISE
HYG1 =
All All All
Treatment plan fees will be updated from the current fee schedules.
[ Update | [ cancel

clinics (to select multiple clinics, while pressing the Cerl key, click each clinic), or leave All
selected to update procedures for all clinics.

Tx Provider — To update treatment-planned procedures performed by a specific provider, select
the providers (to select multiple providers, while pressing the Ctrl key, click each provider), or

leave All selected to update procedures for all providers.

Billing Type for Patient’s Guarantor — If you are updating treatment plan fees for all patients,
to update treatment-planned procedures for patients with specific billing types, select the billing
types (to select multiple billing types, while pressing the Ctrl key, click each billing type), or leave
All selected to update procedures for patients with any billing type.
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*  Case Information — This tab provides the following options for updating treatment plan fees:

*  Current Status — To update treatment-

. . Update Treatment Plan Fees
planned procedures in cases with =
. Update Treatment Flan Fees For: |Cumsrt Patisnt e

specific statuses, select the case poate Trestment Flan Fees For
statuses, or leave All selected to update Etocedure hjorpotiog, | s Informaton
treatment-planned prOCCdureS il’l cases Update Treatment Planned Procedures in Cases With

. Current Status: Case Financing Flag:
with any status.

Created - In Progress
. . Printed K Needed
*  Case Financing Flag — To update Prefuth (Frm) |5 Not Necessary
. Pre-Auth (Sec) F- Pending More Information

treatment-planned procedures in cases Folow-Up Made

. . . Refemed 2
with specific financing flags, select the = il
financing types, or leave All selected to ety
U»Pdate treatment’planned pfOCCdUJ'CS Immediate [] Exclude Default Treatment Plan
. . . Eventual . L.
in cases with any financing flag. Optiona] [F] Estimate Expiration Date Before:

None
e Severity — To update treatment- A

planned procedures in cases with
SPCCiﬁC case SCVCl'itiCS, SCIeCt the Treatment plan fees wi updated from the current fee schedules.
severity levels, or leave All selected to 3 Yuese ) [ Conce
update treatment-planned procedures

in cases with any severity.

*  Exclude Default Treatment Plan — To exclude all procedures added to a default treatment plan,
select this option.

* Estimate Expiration Date Before — To update fees for procedures in cases created prior to but
not on the date specified, select this option, and then select a cut-off date.

3. Click Update.

Important: Depending upon which fee schedule is assigned to the patient, the fee for the patient’s
treatment-planned procedures might not have been updated or not updated with the fee you might have
expected. For more information about fee schedule hierarchy, see the “Updating treatment plan fees”
topic in the Dentrix Enterprise Help.
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Generating Treatment Planner Reports

You can print the following Treatment Planner reports:

*  Treatment Case Report — To report on a specific case.

e  Patient Treatment Case Report — To report on the current patient.
*  Practice Treatment Case Report — To report on the whole practice.

You can customize the data that prints on each of these reports.

To generate a Treatment Planner report

1. In the Treatment Planner, on the Treatment Plan panel, from the Treatment Plan Case Setup section,
select a case.

From the File menu, point to Print, and then click the report you want to generate.

Set up the report options. The options for each report are explained in the sections that follow.

4. Click OK.

Treatment Case Report Options

From the Print Treatment Case dialog box, set up any of the following options:

e Print — Select the information you

Print Treatment Case @
want to include. Select Report Options:
¢ Insurance — Select the insurance | efaut Modied] =
. f . 1 d Print Insurance Case Procedure Options
Information you want to exclude. [] Treatment Plan Total [] Hide Dental Insurance Benefits Select Visits:
To include the amount of any [E] Finane Status [ Hide Insurance Estimtes <ALL>
. . . Enter wisit be dior visit
deductibles applled, select Use [C] Patient Balance [] Hide Family Insurance Benefits rannzg_lséx;;r:b:?.;n&gr e
1 Family Bal Use Dental Plan Maxi
Dental Plan Maximums and E gl B [ Use Dental Plan Maximums ] Print Subtotals by Visit
: Fee Expiration Dats
DeduCtlbles- B P [] Use Patient Friendly Descriptions
) Trestment Case Note [T Hide P; t'wt 55N [ Include Procedure Mot
*  Patient Privacy — Select the [F] Graphic Chart ide Fatien nelude Frocedure Hotes
. . . [T] Hide Patient Chart Number 7] Exclude Completed Procedures
patlent mformatlon you want to [T] signed Consent Forms ) ) )
1 d [ Hide Patient Birthday [F] Compare to Fee schedule:
X .
exclude 1. Office
* Case Procedure Options _
Appearance Options
*  Type a visit or range of visits Tooth Style: [Shaded <] Website Address:
(for example, 1, 3, 5-7) you Report Style: [Contemporay |
. - E-mail Address:
want to include on the report Header Style: [Provider Name | 1)
in thC Select ViSitS ﬁeld, or [[] Use Cover Page
leave “<ALL>" entered to -
. . . Save Options... Manage Options... Print Preview oK Cancel
include all visits. [ tite...) | Meteos Oploms... [ J )

*  Select the visit-specific information you want to include.

* To include a comparison of the current fee schedule to a selected fee schedule, select the Compare to

Fee Schedule search button -, and select a fee schedule.
Tips:
* To save the current report settings as a set for the next time you run this report, click Save Options.

* To preview the report before printing it, select Print Preview.
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Patient Treatment Case Report Options

From the Patient Treatment Case Report dialog box, set up any of the following options:

* Procedure Code Date Range — Enter a
date or date range of treatment-planned

procedures posted in the range to include.
To include all dates, select All Dates for

From and To.

e Case Fee Expiration Date Range —
Enter a date or date range of cases with
an expiration date within that range to
include. To include all dates, select All

Dates for From and To.

*  Select Provider — To select a provider
or range of providers for the patient’s
treatment-planned procedures to include,
click the From and To search buttons

, and select the providers. To include

all providers, leave From “<ALL>" To

“<ALL>” entered.
*  Report Options

e Select the options that correspond to
the information you want to include.

* To include a comparison of the current

Patient Treatment Case Report

Procedure Code Date Range

Oz =1, Olsras =]

(®) &l Dates (@ &l Dates

Fram:

By (&
Caze Fee Expiration [ ate Fange

Ofrae =] ., Offeneam =]

(®) &l Dates (@ &l Dates

O Procedure Date

Fromm:

Select Provider

Fram: Ta

Eeport Options
Primt Subtotals by Wisit

Inzlude Finance Status

[[] Use Patient Frisndly Descriptions

[] Exclude Completed Procedures from Case
Include Patient B alance

Include Farmily Balance

[] Use Dental Plan Maximums and Deductibles

Compare to Fee Schedule: | 1. FEE1
Select Columns...

[ Save as Default
[ Print Preview

Include Cazes With

LCasze Status:

Created

Printed

Pre-Auth [Prim]
Pre-Auth [Sec]
Follow-Up Made
R efered
Fropozed
Accepted
Fiejected
Completed

All

Caze Severity:

Immediate
Eventual [Future]
Optional

MOME

All

Fatient Privacy
[] Hide Patient S5M
[] Hide Patient Chart Mumber
[] Hide Patiert Birthdate

fee schedule to a selected fee schedule, select the Compare to Fee Schedule search button -, and

select a fee schedule.

* Include Cases With — Select the case statuses that you want to include, or select All to include all

statuses. Also, select the case severities that you want to include, or select All to include all severity levels.

*  Patient Privacy — Select the options that correspond to the patient information you want to exclude.

Tips:

* To save the current report settings as a set for the next time you run this report, select Save as Default.

* To preview the report before printing it, select Print Preview.
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Practice Treatment Case Report Options

From the Practice Treatment Case Report dialog box, set up any of the following options:

*  Select Patient — To select a patient or -
Practice Treatment Case Report

range of patients with treatment-planned clade Canes it
ncluge Lases \With:

d . h h . 1 d Include Clinic: Choose Patient Clinic By:
pr‘oce ures within the range to include, - R Case Simte.
click the From and To search buttons (-] PO € Trastmon Case e
and select the patient(s). You can also type Seloct Pationt oy AN
. = Pre-futh (5
names or partial last names (for example, From: | <ALL> FetowLp tade
. . . Refemed
From “a” To “¢”) in the fields. To include Tor | kALL> Proposed
. Azcepted
all patients, leave From “<ALL>” To Procedure Code Date Ronae Rejected
« ALL 3 d = g Completed
< >” entered. o a
rom:
* Procedure Code Date Range — Enter a © All Dates
Tre@mmy
date or date range of treatment-planned By © Entry Date [ — ase Severity
. . Immediate
procedures posted in the range to include. . Evertual (Future)
. Case Fee Expiration Date Range Optional
To include all dates, select All Dates for ) ] NONE
From: To: A
From and To. Also, select whether you K P —— Al

want to include procedures by Entry Date

Select Provider Patient Pris
or Procedure Date. afient Privacy

From: | <ALL» Too | <ALLs [7] Hide Patient SSN

[ Hide Patient Chart Number
[] Hide Patient Birthday

*  Case Fee Expiration Date Range —
. Select Billing Type
Enter a date or date range of cases with
. . L. From: | <All> To: | <ALl
an expiration date within that range to
include. To include all dates, select All Report Options

[] Print Condensed Report [ Print Preview
Dates for From and To. _ _
[ Print Subtotals by Visit

7] Include Finance Status

[[] Save as Default

*  Select Provider — To select a provider
or range of providers for the patients’
treatment-planned procedures to include,
click the From and To search buttons
, and select the provider(s). To include
all providers, leave From “<ALL>” To
“<ALL>” entered.

7] Include Procedures for Treatment Case

Use Patient Friendly Descriptions 0K ] [ Cancel

[ Use Dental Plan Maximums and Deductibles
7] Exclude Completed Procedures from Case
[T Include Case Status History

e Select Billing Type — To select a billing type or range of billipes of patients with treatment-planned

procedures to include, click the From and To search buttons [>=-J, and select the billing type(s).
*  Report Options — Select the information you want to include.

* Include Cases With — Select the case statuses that you want to include, or select All to include all
statuses. Also, select the case severities that you want to include, or select All to include all severity levels.

* DPatient Privacy — Select the patient information you want to exclude.
Tips:
* To save the current report settings as a set for the next time you run this report, select Save as Default.

* To preview the report before printing it, select Print Preview.
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The Dentrix Enterprise Ledger displays a wealth of information in an easy-to-read format. Also, from the

Ledger, you can enter payments, file claims, print statements, and much more.

This chapter covers the following topics about using the Ledger:

Using the Ledger Window
Selecting Ledger Views

Changing an Account’s Billing Type
Entering Transactions

Editing Current Transactions
Deleting Current Transactions
Invalidating Transactions in History
Processing Dental Insurance Claims
Working with Treatment Plans
Generating Ledger Reports

Using Fast Checkout

Posting Batch Guarantor Payments
Posting Batch Insurance Payments
Searching for Payments

Working with Payment Agreements
Working with Notes in the Ledger

Performing Month-end Routines
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Using the Ledger Window

The Ledger window consists of the menu bar, toolbar, transaction log, and various sections containing

financial information.

Transaction log
/

E Dentrix Ledger - (Abbott, James 5) [CENTRAL] [DROBE] [ABB101
File Options View Transaction Insurance
Description Amount Balance

01/09/2000 [James S Abbo 5 DE7S0 “Hetainer cin-parc fused-h E13.00{ DROBE CENTRAL Mo 579.00( .
02/28/2002 | <Family> Payment “Check Payment - Thank You i -37.00| DDS1 CEMTRAL h42.00
01/09/2012 [James S Abba g DE7S0 Retainer cm-porc fusedh E13.00{ DROBE CEMTRAL o 115600
01/09/2012 | James S Abbo 5 DE240 Pontic-parcelain fused to 620.00| DROEB CENTRAL o 1775.00
01/09/2012 | James S Abbo 7 DE240 Pontic-porcelain fused to 620.00{ DROEB CENTRAL o 2395.00
01/20/2012 |James S Abbo D245 Apically positioned flap 0.00] DROEE PROYO o 239500
014202012 [James S Abbo D110 Prophylaxiz-adult 48.00[ DROEE FROYO o 2443.00
/3142012 | James 5 Abbo D40 Lirited oral evaluation 35.00) DROEB CENTRAL 2478.00
01/31/2012 | James 5 Abbo DoE0 D etail/estensive oral eva 38.00) DROEB CENTRAL 2516.00
02/13/2012 Jlames 5 Abbo Dent Ins. Prirn Clairn - Sent 7200 ZE1E.00] ~

0->30 | 31->60 | 61->90 | 91-> [ Suspended | Palient Balance | Today's Charges 0.00

197400 | 000 | o000 | 7300 | 000 | 267700 Est. Dental Ins. Portion 0.00

Est. Patient Portion — o
0->30 | 31->60 | 61->90 | 91-> | Suspended | Family Bal ki = = =
204300 | 000 | 000 | 7020 | 49620 | -2207.00 \ el AgEEEl Sy
Monthly Pmt 100.00 Pmt Due 0.00
Billing Type (4] Insurance Family - finance charges mt Past Due 0.00 Due Date —O5/PN0P
Last Guar. Payment R000.00 Date 01./31/2012
Last Ins. Payment 8000 Dale 04/05/2002 Future Dug Payment Plans Summna
Last Statement Date 02A14/2m2 000 Payment n.oa
tstanding Billed to Medical/Dental 0.00473.00 0.00 Due Date
Expected from Dental Insurance 73.00 \
Guarantor Portion of Total Balance 2B86.20
\

| Today's
charges

Payment
™ agreement
summary

Future due
| payment
plan

Account information

Aged balances

This section covers the following topics to help you understand how to use the Ledger window:

e Using the Ledger Toolbar

*  Viewing the Transaction Log
*  Viewing Aged Balances

*  Viewing Account Information
*  Viewing Today’s Charges

Viewing Payment Agreement

Viewing Future Due Payment
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Using the Ledger Toolbar

The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

The function of the buttons specific to the Ledger are explained in the following table.

Click the Patient Financing button to go to the Citi website to sign up and manage patient
financing options.

Click the Select Patient button to select a patient whose record you want to view in the Ledger.

Click the Billing/Payment Agreement button to view and add payment agreements and change
account billing types.

Click the Guarantor Notes button to enter notes for an account and/or that accounts billing
statements.

Click the Enter Payment button to enter patient payments.

Click the Enter Procedure button to post procedures to a patient’s Ledger.

g O E & [E] B B

Click the Ins. Today’s Proc button to create and then display and/or batch (according to the setup
options selected) an insurance claim for any procedures posted on the current system date.

=
=

Click the Ins. Selected Proc. button to create and then display and/or batch (according to the setup
options selected) an insurance claim for the selected procedures.

Click the Print Walkout button to display and/or batch (according to the setup options selected) a
family walkout statement.

Click the Print Statement button to display and/or batch (according to the setup options selected) a
billing statement.

Click the Print Family Ledger button to display and/or batch (according to the setup options
selected) a family ledger report.

Click the Fast Checkout button to perform a fast checkout (according to the setup options selected).
Click the Patient Alerts button to enter or manage the alerts for the patient currently being viewed
in the Ledger.

Click the Clinical Notes button to manage clinical notes regarding the treatments for the patient
currently being viewed in the Ledger.

[0 <= = S E
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Viewing the Transaction Log

The transaction log is a record of all transactions posted to a patient or family’s account. For each transaction,
the date, patient or guarantor name, tooth number (when applicable), procedure code or type, a description,
amount, provider, and clinic are shown and whether or not insurance has been billed is indicated.

Date Name Tooth| Code Description Amount Provider Clinic Ins| AP| Balance
1041541336 | <Farmily> Payrnert *Check Papment - Thank You i} -34.00) DDST -34.00
02/28/2002 | <Family> Payment *Check Papment - Thank You it -37.00{ DDST CEMTRAL -71.00
01/09/20012 [James 5 Abba 5 |DEFSEO Retainer crn-porc fuzed-h E13.00| DROER CEMTRAL 54200
01/09/2012 | James S Abbo 8 [DE7R0 Retainer crn-porc fuged-h E13.00{ DROBE CEMTRAL 1155.00
01/09/2012 | James S Abbo E |[DE240 Pontic-porcelain fuged ta E20.00{ DROBE CEMTRAL 1775.00
01/09/2012 [James 5 Abbo 7 | DE240 Pontic-porcelain fused to E20.00| DROEE CEMTRAL 23595.00
01/09/2012 J James S Abba Dent Ins, Prirn Clairn- Sent_2466.00 23595001

Four symbols can appear in the description column to provide useful information about a transaction:

>> A double arrow to the right of a description indicates that there is a note attached to the

procedure.

* An asterisk to the left of a description indicates that the transaction has been moved to history.
History transactions cannot be edited or deleted.

+ A plussign to the left of a description indicates that the procedure has been invalidated.
Invalidated procedures still show on the Ledger but no longer display in the Patient Chart.

A A caret to the left of a description indicates that the procedure has been back dated to a month

W

that has been closed out. When the procedure is moved to history, the “A” will change to a

Viewing Aged Balances

The aged balances and the total balances for the current patient and family are displayed. Any suspended
amounts are also shown.

0->30 | 31360 | 61->90 | 91-> | Suspended | Patient Balance
1216720 | 000 | 000 | @00 | 000 | 1216720
0->30 | 31-»60 | 61-290 | 91> | Suspended | Family Balance
1216720 | 000 | 000 | o000 | 000 | 12167.20

Viewing Account Information

The account information displayed includes the billing type, amount and date of the last guarantor payment,
amount and date of last insurance payment, date of the last statement, total amount of all outstanding claims,
estimated amount insurance will pay, and estimated amount of the patient portion.

Billing Type [1] Standard Eiliing - finance charges

Last Guar. Payment 000 Date

Last Ins. Payment 0.00 Date

Last Statement Date

Dutstanding Billed to Medical/Dental 0.00/12675.00
Expected from Dental Insurance 3000.00
Guarantor Portion of Total Balance 9675.00

Viewing Today’s Charges

For the current system date, the total of all transactions, the estimated amount that dental insurance will pay
according to the coverage setup in the Family File, and the estimated amount the patient owes according to
the coverage setup in the Family File are displayed.

Today's Charges 125.00
Est. Dental Ins. Portion 0.00
Est. Patient Portion 125.00
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Viewing Payment Agreement Information

If a payment agreement exists for the account, the current status of the agreement is shown. For information
about setting up payment agreements, see “Creating Payment Agreements” in this chapter.

Payment Agreement Summar:
Monthly Pmt 44817 Pmt Due 44817
Amt Past Due 0.00 Due D ate 1242042008

Viewing Future Due Payment Plan
Information

If a future due payment plan exists for the account, the current status of the payment plan is shown. For
information about setting up future due payment plans, see “Creating Future Due Payment Plans” in this
chapter.

Future Due Payment Plans Summar:
Original Bal. 300000 Payment 250000
Remain Bal. 2500.00 Due Date Thu, 15th
Selecting Led Vi

While in the Ledger, you can choose to display account information in several different ways.

To switch between the Ledger views

*  Options — In the Ledger, with a patient selected, from the Options menu, select a view option. The
option with a check mark is the view currently being used. The Ledger title bar also indicates the current
view.

* Ledger — When first opened, the Ledger displays all transactions posted during the current month for
the selected patient.

*  Ledger + History — You can see all transactions for the selected patient, including history
transactions.

*  Treatment Plan — You can view and work with a patient’s treatment plan.

*  View — In the Ledger, with a patient selected, from the View menu, select a view option. The checked
option is the view currently being used.

*  Show Transaction Links — When the transaction for which you want to find links is selected,
you can see all of the procedures that are linked to an insurance claim and all of the payments and
adjustments that are linked to a procedure.

e All With Running Balance — You can view transactions for the entire family. In addition, a column
is added to the right side of the transaction log that displays a running balance for the account.

*  Family Members — You can quickly switch to any family member’s ledger by selecting that family
member.

169
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Changing an Account’s Billing Type

You can change the billing type associated with an account or family at any time (for instance, when the
account has been sent to collections). The billing type is used on many of the Dentrix Enterprise reports to
filter for the data you want to appear on a given report. You can change the billing type from the Family File

or Ledger.

To change an account’s billing type

1. In the Ledger, with a patient selected, from the File menu, click

Billing/Payment Agreement.

The Billing/Payment Agreement Information dialog box appears.

2. Select a Billing Type.

Tip: To add a note about the change
in the billing type, click Guarantor
Notes.

3. Click OK.

ﬂ Dentrix Ledger - (Abbott, James 5) [CENT

Insur

o]

Options  View Transaction

Billing/Payment Agreement Information

Biling Type: | 2: Standard Billing_ -ho finan_c:e charges

3 Insurance Family - delay finance charg

-
_ Guarantor Mates |

4: Insurance Family - finance charges

0->30 | 31260 | 61-»80 | 91> | Suspended | Balance |~ Last Papment
204500 000 oo0| 71020 498620 [-2207.00 {Amwnt 500000 Date: [o1/31/2012

— Payment Agreement [Pa)

Date: [04/16/2013  Tems ||
Interyval
& Monthly Bal. for Pa: || Bal. Remaining: Amt Due:
5 ernitmonthly First Pmt Due: I Mext Pt Due: Mizzed Pmts: ’_U
 Biweskly Payment At I— At Past Due: ’w Clear/Mew Pé,
7 weekly Tatal # of Payments: I Remaining # of Prots: ’_ Print... |

— Payment Agreement Note

Mote Date:| 0441642013 ﬂ Copy Agreement to Mote | Insert Dateline | E

=CLEARED™ e
PMT AGREEMENT: 04/08/2002 FC: 21.000% E

INTERVAL: Monthly BALANCE FOR P&; 1000.00 FIRST DUE: 05/01/2002 £ e

PMT AMT: 100.00 BAL REMAINING: 0.00 AMT PAST DUE: 0.00

Copy Notel Copy &l | ﬂl

Clear Previous | Tt |

Entering Transactions

This sections covers the following topics about posting transactions in the Ledger:

*  Posting Procedures

e Posting Payments

*  Applying Suspended Credits
*  Posting Adjustments

*  Posting Finance and Late Charges
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Posting Procedures

All charges listed on an account will be posted through the use of a procedure code. Typically, the procedure
code used will be one of the ADA codes that come pre-loaded with Dentrix Enterprise. However, dental
offices often perform procedures or assess charges that don’t have a standard procedure code (sometimes
referred to as “administrative codes”). These charges need to be added and assigned a procedure code. For
information about procedure codes, see “Editing Procedure Codes” in Chapter 1: Introduction and Initial

Setup.

To post a procedure

1. In the Ledger, with a patient selected, from the Transaction menu,
click Enter Procedure. (This option is not available if the selected =

. has b hived i .. h . bal 1 4 Dentrix Ledger - (Abbott, James S) [CENT

patient has been archived or if you are viewing the running balance e —_—

for all family members.)

The Enter Procedure(s) dialog box appears.

2. Enter the procedure information: Enter Procedure(s) =
° Date — TO change [he date Operatar: EMTERPRISE Encaunter ﬂ:|
assigned to a procedure, CliCk Date: |D4.-"1 E/2013 Start Date: Completion Date:
in the field, delete the existing Pracedure: [D212( 2l amelgan surtace, pimay "g“g’ﬂ
Clinic: Chart Stat fioo=
date, and then type the correct e | CENTRAL 2] P CCAdul
7 th:l_ Treatment Plan CCChild
date. oo Approval Status Cinlmp
Surfaces: ﬂ Mone CmPClns
.« . .. DO Amalg.
*  Clinic — To change the clinic, Amount B6.00 & Completsd DO Comp.

l, k h h b . MOD Amalg
click the search button to RVL: 0.00 I DoNotBiDertanzence | |02 Lo
select the correct clinic. Provider: BMCCLURE | [ Dveride Fiog Flags Qandg

[[=21n]
Maodifier: [ Requiie Start/Completion Date | |Parthdand
° Procedure _ Type a procedure oaifier: ,_ equire arl ompleton L ate P:::M::

d l k h h Felated R eferral PerioExarm
code, or click the searc Fefered: 10" Humber Type 10 Mumber E‘UlC'Wn
button *?|to select the ») | | e
correct code.

Procedure List dd | iz | Delel |
¢ Treatment area — Enter the
treatment area (if applicable):
for a tooth, type the Tooth
number; for a surface, click the Add
Surface search button b to *Procedure requires additjgeaal treatment infarmation,
select the correct surface; for a Cancel |

quadrant, click the Quadrant
search button -**
correct quadrant; for an arch, click the Arch search button *?! to select the correct arch.

to select the

e Amount — To change the amount charged for the procedure, click in the field, delete the existing
amount, and the type the correct amount.

E

*  Provider — To change the provider attached to the procedure, click the search button to select the

correct provider.

*  Notes — If a default note has been associated with this procedure, the note text appears automatically.
Make any necessary changes to the note.

b

* Related Referral — To add a related referral to the procedure, click the search button to select the

appropriate referral source.

3. Click OK/Post. The procedures posted in the Ledger automatically appear in the Patient Chart as well.
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Posting Payments

Dentrix Enterprise uses “line item accounting” to calculate account balances. You can view balances for the
entire family and for individual patients within the family. When a patient makes a payment, the payment
can be credited to individual patient charges or to the entire family balance (oldest balance first). Dentrix
Enterprise also allows for pre-payments and suspended payments that are not immediately allocated to a

charge.

All payments made by patients are classified as guarantor payments and will be listed under the guarantor’s
name. Keep in mind that, even though you may have selected a family member other than the guarantor,

guarantor payments are always displayed in the Ledger view, so you can easily see when the last time a
payment was made to the account.

To post a payment
In the Ledger, with a patient selected, from the Transaction menu, @_ Z Dentrix Ledger - (Abbott, James 5) [CEN"

1.
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. Fil T di cti I
click Enter Payment. e —
PEENDEEEEE
The Enter Payment dialog box
z Enter Payment = \EI r
appears. §
Operatar ‘ENTEHPH\SE Collecting Clinic: ‘EENTHAL ﬂ A4 Check Pavment - Thank Vou
. . Cash Payment - Thank Tou
Set up the fOHOWIIlg options: Date: [04/76/2013 Encounter #: Credit Card Payment -Thank ‘tou
—y
. o o . Amount: oo Check #:
*  Collecting Clinic — Click (2
55 W #pply to Pmt Agreement Bank/Branch #:
the SearCh button to 1 Apply to Charges Fnrl(Fam\Iy) j
select a clinic. Hote B
vl
¢ Date — Payments are
automatically assigned the
Apply Remaining | Remove &pplied | [” Do not automatically allacate I OK./Post ‘ Cancel |
current system date, but
Date ‘ Encounte... ‘ Code | Patient Provider | Clinic ‘ Charge | Other ... | Guar ... | Applied | Ealan{al
you can change the date as 12/15/95" 01120 Timothy Smi.. HYGL 3400 2680 0.00 0.00 7.20
10/15/96* D2160  JamesSAbb.. DDS2 90.00 0.00 0.00 000 9000
needed. 01/09/00* D6750  James S Abb.. DROBE CENTRAL  612.00 0.00 0.00 000 61200
01/09/12 D6240  James S Abb.. DROBE CENTRAL  620.00 0.00 0.00 000 62000
. T S | h 01/09/12 D6240  James S Abb.. DROBB CENTRAL  620.00 0.00 0.00 000 62000
ype — dSelect the correct 01/09/12 DET50  James S Abb.. DR, CENTRAL 61300 000 000 000 61300
01/20/12 D110 JamesSAbb.. DR ROVO 48.00 0.00 0.00 000 4800
payment type. For 01/31/12 DO140  James S Abb.. DR ENTRAL 3500 000 000 000 3500
. . 01/31/12 D160  JamesSAbb.. DRQ CENTRAL  38.00 0.00 0.00 000 3800
1nformat10n about hOW to 02/27/12 02150  Patricia Abb... DDSL CENTRAL  75.00 000 1500 000 7500
set up payment types, see
the “Customizing Payment
3 . . .
Types” topic in the Dentrix
H Total Remai... | Total Charges | Total Other Cr| Total Guar Est|  Total Applied | Family Charges Balan...
Enterp rise Help . 000 2786.00 2680 15.00 0.00 2759.20

Amount — Type the dollar
amount of the payment.

Check # — If the patient is making payment to the office with a check, type the Check # and Bank/
Branch # of the check.

Apply to Pmt Agreement — If the account has a payment agreement set up, the Apply to Pmt
Agreement option is automatically selected. With this option selected, the payment amount will be
applied to the outstanding balance on the account’s payment agreement. If this payment is not to be
applied to the payment agreement balance, clear the option.

Apply to Charges for — Select “<Family>" to list charges for the entire family with the amount owed
to each provider; or, to list only a specific patient’s charges, select that patient. For information about
how to set up the Apply to Charges for list default selection, see “Setting Up Program Preferences”
in Chapter 1: Introduction and Initial Setup.

Note — Type any unusual circumstances surrounding the payment.
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3. When you enter an amount, Dentrix Enterprise will automatically allocate the payment to the oldest
provider balances, according to the charges listed. The amount applied will be listed in the Applied
column. You can apply any remaining amount or edit the amount applied. Do one of the following:

To apply a remaining amount, select the correct charges (to select multiple charges, while pressing the
Ctrl key, click each charge), and then click Apply Remaining. The amount in the Total Remaining
field will be applied to the selected charges.

If the amount exceeds the guarantor estimate, a dialog box appears. Click Do not apply the
remaining amount to only apply an amount equal to the guarantor estimate or Apply the
remaining amount to the balances to apply the remaining amount but not exceed the total charge
(which can be paid by insurance and will result in overpayment), and then click OK.

To remove the applied amount, click Remove Applied.
To edit the amount applied, double-click the charge, and then type the correct amount to be applied.

To have the credit not be applied to any listed charge, select Do Not Automatically Allocate. When
you click OK/Post, a message appears and asks if you want to suspend the amount. Click Yes. The
amount of the payment will be suspended and can be applied at a later time as explained in “Applying
Suspended Credits” on this page.

4. Click OK/Post.

Applying Suspended Credits

At times, it can be necessary to suspend a payment or credit in cases of pre-payment or overpayment. Once
charges are posted, the suspended amount can then be applied to those charges.

To apply suspended credits for a patient

1.

4.

In the Ledger, with a guarantor or patient selected, from the
Transaction menu, click Apply Suspended Credits.

The Apply Suspended Credits dialog box appears.

Select the credits to be applied,
or click Select All to select all
suspended credits.

Tip: To view or update the
payment note for a selected
credit, click Note.

From the Apply to Charges
for list, select “<Family>”

1 h f h 4 Apply Credit(s) | Remaove Applied + Flagged to not automatically allo 5 'UK/F'ost Cancel
to list charges for the entire : Date | Encounte... | Code | Patient [ Provider | Clinic | Charge | D[ Guar ... | Applied [ Balance |
famlly with the amount owed 12/15/95* D120 Timothy Smi..  HVGL 3400 2680 000 000 720
10/15/96" D260 James § Abb.. DDS2 900 000 000 000 9000

H . H 01/09/00* D6750  James S Abb.. DROEB CENTRAL 61300 000 000 000 61300

to each p rovider; or, to lisc Only 01/09/12 D6750  James S Abb.. DROEB CENTRAL 61300 000 000 000 61300
i i ’ 01/0942 | | D6240 [ JamesS Abb.. | DROBB CENTRAL | 620.00] 0001 000 0.00] 62000

a SPCCIﬁC patients Chafges) select 01/09/12 D6240  James 5 Abb.. DROEB CENTRAL 62000 000 000 000 62000
. . . 01/20/12 DI110  James S Abb.. DROEB PROVO 4800 000 000 000 4800

that patient. For information 01/31/12 D040 James S Abb.. DROEB CENTRAL 3500 000 000 000 3500
01/31/12 D060 James S Abb.. DROEB CENTRAL 3800 000 000 000 3800

about how to set up the APPIY to 02127712 D210 Patricia Abb.. DDSL CENTRAL 7500 000 1500 000 7500

Charges for list default selection,
see “Setting Up Program
Preferences” in Chapter 1:
Introduction and Initial Setup..

,Q’ Dentrix Ledger - (Abbott, James S) [CENT
[

File Optio | Transaction] Insur

O,

01/03/2000 [James S Abbo

z Apply Suspended Credits

Select Suspended Credit(s] to Apply:

Select Al

o [E ]
Operator. |ENTERPRISE

Note... |

Date

‘ Encounte... ‘ Chec... m Patient

| Clinic | Descript... ‘./‘ Cremt‘ Allocated | Apphadl Balancel

0131412
0131412

James 5 Abbott  PRO..,

<Family>

100,00
5000.00

0,00
33.80

0,00 100,00
0.00 4966.20

Professi...

CEM... CheckP...

Apply to Charges for: | <Familys

Total Cre...

Total Allocat... | Total Applied
3380 ey, 000

Family Credits Balance
4966.20

5000.00

Total Char...
2786.00

Total Other Cr

Total Guar Est
1500

Total Applied | Family Charges Balan...

2680 0.00 2759.20

Click Apply Credit(s).
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5. Click OK/Post.

Tip: To see which charges and credits are linked, select a transaction in the Ledger, and then, from the
View menu, click Show Transaction Links. All linked transactions will be selected.

Posting Adjustments

Adjustments can be used to change an account’s balance for a variety of reasons. Frequently, an adjustment
will be used to discount charges or indicate that a patient has been given a refund. Adjustments can also
be used to correct an account’s balance when a posting error has occurred. Like payments, adjustments can
be applied to specific charges on the account. For information about setting up adjustment types, see the
“Customizing Adjustment Types” topic in the Dentrix Enterprise Help.

To post an adjustment

1. In the Ledger, with a guarantor or patient selected, from the @_ Z Dentrix Ledger - (Abbott Jomes § [CEN'

. . o File | Tranza ionI Insur
Transaction menu, click Enter Adjustment. = - =
PENDEEERE
. M ————— o
The Select Adjustment Type dialog box appears. Soic Adjustment Type =1

2. Select Credit Adjustment (-) if the adjustment reduces the account
balance or Charge Adjustment (+) if the adjustment increases the 9 CEiege =] 2)

account balance. " Charge Adjustment (+

3. Click OK. Then, post the adjustment: 3 ) Cancel |

For a Credit Adjustment, do the following:

a. In the Enter Credit
Adjustment dialog box,

‘ z Enter Credit Adjustment

. Dperstor. [ENTERPRISE ing Clinic: [CENTRAL P
set up the following P Folestra Hric I ‘Cash Discourt
. Date: [04/17/2M13 Encounter #: -Credit Adjustment
OptIOIlS: “wdrite-Dff
Amount: o.oo
*  Collecting Clinic _
— Click the SCaI‘Ch Apply to Charges IUr.|<Fam|Iy> j
button | to select a ot | -
e

clinic. @\
° Date - Ad) ustments Apply Remaining ‘ Remove Applied ‘ [~ Do not automatically augcatgl OK./Post | Cancel |

arc autOmatlca“y Date ‘ Encounte... | Code | Patient Provider | Clinic | Charga‘ Other ... | Guar ... |App\ied | Balaﬂcel
assigned the current 12/15/95% D1120  Timothy Smi.. HYGL 34.00 26.80 0.00 0.00 7.20
10/15/96% D2160  James 5 Abb.. DDS2 90.00 0.00 0.00 000 9000
System date, but you 01/09/00% D6750  James S Abb.. DROBB CENTRAL  £132.00 0.00 0.00 000 61300
01/08/12 D6240  James S Abb.. DROBB CENTRAL 620,00 0.00 0.00 000 62000
can Change the date as 01/09/12 D6240  James 5 Abb.. DROEB CENTRAL  620.00 0.00 0.00 000 62000
01/08/12 DE750  James S Abb.. DBERR CENTRAL  613.00 0.00 0.00 000 61300
needed. 01/20/12 D1110  James 5 Abb... PROVO 48.00 0.00 0.00 0.00 48.00
01/31/12 D0140  James 5 Abb.., CENTRAL 3500 0.00 0.00 000 3500
01/31/12 D0160  James 5 Abb... CENTRAL 38.00 0.00 0.00 0.00 38.00
b Type — SCICCt the 02/27/12 D2150  Patricia Abb... CENTRAL 75.00 0.00 15.00 0.00 75.00
correct adjustment type.
*  Amount — Type the
dollar amount to
. Total Remal...
be adjusted off the 0.00 2786.00
account.

*  Apply to Charges for — Select “<Family>" to list charges for the entire family with the
amount owed to each provider; or, to list only a specific patient’s charges, select that patient. For
information about how to set up the Apply to Charges for list default selection, see “Setting Up
Program Preferences” in Chapter 1: Introduction and Initial Setup.

*  Note — Type the reason for the adjustment.
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b. When you enter an amount, Dentrix Enterprise will automatically allocate the adjustment to the

oldest provider balances, according to the charges listed. The amount applied will be listed in the
Applied column. You can apply any remaining amount or edit the amount applied. Do one of the
following:

*  To apply a remaining amount, select the correct charges (to select multiple charges, while pressing
the Cul key, click each charge), and click then Apply Remaining. The amount in the Total
Remaining field will be applied to the selected charges.

If the amount exceeds the guarantor estimate, a dialog box appears. Click Do not apply the
remaining amount to only apply an amount equal to the guarantor estimate or Apply the

remaining amount to the balances to apply the remaining amount but not exceed the total
charge (which can be paid by insurance and will result in overpayment), and then click OK.

*  To remove the applied amount, click Remove Applied.
¢ To edit the amount applied, double-click the charge, and then type the correct amount to be
applied.

*  To have the credit not be applied to any listed charge, select Do Not Automatically Allocate.
When you click OK/Post, a message appears and asks if you want to suspend the amount.
Click Yes. The amount of the adjustment will be suspended and can be applied at a later time as
explained in “Applying Suspended Credits” in this chapter.

c. Click OK/Post.
For a Charge Adjustment, do the following:

a.

In the Enter Charge Adjustment dialog box, set up the following options:
e  Clinic — Click the

Enter Charge Adjustment
search button | to
. Operator: [ENTERPRISE Clinic: [CENTRAL 2| Type [
select the appropriate +Petent Fefund
L. Date: (044172013 Encounter #:
Chnlc' Amaunt; 0.00 Provider: |DDS1 ﬂ
* Date — Adjustments pply Charges: [<Famiy =l
are automatically Hate: |
assigned the current ¥l ( 5 \
system date, but you \ 4 L
can change the date as < b )DK o -
needed.

*  Type — Select the correct adjustment type.
*  Amount — Type the dollar amount to be adjusted onto the account.
*  Provider — Click the search button **/ to select the appropriate provider for the adjustment.

*  Apply to Charges for — Select “<Family>” to list charges for the entire family with the amount
owed to each provider; or, to list only a specific patient’s charges, select that patient. For
information about how to set up the Apply to Charges for list default selection, see “Setting Up
Program Preferences” in Chapter 1: Introduction and Initial Setup.

*  Note — Type the reason for the adjustment
Click OK/Post.
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Posting Finance and Late Charges

Finance and late charges are always applied to the account balance and are listed with the guarantor’s name.
Current finance and late charges are displayed in the Ledger regardless of which family member is selected.

To post a finance or late charge

1.

In the Ledger, with a guarantor or patient selected, from the
Transaction menu, click Enter Finance Charge or Late Charge.

The Enter Finance Charge or Late Charge dialog box appears.

Set up the following options:

¢ (Clinic — Click the search
button *?
correct clinic.

to select the

*  Date — Adjustments are
automatically assigned the
current system date, but
you can change the date as

needed.

e Amount — Type the dollar amount to be charged to the account

0,

z Dentrix Ledger - (Abbott, James S) [CENT
I

pti

File

'Transad:ionl Insus

01/03/2000 [ James 5 Abba

Enter Finance Charge or Late Charge

Operator: [ENTERFRISE Ciinic: [CENTRAL > Tpe & Finance Chage
Date: |04/17/2013 Encounter #: " Late Charge
Amaunt: oo Provider. ’[)[)517 ﬂ
#pply Charges: [<Family> |
Mate: | o
v N
2

\/

Cancel

‘ 3 DDK/PDSI

*  Provider — Click the search button **! to select the appropriate provider for the charge if the charge

is to be attached to a provider other than the guarantor’s primary provider.

*  Type — Select the correct type of charge: Finance Charge or Late Charge.

*  Apply to Charges for — Select “<Family>" to list charges for the entire family with the amount owed
to each provider; or, to list only a specific patient’s charges, select that patient. For information about

how to set up the Apply to Charges for list default selection, see “Setting Up Program Preferences”

in Chapter 1: Introduction and Initial Setup.

*  Note — Type an explanation for a finance or late charge.

Click OK/Post.
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Editing Current Transactions

From time to time, a posting mistake will be made. If a transaction posted in the Ledger or Patient Chart has
not been moved to history (the previous month has not been closed), you can edit that transaction:

Procedures attached to an insurance claim cannot be edited until the claim has been deleted. For information
about how to delete a claim, see “Deleting Dental Insurance Claims” in this chapter.

To edit a current transaction

1. In the Ledger, with a

] Date Mame T ooth Code Description
patient selected, 10415/1996 | <Farmily: Payrent *Check Payment - Thank “ou
double-click the 02/28/2002 [ <Family: Payment *Check Pavment - Thank “'ou

. M./08/2012 |James 5 Abbo 5 | DEFRD R etainer crh-porc fused-h
transaction you want 171 ;93 ;5012 [ James 5 Abbo_|__8 Retainer cin-porc hussd-h
to edit. M./08.2012 | James 5 Abbo G Paontic d ko
The Edit Or Delete
Procedure dlalog bOX Edit or Delete Procedure @
appears.

2. Make any necessary
changes to the transaction.
For an explanation of the
options available for editing
transactions, see “Editing
Treatment” in Chapter 4:
Patient Chart.

3. Click OK.

Cliric:| PROVO

Ry

Operator: | EMTERFRISE

Date: |01/20/2012
|Procedure: |D1110 ﬂ

Amount: 48.00

>

Provider: |DROBE ﬂ

Encounter #:
Start D ate: Completion D ate:

Prophylaxis-adult Procedure Status

" Treatment Plan
Approval Statuz

Override Ins. estimate Maone
I~ Prim. Inz * Completed
™ Sec. Inz. " Ewisting-Current Prov

. ™ Existing-Other Prov
o Mot Bill Dental Insurance d

™ RXguire Start/Completion Date  Modifier:

Diagnoses: >

Motes: |General szaling with hay

y Baking soda used o

with & medicated rinse after Px.

Credits >

Fielated Referral
Fiefered:

|B¥v: Dr. Evans, Jeff

Delete

ﬂ Remave -

ihetrumentz. Ulrasonic scaler on lower anteriors-lingual. — »
pper and lower arch. Flossed all contacts. Patient ringed

1D Mumber Type 1D Mumber

e Cancel
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Deleting Current Transactions

If a transaction posted in the Ledger or Patient Chart has not been moved to history (the previous month has
not been closed), you can delete that transaction.

To delete a current transaction

1. Inthe Ledger, with a Date Mame Tooth Code Description
patient selected, 1041541996 <Fam!l_l,l> Payment *Check Payment - Thank “'ou
double-click th 024282002 | <Family: Payrent “Check Pavment - Tharnk ou

ouble-ciick the 01/09/2012 |James 5 &bbo | 5| DE7S0 Retaines cin-porc fused-h
transaction you want 01/09/2012 [ James 5 Abbo 8 |DE7AD R etainer cirepors fused-h
to delete. M./0842012 | James 5 Abbo 6 |DE240 Pontic-porcelain fused to
|-| .-"|:|E|.-"::_"|:| : ._| ames E; .n'l'.. | n]n] .? :E;::_'" |:| I|:| 't.|::- 1arCe .'. i -_ F =1 tl:l
The Edit Or Delete 1] 1 A bh DE24 Paontic-porcelain fused
Procedure dialog box Notes: (General scaling with hand instruments. Ultiasonic scaler on lower anteriors-ingual
appears. % aﬁhir;gms:é:!gaﬁeddﬂﬁzeugﬁee: S:_d lowser arch. Floszed all contacts. Patient rinsed
2. Click Delete in the lower-lefc | == -

Related Referral
R eferred:
|BYY: Dr. Evans, Jeff

Invalidating Transactions in History

Dentrix Enterprise locks out changes to a transaction once the transaction has been moved to history (when
the month is closed). Posting errors in the Ledger should be corrected using an adjustment. Invalidating a
procedure removes it from the Patient Chart but leaves it in the Ledger.

corner of the dialog box. On
the confirmation message that
appears, click OK.

1D Number Type 1D Murmber

ﬂ Remave -
Cancel

To invalidate a history transaction

1. In the Ledger, with a T0/15/153 “Check Payment - T hank Tou
patient selected, Jarmes 5 Abbo DE/S0 *Retainer cro-porc fused-h
double-click the I:IE.-’EELI’EEIEIE <Family: Payment “Check Pavment - Thank “'ou

. m0942012 | James 5 Abho 2 1INEFARA B etainer crn-noe: bized-h
transaction YOU want mA09/2012 [James S Validate / Invalidate Procedure in Histol
to 1nvahdate. Walidate / [nvalidate Procedure
The Validate/Invalidate Procedure in @ Validate Procedure C_Afivaidwefoceduie Stat
History dialog box appears. Compietion Date
Operator: ENTERPFISE Clric: [CENTREL
2. Under Validate/Invalidate Procedure, Date:[01/0972000  Encounterst| [ Frocedue Status
. . i
Clle Invalldate Pl'OCCdlll'e. Procedure: |DE7S0 Retainer cm-parc fused-hi nob
Overide Ins. estimate Mone
. Tooth: | 5

3. Click OK. octi] 3 - I &
In the transaction log, a plus sign (+) P EEGE :
appears in front of the procedure’s RYL: 000 podiier [
description to indicate that the procedure Provider: PROBE [ Do Not Bil Dertal Insurance
has been invalidated.
Important: Post a credit adjustment for the Piagnases:|
entire amount of the invalidated procedure, Hotes: :
and then post the procedure again with Credits >>
the same date and amount as those of the u
. . . Felated Referal
invalidated procedure. This process must g 1D Nurber Type —
be done in case the procedure needs to be > |
resubmitted on an insurance claim. [k | Corce
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Processing Dental Insurance Claims

Managing insurance claims is a big part of the practice management routine. However, billing dental
insurance can be a complicated operation because of the inconsistent way different insurance carriers handle
claims. Fortunately, Dentrix Enterprise has the tools to handle most insurance situations.

This section covers the following topics about processing dental insurance claims:

Understanding Insurance in the Ledger

Creating Primary Dental Insurance Claims

Changing Dental Claim Information

Including Attachments with Dental Insurance Claims
Reprinting Dental Insurance Claims

Deleting Dental Insurance Claims

Posting Dental Insurance Payments

Creating Secondary Dental Insurance Claims

Editing or Deleting Dental Insurance Payments

Indicating Dental Insurance Benefits Used and Deductibles Met

Understanding Insurance in the Ledger

The Ledger module provides substantial insurance information at a glance:

Insurance coverage — You can easily tell if a patient has insurance coverage by looking at the Ledger
menu bar. The Insurance option is available if a patient has been assigned insurance in the Family File. If
the Insurance option is unavailable but the selected patient has insurance, on the View menu, make sure
that “All (with running balance)” does not have a check mark.

Procedure or claim status — From the transaction log, you can quickly see the status of a procedure or

claim. The Ins column indicates whether or not a procedure has been billed to insurance: if the column
is empty, the listed procedure has been attached to an insurance claim; if the column displays “No,” an

insurance claim has not been created for the procedure.

Claim amounts — Once a dental insurance claim has been created, the Outstanding Billed to Insurance,
Expected from Dental Insurance, and Guarantor Portion of Total Balance amounts will change to
reflect the amount of the procedures on the claim and the insurance coverage percentages.

The insurance estimates in the Ledger and on billing statements only include procedures that have been
billed to dental insurance. The entire procedure cost is allocated to the Guarantor Portion of Total
Balance until a dental claim is created for the procedure.

Pre-treatment estimate status — Pre-treatment estimates can be created from the Ledger-Treatment

Plan view. In addition to indicating whether a pre-treatment estimate has been created, the Ins column
indicates the status of an estimate: an “Acc” indicates that the procedure has been pre-authorized; an “Rej”
indicates that the procedure has been rejected.

Submission status — An insurance claim or pre-treatment estimate will have “Not Sent,” “Sent,” or
“Received” as part of its description in the transaction log. A claim is considered “Not Sent” until it is
sent to the Batch Processor or printed. A claim is considered “Sent” once it has been sent to the Batch
Processor or printed. The claim is considered “Received” when a payment or pre-authorization is entered.
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Creating Primary Dental Insurance Claims

You will create an insurance claim each time an insured patient receives treatment. You can create a claim
immediately after a patient checks out, or you can create a batch of insurance claims at the end of the day.
This section explains how to create a claim as the patient checks out.

To create a claim

Today’s procedures — This option is the simplest way to
create a claim. Use this method for creating insurance claims
immediately after procedures have been posted:

a.

ile ptions 7 Insurance

1. In the Ledger, with a patient selected, do one of the following: @_ [ Dentrix Ledger - (Abbott, James 5) [CENTRAL]
e |

[ [EE]

urf C

01/03/2000 |James S Abba

In the Ledger, with a patient selected, from the

Insurance menu, click Today’s Procedures, Today’s Procedures - Direct Print, or Today’s
Procedures - Batch, or click the Ins. Today’s Proc. button Lwl on the toolbar. Dentrix Enterprise
creates a claim that includes all procedures posted on the current date and sends it to the Batch
Processor or prints it immediately, or the Claim Information window appears.

Specific procedures — Use this method to create a claim for a procedures posted on another date:

a.

In the Ledger, with a patient selected, select the procedures for which you want to create a claim
(to select multiple procedures, while pressing the Ctrl key, click the appropriate procedures).

From the Insurance menu, click Selected Procedures, Selected Procedures - Direct Print, or
Selected Procedures - Batch, or click the Ins. Selected Proc. button %l on the toolbar. Dentrix
Enterprise creates a claim that includes all selected procedures and sends it to the Batch Processor
or prints it immediately, or the Claim Information window appears.

For information about how to set the printing default for the Ins. Today’s Proc. button and Ins. Selected
Proc. button, see “Setting Up Direct Print Options” in Chapter:1 Introduction and Initial Setup.

2. If, from the Insurance menu, you select Today’s Procedures or Selected Procedures to create a claim,

before the claim is sent, the Insurance Claim

-
WindOW appears, allowing you to edit the Claim @ /Z Primary Dental Insurance Claim (DM;/Z)IZ):TM
e p— == - ‘__.l rintl elp

information. If not, ignore the steps that follow.

Palienl: Abbott, James S Carrier: Aetna Dental
You only need to edit a claim when it requires e T > E""‘rﬂ';:'; if:;fﬁ;‘s’:m
special handling, such as to attach X-rays. Make any Billing Provider: Srith, De\ <~/ Claim Information

necessary changes to the claim as explained in Rendering Provider: Srith, Derris D o Insurance.. a5

. . . . . Include
“Changing Dental Claim Information” in this chapter. Pay-To Provider: Smith, Dennis D P
F — |
. . Tooth|Surface Description | 4 [
3. On the menu bar, click Print. = { 4 )~ svachments)
Detail/extensive oral eval, Ny
Send ta batch |

The Insurance Claim Print dialog box appears.

4. Ifyou are not including any attachments, clear the 5 ) SendElectroricaly |
Attachment(s) check box.
5. Click Send to Batch to send the claim to the Batch Processor, Send | Gmeel

Electronically to send the claim through electronic filing, or Print to print the
claim now.

Important: If you click Cancel, the claim will be created, but the status will be “Not Sent.” This is not

recommended.
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Changing Dental Claim Information

When an insurance claim is created, a standard set of information is used to fill out the claim. If you need
to add non-standard information to a claim, you can edit the claim information from the Insurance Claim
window. You can access the Insurance Claim window from the Ledger, with a patient selected, using one of
the following methods:

*  Double-click an existing claim in the Ledger transaction log.

* Ifyou have not yet created a claim for procedures posted today, from the Insurance menu, click Today’s
Procedures.

* Ifyou have not yet created a claim for procedures posted on a day other than the current system date,
select the procedures, and then, from the Insurance menu, click Selected Procedures.

The Insurance Claim window is made up of the following boxes called “blocks”: Subscriber Information,
Billing Provider, Rendering Provider, Pay-To Provider, Claim Information, Diagnostic Codes, Procedure
Information, Payment Information, Claim Status, and Insurance Plan Notes.

Subscriber Information Diagnostic Codes Claim Information
ﬁ Primary Dental Insurance Clainp (02/13/2012) Sent @
File Claim Enter Payment MNpte Print Help
Patient: Abbott, James S Carrier: Aetha Derta)
Subscriber: Abbott, James 5 Group Plan: HSPS Aetna
Employer: HSFS [Release of Info/Azzign of Benefits] [Sefondary Insurance]
Billing Provider: Smith, Dennis [ Claim Information: Mon-Standard
Providers Rendering Prowvider: Smith, Dennis Diag. Codes:
Pay-To Prowvider: Smith, Dennis D
?oolh Surface Description Date Code Fee Ins Amt
Limited oral evaluation 01/202 | Do140 3500 0.00 -
Procedure Detail/extensive oral eval, 01/31/2m2 | DOED 38.00 0.00 i
Information il
Total Billed: 73.00| Pmt Date Pmt Amt Description Check #
Payment Ezt Ing Portion: Fa.00 -~
and || Ins Amt Total: 0.on [
Adjustment Total Paid: 0.0 -
Information Total Credit Adj: 23.00 [_AdjDate Adj Amt Type
Total Chrg Adj: n.on i
Ded 5/P/0: 2/0/0 |
Status Invoice #: 010000360 Insurance Notes
Create Date: 02/13/2012  Tracer: Ask. for Debbie if you have coverage questions.
Date Sent : 02/13/2012 On Hold:
Re-Sent:
Yoided:

Claim Status Insurance Plan Notes

To edit the information in any of these blocks, double-click the appropriate block. Each block is explained in
the sections that follow.
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Editing Patient and Subscriber Information

The Subscriber Information block displays the patient name, subscriber name, employer, insurance carrier
name, and the group plan name. From this block, you can edit the signature options for the claim, the

subscriber ID, and the benefits used and deductible met amounts.

To edit subscriber information for the claim

1. Double-click the Subscriber Information

block.

Z Primary Dental Insurance Claim (02/13/2012) Sent
File Claim EnterPayment Note Print Help

Patient: Abbott, James 5
Subscriber: Abbott, James 5
Employer: HSPS

The Patient/Insurance Information dialog
box appears.

O,

Carrier: Aetha Dental
Group Plan: HSPS Aetna

[Release of Info/Assign of Benefits]

2. Edit the following information:

e Signature on File — Whatever options
are selected in the patient’s Family File are the defaults for
all insurance claims created for the patient. Changes made
to the Signature on File options in the Patient/Insurance
Information dialog box affect only the corresponding claim.

* Release of Information — Select this option to indicate
to the insurance carrier that the patient has signed release
forms authorizing the office to submit information on
the patient’s behalf. The patient will not have to sign box
19 on the ADA claim form.

* Assignment of Benefits — Select this option to indicate
to the insurance carrier that the patient has signed
release forms authorizing the insurance carrier to send
reimbursement to the office rather than the patient. The
patient will not have to sign box 20 on the ADA claim
form.

Billing Provider: Smith. Denniz 0

[ Caim Information- Man-Standar,

Z Patient / Insurance Inf

v Assignment of Benefits

10 Murnber (SS#): 111111111

£ CEIE =

Lifetime Annual Annual
Individual  Individual Family

Standard Required: | 0.00 R00.00 1500.00

Met: [0.00 |n.oo

|0.00

Freventive Required: | 0.00 100000 | 3000.00

Met [0.00 [0.00

|0.00

Other Required: |0.00 150000 | 4500.00

Met: [0.00 |0.00

Individual
b awirnum Benefits: | 20000.00

Benefits Applied: |0.00

0,00

F arnily
15000.00

80.00

3 Cancel

e ID Number (SS#) — The subscriber’s ID number from the Family File (usually the Social Security
number) appears in this field. If necessary, change the subscriber ID that will appear on this claim.

* Deductible and Benefits — The maximum benefits and deductibles for the carrier and the benefits
used and deductible met amounts from the Family File appear in this dialog box. If necessary, edit the
deductibles met and benefits applied in the appropriate fields. Dentrix Enterprise will use the updated

information for calculating all future insurance estimates for the patient or family.

* Update Secondary — If the secondary (or tertiary or quaternary) insurance information was entered
after the primary claim was created, in the lower-left corner of the dialog box, an Update Secondary
Insurance (or Tertiary or Quaternary Insurance) check box appears. Dentrix Enterprise will not use
the new secondary (or tertiary or quaternary) insurance information until this check box has been

selected.

3. Click OK.
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Changing Providers

The Providers blocks display the billing, rendering, and pay-to providers for the claim. From these blocks, you
can change any of those providers for the claim. For information about setting up the default providers for
these blocks, see “Setting Up Practice Defaults” in Chapter 1: Introduction and Initial Setup.

To change a provider for the claim

1. Double-click the Billing Provider, Rendering
Provider, or Pay-To Provider block.

The Select Provider dialog box appears.
Search for and select the appropriate provider.

Click OK.

ﬁ Primary Dental Insurance Claim (02/13/2012) Sent
File Claim EnterPayment Note Print Help

Patient: Abbott, James 5 Carrier: Aetha Dental
Subscriber: Abbott, James 5 Group Plan: HSPS Aetna
Employer: HSPS [Release of Info/Assign of
Billing Prowider: Smith, Dennis D P Claim Information: Mo
Rendering Provider: Smith, Dennis D ( ) Diag. Codes:
Pay-To Provider: Smith, Denniz D

Tooth|Surface| Description Date Code F
e 01/31/202 | DO140

Select Provider

D Last Mame:

01/21/2012 | DOTED

Search By:

& Thiz Clinic | Al Providers
" In ApptBook.

Al Clinics

Hewitt, Mark O
DROEB Fobb, David
JED Kimbal, Jacob & MESA
MCCLURE McClure, Jeffrey AF

| Cliric: 1D

( 3 'DK | Cancel
4

N’
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Editing Claim Information

The Claim Information block displays information that is specific to the patient and the insurance claim. The
standard information will appear on a standard ADA insurance claim form unless it has been edited.

This block displays “Standard” unless the information has been changed; in which case, “Non-Standard”

appears.

Note: When claim information is entered or cleared from the Insurance Claim window, the changes apply
only to the claim currently being displayed and to any associated dental claim (primary, secondary, tertiary, or
quaternary) or medical claim. When a new claim is created, Dentrix Enterprise uses the defaults for a patient
in the Appointment Book for the new claim. For information about how to set up claim defaults, see the

“Scheduling - comprehensive” topic in the Dentrix Enterprise Help.

To change claim information for this claim
1. Double-click the Claim Information block.

The Insurance Claim Information dialog box appears.
2. Edit the following information:

*  Place of Treatment — To indicate where the treatment
for this claim was performed, select Office, Hosp,
ECEF, or Other. If you
select Other, type the

Sent
Help

Carrier: &etna Dental
Group Plan: H5PS Aetna

[Release of Info/Assign of Benefits) Nndary Insurz
Claim Information: Non-Standal{ 1 )

Diag. Codes:

2)

appropriate COdC. 4 Tnsurance Claim Information \ ) @
Flace of Treatment o For Special/Medicaid Claims
° Pre-Authorization ? Office i Megp || el M Referming Prov:li
ECF Other First Wisit Date Current Series: Reason for Pre-Auth:
Number — If a treatment —— & Foqired
h . . Original Reference Mumber [#]: " Services Exceed Max
re-authorization )
p d f h Student Status Service Authaorization- E xeeption Code
was approve or tnis MNOME -

. pp & MNone  Part-Time ¢ Ful-Time | |< i . J
claim, type the pre- fuﬁt)ua,féndmtm =
authorization number. Atschments o -

: ¥ Radiographiz] Enclosed : How Many? |4— [~ Other Attachments I Oral Surgery ™ ReEvaluation

. . o I” Special Case/EPSDT [~ CHDP
¢ First Visit Date Current ™ Oral Imagels) Enclosed: r  Modioars =i
Series — If this claim is [ Modelis) Enclosed: r [ Elighilty Pending
. ™ Retroactive Eligibility
for treatment that is part Include Attachment(s] | Insurance Ref # ——
. elerring Physician
of a multi-visit treatment, | ~ 5 Referred:
f)’pe the ﬁI'St date Of Dates Drescriptions ﬂé
] . . I~ Occup. lness Or lrjury s | [ 1D Humber Type 1D Number
service for this series of = ap— |
™ Other Accident | | 2nd [D Mumber Tepe 2nd 1D Mumber
treatments. |
[ Services Covered by Another Plan: e —— =
. o . ther Subscrber Information
° Prasth
Orlglnal Reference rasnEss Fiemaining Patient Liability Amount:
Number (#) —Fora @ No € Iniial (" Replacement | | Total NonCoversd dmount|
voided or resubmitted r | |
Medicaid Claim tYPC I Orthodantic Treatment-
bl
. . Cl ok L. |

the original reference [ | 3 =

number.

N

*  Student Status — If the patient is enrolled in school (college, university, and so forth), select Part-

Time or Full-Time, and then type the school and city.

e Attachments — To add, edit, or remove claim attachments, select or clear the appropriate option.
For more information about claim attachments, see “Including Attachments with Dental Insurance

Claims” in this chapter.

* Disabled — Select this option if the patient is disabled (work-related or not).
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*  Occupational Illness or Injury — If the treatment for this claim became necessary due to a work-
related injury or illness, select this option, and then type the date and description of the injury or
illness.

*  Auto Accident — If the treatment for this claim became necessary due to an automobile accident,
select this option, and then type the date and description of the accident.

*  Other Accident — If the treatment for this claim became necessary due to an accident that was not
automobile-related or work-related, select this option, and then type the date and description of the
accident (the fields are not available if the check box is not selected).

*  Prosthesis — To indicate that a prosthetic device is required for the treatment for this claim,
select Initial or Replacement. If you select Initial, type the relevant Date Ordered. If you select
Replacement because a new prosthesis is required, type the Replace Reason, Prior Date, and Date
Ordered. Also, if the date in the Prior Date field for the placement of a prosthesis done previously is
an estimate, select the Estimated check box.

*  For Special/Medicaid Claims — If necessary for a special or Medicaid claim, enter the referring
doctor, a reason for the pre-authorization, an exception code, and other options that apply to the
claim.

Tip: If a pre-authorization has been received and entered into Dentrix Enterprise, the pre-
authorization number will automatically appear on the insurance claim. If there is more than one pre-
authorization number for the procedures on the claim, create a claim for each set of procedures with a
different pre-authorization number.

*  Referring Physician — To specify a referring provider and the ID, such as the UPIN, of that provider,
click the Referred search button to select a provider. Next, select the ID Number Type, such as
“UPIN,” and type the ID Number. To specify a second ID for the selected referring provider, select
the 2nd ID Number Type, and type the 2nd ID Number.

Notes:

* By default, the options are populated automatically with the referring doctor’s information
entered for a procedure on the claim, using the provider’s UPIN from the Provider Information
dialog box.

*  For rendering, billing, and pay-to providers on a claim, you can enter a referring provider’s ID for
a specific insurance plan in the Provider ID Setup dialog box.

*  Other Subscriber Information — Specify the following information for secondary claims:
* Remaining Patient Liability Amount — Type the amount remaining to be paid by the patient.
e  Total Non-Covered Amount — Type the total amount that is not covered by insurance.

* Primary Claim Adjustment Reason(s) — If this is a secondary claim, to enter, edit, or delete
reasons for adjustments made to the corresponding primary claim, click this button.

e HSN - If the payor ID entered for the insurance plan associated with the claim is “MCMAL1,”
click this button to specify whether the patient has full or partial coverage (and starting coverage
date), the status of the deductible for the claim, the amount the patient has paid for the
procedures included on the claim, and the total estimated amount due from the patient for the
procedures on the claim.

3. Click OK.

For comprehensive details about all the options available for changing claim information, see the “Changing
dental claim information” topic in the Dentrix Enterprise Help.
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Editing Procedure Information

The Procedure Information block lists all of the procedures attached to the claim and shows the tooth, surface,
description, date, procedure code, fee, and amount insurance has paid or pre-authorized for each procedure.
The Date column shows the date of completion for insurance claims and the date recommended for pre-
treatment estimate claims (the recommended date does not print on a pre-treatment estimate).

To edit a procedure amount

| == m— =
. . Tooth|Surface Description Date Code Fee Ins Amt
1. To edit the amount the insurance plan Cinited oral evalugtion [ 1 N [ Ti7t/z0iz [ Doian 35.00 o

. . . Detail/extensi | eval, 0/31/2mz2 | Doveo 38.00 0.00
will pay for a procedure on this claim, sliferenveoaleval, \_J

double-click that procedure.

Total Billed- 720N PmtNate | Pmt Amb | Nezcrintion

The Edit Insurance Payment
Amount For Procedure dialog box
3 Edit Insurance Payment Armount For Proce @
appears.
Insurance Amount: [[35.00 Update nt Table
2. Type the Insurance Amount (from an EOB, the
. . . . Applied Amount: |12.00
amount that the insurance carrier is paying). For
. . . « . Pre-Treat Estimate; |0.00
information about the applied amount, see the “Posting
. o : Curert Coverage: [0
dental insurance payments” topic in the Dentrix e e
Enterprise Help.

3. Update the payment table, if appropriate.

Important: It is important that you only the payment table only when the payment amount applies to

all patients covered by a given plan. For example, if the estimated insurance portion is different from the
payment amount because money is being withheld toward a deductible, do not update the payment table.
Similarly, if a patient has exceeded his or her maximum benefit, do not update the payment table.

4. Click OK.
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Editing Payment and Estimate Information

The Payment/Estimate Information block displays the total charges for procedures on the claim; estimated
insurance portion; total payment or authorized amount; total of the itemized payments or estimates; date,
amount, and check number of payments or pre-estimates received; and amount applied to the deductible.
To edit or delete a payment or pre-estimate

1. Double-click the appropriate | | | | | | |

. Total Billed: 73.00 | Pmt Date Pmt Amt D
payment or pr €-estimate. Est Ins Portion: 73.00 [_04/17/2013 50.00f Insurance Payment 1
Ins Amt Total: 73.00

The Edit or Delete Insurance Total Paid: 50.00

. Total Credit Adj: 23.00 A A
Payment dialog box appears. G e THe
i Edit or Delete Insurance Payment =R ECR (=)
2. Make any necessary Changes’ Dperator: [ENTERPRISE Colscting Cliic: [CENTRAL |
and then click OK/Post to apply Dat: [OUT720T3 o]
the changes. For information fmaurt R Eheck B [122:5
b h . 'l bl f Pre-Auth Number. Bank/Branch &
about the op tions available 1or Claim Clinie: [CENTRAL Payment Type: & Check Papment Delete
. « . [ L} 1= L
insurance payments’ see POStlIlg Apply F\emawwg‘ Fiemove Applied ‘ [NOTE: Insurance: Estimates are only for this claim] Ok/Post | Cancel ‘
3 .
Dental Insurance Payments mn Date | T.] Suface | Code | Description | Provider | Charge| Othlns| GuarCr| Ins Est[ Ins Amt [ Applied [ Balance [
. 01/31/12 DO140  Limited oral ..  DDSL 3500 000 2300 000 000 1200 000
thlS chapter. 01/31/12 DO160  Detailfextensi.. DDSL 38.00 000 000 000 000 3800 000
Total Remai... | Total Charges | Total Otherlns| Total GuarCr|  TotallnsEst| Totallns Amt| Total Applied|  Total Balances
000 73.00 000 2200 0.00 000 5000 0.00

Updating Claim Statuses

The Claim Status block displays the dates the claim was created, sent, traced, placed on hold, re-sent and/or
voided. From this block, you can modify these dates as needed.

To manually change a status and date for the claim

1. Double-click the Claim Status block. Total Paid: 50.00
Total Credit Adj: 23.00 [~ Adi Dat di Amt
The Insurance Claim Status dialog box appears. Tolthig s ooy 200
2. Select a Status: Claim Sent, Tracer Sent, On Hold, Re-Sent,

Status Invoice #: 010000360 In
or Voided; and then type or change the Date. You can also Penntn Pintos N2A42/9017 Temne Ae

change the Create Date. ( 2 \
3 lnsurau Stat... @

3. Click OK.
Create Date: 441772013
Statuz Drate
[+ Claim Sent: |0417/2013
[~ Tracer Sent: I—
[~ OnHold:
[~ Re-Sent:
™ ‘oided: [

3 Cancel
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Editing Dental Insurance Plan Notes

The Insurance Plan Note block displays any notes that have been entered for an insurance plan from the

Family File of any patient with that insurance plan. From this block, you can add, edit, or delete the notes for

all patients covered by the same insurance plan.

The insurance plan note does not print on the insurance claim. For information about how to include a note
on the claim, see “Adding Dental Insurance Claim Notes” in this chapter.

To edit an insurance plan note

1. Double-click the Insurance Plan Note block.
The Insurance Plan Note dialog box appears.

Type or edit the notes for the insurance plan.

Click OK.

Insert D ateline m

ks for Debbie if you have coverage questions.

Adding Dental Insurance Claim Notes

You can add a narrative to your claim to document and/or explain treatment.

To add a note that will print on the claim
1. On the Insurance Claim window menu bar, click Note.
The Insurance Claim Note dialog box appears.

2. Type any notes regarding the claim that you want to have

appear on the claim.

3. Click OK.
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Z' Primary Dental Insurance Claim (02/13/2012) Sent
Print Help

Patient: Abbott, James S
Subscriber: 4bhott, James §
Employer: HSPS

G

z Insurance Claim Note

H

Insert Dateline | i 3

A nate specific to thiz claim here, such as remarks for unusual

services.- Wed - Apr 17,2013 @

Clear |

-

N

Billing Provider: Smith. Denni

D

Amt o 1VPE
(1) B
‘In:urance Notes
As far Nahhis i uai haua ~nuarans anackane
z Insurance Plan Mote @




Including Attachments with Dental Insurance

Claims

Chapter 7: Ledger

You can attach radiographs, images, models, documents, and perio charts to insurance claims.

To include attachments with a claim

1. In the Ledger, with a patient selected,

open the Insurance Claim window

using one of the following methods:

*  Double-click an existing claim in

the Ledger transaction log.

* Ifyou have not yet created a claim
for procedures posted today, from
the Insurance menu, click Today’s

Procedures.

4 Dentrix Ledger - (Abbott, James 5) [CENTRAL] [DROBB] [ABB101] [11/11/1962] [50]

* Ifyou have not yet created a claim
for procedures posted on a day other than the current system date, select the procedures, and then,
from the Insurance menu, click Selected Procedures.

2. Double-click the Claim Information block.

The Insurance Claim Information dialog box appears.

File Options View Transaction Insurance Print M
=i [ [E
01/09/2000 [James 5§ Abbo DE7S0 “Retainer crn-porc fused-h E
02/28/2002 | <Family: Payment “Check Payment - Thank You i
01/09/2012 [James § Abbo g DE7R0 Retainer crn-porc fused-h E
01/09/2012 | James S &bbo B DE240 Pontic-porcelain fused to E
01/09/2012 | James 5 Abbo 7 DE240 Paontic-porcelain fused to E
01/20/2012 | James 5 Abbo D4245 Aﬁicaﬂ# Eositioned fIaE f\
01/20/2012 | James 5 Abbo D110 = g 1
01/31/2012 | James 5 Abbo poT40 | imited oral evalustion ‘ l
01/31/2002 | James 5 Abbo DO160 etail/extensive oral eva
02/13/2012 § James 5 Abbo Dient Ins. Frimn Clairm - Sent 73.00 1
———
N | 1-=en [e1-s90 [ 91+ [ Suszpen e b T W | TS Tadau's Charnes

Sent
Help

(5525

3. Select whether you are attaching radiographs, oral

images, models, and/or other, and then type the

number of items being attached in
the appropriate How Many? fields.

4. Click Include Attachment(s).

The Include Attachments dialog
box appears.

Carrier: &etna Dental
Group Plan: HSPS Aetna

[Release of Info/Assign of Benefits) Mndary Insurance]

Claim Information: Non-5 landal( 2 )

pummemnl il Attachment(s) | |nsurance Fef #:

Clear

I Disabled
Dates Diescriptions

™ Deoup. Hiness Or Injury : | |

[ Auto Accident | |

[~ Other Accident

™ Services Covered by Anather Plan:

Prosthesiz

& Mo " Initial ¢ Replacement ‘ |

— r

[ Orthodontic Treatment-

Diag. Codes:
Z Insurance Claim Infermation @

Place of Treatment o For 5pecial/Medicaid Claims

@ Office  Hosp | Predfuthorzation Humber: ReferingProv:|

©ECF " Other First Wisit Date Curent Series: Feason for Pre-tuth:

.. ’7 % Required
Original R eference Mumber [§):  Semvices Excesd Max

Student Status Service Authorization- Exception Code
<MOME> hd

& Mone © Pat-Time © Ful-Time | = J
90-Day Indicator

e [<NONE> |

V' Radiographis) Enclosed :  How Many? F [~ Other Attachments [~ Oral Surgery I~ ReEvaluation
[~ Special Case/EPSDT [~ CHDOP

[~ Oral Imagefs) Enclosed : r [ Medicare [ cos

I Modells] Enclosed : W [ Eligibility Pending
[~ Retroactive Ehgibility

Referring Physician
Referred:

| Femove |

1D Murber Type 1D Murber

2nd 10 Mumber Type 2nd 10 Mumber

Other Subscriber Infarmation

Fiemaining Patient Liability Amount
Tatal Non-Covered Amount:

9 Cancel

e’
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5.

Under Attach From, click a button to import any document from the Document Center, any saved
periodontal examination, any digital images

stored in Image, or any file with an .RTF or .TXT

E Include Attachment(s) @

extension Altach From
Document Eentet/\lmport Peria Chart |
For a printed (not electronic) claim, if you will 5
. . . Impart File: |
be including an attachment of another type, click
Non-Electronic. In the Attachment Information | 5, [ s [oin L = T
1 02/24/2001  Test tff document. it Imported Support D...
dlai:g bC;i(, typeTan Atta:ih;lent NOtC, SCICC; 01/25/2012  1000051_2_113921.per  Peria File
n men n I mi i n 047/2M3  MIPACS <rapsdpan DocCenter Support D...
4 ttac ent ype a ans S8 _0 CO ¢ 0417/2013 123341 MonElectronic  Support D...  note for no
type a Control Number, and then click OK to - - .

save the information and return to the Include _
) 7 Abtachment [nformation Remove Attachment
Attachments dialog box.

‘Wwhen an attachment iz printed or gent electronically the
most recent version of the attachment will be uzed.

If you want to view or add attachment

information for a selected attachment, click
Attachment Information. In the Attachment
Information dialog box, type an Attachment
Note, select an Attachment Type and Transmission Code, type a Control Number, and then click OK
to save the information and return to the Include Attachments dialog box.

Click Close to return to the Insurance Claim Information dialog box.

Click OK.

Reprinting Dental Insurance Claims

If you have edited an insurance claim, you can reprint it.

T() repl‘int a Claim Tooth| Surf Code Description Amount Provider Clinic
5 E750 “Retainer crn-porc fuged-h E13.00| DROBE CENTRAL
. . Payrment “Check Payment - Thank Y'ou i -37.00| DDS1 CEMTRA
1. In the Ledger, Wlth a patlent SCICCth, [ E750 Fetainer crn-porc fused-h £13.00{ DROBE CENTRAL
. .. . . 5 6240 Paontic-porcelain fused to 620.00| DROBE CENTRAL
double-click an existing claim in the 7 B2d0 Poniic-porcelain fused to £2000{DROBE | CENTRAL
. 4245 Apically positioned flap 0.00] DROEBE PROVO
transaction log. 1110 Prophylasis-adult 45.00[ DROBE PROVO
0140 Lirnited oral evaluation N 35.00) DROEE CENTRAL
. . 0160 i i 38.00{ DROBE CEMTRAL
The Insurance Claim window appears. e e e 1Y
/
. . -»90 9--» Suspended | Patient Balance | Today ges
2. On the menu bar, click Print. The T T T T T £St Bomat s Porion
Insurance Claim Print dialog box ' ' ' e
appears. ﬁ Primary Dental Insurance Claim (02/13/2012) Sent
3. Ifyou are not including any attachments, clear the
atient: Abbotl, James
Subscriber: Abbott, James 5 G
ttachment(s) chec OX. Empi
lover: HSPS
. l( h h . h o Elnsurance @ o
4. Click Send to Batch to send the claim to the Batch .
nclude
Processor, Send Electronically to send the claim through ¥ Claim
electronic filing, or Print to print the claim now. 3)'7 Attachments)
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Send ta batch |

4 Send Electronically |

Cancel
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Deleting Dental Insurance Claims

You can delete a claim after it has been created. If a secondary claim has been created, you must delete the
secondary claim before you can delete the corresponding primary claim. If a claim has been paid and is in

history, you cannot delete it.

For information about how to delete a payment for a claim without deleting the claim, see “Editing or
Deleting Dental Insurance Payments” in this chapter.

To delete an insurance claim

1. In the Ledger, with a patient selected,
double-click an existing claim in the
transaction log.

The Insurance Claim window appears.

2. From the File menu, click Delete.
On the confirmation message that
appears and cautions you that deleting
the claim will also delete any attached
payments and adjustments, click OK.

4 Dentrix Ledger - (Abbott, James S) [CENTRAL] [DROBB] [ABB101] [11/11/1962] [50]

File Options View Transaction Insurance Print Month End Help

[ [ i [ [
Tooth| Surf [
01/09/2000 |James 5 Abba 5 DE¥S0 *Retainer crmrpore fused-h 5
| 02/28/2002 | <Family> Payment *Check Payment - Thank You i
01/09/2012 [James S Abbo ] DEYR0 Retainer crm-porc fused-h E
01/09/2012 | James 5 Abbo [ DE240 Pontic-porcelain fused to [
01/09/2012 |James 5 Abbo 7 DE240 Paontic-porcelain fused to £
01/20/2012 |James 5§ Abbo L4245
01/20/2012 [James 5 Abbo D110 =
01/31/2012 |James 5 Abbo pot40 |
01/31/2012 | James 5 Abbo DOT6O etailfextensive oral eva
02/13/2012 §James 5 Abbo et [ng. i Clairn - Sent 73,00 1
noaan | I z Primary Dental Insurance Claim (02/13/2012) Sent .~ ", .~
ile} Claim Enter Payment MNote Print Help
Patient: Abbotl, James S
Subscriber: Abbott, James 5 G
Employer: HSPS
Rilling Provider: Smith, Dennis D
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Posting Dental Insurance Payments

When posting an insurance payment, Dentrix Enterprise will automatically itemize the payment for each
procedure according to the insurance estimate. You can edit or remove the applied amount, as well as add
the amount to the insurance payment table. Insurance payments will be calculated when a deductible is to be
applied. You can also write off an amount (make an adjustment) while posting an insurance payment.

Tip: For new offices, if the claim for which you are posting payments was not created using Dentrix
Enterprise, post the insurance payment as a guarantor payment. For information about how to add a
payment type, such as “Insurance Payment,” to distinguish these payments from patient payments, see the
“Customizing Payment Types” topic in the Dentrix Enterprise Help.

To post an insurance payment

LA U 2 [ James o S00D0 o Lbedl ontc-porcelain rised o =
01/09/2012 | James S Abbo 7 DE240 Pontic-porcelain fused to E
. . 01/20/2012 [James S Abbo Dd245 Apicaly positioned flap
1. Inthe Ledger, with a patient selected, f11/20/2012 | James 5 Abbo D110 Prophylasis-adult
. P . . olsas2me [J SA DO140 Limited cral evaluati
dOublC‘Clle an CXIStlng Clalm m the 0173172012 J:m:zSA;;E DOTED T TR
. 02/13/2012 §James 5 Abbo Dent Ing. Prin Claim - Sent 73,00 1
transaction log.
D->20 | 21-360 | 61590 | 91-> | Suspen ded | Patient Balance | Todav's

The Insurance Claim window appears.
2. On the menu bar, click Enter Payment.

The Enter Insurance Payment dialog box appears.

\Z Primary Dental Insurance Claim (02/13/2012) Sent
= - Note Print Help
Patient: Abbott, James 5

Subscriber: Abbott, James 5 G
Employer: HSPS

3. Set up the following options: T —— = e
cHblE or
. . e . Operator [ENTERPRISE Collecting Cliric: [CENTRAL »| Standad  Prevenlive  Other
¢ Collecting Clinic — Click
8 = Date; [04717/2013 ncounler 4 [F00 o0 fooo
the search button **| to st G o —
select the clinic that is P nber [ T
Collecting the paymel’lt. Tl_le Claim Clinic: |CENTRAL Payment Type: & Check Payment e e s
Claim Clinic (the clinic b Pent ol e e © Adut T et 6 Jors | comi |
. Date 5 \ [Code [Description [ Provider | Charge| Othlns [ Guar Cr ™t [ Ins Amt [ Applied [ Balence [
Where the clalm was created) 01/31/12 \ ’ D0140  Limited oral ... DDSL 3500 1200 2300 000 000 000 000
01/3112 D0160  Detail/extensi.. DDS1 38.00 38.00 0.00 0.00 0.00 0.00 0.00

appears for your reference.

¢  Date — Dentrix Enterprise
automatically assigns the

current system date to the payment, but you can change the date as needed.

Dentrix Enterprise 7.0 User's Guide

*  Amount — Dentrix Enterprise automatically inserts the estimated insurance portion in this field, but

you can change the dollar amount of the payment as needed.

Check # — If the patient is making payment to the office with a check, type the Check # and Bank/
Branch # of the check.

Adjust YID Benefits/Deductible — Leave this check box selected if you want Dentrix Enterprise to
adjust the patient’s year-to-date benefits and any applied deductible accordingly.

Deductible Applied For Claim — If money has been withheld toward a deductible, type the withheld
amount in the appropriate field(s): Standard, Preventative, and/or Other.

In cases where your practice does not bill the patient, such as with some preferred provider (PPO)
plans, to quickly create an adjustment to offset any remaining balance, under Enter Adjustment, select
Write-Off, and then select whether you are adjusting off a dollar amount or a percentage of the claim’s
remaining balance. Next, do one of the following:

If you selected $, the unpaid balance for the claim appears in the Total Amount field, but you can
change the adjustment amount as needed.

If you selected %, the unpaid balance for the claim appears in the of field. Type the percentage to be
adjusted in the % field, and Dentrix Enterprise will calculate the adjustment amount and populate

the = field.
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When you enter an amount, Dentrix Enterprise will automatically allocate the payment to the oldest
provider balances, according to the charges listed. The amount applied will be listed in the Applied
column. You can apply any remaining amount or edit the amount applied. Do one of the following:

*  To apply a remaining amount, select the correct charges (to select multiple charges, while pressing the
Ctrl key, click each charge), and then click Apply Remaining. The amount in the Total Remaining
field will be applied to the selected charges.

If the amount exceeds the insurance estimate, a dialog box appears. Do one of the following:

*  Select Do not apply the remaining amount to apply only an amount equal to the insurance
estimate, and then click OK.

e Select Apply the remaining amount to and Exceed insurance estimates to apply the remaining
amount but not exceed the total charge (which will result in an overpayment), and then click

OK.

* Ifatleast one of the selected procedures has a non-insurance credit amount (Guar Cr column)
that can be suspended or re-allocated and one or more non-insurance credits have not been
placed in history, select Apply the remaining amount to and Change guarantor credit
allocations to suspend the non-insurance credit amount but apply the insurance payment, and

then click OK.

Tip: You can use the Change guarantor credit allocations option in cases where you have

a primary claim with a pending secondary claim and paying the balance might result in a
remaining balance that is less than what will be paid by the secondary insurance carrier. However,
it is more practical to deal with that possibility when the secondary claim is paid rather than with
the payment for the primary claim.

* To remove the applied amount, click Remove Applied.

*  To edit the amount applied, double-click the procedure, and then type the correct amount to be

applied.

*  To save the paid amount as a reference for future estimates, double-click the procedure (or right-click
the procedure, and click Edit Ins Payment Amount). In the Edit Insurance Payment Amount for
Procedure dialog box, type the insurance amount from the insurance EOB, and then, if appropriate,
you can update the payment table. If the applied amount exceeds the amount of the procedure, a
message appears and asks if you want to automatically adjust the applied amount to the amount of
the procedure or return to edit the applied amount.

The next time any patient with this insurance plan has the same procedure recommended or
completed, Dentrix Enterprise will use the payment amount as the insurance estimate.

Important: It is important that you update the payment table only when the payment amount
applies to all patients covered by that plan. For example, if the estimated insurance portion is different
from the payment amount because money is being withheld toward a deductible, do not update the
payment table. Similarly, if a patient has exceeded his or her maximum benefit, do not update the
payment table.

Click OK/Post.

If Write-Off was selected, the Enter Credit Adjustment for Insurance Claim dialog box appears. Make
any necessary changes to the adjustment type, provider, and amount, and then click OK to post the
insurance payment and corresponding adjustment.

If the patient has secondary insurance or medical coverage, a message appears and reminds you to create
a secondary or medical claim. Click OK, and then click Create Secondary or Create Medical on the
Insurance Claim window’s menu bar.
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At times, an insurance carrier will send partial payment for an insurance claim while waiting for more
information on certain procedures. In this situation, Dentrix Enterprise provides the following methods for

posting two separate payments to the claim:

»  Splitting an existing dental claim into two separate claims

*  DPosting multiple payments to one dental claim

For information about how to perform these tasks, see the “Posting partial dental insurance payments” topic

in the Dentrix Enterprise Help.

Creating Secondary Dental Insurance Claims

With Dentrix Enterprise, you can create secondary, tertiary, and quaternary insurance claims. This section

explains how to create a secondary claim.

To create a secondary claim

1. In the Ledger, with a patient selected,
double-click the primary insurance
claim for which you want to enter a
payment. The Insurance Claim
window appears.

2. If secondary insurance information
has been changed in the patient’s Family
File since the primary claim was created,
to update Dentrix Enterprise to use the
new insurance information for creating
the secondary claim, double-click the
Subscriber Information block, select

Update Secondary, and then click OK.

LAl U 2 [ James o A00D0 o Ubedl ontc-porcelain rised o o
01/09/2012 |James 5 Abbo 7 DE240 Pontic-porcelain fused to E
01/20/2012 [James S Abbo Dd245 Apicaly positioned flap
01/20/2012 [James 5 Abbo 01110 Prophylasiz-adult
01/31/2012 [James S Abbo DO140 Lirited oral evaluation P
01431720012 |James 5 Abba Do160 il k 7
02/13/2012 §James 5 Abbo Dent Ing. Prirn Claim - Sent 7.3.00 1
0->30 | 31->60 | 61->90 | 91-> | Suspended | Patient Bal Today iges
197400 | 000 | 000 | 70300 | 000 | 267700 Est. Dental Ins. Port

O,

Patient: abbatt, James 5
Subscriber: Abbott, James 5
Employer: H5PS

Carrier: &etna Dental
roup Plan: H5PS Aetna

[Release of InfasAssign of Benefits)

Billing Provider: Smith, Dennis D | Claim Information: Mon-Standa

3. From the Claim menu, click Create Secondary. Dentrix Enterprise creates the additional claim, and the
Insurance Claim window displays that secondary claim.

Tip: To switch back to the primary insurance claim, from the Claims menu, click View Primary Dental.

4. While viewing the secondary claim, on the menu bar, click Print. In the dialog box that appears, click
Print to print the claim immediately or Send to Batch to send the claim to the Batch Processor in the

Office Manager.
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Editing or Deleting Dental Insurance

Payments

You can correct a mistake that was made when posting an insurance payment. However, you cannot change or
delete an insurance payment in history.

To edit or delete an insurance payment

1. In the Ledger, with a patient selected, double-click an insurance payment in the transaction log. The Edit
or Delete Insurance Payment dialog box appears.
Date T ooth Code D escription Amount F
104151396 Payrent “Check Payment - Thank. it -34.00| DD
J 0 Dent Inz. Frirn Dent Inz. Payment a -148.00 O
M./09/2012 | James 5 Abba 5 | DEYED R etainer crn-pare fuzed-h 61.3.00] DRI
M/08/2012 | James 5 Abbo g [ DEFRO R etainer crn-pors fuzed-h 613.00] DRI
01/09/2012 [James 5 Abbio || % et or Delete Insurance payment = === |0.00) DR
I:I1 ."II:IE."IEI:” 2 JamES S .‘Il".l:ll:ll:l Operstor [ENTERFRISE Colleting Clinic: [TENTRAL ﬂ I:II:ID DH[
01/09/2012 |James S5 Abba Iy Ermem |
Amount [ F0.00 Check # [12345
PrefwthNumber [ Bark/Branch#t: |
2' Edit the payment amount Claim Clinic: ’W Payment Type: @ Check Papment Delete

or applied amounts

as necessary, and then
click OK/Post. Or, to
delete the payment, click
Delete, click OK on the
confirmation message

that appears, and then,
when the Insurance Claim
window appears, re-post
the payment correctly.

dpply Femaining | Remove Appid |

" Electionic Payment
[NOTE: Insurance Estimates are only for this claim]

OK/Post Cancel |

Date | T..J Suface [ Code | Description | Provider | Charge | Othlns | Guar Cr[ TnsEst [ Ins Amt [ Applied [ Balance [
01/31/12 D0L40  Limited oral..  DDSI 00 000 2300 000 000 1200 000
01731712 D0160 Detail/extensi... DDS1 38.00 0.00 0.00 0.00 0.00 33.00 0.00

Total Remai...

0.00 73.00

Total Charges | Total OtherIns|  Total Guar Cr

0.00 23.00 0.00

0.00

TotalInsEst | Total Ins Amt | Total Applied

Total Balances

5000 0.00
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Indicating Dental Insurance Benefits Used
and Deductibles Met

Typically, you will indicate deductibles met when posting an insurance payment, and Dentrix Enterprise

will automatically track benefits used and deductibles met for patients. However, on occasion, you can have
patients who come to your practice mid-year. These patients might have met part or all of their deductible for
the year or used part or all of the maximum benefits.

To enter benefits used and deductibles met

1. In the Ledger, with a patient selected, | oo e e
double-click a pending/sent claim in O1/20/2012 | James 5 Atbo D42i5 Aoy pstonedg E
the wansaction log T tee e g e
. 021372012 | James 5 Abbo et Is,
The Insurance Claim window appears. 0-->30 ! 31--560 ! 61-->90 ! 91-> [Susp Patient Bal Today's

ges
197400 | non 2nann | non | 77 I Est. Dental Ins. Port

Tip: If an insurance claim for this

patient has not yet been created, you

can post “dummy” procedures and create a
“fake” claim and then delete them once the
deductible information has been entered.

Z Primary Dental Insurance Claim (02/13/2012) Sent
Print Help

@)

File Claim Enter Payment Note

Patient: &bbott, James 5
Subscriber: &bbott, James 5
Employer: HSPS

Billing Provider: Smith, Dennis D

Carrier: Aetna Dental
Group Plan: HSPS Aetna

[Release of Info/Assign of Benefits)

[ Claim Information: Non-Standar

2. Double-click the Subscriber Information

. . . ﬁ Patient / Insurance Information
block. The Patient/Insurance Information dialog box =
Signature on File
appears. ¥ Release of Infamation
. . . ¥ &ssignment of Benefits
3. The maximum benefits and deductibles for the carrier
and the benefits used and deductible met amounts from 1D Number (554 [T 1117111
. . . . . Deductible
the Family File appear in this dialog box. If necessary, Lietine  Arnual  Annual
. . . . Individual  Individual Family
edit the deductibles met and benefits applied in the Standard Fequied (000 [50000  [1500.00
appropriate fields. Dentrix Enterprise will use the updated Met [T [o00 [omo
information for calculating all future insurance estimates Prevertivs Required: (000 100000 [3000.00
for the patient or family. 3 Met 000 fooo oo
. Other Required: [0.00 150000 |4500.00
4. Click OK. Met [0.00 [N Jnn
Indiidual Famnil
M awimum Benefits: | 50000.00 15000.00
Benefits Applied: IU.UU IBU.DU
Cancel |
N

Working with Treatment Plans

Treatment Plans play an important part in generating and sustaining revenue for most dental offices. This
section covers the following topics about the Ledger features that can help you manage patient treatment
plans:

*  Posting Treatment-planned Procedures
e Creating Dental Pre-treatment Estimates
*  Entering Pre-treatment Estimate Authorizations

*  Completing Treatment-Planned Procedures
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Posting Treatment-planned Procedures

Posting procedures to a patient’s treatment plan is accomplished in almost the same manner as posting
procedures to the patients Ledger. The biggest (and most important) difference is that you enter treatment-
planned procedures from the Treatment Plan view rather than the Ledger view.

To add a procedure to a patient’s treatment plan

1. In the Ledger, with a patient selected, from the Options menu, 2 Do Lot Gt s GO
. . . entrix Ledger - ott, James
click Treatment Plan to switch to the Treatment Plan view. O] View Transaction Insu
2. From the Transaction menu, click Enter Procedure. R =
url [
The Enter Procedure(s) dialog box appears. O1/09/2000 [Jomes 5 Abbo | 5 |
3. Enter the procedure information as explained in “Posting o
» . . . R . g Dentrix Ledger, Treatment Plan - (Abbott
Procedures” in this chapter with the following exception: under r——
Chart Status, leave Lz
Treatment Plan selected, /# Enter Procedure(s)
and then select an Approval Operator: ENTERPRISE Encourter
Status. For information Date: |D4.-"1 7423 Start Date: Completion D ate:
about how to set up approval Procedure: 02120 || Amslgan2 suface, pimay MuliCodes
- Bridge
« .. Clinic: | CEMTRAL 3 Chart Status AUl
statuses, see the ) Customizing oo ] S CChdut
Approval Status” topic in the ' Approval Stalus Cnlmp
. . Surfaces: ﬂ Mone - CrmPClns
Dentrix Enterprise Help. DO Amalg
Amaunt; 5600 " Completed Ed%[?oﬁmp.l
malg
Note: When a procedure is RvL: 0.0 [ Da Mot Bill Diental Insurance Ir:'IPDEHEomp.
completed, the last approval Fr SR 2] ] Ot e e e
> resin
status SClCCth befOI‘C the Modifier: ’_ [™ Require Start/Completion Date Ea[tmand
arthd ax
PerioE xam
procedure was set complete e
Scal
appears next to the procedure Related Fiefenal g
. Referred: 10 Humber Tupe 10" Humber
in the AP column of the
2 | I
Ledger, Ledger-Treatment
1 Procedure List Add | Change | etk |
Plan, and Patient Chart.
4. OK/Post.
Adld
*Procedure requires addit treatment informnation,
Cancel
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Creating Dental Pre-treatment Estimates

You can create a pre-treatment estimate when a pre-authorization for treatment is required or when an insured
patient requests a pre-determination of benefits for recommended treatment. The process is similar to creating
dental insurance claims except you do it from the Treatment Plan view rather than the Ledger view.

To create a pre-treatment estimate

1.

Dentrix Enterprise 7.0 User's Guide

In the Ledger, with a patient selected, from the Options menu,
click Treatment Plan to switch to the Treatment Plan view.

Do one of the following:

Today’s procedures — This option is the simplest way

. U h h d f . 2 B Dentrix Ledger, Treatment Plan - (Abbott, James ©

to create a pre-estimate. Use this method for creating e .

insurance pre-estimates immediately after treatment- S Clore|ml = |5

planned procedures have been posted: Date Name  [Tooth] Surf | Cod:
04/12/2002 | James 5 Abba |E]] D710

a.

From the Insurance menu, click Today’s

Procedures, Today’s Procedures - Direct Print, or Today’s Procedures - Batch; or click the Ins.
Today’s Proc. button =] on the toolbar. A pre-estimate that includes all procedures posted on
the current system date is created and sent to the Batch Processor or printed immediately, or the
Pretreatment Estimate window appears.

Specific procedures — Use this method to create a pre-estimate for treatment-planned procedures
posted on another date:

a.

Select the procedures for which you want to create a claim (to select multiple procedures, while

pressing the Curl key, click the appropriate procedures).

From the Insurance menu, click Selected Procedures, Selected Procedures - Direct Print, or
Selected Procedures - Batch, or click the Ins. Selected Proc. button [% on the toolbar. A pre-
estimate that includes all selected procedures is created and sent to the Batch Processor or printed
immediately, or the Pretreatment Estimate window appears.

If, from the Insurance menu, you select Today’s Procedures or Selected Procedures to create a pre-
estimate, before the pre-estimate is sent, the Pretreatment Estimate window appears. Make any necessary

changes to the patient or

E Primary Dental Pretreatment Estimate (01/30/2012) Sent @
subscriber information, rtre—errrr—trrereetrmrere=—rore] Print] Help
1 1 Patient: Abbott, James 5 Carrier: 4etna Dental
pI‘OVIdCI‘S, Clalm Subscriber: Abbott, James S 3 Group Plan: HSPS Aetna
information, Claim statuses, Employer: H3P3 [Release of Infoltssign of Benefits)  (Secondary Insurance)
and/or insurance plan notes as Billing Prowider: Smith, Dennis [} l/ mClaim Information: Non-Standard
explained in © Changing Dental Rendering Provider: Smith, Dennis O \ Diag. Codes:
. . . . Pay-To Provider: Smith, Dennis
Claim Information” in this e eem————— \
Tooth|Surface Description \Date Code Fee Ins E st
chapter. You can also add 7 Eiiraction sngl oolh DiN/2002 | D710 paR i I
attachments to the pre-
treatment estimate.
Date Received Total Fee: 71.00
Estimated Ins. Portion: 56.80
Ins Amt Tptal: 0.00 Total Auth: 0.00
Status Invoice #: OJ0000320 Insurance Mot
Create Date: 01/30/2012  Tracer: Aszk for Debbie if yoy have coverage questions.
Date Sent : 01/30/2012 On Hold:
Re-Sent:
Voided:




4. On the menu bar, click Print.

The Pre-Estimate Print dialog box appears.

5. If you are not including any attachments, clear the Attachment(s) check box.

Click Send to Batch to send the pre-estimate to the Batch Processor, Send
Electronically to send the pre-estimate through electronic filing, or Print to print

the pre-estimate now.

Important: If you click Cancel, the pre-estimate will be created, but the status

will be “Not Sent.” This is not recommended.
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z Pre-Estim... IEI

Include

¥ Claim
Send to batch

v Attachment(s
Send Electronically

Cancel

Entering Pre-treatment Estimate

Authorizations

When a pre-estimate has been received back from an insurance carrier, you can enter the authorization in

Dentrix Enterprise.

To enter a pre-treatment estimate authorization

1. In the Ledger, with a patient selected, from the Options menu,
click Treatment Plan to switch to the

E Dentrix Ledger - (Abbott, James S) [CENT
View Transaction Insur

Treatment Plan view.

2. Double-click the authorized pre- e ————

z Dentrix Ledger, Treatment Plan - (Abbott, James 5) [MESA] [AMCCLURE] [ABE101] [11/11/1962] [50] I

Insurance  Print  Month End  Help

estimate on the transaction log.

The Pretreatment Estimate window 04/12/2002 1)ames § Abbo 131

0143042012 | Jamnes 5 Abba

appears.

Dentlns.  § | Prim PreEst - Sent 71.00 | 2 1
A

3. From the Enter Estimate menu, select
one of the following options:

* Total Estimate Only — To open the Total Insurance Pre-
Estimate dialog box. Skip to step 5.

* Itemize by Procedure — To open the Pre-Treatment
Estimate Update dialog box.

4. Do one of the following:

*  Dentrix Enterprise automatically inserts the estimated

4 Primary Dental Pretreatment Estimate (01/30/201°
-m—au-lm Note Print Help
I Patient: Abbotl, James 5

3 Pre-Treatment Estimate Update @
Procedure Status: Update Payment Table:
* pccepted ¢ Rejected " Yes ™ Mo
Estimate Amount: |5D. il oK 4
Current Coverage: |56.80 Cancel

insurance portion in the Estimate Amount field. If the amount is correct, click OK.

* If the procedure was rejected, under Procedure Status, select Rejected, and then click OK.

* If the estimate amount is different from what appears, type the correct amount in the Estimate
Amount field. To save the estimate amount as a reference for future estimates, under Update
Payment Table, click Yes, and then, click OK so that the next time a patient with this plan has the
same procedure recommended or completed, Dentrix Enterprise will use the new estimate amount.

Important: It is important that you update the payment table only when the payment amount
applies to all patients covered by that plan. For example, if the estimated insurance portion is
different from the payment amount because money is being withheld toward a deductible, do not
update the payment table. Similarly, if a patient has exceeded their maximum benefit, do not update

the payment table.

Repeat this step for all the other procedures attached to the estimate. Once all procedures have been

entered, the Total Insurance Estimate dialog box appears.
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5. Type the Pre-Auth Number. /4 Total Insurance Pre-Estimate ==
6. Ifyou did not itemize payments, type the authorized amount in Authorze Date: [04/17/2013

the Total Estimate field. Pre-buth Number: m
7. Cllck OK/POSt Coverage Amount: |56.80 Delete |
Total mount Billed: [71.00

Itemized Total: [0.00

Tatal Estimate: [B0.00 Cancel

Completing Treatment-Planned Procedures

When a recommended treatment has been finished, you can set the procedure complete in the Ledger-
Treatment Plan. Setting a procedure complete removes it from the Ledger-Treatment Plan and posts it in the
Ledger with the appropriate charge and insurance coverage information, including any pre-authorizations
received.

To set a treatment-planned procedure complete

1. In the Ledger, with a patient selected, from the Options menu, click Treatment Plan to switch to the
Treatment Plan view.

2. Select the procedures you want to complete. To select multiple procedures, while pressing the Cerl key,
click each procedure.

3. From the Transaction menu, click Set Procedures Complete.

Generating Ledger Reports

You can print the following reports from the Ledger:
*  Walkout Statement

* Single Billing Statement

e Family Ledger Report

e Patient Ledger Report
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Walkout Statement

A walkout statement is generally given to a patient as a receipt of charges posted and payments made on the
day of treatment. Dentrix Enterprise provides you with several options when printing a walkout statement.
To print a walkout statement

1. In the Ledger, with a patient selected, do one of the following:

* Ifyou have set up your walkout statement defaults, click the Print Walkout button L&l on the toolbar.
Ignore the steps that follow.

° To override the walkout default OptiOﬂS to print a 4 Dentrix Ledger - (Abbott, James 5) [CENTRAL] [DROBB] |
different type of walkout for the patient. From the [Fie_Optians_View—Trameremmr—tromemee] Print ]
Print menu, click Walkout. The Print Report dialog ;ﬁ@ﬂﬂﬂﬂ|ﬂ|@ e §|’3R|g/’ |§

Date Name Tooth| Surf Code
box appears. 017051200 s St | 5 | [oors0 |

2. Set up the following options:

3 Print Report @
e Select Report Types — Select the report types walkout Farm Tupe: Wakout Date 04772073
that you want to print: & Enhanced Fom Message: ¥l
. . " Plain Farm
e Family Walkout — The family walkout
statement shows all completed procedures, Select Report Types:

Iv Farnily '/ alkout

guarantor payments, and adjustments  walkaut/Dotors Statament

posted to the account on the date of I Acpcinimert Card

the WalkOllt. The WalkOth then tOt'als all I™ Print Doctor Recommendations Save as Default l_(3
charges and credits for the day to indicate [ Piint TD Finance Charges, Lats Chaiges, g Payments
a total balance, estimated insurance I~ Send to batclf 4 Fit | Cancel |
. <« p2l N y 4
portion, and a “Please Pay” amount. In NV

addition, as a reminder, Dentrix Enterprise prints the next future appointment at the bottom of
the statement.

*  Walkout/Doctor’s Statement — If your office does not handle insurance for patients, use the
doctor’s statement for the patient to use in place of an insurance claim. The doctor’s statement
shows all procedures for the selected patient but does not include payments. A signature line
appears at the bottom of the statement for the doctor’s signature. To include adjustments on the
statement, select Print Adjustments.

* Appointment Card — This is a 4" x 6" reminder card that lists the next appointment for the
patient.

e Print Doctor Recommendations — With this check box selected, if you have added recommendation
notes to your procedure codes, these notes appear on the family walkout statement. For information
about adding recommendation notes, see “Editing Procedure Codes” in Chapter 1: Introduction and
Initial Setup.

e  Print YID Finance Charges, Late Charges, and Payments — Select this option if you want to add
a row to the family walkout statement that shows the year-to-date account totals for finance charges,
late charges, insurance payments, and guarantor payments.

*  Print Adjustments — For a walkout/doctor’s statement, if you want adjustments in addition to
procedures to appear on the statement, select Print Adjustments.

*  Message — If you have a standard message that you want to print on all walkout statements by
default, type the note.

3. Ifyou are not doing a one-time override of the default options, select Save as Default to store your
settings as the default options for the next time you print walkout statements.

4. Click Send to Batch or Print.
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Single Billing Statement

You can generate a single billing statement for a selected account from the Ledger. Also, you can generate
billing statements for a range of accounts from the Office Manager.

To print a single billing statement

Dentrix Ledger - (Abbott, James 5) [CENTRAL] [DROBE
File Options

1. In the Ledger, with a patient selected, from the Print menu,
click Statement.

2. Click Send to batch or Print.

52
Code
E)B?SD

01/09/2000 |James Sibba | 5
N TSR LT e T T

Dentrix Enterprise generates the billing statement according @ single Billing Statement s3]
to the options you have selected from the billing statement options set up ]—(s.and T @) ‘Print |
in the Office Manager. The Balance Forward date on the statement is one \_/
month prior to the current date unless you change that default setting for Cancel

the billing statement from the Office Manager. For details about the billing
statement options, see “Generating Billing Statements” in Chapter 8: Office
Manager.

Family Ledger Report

The Family Ledger Report shows an account history that includes all procedures, payments, adjustments, and
service charges posted to the Ledger. You can also generate this report for a range of accounts from the Office
Manager.

To print the Family Ledger Report for the family being viewed in the Ledger

1. In the Ledger, with a patient selected, do one of the following:

* Ifyou only want current transactions (transactions posted since the month was closed out) on the

report, click the Print Family Ledger button [ on the toolbar. Ignore the steps that follow.

* Ifyou want to include more transactions than the
current transactions on the report, from the Print
menu, click Family Ledger. The Family Ledger Report
dialog box appears.

Dentrix Ledger - (Abbott, James 5) [CENTRAL] [DROBE
File Options

01/09/2000 [James SAbbo | 5
T T T

T

2. In the First Transaction Date field, type the date from
which you want to print all transactions that have been 4 Family Ledger Report

pOSth. First Transaction Date: (0321872

3. Click Send to batch or Print. Sendto bath 3 ) P |

Cancel
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Patient Ledger Report

The Patient Ledger Report is very similar to the Family Ledger Report; however, instead of printing
transactions for all family members, it shows transactions for the selected patient only. You can also generate
this report for a range of patients from the Office Manager.

To print the Patient Ledger Report for one patient
 Dentrix Ledger - (Abbott, James 5) [CENTRAL] [DROBE]

1. In the Ledger, with a patient selected, from the Print File Options  view

menu, click Patient Ledger.

o1/032¢

2. Type a First Transaction Date. All transactions posted

after the entered date will be included on the report. _ _
First Transaction Date: (03/18/2013

3. Click Print to print the report now or Send to batch to send the report

to the Batch Processor to be printed at a later time.
Send to batch 3 Print |
v
Cancel |

Using Fast Checkout

The Fast Checkout button combines the three tasks that are typically completed as a patient checks out

after a visit. All at one time, you can collect a payment, generate an insurance claim, and print a receipt. For
information about how to customize the Fast Checkout button to meet the needs of your office, see “Setting
Up Checkout Options” in Chapter 1: Introduction and Initial Setup.

To use Fast Checkout

In the Ledger, with a patient selected, if you have not already done so, post the completed procedures for the
day for the patient. Then, on the toolbar, click the Fast Checkout button [,

Depending on the setup of the Fast Checkout button, any of the following may occur:

*  The Checkout Options dialog box appears. Select the desired options, and then click OK.

*  The Enter Payment dialog box appears. Enter the payment information, and then click OK.
* Dentrix Enterprise creates an insurance claim.

*  Dentrix Enterprise prints or batches a walkout statement.

203
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Posting Batch Guarantor Payments

With Dentrix Enterprise, you can quickly enter a stack of checks and payments from patients and/or
guarantors, saving you valuable time.

To post a batch of guarantor payments

1. In the Ledger, from the File menu, click Enter Batch Payments. The inﬂ‘t'ﬁ_Ledge'j e
Batch Payment Entry dialog box appears. R —

2. Click the Patient Name search
button **| to search for and A —

. Patient Name:
SCICCt a patlent. | e Entries: 0 Batch Total: | 0.00

3. In the Enter Payment dialog Diate ~ Name Check # Emount_| Encounter | Cinie
box that appears, enter the
payment information. For details
about the options available for -

entering a payment, see “Posting e | < 5 > Cose |

Payments” in this chapter. N

4. Click OK/Post to post the

4 Enter Payment \E [E
payment to the Ledger and return to —
h B h P E d l b Operator: [ENTERPRISE Collecting Clinic: [CENTRAL | Type: Pa ntYw
B! "By | ou
the Batch Payment Entry dialog box, T — G Card Pt Thark You
where the payment now appears. aveurt [ B ——
¥ Apply to Pmt Agreement Bank/Branch #:
Repeat steps 2 — 4 for all other s e [ e
0 arges tor: | <Family> -
guarantor payments you want to e -
enter. When you are finished making i o~
payment entries, compare the number [ 3 ) —
of entries made to the number of Ay emsring | FemorsAprod |1~ Ontraticaly dcle 4 e E=
H Date I Encounte... I Code l Patient l Provider I Clinic I
payments n hand' 12/15/95* D1120  Timothy Smi.. HYGL 34.00 26.30 0.00 0.00 720
10/15/96™ D2160 JamesSAbb.. DDS2 90.00 0.00 0.00 0.00 90.00
1 01/09/00% D750  James S Abb.. DROBB CENTRAL  613.00 0.00 0.00 000 613.00
5. Click Close. - o [ oo NTRAL g
01/09/12 D6240 ) S Ab DROBE CENTRAL 62000 0.00 0.00 000 62000
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Posting Batch Insurance Payments

When an insurance carrier sends your office one check or electronic funds transfer (EFT) to cover multiple
claims for multiple patients, with Dentrix Enterprise, you can post the large insurance check to multiple
patients without having to switch back and forth between different accounts and insurance claims.

Similarly, when an insurance carrier sends your office an electronic EOB (eEOB) to cover multiple claims for
multiple patients, you can import the eEOB and post payments. This feature must be purchased separately.

To post a batch of insurance payments manually 2 o ot oo
ENtrix Ledger - 01 ame

Options  View Transacti

1. In the Ledger, from the File menu, click Enter Batch Ins. Payment.

The Batch Insurance Payment Entry dialog box appears.

n fDS./2UDD James 5 Abbo

Batch Insurance Payment Entry - Check (2\
Nt Batch Entry Type: Prmt Ty Ins Ty
Date:[02/1772013 =] Check#: Collect Clinic: [CENTRAL | EnEL Y e I s ns IVPE: ) NexTCheck

" Manual {+ Check + Dental

r\mount_ Bank/Branch £: l:l Encounter #: l:l  El ic EOB (1 Unps d) " B i " Medical Close

Insurance Carrier Name: Group Plan: Group # Select Patient:

||AEME\nsurancE ‘ > ‘ | ‘ ‘ | )J ]

Date Subscriber Name Subscriber 1D Patiert Mamne = e5tatus Billed At | Estlns
[ | o Crashy. Brent L 111111111 Crashy, Brent L _ 20000 g

Enter Payment:
Hide Enter Payment Post Claim
ltemized Procedures and Amounts

Date Description Th | Surface | Code Prov Charge | Ad Oth Ins, uar Cr | InsEst | Ins Amt § Applied JBalance § Deduct § Pt Table

» ¥ Pontic-porcelain fused ta hnob B DEz40  DDS1 100.00 0.00 50.00 50.00; 0.00 § 100.00 000§ Update
2 | Pontic-porcelain fused ta hnob 7 DEz40  DDS1 100.00 0.00 50.00 50.00; 0.00 § 100.00 000§ Update

07/05/12 | Retainer cin-porc fused-hi nob 5 DEFS0  DDS1 100.00 0.00 0.00 50.00|  50.00 0.00§ 10000 000§ Update
07/0512  Retainer cin-porc fused-hi nob 8 DEFR0  DDS1 100.00 0.00 0.00 50.00 50.00; 000§ 10000 000§ Update

Payment Total:

| Adj Amount | 0.00 | 0.0 000 Other|
Posted Claims
Hide Posted Claims Totals #Posted: [ 0] Adi Amt Posted: Paid Amt Posted:

Date Subscriber Name Subscriber ID | Patient Mame Pii/Sec eStatus Billed Amt | Estlns A dmt Paid &mt Edit Claim...

S | aom| o ow 0w

2. Set up the following options:

*  PmtType — Select Check if a check was mailed to the office or Electronic if payment was received

through an EFT.
s  Collect. Clinic — Click the search button > to select the clinic that is collecting the payment.
* InsType — Select the appropriate type of insurance: Dental or Medical.
*  Amount — Type the amount of the check or EFT.
e Check # — Type the check number.
e Bank/Branch # — Type the bank or branch number.

3. Under Pending Claims, click the Patient Name or Insurance Carrier Name search button | select
the correct patients or carriers, and then click OK.

A list of all outstanding insurance claims for that carrier or patient appears.
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4.

For each claim listed under Pending Claims, select the claim, and then do any of the following:

Under Enter Payment, for each of the procedures listed, type the amount to be Applied to the
procedure, type the amount of the deductible (Deduct) to be applied to the procedure, and if
applicable, select Update if you want to update the payment table for the procedure (only if a
deductible is not being applied and if the maximum benefit has not been exceeded).

To enter an adjustment, under Enter Adjustment, from the Adj list, select Write-Off or Refund;
select the Type of adjustment to use; and then, in the Adj Amount field, type the amount of the
adjustment.

To modify the deductibles being applied for the claim, under Deductible Applied for Claim, change
the values for Standard, Preventative, and/or Other as needed.

Click Post Claim.

Then, repeat steps 3 — 5 until all of the insurance payments from a single check or EFT have been
entered. When you are finished attaching claims to one payment, the Paid Amt Posted under Posted
Claims should equal the check or EFT Amount under Insurance Payment.

If you attempt to close the Batch Insurance Payment Entry dialog box while these two amounts differ,
a message appears. If you want to return and correct the difference, click Cancel; if you want to save
the batch session entry and return later to complete it, click Yes; or if you want to end the batch session
without saving, click No.

Tips:

To resume a saved batch entry, in the Ledger, from the File menu, click Batch Ins. Payments
(Pending) to reopen the session.

Closing the Ledger window before returning to a saved batch session or not saving a batch session will
end the session. However, all payments posted prior to closing the Batch Insurance Payment Entry
dialog box remain posted to the individual accounts.

7. To post the payments from another check or EFT, click Next Check.

For comprehensive information about batch insurance payments, see the “Posting a batch of insurance

payments manually” topic in the Dentrix Enterprise Help.

For information about how to post batch insurance payments from eEOBs, see the “Posting a batch of
insurance payments from eEOBs” topic in the Dentrix Enterprise Help.
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In Dentrix Enterprise, you can search for payments by check or bank number, amount, payment date,
payment type, clinic, patient, or insurance name. Also, you can print a report that lists the payments found by
the search. Use this feature when you want to search for (and print a list of) insurance payments entered in a

batch.

To search for payments
1. In the Ledger, from the File menu, click Search Payments.
The Search Payments dialog box appears.

2. Set up the following search options:

O}

g Dentrix Ledger - (Abbott, Jame

Options  View Transacti

g—
e Select Date — Select your PP /2\
1 i - SelectD \ J Select Insurance Carier————————————
dace range critera. 0 baehge @ A v ByDaeTope: | | & ot ppicable  Dental © Medcd
From: |04/17/2013  To:|04/17/2013 & Entn
* By Date Type — Select - e b L —
whether you want to search s = -

~ Check.

by the date a payment was

Check #:
entered or by the date of a

Bank/Branch #:

From: |<ALL> Tar |<ALl>

Select Patient
( IS |

Clinic

|

= Al

 Collecting Clnic
" Rendeiing Clinic

payment.

¥ Inchude History Payments I

Check Batch Entries: |1

Check Batch Total:|50.00

Date Mame Subscriber Description

¢ Select Insurance Carrier —

01/31/2012  <Family> Abbatt, P..
01/31/2012  Abbott, James S
01312012 Abbott, James 5

Select your insurance carrier
criteria.

*  Check Information — Type
the Check # and Bank/
Branch #.

Insurance Carrier | Clinic

[02/17/2013 T Abbott James S___] Abbott, Jame.__ INSURANCE PAYM.._ Actna Dental __] CENTRAL |
Check Payment - Th

Abbott, James 5 INSURANCE PAYMENT  Astna Dental

Abhott, Patricia  INSURANCE PAYMENT  Astna Life and ..,

CENTRAL
PROVO
PROVO

Bank/Branch | Check# | Amount | Provider
[1235 ] s000Tobst ]
5000.00  <Multiple>
148,00 DROBE
100,00 DROBS

1234

N

@

*  Amount - Type the amount
range by which you want to

search in the From and To fields, or leave From <ALL> To <ALL> entered to search for any amount.

e Select Patient — Click the search button >*| to select the patient whose payments you want to search
for, or leave <ALL> selected to include all patients in the search.

*  Clinic Selection — Select whether you want to search by Collecting Clinic or Rendering Clinic.
Then, click the search button | 1o select the desired clinics, or select All to search in all clinics.

*  Select Payment Types — Select the types of payments you want to search for , or select All to include

all payment types.

* Include History Payments — Select this check box to include payments that are in history.

3. Click Search to begin your search.

The search results appear in the list box in the bottom portion of the dialog box.

4. To print a copy of the search results, click Print. On the message that appears, click Yes.

5. To view a payment in the corresponding patient’s Ledger, select that payment, and then click OK.

For comprehensive instructions on searching for payments, see the “Searching for payments” topic in the

Dentrix Enterprise Help.
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Working with Payment Agreements

Use payment agreements when treatment has been completed and the balance will be paid over time. You set
up payment agreements by account not by patient. Dentrix Enterprise allows one payment agreement per
account. You can set up payment agreements from not only the Ledger but the Billing/Payment Agreement
Information block in the Family File.

This section covers the following topics about payment agreements:

Creating Payment Agreements
Posting Payments to Payment Agreements

Printing Payment Agreement Documents

Creating Payment Agreements

You can create a payment agreement with clients from the Ledger.

To create a payment agreement

1.

In the Ledger, with a patient (or any one of that patient’s family
members) selected, from the File menu, click Billing/Payment

Agreement. The Billing/Payment Agreement Information dialog box

appears.

Z Dentrix Ledger - (Abbott, Jame
1 Options  View Transacti
| _Date [ Name |

Billing/Payment Agreement Information
Under Payment Agreement

Biling Type: | 2: Standard Billing_ -ho finan_c:e charges -
(PA), thC current systern Date 3: Insurance Family - delay finance charges Guarantor Motes
4: Insurance Family - finance charges %

appears by default, but you
can change it as needed.

0-»30 | 31360 | B1-:90 | 91-» Suspen

ded | Balance | Last Payment

Set up the payment

209a00] 00| 000 7i020] -49esz0|-zzar.0n | Amount (500000 Date: [01/31/2012 3
ent Agreement [FA)

. \ |
agreement terms: @ W
il

Bal. Remaining: Amt Due:

Mext Prot Due: Miszed Prts:| 0

Amt Past Due: 0.00 g
Fiemaining # of Prats: L

y

ement to Note | Insert Dateling

a. Click Terms. The thly
: First Pt Due:
Payment Agreement & Sl !
. " Biweekly Payment &mt:
Terms dialog box
7 Weekly Total # of Payments: l_
appears.
=rmment Agreement Mote
b. Do one of the Note Date]| 04/16/2013 | Copy Agre
ing: = EARED™
followmg. PMT AGREEMENT: 04/08/2002 FC:
INTERVAL: Monthly BALANCE FOR
* To select a payment PMT AMT: 100.00 BAL REMAINING:
agreement template’ Clear | Previous | |

click Select Type. For

PAST DUE: 0.00

FIRST DUE: 05/01/2002

o=

Copy Mote | Copyp All m

details about setting up

payment agreement types, see the “Adding and editing payment
agreement types’ in the Dentrix Enterprise Help. The terms
for the selected type populate the fields. As needed, modify the

terms to fit the needs of the account.

*  Enter specific payment agreement terms.

c. Click OK.

Note: You cannot change the terms once the agreement has been saved.

4. Select the appropriate payment Interval.
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Select Type...

Annual Finance Charge Percent; 0,000

Late Charge
Annual Late Charge Percent: |0.000

Grace Period [days]: ’D—
Minirmum Late Charge: |0.00
0.01

Minimum Balance to Charge:

oK | Cancel |




Chapter 7: Ledger 209

5. By default Dentrix Enterprise inserts the guarantor portion of the account’s balance in the Balance for PA
field. If necessary, type the amount of the balance that the account will pay off with the agreement.

6. Set up the following options:

e First Pmt Due — Type the date the first payment will be due.

*  Payment Amt — Type the amount the account will pay at each interval to have Dentrix Enterprise
calculate the Total # of Payments, or type the Total # of Payments to have Dentrix Enterprise

calculate the Payment Amt.

Under Payment Agreement Note, type any notes pertaining to the payment agreement.

8. Click OK.

Posting Payments to Payment Agreements

You can credit a payment toward a payment agreement balance.

To post a payment agreement payment

1. In the Ledger, with a patient selected, from the Transaction menu,
click Enter Payment. The Enter Payment dialog box appears.

E Dentrix Ledger - (Abbott, James S) [CENT
File

- Transactipn  Insur

O,

2. Enter the payment information.

E Enter Payment

For details on posting payments,
« . » . . Operator. [ENTERPRISE Colecting Cliic: [CENTRAL YR T Ctocl Payment Tharic vou
see “Posting Payments” in this Cesh Payment - Thark You
Date: |04/16/2013 Encounter H: Credtt Card Papment -Thank You

Chapter' Amount: oo Check H:

3‘ verify that thC Apply to Apply ta Pt Agreement Bank/Branch f#:
. Apply to Charges for: | <Family> ;I
Pmt Agreement check box is
Mote: a
selected. w

(2)

4. Click OK/Post.

Apply Remaining | Remave Applied |

™ Donot Maﬂy allocate

-
I @\ﬁk/ﬁm | Carcel |

Date | Encounte... | Code | Patient | Provider | Clinic | ChargeT Other | Guar ... | Appliedl Balancel
12/15/95* D1120  Timothy Smi... HYG1 34.00 26,80 0.00 0.00 7.20
10/15/96% D2160  James S Abb.. DDS2 90.00 0.00 0.00 0.00 90.00
070 amesSbh. DROD CORAL G0 000 0 000 oy |
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Printing Payment Agreement Documents

You can print payment agreement documents to give to a patient or guarantor.

To print payment agreement documents

1. In the Ledger, with a patient selected, from the File menu, click Billing/
Payment Agreement. The Billing/Payment Agreement Information

4 Dentrix Ledger - (Abbott, Jame
Options  View Transacti

dialog box appears.

Billing/Payment Agreement Information

2. Click Print. The Print for Payment

. Billing Type: | 2: Standard Billing - no finance charges
Agreement dlalog bOX appears. 3 Insurance Family - delay finance charges
4 Insurance Family - fi h
3. Select the documents you want to give
to the patient/guarantor: | 0-»30 | 31580 | 61530 | 91> | Suspended | Balance | Last Pa’““f,”,t, = —
[Zossoo[ ooo[ ooof 7020 -4se6.20[-zz07.00 Amount: [5000.00  Date: [01/21/2012
e  Truth in Lending Disclosure Payment Agreement (2]

Date: [04/16/2013  Tems ||

Interval -

& Monthly Bal. for PA: || Bal. Remaining: At Due:

@ Sl First Pt Due: I— Mt Pt Due: ,7 Mizsed Pmts:m
" Biweekly PaymentAmt:I Amt Past Due: 0.00 "

Statement — Discloses the terms
of the agreement. It includes

the annual percentage rate, the
finance charge amount, the total

7 weekly Total # of Payments: l_ Remaining # of Prots: ,7
amount financed, and the total
amount paid at the end of the i — e e 1]
agreement.

* Amortization of Payments and
Finance Charges — Prints a schedule listing the interest

Print for Payment Agreement

accrued on the balance amount for each payment interval. ¥ Truth in Lending Disclosure Statemert

3 Amortization of Payments and Finance Charges
*  Coupon Book for Scheduled Payments — Prints payment T Coupan Book for Scheduied Papments
remittance coupons for the patient. o
. . Sendto batc(4)ﬂrint | Caniel
4. Click Print or Send to batch. \_/

Working with Future Due Payment
Plans

Use future due payment plans when treatment will be completed over time and you want to charge an
account monthly while the work is in progress, such as for orthodontics.

This section covers the following topics about future due payment agreements:
*  Creating Future Due Payment Plans

*  DPosting Manual Charges to Future Due Payment Plans
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Creating Future Due Payment Plans

You can set up future due payment plans for individual patients.

To create a future due payment plan

1.

In the Ledger, with a patient selected, from the Transaction
menu, click Process Future Due Payment Plan.

The Select Payment Plan dialog box appears and lists any
previously created plans.

Click New Plan.
The Create Payment Plan dialog box appears.

3. Set up the plan options:

* Provider and Clinic — Dentrix Enterprise automatically
displays the patient’s primary Provider and the current
Clinic. To change the provider and/or clinic, click the search
buttons *”/, and then select the appropriate provider and/or
clinic.

* Note — Type details or
clarification for the payment

1 g Dentrix Ledger - (Abbott, James 5) [CENT
File ptl ¥ Transaction Insur

[0

01/09/2000 | James 5 Abbo
T e

Select Payment Plan

Provider: Cliric: Agreement D ate:

Cancel

2 New Plan_| Edt |

® ©

P lan mn thC Note ﬁeld Create Payment Plan [AMCCLURE][MESA] ==
° Initial Agreement Provider and Clinic: MNote: l% Cunent Plan Status Charged Remaning
. Rovie| SMEELUGE > Total Amount oo0 [ zoo000
Information o
_ | BMonthpChages: [ 0 [18
e Date of Agreement Il Agreement Infomation IRV 00 T
Date of Agieement ,m Insurance E stimates: Prim Ins Est Amt: 0.00 0.00
— 1 1 Patémt:  PrimIns Amt Sec Ins Amt:
Dentrix Enterprlse Total Plan Amaurt. | 200000 TotelPlan [ 84000 | aon [ tieam Seelns Eethnt ,T ’ﬁ
. . ate Amoun
automatically inserts DomPorChags [ T8 | pounie [0 [T T8 | | ooy [ ey
the current date as the o Pay ros Cod 2l Lost Crarze a0
d f h If Monthly Charge Infarmation: Last Claim:
ate or the agreement. Charge Proe Code: [08830 | ¥ Aulo Chame E——

necessary, you can change

Insurance Estimates:
tof Charges: | 18 Pat bt

Primn Ins &mt: - Sec Ins Amt:

Morthly: |

the date. Charge Amount: 10556

e Total Plan Amount —
Type the total amount to
be charged over time.

Auto Ins Claim Options:
¥ Auto Prim Ins Claim
& Monthly

" Recur every

Benefits 4pplied for Other Treatment

*  Down Pay Charge — If

4112 0.0
Muonthly &mount: 412
First Pay Due Date: ~ |04417/2013

Additional Proc. Code ta Include: =

I Mark Claims as Orthodontic Treatment

Frimary Ins. 50.00

G444 # of Months: 18

Manual Charge Entiy:

Manthly

Cancel

Secondaylne: [ 0.00

a down payment will be
charged, type the amount.

*  Down Pay Proc Code — Type the procedure code for the down payment charge, or click the

search button >7! to select the code.

* Insurance Estimates — Patient and insurance portions for the total amount and the down payment

are displayed.
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Monthly Charge Information

e  Charge Proc Code — Type the procedure code, or click the search button **! to select the

procedure code you want to use to post the monthly charge. If there is not an ADA code for
the type of charge you need to post, you can create one. For details about procedure codes, see
“Editing Procedure Codes” in Chapter 1: Introduction and Initial Setup.

* # of Charges — Type the # of Charges to have Dentrix Enterprise calculate the Charge Amount,
or type the Charge Amount to have Dentrix Enterprise calculate the # of Charges.

*  Auto Charge — To have a charge posted to the account automatically when updating future due
payment plans each month, select this option. If this option is cleared, no charges will be posted
to the account unless done manually.

Auto Ins Claim Options

*  Auto Pri Ins Claim — To have a primary insurance claim generated, select this option. Next,
select Monthly to have insurance claims created monthly when the charges are posted; or select
Recur every, and then select the number of months to set a schedule for the insurance billing.
Dentrix Enterprise will generate an insurance only if the specified number of months has elapsed
since the last claim was generated for the future due payment plan.

* Additional Proc. Code to Include — Type an additional procedure code, or click the search
button **| to select a procedure code to include on the claim.

*  Mark Claims as Orthodontic Treatment — If the payment plan is being used for orthodontic
work, select this option. When Dentrix Enterprise generates the automatic insurance claim, the
orthodontic treatment information for the insurance claim information will be completed using
the information entered for the payment plan.

Benefits Applied for Other Treatment — The patient’s used benefits for primary and secondary
insurance before the payment plan is posted appear. The insurance estimates for the payment plan
will be calculated using the amounts in the Primary Ins and Secondary Ins fields. You can change
these amounts if necessary.

Current Plan Status — Information for the current payment plan appears, including remaining
balance and number of monthly charges, patient and insurance estimates, date and amount of the
down payment, date and amount of the last charge, and date of the last claim created for the payment
plan. You can change the values of the total amount being charged and number of monthly charges,
last amount charged and remaining, and date of the last claim.

Print Options — To provide the patient with a payment or coupon book, select Print Payment
Book. Next, type the # of Months to print, the Monthly Amount, and the First Pay Due Date.

Manual Charge Entry — If an amount has been entered in the Down Pay Charge field, to post a
down payment charge, click Down Payment. In the Down Payment Charge dialog box, if necessary,
edit the Date, and then click Post Charge.

4. Click OK.

Tip: During your month-end processes, run the utility for processing the future due payment plans to
post charges to individual accounts all at the same time as explained in “Processing Future Due Payment

Plans” in this chapter.

Payment Book @
5. If you had the option to print a payment book selected, the Payment SRR T3 SRS
. . . " Pre-Printed F L Frint
Book dialog box appears. Click Print or Send to Batch. s R
(% Plain Form " Dot Matrix Prirter
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Posting Manual Charges to Future Due

Payment Plans

At times it may be necessary to manually add a payment plan charge to a patient’s Ledger.

To post a manual future due payment plan charge

1. In the Ledger, with a patient selected, from the Transaction menu,
click Process Future Due Payment Plan. The Select Payment

Plan dialog box appears.

2. Double-click a payment plan. The Payment Plan dialog box

appears.

3. Under Manual Charge Entry,
click Monthly. The Monthly
Charge dialog box appears.

4. If necessary, edit the Date of the
transaction.

5. Click Post Charge.

z Dentrix Ledger - (Abbott, James S) [CENT
File Ophi , § Transaction | Insur

Provider:

AMCCLURE

Select Payment Plan

E
0
jm
e
=l .ﬁ@

Clinic:
MESA

dgreement [ate:
e PHTETE

I Auto Prim Ins Claim
& Manthly

" Recur every ~| m

Benefits &pplied for Other Treatm

5 sPost Charge I

Payment Plan [AMCCLURE][MESA]
- Provider snd Clric Nots [F] cuemPnsteus
) i Charged Remsiring
et AN EELUAE [ Total Amount 000 [ 200000
Clinic: | MESA ﬂ # Monthly Charges: 1 18

Pl Est At o 008
 Initial Agreement Information: aEstAm
lnssnce Estinatess | | PrimIns Est At om [
Dateof Agieement.  |04/17/2013 Patdm:  Pimlns Amt  Seclns At S
Total Plan Amount 2000.00 TotslPlan: | 84000 | aon [ tieam 86 Ins EstAmt —
de Amoun
Down Pay Charge: 100.00 DownPay: [ 10000 | oo | 000 DemEay 0.00
Down Pay Proe Code: | lattrage [ [ 0m
~ Monthly Charge Infomation Last Claim:
Charge Proe. Code: [D8630 = = it Dptians
tt0f Charges: [ 76 Monthly Charge I Pint Payment Back
Chargs Amount: 105 uf blonih: 18
Date: |04417/2013 Morihly Amourt [z
o Ins Claim Ointors: PN Fist Poy Due Date: [DAA772013

Procedure Code: IDSBSD

" Manual Charge Entiy:

Dovn Pagment Monthly 3

Encounter Mumber: ||

Cancel |

Delete | ok | cencel |

Working with Notes in the Ledger

Dentrix Enterprise can store important account and transaction information. The Ledger provides the

following types of notes:

*  Guarantor Notes

* Billing Statement Notes
e Transaction Notes

¢ Procedure Notes
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Guarantor Notes

Guarantor notes are notes attached to an account. These notes are available not only from the Ledger but also
from the Family File and Appointment Book. The guarantor note will usually contain information specific to

the financial situation of an account.

To add a guarantor note
In the Ledger, with a patient (or any of the patient’s family members) @_ {d Dererx Ledger - (Abbott, Jame

1.

selected, from the File menu, click Guarantor Notes.

The Guarantor Notes dialog box appears.

Click Insert Dateline to insert the current
date at the position of the text cursor to
record when the note is being input.

In the Account Note field, type any
relevant account notes.

Click OK.

Options View Transacti

Guarantor MNotes

Account Note

Account note here ‘ 2 ’InsertDateIine
Clear
w«

Biling Statement Note

Billing statement mate for this account only herd - Clear

Prirt on Statement until: (05/17/2013

4 1] 3 Cancel |

Billing Statement Notes

You can enter account-specific information that prints automatically on an account’s billing statement. These

notes can be anything from payment reminders to congratulations on a new baby.

To add or clear a billing statement note
. . N .  Dentrix Ledger - (Abbott, J
In the Ledger, with a patient (or any of the patient’s family members) @_ { Dentr Ledge - (Aboott Jome

1.
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selected, from the File menu, click Guarantor Notes.

The Guarantor Notes dialog box appears.

In the Billing Statement Note field, type
a statement note. This note will be seen
by patients, so grammar and spelling are
important.

Many notes are only relevant for a certain
length of time. To have Dentrix Enterprise
clear a time-sensitive note, type a Print
on Statement until date. After the date
entered passes, Dentrix Enterprise will

no longer print the note on the account’s
statements. By default, the date is one
month in the future.

Click OK.

Guarantor Motes

Account Mote

Account note here - Inzert D ateline
Clear

&

Eiling Statement Mote

Biling statement note for this ac:ft otly herel - Clear

Print an Statement until: |05/17/2013 @

4 ()8 Cancel |
A

e’
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Transaction Notes

Each transaction type in the Ledger includes a note field, allowing you to add clarification to any type of
entry. You can enter notes while posting a transaction or editing an existing current transaction. For details
about entering a note when adding a transaction, see “Entering Transactions” in this chapter.

To add a note to an existing transaction

1. In the Ledger, with a patient selected, double-click a transaction.

2. In the edit or delete dialog box that appears, type a Note, and then click OK.

Procedure Notes

With a procedure note, you can add clarification to a completed procedure. Ledger procedure notes are
directly linked to the Patient Chart procedure notes and consequently are generally used to note clinical
information about the procedure rather than financial data. For details about procedure notes, see the “Adding
and editing ADA-CDT dental codes” topic in the Dentrix Enterprise Help.

Performing Month-end Routines

Dentrix Enterprise provides several utilities that you can run on a monthly basis to keep your accounts in
good order. To avoid data corruption, all users are required to exit Dentrix Enterprise before running any of
these utilities. This section covers the following topics about month-end processes:

*  Applying Finance Charges
*  Applying Late Charges
*  Processing Future Due Payment Plans

*  Running the Month-end Update
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Applying Finance Charges

Dentrix Enterprise can apply finance charges to accounts with and without payment agreements at the same
time. If Dentrix Enterprise determines that a finance charge should be assessed for an account with a payment
agreement set up, it will use the payment agreement terms to calculate the charge.

Note: Apply finance charges on a monthly basis. While you can run the utility at any time during the month,
it is important to run it consistently and at approximately the same time each month.

For information about how to post a finance charge to an individual account manually, see “Posting Finance
and Late Charges” in this chapter.

To apply finance charges

Important: Before running the utility, close all Dentrix Enterprise modules on all computers, create a backup
of your Dentrix Enterprise database on the file server, and then open the Ledger on one computer and enable
single-user mode (as explained in “Changing the Database Mode” in Chapter 8: Office Manager.

1. In the Ledger, from the Month End menu, click Finance Charge.

The Apply Finance Charges dialog box appears. @_
2. Set up the following options:

* Finance Charge Date — Dentrix Enterprise calculates
finance charges according to the aged balance for

DE7S0 | *Retainer cm
= | Er—

each family account as of the finance charge date. By (2)
. . Apply Finance Ch \*/
default, Dentrix Enterprise inserts the current system i )
. , . Finance Charge Date: Cliics: 41 O
date as the Finance Charge Date, which will become e — el
the transaction date for each finance charge entry, but | .. oo oo |CENTRAL a
you can change the date as needed. 1000 hiES =
. . . . Minimurm Finance Charge: Primary Providers: W Al Providers
*  Minimum Balance to Charge — Dentrix Enterprise . AWCOLURE oDl Arngels =
compares the minimum balance to each aged account e Do D O e il
. ast Due Diays to Lharge DEF_PROV  DEF_PROY, DEF ~
balance and applies a finance charge only to those & Overd C DverdD - =
i Biling Types: AT
accounts with an aged balance greater than the ® 0o ® 0w | i b
1: Standard Biling - finance char «
minimum. By default, the Minimum Balance to Finance Charge 2 Stendard Biling - no fnence C|j|
. = v 18 nsurance am!}" .E ay |nanfi
Charge is $10.00, but you can change the amount as Fesn g losearee Fan - fnarec oy
£ Monthly & Yealy : Payrnent F‘Ian-flnance charge
needed. E: Payment Plan - no finance che ™
- . . : ™ Apply as Adjustment Type:
*  Minimum Finance Charge — Dentrix Enterprise PPl 2 Adusiment |vp=
.. ﬂ [~ Save As Default
charges the minimum finance charge to accounts
when the calculated finance charge is less than the o Cancel

amount entered. By default, the Minimum Finance
Charge is $.50, but you can change the amount as

needed.

*  Past Due Days to Charge — Dentrix Enterprise calculates finance charges on the portion of each
account balance that is past due according to the Past Due Days to Charge option selected and the
aging of the account as of the Finance Charge Date. By default, Dentrix Enterprise assumes charges
are due to be paid when they are incurred, so the Past Due Days to Charge is Over 0 days, but if
you do not want to charge finance charges to current accounts, select a different option.

e  Finance Charge — Dentrix Enterprise uses the finance charge percent to calculate the finance charge
amount. Type the Percent to you want to charge, and then select Monthly or Yearly. Dentrix
Enterprise always calculates finance charges on a monthly basis, so if you are using the Yearly option,
Dentrix Enterprise will divide the percentage entered by 12 months (for example, your charge 18%
yearly, Dentrix Enterprise will apply 1.5% to accounts each time you apply finance charges with this
utility).
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*  Apply as Adjustment Type — To have Dentrix Enterprise post the finance charge as a charge
adjustment, select this option, and then click the search button *”/ to select an adjustment type.

*  Clinics — Select the clinics with patients to whom you want to apply finance charges, or select All
Clinics to include all clinics.

*  Primary Providers — Select the primary providers of patients to whom you want to apply finance
charges, or select All Providers to include all providers.

e Billing Types — Select the billing types of patients to whom you want to apply finance charges, or
select All Types to apply finance charges to all accounts regardless of billing type.

Tip: If you do not want to charge finance charges to billing types that are labeled “No Finance

Charges,” you must clear All Types and then select only the billing types that should receive finance

charges.

If you want to save the current settings for the next time you run this utility, select Save as Default.

Click OK. On the confirmation message that appears, click OK.

Note: A progress bar appears and displays a count as each account is processed. You can click Abort if you
need to stop applying finance charges, but any finance charges that have already been calculated before

the button was clicked will still be applied. So, after aborting the process, you may want to print the

Finance Charge Report from DXOne Reporting, open each guarantor’s Ledger that appears on the report,

and edit or delete the charges; or you can restore the backup of your Dentrix Enterprise database from
immediately before you ran the utility.

Chapter 7: Ledger
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Applying Late Charges

Dentrix Enterprise applies late charges to accounts with payment agreements that have failed to make a
payment within the grace period of their payment due date.

Note: Run this utility on a monthly basis. While you can run the utility at any time during the month, it is
important to run it consistently and at approximately the same time each month.

For information about how to apply late charges to an individual account manually, see “Posting Finance and
Late Charges” in this chapter.

To apply late charges

Important: Before running the utility, close all Dentrix Enterprise modules on all computers, create a backup
of your Dentrix Enterprise database on the file server, and then open the Ledger on one computer and enable
single-user mode (as explained in “Changing the Database Mode” in Chapter 8: Office Manager.

1.
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In the Ledger, from the Month End menu, click Late Charge.

The Apply Late Charges dialog box appears.

Set up the following options:

O

ﬁ Dentrix Ledger - (Abbott, James S) [CENTRAL] [DROBB]

ile Options ™ View ElEs:TadLe e

Charge Date — By default, Dentrix Enterprise inserts

01/09/2000 |James 5 Abbo

o)

[ABB101] [11

*Hetainer cin
T

the current system date as the Charge Date, which will '
become the transaction date for each late charge entry,
but you can change the date as needed.

Select Clinic — Select the clinics with patients to whom you want to
apply late charges, or select All Clinics to include all clinics.

Primary Providers — Select the primary providers of patients to
whom you want to apply late charges (only primary providers are
listed), or select All Providers to include all providers.

Billing Types — Select the billing types of patients to whom you
want to apply late charges, or select All Types to apply late charges
to all accounts regardless of billing type.

Tip: If you do not want to charge late charges to billing types that
are labeled “No Finance Charges,” you must clear All Types and
then select only the billing types that should receive finance charges.

Click OK. On the confirmation message that appears, click OK.

Note: A progress bar appears and displays a count as each account is
processed. You can click Abort if you need to stop applying late charges, but any late charges that have
already been calculated before the button was clicked will still be applied. So, after aborting the process,
you may want to print the Late Charge Report from DXOne Reporting, open each guarantor’s Ledger
that appears on the report, and edit or delete the charges; or you can restore the backup of your Dentrix
Enterprise database from immediately before you ran the utility.

Apply Late Cha\ "/ ==
Charge Date [[014/17/2013
Select Clinic: [~ Al Clinics
AF -
DRAPER |E|
MESA |
Ma_Clinic
PINEDALE 2
Select Provider: W Al Providers

Select Biling Type: W Al Types

AMCCLURE  McClure, Angela »
Dos1 Smith, Dennis D
oos2 Brown, Mary D |i|
DEF_PROY DEF_PROY, DEF
DESMITH Srith, Dennis E
DHAYES Hayes, Deborah ™

1: Standard Billing - finance char

3 Insurance Family - delay finan
4: Inzurance Family - finance che
5. Payment Plan - finance chargd—
E: Payment Plan - no finance che

7 Mo Statement and Mo Finance ™

Cancel

2. Standard Billing - no finance c—
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Processing Future Due Payment Plans

You can post charges due on all accounts with a future due payment plan.

Note: Run this utility on a monthly basis. While you can run the utility at any time during the month, it is
important to run it consistently and at approximately the same time each month.

To process future due payment plans

Important: Before running the utility, close all Dentrix Enterprise modules on all computers, create a backup
of your Dentrix Enterprise database on the file server, and then open the Ledger on one computer and enable

single-user mode (as explained in “Changing the Database Mode” in Chapter 8: Office Manager.
1. In the Ledger, from the Month End menu, click Future Due Payment Plan.
The Future Due Payment Plan Update dialog box @_

appears.

2. Set up the following options:

DE7S0 | “Retainer cm

*  Charge Date — By default, Dentrix Enterprise inserts
the current system date as the Charge Date, which will 5
become the transaction date for each payment plan charge entry, but  [Futureuepayd £ Mpete (B3

you can change the date as needed. Charge Date [p4/17/2013
*  Select Clinic — Select the clinics with patients to whom you want preathic T A Onke
ini 1 CENTRAL b
to apply payment plan charges, or select All Clinics to include all SR E
L MESA
CllnICS. Mo Clinic
. . ) . ) PINEDALE -
*  Primary Providers — Select the primary provider of patients to i Al
whom you want to apply payment plan charges (only primary BMCCLURE  MeClue, Argela -
. . . . . Dos1 Srith, Denniz I =
providers are listed), or select All Providers to include all providers. DD52 Brown, Mary D |5

DEF_PROY DEF_PROY, DEF

* Billing Types — Select the billing types of patients to whom you want DHAVES.  Hayes, Deborah =
to apply payment plan charges, or select All Types to apply payment Select Biling Type: ¥ Al Types

Standard Biling - finance char «
Standard Billing - no finance c—
Insurance Family - delay finand -
Insurance Family - finance chs ~
Payment Plan - finance chargs—
Fayment Plan - no finance ch:

Mo Statement and Mo Finance ™

plan charges to all accounts regardless of billing type.

*  Create Insurance Claims — To have Dentrix Enterprise create

S R D

insurance claims for the payment plan charges posted, select this
option.

3. Click OK.
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Running the Month-end Update

Running the month-end update is a crucial management routine. Perform this update each month to
complete many maintenance tasks that are important for getting accurate patient data quickly:

Aging account balances — Account balances will not remain current on your aging reports.

Moving procedures to history — All procedures posted during the month being closed will be moved

into history, locking out changes and deletions.

Creating totals records — To speed report generation, Dentrix Enterprise creates a monthly totals record
each time a month is closed. Without this monthly record, Dentrix Enterprise must calculate analysis
information each time a report is generated, which can greatly slow the report generation process.

Resetting insurance benefits (optional) — For all patients who have dental insurance coverage that resets
during the month being updated, the benefits used and deductible applied amounts will be reset.

You cannot close out the current month. You must wait until the first day of the next month before Dentrix
Enterprise will allow you to close out the previous month (for example, you cannot close out the month of
June until the first day of July).

To run the month-end update

Important: Before running the utility, close all Dentrix Enterprise modules on all computers, create a backup
of your Dentrix Enterprise database on the file server, and then open the Ledger on one computer and enable
single-user mode as explained in “Changing the Database Mode” in Chapter 8: Office Manager (remember to

disable single-user mode after the month-end update is complete).

1.
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In the Ledger, from the Month End menu, click
Update. The Close Out Month dialog box appears.

Dentrix Enterprise requires that months be closed out in
chronological order. Dentrix Enterprise will display the
correct month to be closed out in the Close Out Month
field. You cannot edit this date.

To have Dentrix Enterprise reset all dental insurance plans
whose benefit renewal month is the month following the
Close Out Month, sclect Reset Insurance Benefits for
[month].

To speed up the month end process, select Disable Audit
Triggers During Month End Proc.

Click OK.

(/4 Dentrix Ledger - (Abbott, James S) [CENTRAL] [DROBB] [ABB101] [11

File Options View lranca

[Month End

Date
01/0%/2000

G

O

Close Out Month

Close Out Month:

03/2006

This process will move curment
iternz in the ledger to 'History'.

Options:

Reset Insurance Benefits for Oct.
/ Disable Audit Triggers During Manth End Proc.

Cancel

4 ) ok

Note: The amount of time required to run the update depends on many factors, including the processor
speed of your server. However, a very important factor in the speed of the utility is the amount of
information already in history. If you wait to close out the month, leaving two to three months current at
a time, the update has more data to process and will take more time to run. Running the update monthly
will reduce the time required considerably, as Dentrix Enterprise has less data to process.




Chapter 8: Office Manager

Chapter 8: Office Manager

The Dentrix Enterprise Office Manager provides powerful tools to enhance the management processes of your

practice. This chapter covers the following topics:

*  Using the Office Manager Window

*  Changing Fee Schedules Automatically
e Changing the Database Mode

*  Maintaining Employers

*  Maintaining Insurance Carriers

*  Analyzing Referrals

*  Purging Appointments

*  Purging Dental Insurance Benefits Used

Generating Office Manager Reports
Generating Billing Statements

Printing Blank ADA Claim Forms

Creating Letters

Creating a Batch of Primary Insurance Claims
Submitting Electronic Claims

Sending Statements with QuickBill

Using the Office Manager Window

The Office Manager window consists of a menu bar, toolbar, and Batch Processor.

Batch Processor

ﬁ Dentrix Office Manager - The Dentist Group <CENTRAL=
File View Reports Letters Maintenance Analysis Hel

ol ® s

anmily ]}
Prim. Dental Ins. [ 1 Abbatt, James 5-Aetna Denfal
0241472012 | Billing Statements [From: <ALL> To: <ALL:]
02142012 | Single Biling Statement [Sbbott, Patricia |
0641142012 | Prim. Dental Ins. [[D2007] Winters, Carl-Lincoln M ation|
06/26/2012 | Prim. Dental Ins.[[ECSFOR] Crosby, Brent L-Connectic
07042012 | Prim. Dental Ins. [[0:2007) Crosby, Brent LACKME Insuran
07042012 | Prim. Dental Ins [[D2007] Winters, Carl-Lincoln Mation
07042012 | Prim. Dental Ins. [[D=2007) Winters, Carl-Lincoln Mation
1140542012 | Prim. Dental Ins. [[DE2007] Crozby, Shirley H-ACME Inzur
1140542012 | Prim. Medical Ins. [[HCFA] Crosby, Brent L-ACME Medical

CENTRAL  |ENTERPRISE |Ungent |—|
CENTRAL  |ENTERPRISE [UnPrinted E
CENTRAL  |ENTERPRISE |UnPrinted

CENTRAL DSMITH Printed

CENTRAL  [ENTERFRISE |Printed

CENTRAL  |ENTERPRISE |Printed

CENTRAL  [ENTERFRISE | Printed

CENTRAL  |EMTERPRISE |Printed

CENTRAL  [ENTERFRISE | Printed

CENTRAL  [ENTERFRISE |Printed

Status

Frinted

»

This section covers the following topics to help you understand how to use the Office Manager window:

*  Using the Office Manager Toolbar
*  Understanding the Batch Processor

*  Previewing Reports

Printing Reports

Deleting Reports

221
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Using the Office Manager Toolbar

The toolbar contains several buttons that you can click to access certain areas or features of Dentrix Enterprise.

PRENPEE N

The function of the buttons specific to the Office Manager are explained in the following table.

Click the Electronic Billing Submission button to send billing statements and/or a batch of billing
statements to a clearinghouse to have them mailed for you.

Click the Electronic Claim Submission button to submit dental and/or medical insurance claims
electronically.

D [

Click the Create Batch Primary Ins Claims button to generate multiple claims for procedures
posted within a specified date range

Click the Print Preview button to display the report selected in the Batch Processor.

Click the Print Report(s) button to send the reports selected in the Batch Processor to the printer
set up for use by the Office Manager.

Click the Delete Report(s) button to delete all or certain reports.

Click the Refresh/Clear Selection button to deselect any reports that are selected in the Batch
Processor.

=S

Click the Day Sheet Report button to generate a day sheet.

Click the Operator Day Sheet Report button to send the operator day sheet to the Batch Processor.

Click the Referral Analysis button to monitor referrals or enter gratuities.

Click the Collections Manager button to view and manage collections information to help you as
you contact patients regarding their accounts.

5 1% B2

7|l  Click the DXOne Reports button to generate and manage reports.

Understanding the Batch Processor

The Batch Processor is a report management tool that allows you to print and/or preview reports generated
and sent to the Batch Processor.

Batch Processor [This Clinic, Full Display]
Date Description Clinic Dperatar Status

01/30/20 alkD atement [Abbott. James R RPR ed -
02A13/2012 | Prim. Dental Ins.([DX2007) Abbott, James S-Aetna Dental CENTRAL  [ENTERPRISE |Unsent B
02/14/2012 | Biling Statements (From: <ALL> Tor <ALL>] CENTRAL  |ENTERPRISE | UnPrinted pe=
02/14;2012 | Single Billing Statement [Abbott, Patricia ] CENTRAL |ENTERPRISE |UnPrinted

0671172012 | Prim. Dental Ins ([DX2007) Winters, Carl-Lincoln Nation CENTRAL DSMITH Printed

06/26/2012 | Prim. Dental Ins ([ECSFOR)] Croshy, Brent L-Connecticut CENTRAL |ENTERPRISE | Printed

07A10/2012 | Prim. Dental Ins.([D2007) Crosby, Brent LACME Inswan CENTRAL  [ENTERPRISE |Printed

07/10/2012 | Prim. Dental Ins ([DX2007) Winters, Carl-Lincoln Nation CENTRAL  |ENTERPRISE | Printed

0771072012 | Prim. Dental Ins.([DX2007) Winters, Carl-Lincoln Mation CENTRAL |ENTERPRISE |Printed

11/05/2012 | Prim. Dental Ins ([DX2007) Croshy, Shidey H-ACME Insur CENTRAL  |ENTERPRISE | Printed

11/05/2012 | Prim. Medical Ins.[[HCFA] Crosby, Brent LACME Medical CENTRAL |ENTERPRISE | Printed

For each report listed, the Batch Processor displays the date the report was generated, a brief description of the
report, and a status that indicates if the report has been printed, displayed, or sent (for claims and pre-estimates).

Tip: Since the Batch Processor can easily become crowded with reports from every clinic, you can specify the
reports you want to have displayed in the Batch Processor and the sort order of those reports. For information
about setting up the view of the Batch Processor, see the “Setting up the Office Manager view” topic in the
Dentrix Enterprise Help.
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Previewing Reports

You can preview a report before printing it. You can preview one or two pages at a time, zoom out to see more
of the page, zoom in to see more detail, and easily navigate between reports and pages of the current report.
While you are previewing a report, the report appears in a format as close to the printed report as possible.

To preview a report

1. In the Office Manager, @
from the Batch Processor,
select the reports you want to

% Dentrix Office Manager - The Dentist Group < CENTRAL> EI‘ & '@

Batch Processor [This Cl

Description
Fan Jut Statement [Abbott, J

Full Display]

Dperator
CEMTRAL  ENTERFRISE  Frinted

021372012 me.Denta\\ns.[[DXZUU?]Abbolt,James S-fetna Dental CENTRAL  |ENTERPRISE |Unsent
. 0271472012 | Billng Statements (From: <ALL> T g CENTRAL  |ENTERPRISE | UnPrinted
prevlew‘ nl Lo0 I YR d=FN EIITEED\ = W =P e
06/11/2012 | Prim. Dental \ns.{[_DXZUU?] i 1 rln Nation CEMTRAL DSHITH Printed I
. : . 071072012 | Prim, Dental Ins. [D2007) ErosM{ME Insuran CENTRAL  |ENTERPRISE | Printed
2. From the File menu, click Print 07/10/2012 | Prim, D ental In [[DX2007) inters, eSPLrcoln Nstion CENTRAL  |ENTERPRISE | Printed
Previ The Print Previ 071072012 | Prim. DentalIns.([DX20017) Winters, CartLincoln Hation CENTRAL  |ENTERPRISE | Printed
11/05/2012 | Prim. Dental Ins. ([DX2007) Croshy, Shiley H-ACME Insur CENTRAL |ENTERPRISE | Printed
review. ¢ rint Preview 11706/2012 | Prim Meddical Ins. ((HCFA) Croshy, Brent L-ACME Medical CENTRAL  |ENTERPRISE | Printed
window appears.

| Drentrix Print Preview EI@

le  Options  Help

|Blank ADA 2012 Claim Form - 5o [€TH Page: 1 of 1

ADA American Dental Association- Dental Claim Form
HEADER INFORMATIGN

1. Ty Toarmas v Mok =l apies e vress
[atetersant et seia 2esices [CQraenact e Fredotane vobun et iz
I:lEFSDT TR

2. liradeter et M estizaliae ol POLICYHDLRER'SLIBZCRIBER INFORMATIOM (=cr Incuranaa Conpary Hamas na3.

(12 1l At thalet “le vz ] an, Finel Wddbe Initia S, Sddeeas, Siv Slce Bp Cuds

INJURANCE COMPANYIGENTAL BENEFIT PLAM INFORMATION

L o Ban Hames, AH eew, £ Gt i G

La. 0wl Ritn MEACDGCOYY | 1o gl
o
E-10Mre my L Llarka 13 PGy Munbe 1T R Ber
o dantal 2rL)

15, Pzl rgelzrafi beribrn I0GEEM a0 Dl

OTHER COVERAGE (a1 Aapiha im 112 5 51w o1
sy ] ueacns [ ¢l oo e

B hamg gt 20w heddensubea 1er 112 4 SLeal, b s, tidele 1 al, S0t PATIENT INFORMATION

15 et T4 Farto = Fuliie
T g TR — Ui
£ Dt of Gl L0 S T Zenda BORiy e e 1 o |:| i

v 0= 8. i (- 18, T e, Kl il ],
= Flan iy Horke i1 iz ls Folalns w3 I; Fen rznzd e

et [owveee []rmperdem =

V1 AT EME 1R LI 280 Caal Banaf ITI2r Maws A cess, Ci, i, 2 Code

ity o, Fp e

CL stz af Dirty he MDD 22 Serdr P alen D 'onnl e Jas peed o el
- -
oF P
M, Proccd oL P AT ] it Tanin BER R RN T E L 23 1y Lt e
e nnee s erLol=ul Sk z Fiew Plinie e o Lssapled, 2o K,

3. Do any of the following for the report you are previewing:

e Print Report — To print the report being displayed or all reports in the preview session, from the File
menu, click Print Report.

* Report Title — Select a report from the list to view that report (if you are previewing multiple
reports).

*  View One Page / Two Page — To switch between viewing one or two pages (displayed side by side),
from the Options menu, click View One Page or View Two Pages.

e Zoom —To increase or decrease the zoom percentage (from 10% to 200%), from the Options menu,
point to Zoom, and then click the appropriate percentage.

* Previous / Next Page — To advance to the next page in a multi-page report, click the right arrow
button. To go to a previous page of a multi-page report, click the left arrow button.

4. To close the Print Preview window, from the File menu, click Exit.
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Printing Reports

If you do not want to preview a report, you can send it directly to the Office Manager printer.

Tip : To print certain pages of a report or to print more than one copy of a report, you must print that report
from the Print Preview window so that you can enter the page range and the number of copies.

To print a report from the Batch Processor

1. In the Office Manager,
from the Batch Processor,
select the reports that you
want to print.

% Dentrix Office Manager - The Dentist Group < CENTRAL>

View Reports Letters Maintenance Analysis Help

Unsent
abooied L

CohTon)

Tips: sdicc
ips: 02/14/2012 | Single Biling Glatemenl [bbott, Patriia ) CENTRAL UnFrinted 1
06/26/2012 | Prim Dental Ins ([ECSFOR) Crosby, Brent L i CENTRAL  |ENTERPRISE | Printed
M 07102012 | Prim. Dental Ins.[[D<2007) Crasby, Brent L-ACME Insuran CENTRAL  |ENTERFRISE | Printed
*  To select multlple reports, 07/10/2012 | Prim. Dental Ins [[D42007) winters, Car-Lincoln Nation CENTRAL  |ENTERPRISE | Printed
hil K h Ik 07/10/2012 | Prim Dental Ins ([DX2007) Winters, Car-Lincoln N afion CENTRAL  |ENTERPRISE | Printed
11/05/2012 | Prim. Dental Ins. ([DX2007) Croshy, Shiley H-ACME Insur CENTRAL |ENTERPRISE | Printed
while pressing the Cur €y, 11/05/2012 | Prim Medical Ins.((HCFA] Crosby, Brent LACME Medical CENTRAL  |ENTERPRISE | Printed
click each report.

*  To deselect a report in the
Batch Processor, from the
File menu, click Clear; or select a different report.

2. With reports selected, from the File menu, click Print. Dentrix Enterprise sends the report to the printer
set up for the Office Manager.

Deleting Reports

You can delete any report from the Batch Processor that is not being previewed.

Note: Do not try to delete a report that is currently being previewed. A report being previewed may have
“Displayed” or “Schd” (followed by a number) in the Status column.

To delete a report from the Batch Processor

1. In the Office Manager,
from the Batch Processor,
select the reports that you
want to delete.

k Dentrix Office Manager - The Dentist Group <CENTRAL>
View Repoerts Letters Maintenance  Analysis  Help

= i
7 |
. . 02/14/2012 | Biling Statements [From: <ALL> Tor <Al CENTRAL UnPrinted
2. From the File menu, click 2 L 1] 1
06/11/2012 | Prim. Dental Ins.([0¥2007) Winters. Carl-Mn CENTRAL DSMITH Printed
Delete 0E/26/2012 | Prim. Dental Ins.([ECSFOR] Croshy, Brent L-Connecticut CENTRAL  |ENTERPRISE | Printed
* 07/10/2012 | Prim. Dental Ins.([DX2007) Croshy, Brent LACME Insuran CENTRAL |ENTERPRISE | Printed
07/10/2012 | Prim. Dental Ins.([DX2007) Winters, Carl-Lincoln Nation CENTRAL |ENTERPRISE | Printed
. . 07/10/2012 | Prim. Dental Ins. ([DX2007) Wwinters, Carl-Lincoln Nation CENTRAL  |ENTERFRISE | Printed
I I 1€ Delete Optlons dlalog bOX 11/05/2012 | Prim. Dental Ins. ([0 2007) Croshy, Shirley H-ACME Insur CENTRAL |ENTERPRISE | Printed
11/06/2012 | Prim. Medical Ins. [[HCFA) Croshy, Brent LACME Medical CENTRAL  |ENTERPRISE | Printed
appear S.

3. Select one of the following
options:

Delete Options @

Delete

* Selected Reports — To delete the reports selected in the Batch Processor
" Selected Reports

*  Printed Reports — To delete all printed and displayed reports listed in the
Batch Processor

+ Printed Reports
Sent Reports
" Al Reports

Cancel

*  Sent Reports — To delete all sent claims listed in the Batch Processor (used
with electronic claims)

*  All Reports — To delete all reports listed in the Batch Processor ~—
4. Click OK.
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Changing Fee Schedules Automatically

When you are logged in to the Central clinic, you can make alterations to an entire fee schedule or specific
segments of a fee schedule without having to manually enter each amount for a procedure.

To make automatic fee schedule changes

1. In the Office Manager, from the Maintenance menu, point to 3 Dort Ot borager T guiil G <CENTRAL
Practice Setup, and then click Auto Fee Schedule Changes. = EE FIE
. . Batch Pi
The Automatic Fee Schedule Changes dialog box appears. Doscription
. Automatic Fee Schedule Changes @
2. Click the Select Fee Schedule search button **/ to select the 5
Select Fee Schedul i 33
fee schedule that you want to change. cem s I Dfiee
Select Procedurs Code

3. Under Select Procedure Code, click the From and To search 3) Fom[alls > Tofall »
buttons *?| to select the first and last code in the range of TeRe Operarn
procedures for which you want to change the fee schedule, (¢ Doy Fee Schedue To: [7 PULLEM 2
or leave From <ALL> To <ALL> entered to include all S0

" Change Fee Schedule
procedures. -
o=l

4. Under Select Operation, select how you want to change the Jc e

i i
fee schedule:
c —

*  Copy Fee Schedule To — Select this option, and thCI'l click —
the search button %/ to select the fee schedule to which
you want to copy the fee schedule selected in step 2. @M Cose

e Clear Fee Schedule — To clear the fee schedule (to make
each amount in the fee schedule 0.00), select this option.

e Change Fee Schedule — To change the fee schedule, select this option. Next, select one of the
Increase By or Decrease By options, and then type the percent or dollar amount by which you want
to increase or decrease the fees in the range you have selected. Then, select the appropriate Round To
option to indicate whether you want to round the new fees to the nearest Dollar, Dime, or Penny.
Also, type a Minimum Amount to Increase to indicate the minimum amount required for a fee in
the fee schedule to be changed.

5. Depending upon the type of operation you want to initiate, click Copy, Clear, or Change. Once Dentrix
Enterprise has processed the changes, it will display the entire fee schedule for you to review in the
Automatic Fee Schedule Change Results dialog box.

Autormatic Fee Schedule Change Results @

6. Make any necessary changes to the new fee schedule: Prcedws  Feeffl  NewFesh2 Diftrence

Code Office PULLEM
a.  Double-click the amount you want to change. T
h D7876 310000 219200 93.00
Type the new amount. e p—— e 6
c.  Press Tab to apply the change and move to the next e e e s
fee down in the list, and, after editing the last fee Dizo 10w 1400 o
. D7340 800.00 824.00 24.00
you want to edit, press Enter on your keyboard to Dm0 w0 o
apply the last change. Or, you can make a change to Bl e s e
a single fee and then press Enter. e o i
D7347 8200.00 8446.00 246.00
: D734a 825000 843750 24750
7. Click Accept. D733 20000 BMEDD 24500

D73E0

Edit | ( 7 'Accapl | Reject
A

243000 /3280

N
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Changing the Database Mode

You can turn on single-user mode for operations that require that Dentrix Enterprise be closed on all but one
computer. After those operations have been completed, you must turn off single-user mode.

To turn on singe-user mode

In the Office Manager, from the Maintenance menu, point to Practice Setup > Database Mode Setup, and
then click Enable Single User Mode. On the confirmation message that appears, click Yes.

To turn off single-user mode

In the Office Manager, from the Maintenance menu, point to Practice Setup > Database Mode Setup, and
then click Disable Single User Mode. On the confirmation message that appears, click Yes.

[ J [ [ J
Maintaining Employers
With the Employer Maintenance utility, you can add, edit, and delete employers without selecting a patient.
Additionally, you can join and purge duplicate employers. For information about adding and editing

employers from the Office Manager, see the “Adding and editing employers” topic in the Dentrix Enterprise
Help.

This section covers the following topics about employers:
*  Joining Employers
e Purging Employers

Joining Employers
You can combine duplicate employers.

Tip: You do not need to enable single-user mode when running this utility, but run it outside of peak office times.

To join employers

& Dentrix Office Manager - The Dentist Group <CENTRAL -

Maintenancell Analysis

1 ElE El=

Batch Pro:

1. In the Office Manager, from the Maintenance menu, point to 1
Reference, and then click Employer Maintenance.

‘The Employer Maintenance dialog box appears. Employer Maintenance

Enter Employer Name:

2. Click Join Employers.

[ 2]
The Join Employers dialog box appears. Join Employers | perree—
. _ = 122 Maple Dr
3. Click the Source Employer scarch button > to select | [ SeeetEmoyers o Jan

Source Employer:
| ACME Co. ( 3 »>

Destination Employer:

select the employer that you want the source employer == 4 Nl
. I
to be changed to.

the employer that you want to merge into another.

4. Click the Destination Employer search button **! to

Purge

ssociated with the Source Employer to be

5. Click Join. On the confirmation message that appears, ssodated with the Source Employer o b

click Yes. Then, another message appears and states that

the employers have been joined, so click OK. ( : ) o | concd |

The source employer is now the destination employer.
All patients with the source employer now have the
destination employer attached to their records in the Family File.

E‘ARNING: Clicking "Join" will cause all patients
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Purging Employers
You can purge employers from Dentrix Enterprise that are no longer attached to any patients.

To purge an employer

1. In the Office Manager, from the Maintenance menu, point to
Reference, and then click Employer Maintenance.

% Dentrix Office Manager - The Dentist Group <CENTRAL »

rs Maintenfince  Analysis

Batch Pi

roc

Date D

The Employer Maintenance dialog box appears.

. . Employer Maintenance
2. Click Purge. The Purge Employers dialog box appears and
. . Enter Employer Name:
lists all employers that are not attached to any patients. | ]
10° H H Name [ Acdess
Tip: If an employer you want to delete is not listed, the . Ty
Acme Inc. 123 Maple Dr

employer is attached to at least one patient. You must clear
that employer from those patients in the Family File before it
can be deleted. To find patients with a certain employer, print
the Employers and Employed Patients Report for that

New )\Edil | Jain En‘ployets| Purge |

(el
elete |

@Delete All |
e

employer from the DXOne Reporting module. For
information about this report, see “Reference Reports”

in Chapter 9: DXOne Reporting.

Purge Employers

3. To delete all employers listed, click Delete All; or, to
delete a certain employer, select that employer, and
then click Delete.

4. Click Close.

Maintaining Insurance Carriers

With the Insurance Maintenance utility, you can add, edit, and delete insurance plans without selecting a
patient. Additionally, you can join and purge duplicate insurance plans. For information about adding and
editing insurance plans from the Office Manager, see the “Adding and editing insurance plans” topic in the
Dentrix Enterprise Help.

This section covers the following topics about insurance:
* Joining Insurance Plans

*  Purging Insurance Plans
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Joining Insurance Plans

You can combine duplicate insurance plans without moving subscribers one by one to another plan. Joining
plans does not delete the old, unused insurance plan; it only moves the subscribers to a new plan so that the

old plan can be purged.

Tip: It is not necessary to be in single-user mode when joining insurance plans, but do not use this utility

during peak office times.

To join insurance plans

& Dentrix Office Manager - The Dentist Group <CENTRAL »

1. In the Office Manager, from the Maintenance menu, point to 1 ] Ay
Reference, and then click Insurance Maintenance. 1= Bl El=
Batch Proc
The Insurance Maintenance dialog box appears. Insurance Maintenance
2. Click Join Plans. el [ |
Search By
. . Enter Carrier Name: @ Carrier Name Group Plan " Payor IC
The Join Insurance Plans dialog box appears. q P
3' SeleCt one Of the fOllOWing jOin Criteria: Carrier Name Group Plan I Employer Name Group = I Local # ‘
ACME Insurance HSPS Group Plan HSPS 111222
*  Employer-based — To move all subscribers fckmbenilry S fsina HEES e
attached to one particular insurance plan linked Al G nsuran... Aled G fnssen.. e
to a specific employer to another insurance
plan that is linked to the same employer. Then,
select the Subscriber’s Employer must match | |
. New. Join Plans... Purge...
Insurance Plan Employer Field check box
if you want to move only subscribers who are
assigned the same employer in the Family File. S =
e Join Criteria
e Plan-to-Plan — To join insurance plans regardless of  Enployer-base d@p o to-5lom
employers.
Subscriber's Employer must match
. I Plan Employer field
4. Click the Source Insurance Plan search button **! to R TR e
select the plan you want to join with another. et Insurance Plans to Join
5. Click the Destination Insurance Plan search button ** Brres Ierenes ie
Aetna Life and Casualty =
to select the plan you want the Source Insurance Plan to | 4
Group #: 321863
be transferred to.
Group Plan:  Aetna
6. Click Join. On the confirmation message that appears, Employer: 3. Horton
click OK. Then, another message appears and states that Destination Tneurance Plons
the plans have been joined, so click OK. [Petna Life and Casualty 5 )
Group #: 321863

The source plan is now the destination plan. All patients
with the source plan now have the destination plan
attached to their records in the Family File.

Group Plan:  Aetna

Employer:  J.C. Hod

rton

WARNING: Clicking "Join" will cause all
ubscribers assodated with the Source
nsurance Plan to be assodated with the
estination Insurance Plan
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You can purge insurance plans from Dentrix Enterprise that are not attached to any outstanding insurance

claims.

To purge an insurance plan

1.

In the Office Manager, from the Maintenance menu, point to 1

Reference, and then click Insurance Maintenance.
The Insurance Maintenance dialog box appears.
Click Purge.

The Purge Insurance dialog box appears.

Tip: If an insurance plan you want to delete is

not listed, the plan is attached to at least one
outstanding claim. Those claims must be paid before
the plan can be deleted. To find outstanding claims
for a certain carrier, print the Insurance Claim Aging
Report for that carrier from the DXOne Reporting
module. For information about this report, see
“Ledger Reports” in Chapter 9: DXOne Reporting.

To delete all insurance plans listed, click Delete

All; or, to delete a certain plan, select that plan, and
then click Delete. On the confirmation message that
appears, click OK.

4. Click Close.

ﬁ Dentrix Office Manager - The Dentist Group < CENTRAL »

[Maintenancell Analysis

F% B = EE
Ea.tc|.1 Proc

Insurance Maintenance

Dental | Medical |

Search By

Enter Carrier Name: (& Carrier Name " Group Plan " Payor II
[2 " Employer " Group Number

Carrier Name | Group Plan | Employer Name | Group # | Local # l

ACME Insurance HSPS Group Plan HSPS 111222

Aetna Dental HSPS Aetna HSPS 123456

Aetna Life and Casu... Aetna 1.C. Horton 321863

Allied Group Insuran... Allied Group Insuran... 16023

N
Purge Insurance @ J Purge...

Mail Clair To Blue Shield In
M Irsurance Plan
Tert Lilly
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Analyzing Referrals

You can use the Dentrix Enterprise analysis tool to view referral production and manage gratuities.

To analyze the production of a referral source

Dentist Group <CENTRAL»
g Analysis

1. In the Office Manager, from the Maintenance menu, point to
Reference, and then click Referral Maintenance.

% Dentrix Office Manager - The,

Batch Pro:

The Referral Maintenance dialog box appears. STy -

Referred BY Refterred T

Select the referral you want to analyze.

Cth alYSis' Name Specialty Count
. . . Dr. Evans. Jeff q
The Referral Analysis dialog box appears. The dialog box Dt Ty Mt '
amily
lists the number of Total Referrals Made to/by this referral
source.

4. Set up the following options:

*  Referral Date Span — From the list, select a date span. g 3 Yeeebse | tew Edt | como
All patients who have been referred to/by the referral 4

source within the date span appear in the list box.

Referral Analysis - (Dr. Tyler, Mark) (23]

Total Referals Made: 4

Reterral Date Span Froduction Diate Span

|- Save &
Al Production = D‘:}‘:ults

*  Production Date Span — For referral sources only,

from the list, select a date span. The production for @

the specified date span of each referral appears in

the Production column of the list box. Also, the T RET T ion |
H H Gleason, Gary M 02/28/1993 000
total production generated by the listed referrals sl G .
- : Lake, Shans B 0317133 D00
for the production date span appears in the s e E A
Production field.
5. To enter a gratuity given to a referral source, click
New Gratuity. In the New Gratuity dialog box, type Listed Referrals [ 4
the date the gratuity was given and the amount of the Production 548.00
. . . Gratuity
gratuity, select the type of gratuity sent, and then click oty Do [

OK Last Gratuity Type: |

TiPS ‘ 5 ’Newﬁratuit}l | GratuityAnaIysis“ 6 ’

*  To add a new gratuity type in the New Gratuity Notas
dialog box, from the Type list, select “<Add
Gratuity Type>,” type a new type and amount, and
then click Add.

*  To record the gratuity in each referred patient’s Office Journal, in the New Gratuity dialog box, select

Send Email | Office Journal | ar. Cancel |

Add Journal, and then click the Provider search button **| to select the provider for whom you also
want to record the Office Journal entries.

6. To view an analysis of the gratuities given to a referral, click Gratuity Analysis.

The Gratuity Analysis dialog box appears. This dialog box E— =]

lists all gratuities and the total value of each. bue sy Toe Proder | vabe

Click Close to return to the Referral Analysis dialog box. 7 -
8. Click OK.

Total ltems: |1 Total Y alge 15.00
Edt Delete 7

N
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Purging Appointments

If you are logged in to the Central clinic, you can purge appointments in the Appointment Book before a
certain date for all clinics.

Tip: You can purge appointments for only the clinic you are logged in to from the Appointment Book.

To purge appointments

1. In the Office Manager, from the Maintenance menu, point to Ny er——————————

Reference, and then click Purge Appointment. 1 Maintenance] Analyss
. . . . R EREEC I EE EE
The Delete Appointments for All Clinics dialog box appears. Batch Pro«

2. Type a Cut off date. All appointments in all clinics prior the date T ==

entered will be purged.
3. Click OK. On the confirmation message that appears, click OK. et date:|mxmx2mz( : )

o Cancel |

Purging Dental Insurance Benefits
Used

With the Purge Insurance Benefits Used utility, you can selectively zero out insurance coverage benefits used.
Purging used benefits will clear all of the current year’s benefits for the insurance plans that have the previous
year’s benefits cleared.

To purge used insurance benefits

1. In the Office Manager, from the Maintenance menu, point to 1 ¢ Dentrx Offce Menager - The Dentist Group <CENTRAL-

. Maintenancell Analysis
Reference, and then click Purge Dental Ins Benefits Used. GENZERL RS

Batch Proc

The Purge Dental Insurance Benefits Used dialog box appears.

hﬂn&g _"- D!:cliglinn
2. Select one of the following options: T ey e e =
¢ Insurance Plans with Renewal Month of — Purge Dental Insurance Benefits For
To clear used benefits (reset them to $0) for Cz ¥ Insurance Plans with Renenal Month of: [apri ]
insurance plans with benefits that renew on Selected Insurance Plan:

a specific month, select this option, and then | |
select the appropriate month from the list.

* Selected Insurance Plan — To clear used 3 ) cancel_|
benefits from a specific insurance plan, select

this option, and then click the search button | to select the appropriate insurance plan.
3. Click OK.

Tip: During the month-end update, Dentrix Enterprise will automatically purge benefits used for those
insurance companies that renew their benefits the next calendar month.
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Generating Office Manager Reports

Dentrix Enterprise provides many reports that you can use to gather information from your database. While
some reports can be printed from the Ledger, the Patient Chart, the Appointment Book, the Family File, or
DXOne Reporting, the Office Manager has the following categories of reports you can generate:

Reference reports
Management reports
Billing statements
Ledger reports

List reports

Blank ADA claim forms

All reports you generate from the Office Manager will appear in the Batch Processor.

For a comprehensive explanation of all the options for running these reports, see the “Generating Ofhce
Manager reports” topic and its subtopics in the Dentrix Enterprise Help. Also, to see samples of and read an
explanation of what appears on each report, refer to the Dentrix Enterprise 7.0 Reports Reference.

Reference Reports

In the Office Manager, from the Reports menu, point to Reference, and then click a reference report option:

Dentrix Enterprise 7.0 User's Guide

Procedure Code List — The Procedure Code List is a list of procedure codes, including the procedure
code number, description, abbreviated procedure codes, time allotted for each procedure, appointment
type, paint type, and treatment area.

Dental Diagnostic Code List — The Dental Diagnostic Code List is a list of all dental diagnostic codes
that have been entered.

Medical Code List — The Medical Code List is a list of all medical procedure codes entered. Codes are
grouped by code type (AMA, ICD, modifier, place of service, and type of service).

Multi Code List — The Multi-Code List is a list of all multi-codes or a range of multi-codes.

Standard Coverage Table Report — The Standard Coverage Tables Report lists the coverage tables that
are set up in the Office Manager. The report includes the coverage percentage, co-payment, and pre-
authorization flag for each range of procedures.

Insurance Coverage Tables Report — The Insurance Coverage Tables Report lists the coverage tables that
have been set up for each selected insurance plan.

Updated Dental Insurance Payment Tables Report — The Updated Dental Insurance Payment Tables
Report lists all procedures and the covered dollar amount for procedures listed in the payment table for
the selected dental insurance carriers.

Custom Practice Information Report — The Custom Practice Information Report lists information that
can be customized in Practice Definitions: billing types, payment types, adjustment types, custom notes,
medical alerts, appointment status types, and appointment check list.

Registration Information Report — The Registration Information Report lists the practice information
and serial number of your Dentrix Enterprise software.
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Management Reports

In the Office Manager, from the Reports menu, point to Management, and then click a management report

option:

*  Day sheet (charges and receipts) — The day sheet is a report designed to help you keep track of your
daily production and collection figures. It lists all transactions posted during the day (or date range
specified) including procedures, payments, adjustments, and finance charges. The day sheet can be
customized to include or exclude specified information, and can be printed in a variety of formats.

*  Referred To Doctor Report — The Referred TO Doctor Report lists the number of patients who have
been referred to another practice during a specified time period. Depending on report settings, this report
also lists the name and referral date of each referred patient. The report is organized by referral. You can
also create mailing labels for those doctors to whom your patients have been referred.

*  Referred By Doctor/Other Report — The Referred BY Doctor/Other Report lists each referring doctor
or non-person referral source (for example, an advertisement) that has referred a patient to your practice
within a specified date range. For each referring doctor/other listed, a list of referred patients is included
with patient information and details regarding production generated by the referral. You can also print
mailing labels for each referral source.

*  Referred By Patient Report — The Referred BY Patient Report lists each patient who has referred another
patient to your practice within a specified date range. For each referring patient listed, there is a list of
patients that have been referred, including production details resulting from that referral. You can also
print mailing labels for each referral source.

Ledger Reports

In the Ofhice Manager, from the Reports menu, point to Ledger, and then click a ledger report option:

*  Family Ledger Report — The Family Ledger report includes all transactions for all patients in the family
posted since the beginning date specified. The date of treatment, tooth number, description, patient,
charges, payments and a running balance are included on the report. Depending on report settings, the
current balance of each patient in the family is also displayed on the report.

* DPatient’s Ledger Report — The Patient’s Ledger report includes all transactions for a patient(s) posted
since the beginning date specified. The date of treatment, tooth number, description, patient, charges,
payments, and a running balance are also included on the report.

*  Payment Agreement Report — The Payment Agreement Report displays analysis and management
information for monitoring payment agreements. The report includes information on the agreement
terms, the remaining balance for the payment agreement, and missed payments, and the last payment
date and amount.

*  Future Due Payment Plan Report — The Future Due Payment Plan Report displays payments that can
be expected based on established payment plans by month. You can also run the Monthly Totals Report.

*  Referral Recap Report — The Referral Recap Report lists completed and treatment-planned work for
each referral source that appears on the report. Each referred patient will appear on a separate page.

233
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List Reports

In the Office Manager, from the Reports menu, point to Lists, and then click a list reports option:

Dentrix Enterprise 7.0 User's Guide

Daily Appointment List — The Daily Appointment List consists of three separate reports:

*  Operatory Appointment List — This report lists all appointments for a selected range of dates and
by the selected providers and operatory ranges. The list includes the appointment date, status, time,
patient name, provider and operatory, appointment reason, and appointment duration.

*  Patient Route Slips — Patient route slips can be printed for all patients scheduled within the date
range. The route slip provides comprehensive account and treatment information for the scheduled
patient.

*  Daily Appointment List — This report gives the same information as the Operatory List, but in a
different format, and includes the patient phone numbers.

Unscheduled Appointment List — The Unscheduled Appointment List displays patient appointments
that have been broken (and not rescheduled) or placed on the wait/will call list during a specified time
period. This list can aid your office in rescheduling those appointments.

Unscheduled Treatment Plans Report — The Unscheduled Treatment Plans Report displays patients for
whom there has not been an appointment scheduled for their treatment-planned procedures.

Treatment Plan Approval Report — The Treatment Plan Approval Report lists pre-treatment estimate
insurance claims that have been received and accepted. The treatment plan, estimate amount, and
whether the pre-treatment was accepted or rejected are also included on the report.

Treatment Plan Approval Status Report — The Treatment Plan Approval Status Report lists treatment-
planned procedures for selected approval statuses, along with relevant patient and procedure information.

Insurance Eligibility Report — The Insurance Eligibility Report lists insurance carriers and the patients
eligible for coverage under each carrier and includes information such as the patient’s eligibility date,
subscriber’s name and ID, insurance carrier’s address, group plan number, and patient’s next appointment.

Perio Exam List — The Perio Exam Lists is a list of patients who have had a periodontal exam created
within a specified date range.

New Patient List — The New Patient List is a list of all patients in the practice whose first visit dates fall
within a specified date range. You can also print mailing and chart labels for this list of patients. The list
includes each patient’s name, address and first visit date.

Patient Notes Report — The Patient Notes Report displays any notes you have entered for a patient. You
can indicate which patients to print based on name, provider, or billing type, and you can select which
types of notes to include.
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Generating Billing Statements

Billing statements provide guarantors with a record of their financial transactions with the practice.

Printer-generated billing statements can save you the cost of pre-printed forms without losing the professional
look of pre-printed forms. However, if you intend to use pre-printed forms, be sure to purchase forms that are
supported by Dentrix Enterprise.

For information about where to specify the billing statement form that you want to use, see “Setting Up
Practice Defaults” in Chapter 1: Introduction and Initial Setup. Also, for information about how to set up
billing statements to include the central office, clinic, or provider information, see “Setting Up Clinics” in
Chapter 1: Introduction and Initial Setup.

To generate bllllng statements % Dentrix Office Manager - The Dentist Group <CENTRAL>

= Letters  Maintenance  Analysis
1. In the Office Manager, from the Reports menu, click Billing. 3
The Billing Statements dialog box appears. ‘ D..E:it;.?.,:m

2. Set up the following options: — {2) s

* Statement Date — Type a cutoff date.

Statement Date:\0417/2013  Balance Forward Date: |03 722012

The statements will include procedures Select Gusrantor Optians
up to and including the date entered’ and From: |<al Ls ﬂ ¥ Skip Accounts with Claim Pending
H . 3 ...|f Patient Partion Less Thar:|20.00
all statement calculations will be as of Terjeall> > sherh Faan mess Than
Procedures “With Claims Pending. ..
that date. Furn Report Show: & Curent ¢ Al None
* by Provider I Print Insurance E stimate
° Balance Forward Date — Type a balance From: [<ALL> ﬂ Ta [l ﬂ IV Frirtt greed Payment
f . . . v Exclude Outstanding To Insurance
orward date. Dentrix Enterprise will @ LGl -
calculate the total of all outstanding CENTRAL 2| || T PrintAccount Aging

procedures posted up to the date entered
and give the total balance forward
amount on the statements rather than an
itemization of procedures.

Select Guarantor — Click the search

Select Biling Type:

From <ALL> | TofalLs >

Minirnum Balance To Bill:|0.01

I Include Credit Balances?

Statement Message: e

I~ Allows Credit Card Payment
¥ If Mot Billed Since: |03 7./2013
¥ Only Bill Accounts Aging:
* Ower30 O OverB0 ¢ Owver90

Select Report Types
¥ Biling Staternent
™ Mailing Labels

' H

Payment iz Due on May 1, 2013
buttons ** to select the range of

guarantors for whom you want to generate
statements, or leave From <ALL> To
<ALL> selected to include all guarantors.

[~ Save As Default

3 Cancel

Ng?®

*  Run Report — Select how you want to
generate statements:
* By Provider — To generate statements by provider, select this option, and then click the search
buttons *”| to select a range of providers to generate statements for those providers’ patients; or
leave From <ALL> To <ALL> selected to include patients for all providers.

* By Clinic — To generate statements by clinic, select this option, and then click the search button
»>1 to select the clinic that has the patients for whom you want to generate statements.

*  Select Billing Type — Click the search buttons **/ to select the range of billing types of patients
for whom you want to generate statements, or leave From <ALL> To <ALL> selected to include all
billing types.

*  Minimum Balance to Bill — Dentrix Enterprise will generate statements for patients who have a
balance equal to or greater than the amount entered. For example, if you enter 20, Dentrix Enterprise
will generate statements for patients who have a balance of at least $20.

* Include Credit Balances? —To generate statements for patients who have a credit balance, select this
option.
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* Statement Message — Type the message you want to have appear at the bottom of each statement,
such as “Brush and floss regularly,” or “All payments are due on or before the 5th day of the month.”

Tip: For information about entering a customized billing statement note for any individual
guarantor, see “Billing Statement Notes” in Chapter 7: Ledger.

*  Options — Select the options you want to use to determine which accounts will receive a bill and
what to include on the statements:

*  Skip Accounts with Claim Pending — To skip an account if the patient has any outstanding
claims for which the guarantor portion of the balance is less than the dollar amount you specify
in the If Patient Portion Less Than field.

*  Procedures With Claims Pending
e  Current — To include procedures posted in the current month for which a claim has been
created and s still pending (not received).
*  All - To include all procedures posted for which a claim has been created and is still pending
(not received).
*  None — To exclude all procedures for which there is still a claim pending,.

e Print Insurance Estimate — To include the estimated amount that dental insurance will pay on
pending claims.

*  Print Agreed Payment — To have a box labeled “Please Pay This Amount,” which reflects the
patient portion of the balance or the payment amount required for a payment agreement set up
previously, appear on statements.

To have the “Please Pay” amount exclude the entire amount that has been billed to insurance on a
pending claim, even if some of it is a patient portion, select Exclude Outstanding to Insurance.

*  Print Practice Information — If your default billing statement is not the Full Form/Download
Form, and if you are using a pre-printed form without your practice information already printed
on it, select this option.

*  Print Account Aging — If your default billing statement is the Full Form/Download Form, to
include an aging summary on the statements that are formatted to allow report aging, select this
option.

* Allow Credit Card Payment — If your default billing statement is the Full Form/Download
Form, to include credit card payment options on the statement, select this option.

e IfNot Billed Since — To skip patients for whom a billing statement has already been printed
since the date you specify. (The last statement date appears in each account’s Ledger.)

Tip: This option works well for practices that print billing statements from the Ledger when

an insurance payment is received for an account. You can use cyclical billing as statements are
printed for individual accounts throughout the month and then printed from the Office Manager
in a batch to ensure that each account has received a statement for the month.

*  Only Bill Accounts Aging — To generate statements for patients whose balance has aged at least
as much as the aging bracket you select: Over 30, Over 60, or Over 90.
*  Select Report Types — Select the desired report types:
* Billing Statement — To print statements for all guarantors who fall within the specified parameters.

*  Mailing Labels — To print mailing labels with the guarantor’s name and address. Be sure to enter
the number of Columns of labels your label sheets have on them.

*  Save As Default — To save the current settings for the next time you generate statements from this
computer.

3. Click OK to send the billing statements to the Batch Processor.
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Printing Blank ADA Claim Forms

There may be a circumstance when you need to print a blank ADA claim form.

To generate a blank ADA claim form

& Dentrix Office Manager - The Dentist Group <CENTRAL >
Batch Proc

Description
Dentrix Reports @ e

1. In the Office Manager, from the Reports menu, click Blank
ADA Form.

The Dentrix Reports dialog box appears.

Letters Maintenance  Analysis

Select the claim form that you want to print.
Clle YCS. Send Blank ADA Formn to Batch Processor?

1395 Claim Form
= 2000 Claim Form
2003 Clairn Form
7 2007 Clairn Farm

2012 Clairn Farm

[ Sawe s Default Claim Form

@mm

Creating Letters

With Dentrix Enterprise, you can create custom reports and letters as Microsoft Word documents or as data
files for use in spreadsheet programs, such as Microsoft Excel.

Dentrix Enterprise provides an interface between your patient database and Microsoft Word (if installed) that
allows you to create any letters that are applicable to the success and development of your practice. You can
have Dentrix Enterprise merge information from patient records into your letters, based on various ranges,
parameters, and filters that you establish.

Dentrix Enterprise comes complete with pre-defined letter templates in seven categories that you can use and
modify in conjunction with your patient database. For information about how to customize any letter from
Microsoft Word, see the “Customizing Dentrix Enterprise letters” topic in the Dentrix Enterprise Help. For
information about how to create your own letters and add them to any of the categories for future use, see the
“Creating custom letters” and “Adding letters to categories” topics in the Dentrix Enterprise Help.

This section covers the following topics about letter merges:
*  Merging Dentrix Enterprise Letters
*  Creating Appointment Reminder Cards

*  Creating Cards for Patients Without Appointments
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Merging Dentrix Enterprise Letters

You can create letters by merging information from Dentrix Enterprise into Microsoft Word documents. This

section covers the pre-defined templates installed with Dentrix Enterprise.

To merge a Dentrix Enterprise letter

1. Open and minimize Microsoft Word.

Qi

2. In the Office Manager, click Letters on the menu bar.

The Letters window appears.

& Dentrix Office Manager - The Dentist Group <CENTRAL -

Maintenance  Analysis

3. Click the category button of the letter type you want to create:

* Birthday — Birthday letters for patients with a birth date in a
specified range.

*  Continuing Care — Continuing care (recall or recare) notices to patients
within a recall date range.

Letters @

Birthday... |
Continuing Care...
Referal...

*  Referral — Referral letters for anyone who has referred or to whom you are <3 )M

. . . . . .. | tive Patient...
referring patients within a specified range of first visit dates or referral dates. __Inactve Patert._ |
‘welcome...

Misc...
EXIT

*  Collection — Collection notices for patients within a specified range of last
payment dates.

* Inactive Patient — Notices for patients within a specified range of last visit
dates.

*  Welcome — “Welcome to the Practice” letters for patients within a specified range of first visit dates.

*  Misc — Custom letters for specific patients in your database. You will probably put many of the
custom letters you create in this category.

i Referral Letters < CENTRAL>
4. In the dialog box that appears, select a letter, set up a SelheeE ==

date range (if applicable), and then click Create/Merge.
The Create/Merge Options dialog box appears.

Select Letter

diim15 doc
Patient Referral (Gl only) dtxlm16.doc Mew

Wor-Patient Referal

dtxlrn1 6. doc:
dtulrn 36, doc

Patient Referra

5. Select Create Data File and Merge Letters. Fatoned 7o Coflecialst

For details about the Create Data File ONLY and
Merge Letters using existing data file options, see the o
“Other create and merge options” topic in the Dentrix
. Lazt Referral D ate R arig
Enterprise Help. ~|

6. If you want Dentrix Enterprise to add an entry to each

patient’s Office Journal, indicating that a letter was sent
to that patient, select Add to Journal.

7. Click OK.

When the merge is complete, in Microsoft Word, you can print the
letters. Then, close Microsoft Word without saving the changes to
the document.

Yigw List | Yiew Location
(]

+ Create Data File and Merge Letters
(" Create D ata File OMLY

Warning: If you save the changes to the document, patient
information will be permanently saved in the letter template,
rendering the template unusable.
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Creating Appointment Reminder Cards

You can create reminder cards to send to patients with upcoming appointments.

To create appointment reminder cards

1.
2.

Open and minimize Microsoft Word.

In the Office Manager, click Letters on the menu bar.
The Letters window appears.

Click Continuing Care.

The Continuing Care Letters dialog box appears.
Select Continuing Care -- With Appt.

@j
& Dentrix Office Manager - The Dentist Group <CENTRAL »

Maintenance  Analysis

Note: This is the default for the letter template name

Continuing Care Letters <CENTRAL=

Select Letter

when Dentrix Enterprise is initially installed, but the
name might have been changed.

Click Edit.
The Patient Report View dialog box appears.
In the Merge Letter Template field, type one of the

following template document names, based on the
type of cards you are using:

e  dxlm29.doc — 2-wide, laser cards.

Appointment Cards-F eminder
Cantinuing Care - /0 Appt

Continuing Care Letter-AuIt dthmD4.d Mew
Continuing Care Letter-Child dtxlm05. doc
Continuing Care-Inactive dtxlm03.doc

Creal@™erge |

dtxlm25.doc
dtxlm26. do
dtxlm oc

1 Appk

Delete

“Wiew List Wigw Location

Cloze

* dxlm24.doc — Single-wide, dot matrix cards.
* dtxlm27.doc - 2-wide, dot matrix cards.

Patient Report View

Letter Mame: |F'atient Feport [by filters)

Patient Fiters | Data Fields |

erge Data File Mame: |dtim22. out
Merge Letter Template: | dtim22. doc

==l

Clinic: [CEMTRAL -
E-mail Options
+ Al Patients © Only Patients w/E-mail © Only Patients vw/out E-mail

Patient Mame: |<ALL>

Status Gender
Provider[z]: DEF_PROV r .
DSMITH Patierit [~ Male
v Al SHAYES [ Inactive ™ Femal
[~ Maon-Patient smae

Use Privacy Request for "Mao comespondence’’ to skip patients
" Does not apply for this letter % Applies for Patients and Guarantors

Birthday: ﬁ Emp:
Consent Date: ﬁ Fief By:
st Wisit Date: ﬁ Ref To:
Last Vigit Date: ﬁ Ins Cox
Continuing Care: @—ﬁ City:
Last Ref Date: ﬁ Zip:
Last Pay Date: ﬁ Alerts:
Balance: ﬁ Motes:
Pay Plan Bal: ﬁ Proc:
Appointments: ﬁ
Billng Typeis; _— g
1: Standard Biling - finance charges  »
v Al

3 Insurance Family - delay finance chq £
4 Inzurance Family - finance charges —
5. Payment Plan - finance charges

E: Payment Plan - no finance charges ™

2. Standard Biling - no finance charge |

[T <30 [ <60 I <90 [T <90+

ﬂ to |<ALL> 5

™ Guarantors Only

Pasition
™ Maried [ Chid
[ Single [ Other

" Applies for "Referred By Patients"

e
|

e
v

[ [mBal I~ (]Bal

_g—

9 Cancel
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7. Set up the continuing care filter: Select Continuing Care Ranges
[=Due Date

,— PROPHY Periodic cleaning 49
From: “Lab- Azpen Aszpen Dental Lab

a. Click the Continuing Care search button **..
The Select Continuing Care Ranges dialog box appears.

b. Under Due Date and Prior Treatment Date, leave From

and To blank.
c.  Under Include, select With Attached Appointment.

ontinuing Care | ype:

*Lab-Alpine Alpine Diental Spe

Ta: “Lab-Heritag Heritage Dental Le
*Lab-HiTech HiTech Dental Te =
Prior Treatment CALL AMALG  Amalgam followup |

CALL CROWMN  Crown follow-up el

From: CaLLRC Froot Canal follow-

F43 Full Mouth Series

To ORTHO Ortho post-treatme ™

d. Under Continuing Care Type, select the appropriate
continuing care type.

Include a
ear
Al

* with Attached Appointment I 0K

e. Click OK.

8. Set up the appointment filter:

" Without Attached Appointrment
Cancel

a. Click the Appointments search button.
The Select Appointment Ranges dialog box appears.

b. Under Search, select Existing patients with appointment in
date range.

c.  Under Appointment Date Range, type the Beginning and
Ending dates of the range of appointments for which you are
printing cards.

d. Click OK.

Search

Select Appointment Range @

(" Praspective Patients with appaintment in date range
I + Existing Patients with appointment in date range I

(" Ewxisting Patients with ND appointment in date range

Appointment Date R ange

Beginning: |11/11,/2012 Ending: [11/11/2013

Clear ()8 | Cancel |

9. Click OK to return to the Select Continuing Care Ranges dialog box.

10. With Continuing Care -- With Appt still selected, click Create/Merge.

The Create/Merge Options dialog box appears.

11. Select Create Data File and Merge Letters, and Add to Journal (if
desired), and then click OK.

When the merge is complete, in Microsoft Word, you can print the
cards. Then, close Microsoft Word without saving the changes to the
document.

Warning: If you save the changes to the document, patient

{* Create Data File and Merge Letters
" Create Data File OMLY
" Merge Letters using existing data file

b’ £1dd to Journal

oK Cancel

Create/Merge Options @

information will be permanently saved in the letter template, rendering the template unusable.
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Creating Car